Kofax MarkView

Administrator's Guide for Oracle E-Business Suite, Volume
1
Version: 9.1.1

Date: 2018-02-26

Portions © 2004-2018 Kofax, 15211 Laguna Canyon Road, Irvine, California 92618, U.S.A. Portions ©
2002-2006 Kofax Development GmbH. Portions © 1997-2006 Kofax Development UK Ltd. All Rights
Reserved. Use is subject to license terms.
This product is protected by U.S. Patent Nos. 5,159,667 and 7,478,332.
Third-party software is copyrighted and licensed from Kofax's suppliers.
THIS SOFTWARE CONTAINS CONFIDENTIAL INFORMATION AND TRADE SECRETS OF KOFAX
USE, DISCLOSURE OR REPRODUCTION IS PROHIBITED WITHOUT THE PRIOR EXPRESS
WRITTEN PERMISSION OF KOFAX.
Kofax is a trademark of Kofax, Inc., registered in the U.S. and/or other countries. All other trademarks
are the property of their respective owners. No part of this publication may be reproduced, stored, or
transmitted in any form without the prior written permission of Kofax.
U.S. Government Rights Commercial software. Government users are subject to the Kofax standard
license agreement and applicable provisions of the FAR and its supplements.
You agree that you do not intend to and will not, directly or indirectly, export or transmit the Software or
related documentation and technical data to any country to which such export or transmission is restricted
by any applicable U.S. regulation or statute, without the prior written consent, if required, of the Bureau
of Export Administration of the U.S. Department of Commerce, or such other governmental entity as may
have jurisdiction over such export or transmission. You represent and warrant that you are not located in,
under the control of, or a national or resident of any such country.
DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS,
REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE
DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY
INVALID.
This product includes iText Library - Copyright © 1999-2005 by Bruno Lowagie and Paulo Soares.
The contents of iText Library are subject to the Mozilla Public License Version 1.1 (the “License”); you
may not use this file except in compliance with the License. You may obtain a copy of the License at
http://www.mozilla.org/MPL/. Software distributed under the License is distributed on an “AS IS” basis,
WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific
language governing rights and limitations under the License.
This product includes software developed by:
• Apache Software Foundation (http://www.apache.org/). Licensed under the Apache License, Versions
1.1 and 2.0 (the "License"); you may not use this file except in compliance with the License. You may
obtain a copy of the License at http://www.apache.org/licenses/LICENSE-1.1 or http://www.apache.org/
licenses/LICENSE-2.0. Unless required by applicable law or agreed to in writing, software distributed
under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF
ANY KIND, either express or implied. See the License for the specific language governing permissions
and limitations under the License.
• Jean-Loup Gailly and Mark Adler - Copyright © 1995-2004.
• The JDOM Project (http://www.jdom.org/).
• Jaxen Project (http://jaxen.org/). Copyright © 2001 werken digital. All Rights Reserved.

Copyright © 2000 – 2006 The Legion Of The Bouncy Castle (http://www.bouncycastle.org)
All other third-party products or brands mentioned in this documentation are or may be trademarks or
registered trademarks and are the property of their respective owners.
LibTiff.Net
Copyright © 2008-2012, Bit Miracle
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
• Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
• Neither the name of the Bit Miracle nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL BIT MIRACLE BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Table of Contents
Preface........................................................................................................................................................ 13
Who Should Read This Guide......................................................................................................... 13
Where to Find Answers....................................................................................................................13
Related Documentation.................................................................................................................... 15
Getting Help for Kofax Products...................................................................................................... 16
Chapter 1: Performing System Maintenance......................................................................................... 17
Administrative Tasks.........................................................................................................................17
Identifying Administrative Tasks............................................................................................ 17
Menus for Performing Administrative Tasks......................................................................... 18
Maintaining the System.................................................................................................................... 20
About Administrative Roles................................................................................................... 20
About the Required Skill Sets............................................................................................... 20
Performing Routine Maintenance.......................................................................................... 21
Shut Down and Restart Sequences......................................................................................24
Maintaining Kofax MarkView Export Connector....................................................................24
Establishing Disaster Recovery Strategies........................................................................... 25
Chapter 2: Setting Up MarkView Users with AUSS...............................................................................28
About MarkView Profiles.................................................................................................................. 29
Active Directory Source System Connection Information................................................................ 31
Running the MarkView AUSS Setup Wizard................................................................................... 32
AUSS Interface................................................................................................................................. 32
Configuring AUSS.............................................................................................................................35
Source System.......................................................................................................................35
Initial User Options................................................................................................................ 36
MarkView Profiles.................................................................................................................. 36
Synchronizing for the First Time........................................................................................... 39
Using AUSS......................................................................................................................................40
Current Status........................................................................................................................40
AUSS Options........................................................................................................................41
Synchronization......................................................................................................................42
Journal....................................................................................................................................45
Troubleshooting AUSS..................................................................................................................... 46
Export or Import Fails............................................................................................................46
Inconsistency Between User Rights and the Everyone Profile Groups and Roles................46

4

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Log File.................................................................................................................................. 46
End-Dated User Authorization in MarkView..........................................................................46
User Not Synchronized after Scheduled Synchronization.................................................... 47
Adding MarkView Users to User Groups.........................................................................................47
Chapter 3: Maintaining Organizations.................................................................................................... 48
Setting Up Organizations................................................................................................................. 48
Prerequisites.......................................................................................................................... 48
Required Tasks......................................................................................................................49
Adding an Organization to MarkView....................................................................................51
Assigning Users..................................................................................................................... 52
Giving All MarkView Users Access to an Organization........................................................ 52
Optional Setup Tasks............................................................................................................ 53
Optional Organization Setup Tasks................................................................................................. 53
Configuring the Workflow................................................................................................................. 53
Determining the Impact of Your Answers on the Workflow.................................................. 54
Setting Workflow Preferences............................................................................................... 54
Defining Sub Types.......................................................................................................................... 60
Sub Type Requirements........................................................................................................60
Adding Sub Types................................................................................................................. 60
Associating Sub Type Roles with MarkView Users.............................................................. 61
Changing the Default Sub Type Selection............................................................................ 61
Disabling Sub Types..............................................................................................................62
Configuring Global AP Settings....................................................................................................... 62
Setting Role Configuration for All Organizations............................................................................. 64
Adding a Role Configuration................................................................................................. 65
Modifying the Role Configuration Setting..............................................................................65
Assigning ERP Responsibilities to MarkView Organizations................................................ 66
Mapping Accounting Details.............................................................................................................68
Mapping Accounting Details to All Organizations................................................................. 68
Mapping Accounting Details to an Organization................................................................... 68
Setting Up Accounting Details Reference Mappings for All Organizations........................... 69
Setting Business Controls................................................................................................................ 69
Configuring Invoice Return Reasons............................................................................................... 70
Adding PO Holds..............................................................................................................................71
Adding a PO Hold Definition to MarkView............................................................................ 71
Changing the Order of PO Hold Processing.........................................................................72
Removing a PO Hold from MarkView................................................................................... 72
Routing Based on PO Holds............................................................................................................72

5

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Setting Up Global Routing.....................................................................................................73
Setting Up Routing by Organization......................................................................................74
Removing a Hold Routing Globally....................................................................................... 75
Removing a Hold Routing by Organization...........................................................................76
Changing an Organization Configuration......................................................................................... 76
Copying a Configuration from Another Organization....................................................................... 77
Removing an Organization...............................................................................................................77
Adding Organizations to MarkView User Groups............................................................................ 78
Supporting Multiple Organizations................................................................................................... 78
Chapter 4: Configuring AP Settings....................................................................................................... 79
Setting Recycle Review Options...................................................................................................... 79
Changing the Frequency of Web Inbox Notifications...................................................................... 79
Setting Up Advanced-Search Capabilities for Web Inquiry............................................................. 80
Creating Return to Supplier Reasons.............................................................................................. 80
Controlling How Work Items Open.................................................................................................. 81
Changing or Adding a WI Class Opener.............................................................................. 82
Changing or Adding WI Class Opener Parameters.............................................................. 82
Setting How Workflows Process Invoice Status.............................................................................. 83
Mapping Responsibilities to User Groups and Roles...................................................................... 84
Managing Document Types............................................................................................................. 85
Creating Document Types.....................................................................................................85
Modifying Document Types................................................................................................... 86
Disabling Document Types....................................................................................................87
Managing View Types...................................................................................................................... 87
Adding View Types................................................................................................................87
Modifying View Types............................................................................................................88
Deleting View Types..............................................................................................................88
Invoice Deletion and Cancellation....................................................................................................89
Chapter 5: Preparing for Mobile Access................................................................................................ 90
(Optional) Information for Adding a Bookmark................................................................................ 90
Configuring What Appears on the Mobile Device............................................................................90
Configuring What Appears in the Web Inbox.................................................................................. 91
Configuring What Appears in the Viewer.........................................................................................91
Chapter 6: Setting Up the MarkView Viewer..........................................................................................92
Minimum MarkView Viewer Requirements...................................................................................... 92
Setting Up a User Group................................................................................................................. 92
Using Accounting Details................................................................................................................. 92
Configuring the Email Document Feature........................................................................................93

6

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

MarkView Viewer Data Flow............................................................................................................ 94
Chapter 7: Setting Up Kofax Capture and Kofax Transformation Modules for MarkView................. 95
About Auto-Categorization................................................................................................................95
Setting the Default Document Type for Invoices without PO Numbers.................................95
Setting the RequireCategorizationInCapture Property.......................................................... 96
About the MarkView Workflow Agent.............................................................................................. 96
Workflow Agent Batch Class Properties............................................................................... 97
Interaction Between Kofax Capture and Workflow Agent Batch Class Properties................ 97
About Kofax Capture Batch Class Templates................................................................................. 97
Importing the Batch Class Templates................................................................................... 98
Chapter 8: Configuring MarkView for Expense Management............................................................ 100
Enabling and Disabling Expense Management............................................................................. 100
Providing Submission Instructions................................................................................................. 100
Adding Invoice Submission Instructions..............................................................................101
Sending Receipt Reminders to Employees................................................................................... 101
Setting Up Receipt Requirements..................................................................................................102
Chapter 9: Setting Up the MarkView Document Library.....................................................................103
Scenario.......................................................................................................................................... 103
Creating Object Types....................................................................................................................104
Adding Object Type Properties........................................................................................... 105
Associating an Object Type and Document Type...............................................................108
Adding Object Type Privileges............................................................................................ 108
Adding Search Fields..................................................................................................................... 110
Excluding an Object Type from the Search........................................................................ 111
Creating Object Type Children.......................................................................................................111
Uploading Documents.................................................................................................................... 111
Chapter 10: Monitoring Queues with the Process Monitor................................................................ 113
Working with Monitor Views...........................................................................................................113
Working with Configurations...........................................................................................................113
Scenario............................................................................................................................... 114
Creating a Configuration......................................................................................................114
Editing a Configuration........................................................................................................ 119
Deleting a Configuration...................................................................................................... 119
Monitoring Multiple Queues in One Bar..............................................................................119
Working in the Bar Graph View..................................................................................................... 120
Changing the Bar Graph Appearance.................................................................................120
Adding a Bar to the Graph..................................................................................................121
Deleting a Bar from the Graph............................................................................................121

7

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Accessing Details About Work Items in a Queue............................................................... 122
Working with a Queue Items Display List......................................................................................122
Accessing Work Item Details.............................................................................................. 122
Editing a Queue Items Display............................................................................................123
Using Toolbar Buttons....................................................................................................................123
Changing Process Monitor Characteristics.................................................................................... 125
Displaying UTF-8 Characters.............................................................................................. 127
Monitoring Special Cases....................................................................................................127
Chapter 11: Managing MarkView Users, User Groups, and Roles.................................................... 128
Giving MarkView Users Access to MarkView................................................................................ 130
Scenario: Separating Tasks................................................................................................ 130
Scenario: Restricting Access to MarkView..........................................................................131
MarkView User ID and Password Requirements...........................................................................132
Managing Users..............................................................................................................................132
Creating Users..................................................................................................................... 132
Disabling Users in MarkView.............................................................................................. 133
Deleting Users..................................................................................................................... 133
Assigning Users Manually.............................................................................................................. 133
Adding Users to User Groups............................................................................................. 133
Adding Users to a Role.......................................................................................................134
Managing Alternate Users..............................................................................................................134
Finding a Qualified Alternate User...................................................................................... 135
Adding an Alternate User Assignment................................................................................ 135
Removing an Alternate User Assignment........................................................................... 136
Handling Termination Cases............................................................................................... 136
Managing MarkView User Groups................................................................................................. 136
Creating User Groups..........................................................................................................136
Assigning Permissions to User Groups...............................................................................136
Authorizing User Groups Access by Organization.............................................................. 137
Deleting User Groups.......................................................................................................... 137
Managing User Roles.....................................................................................................................138
Creating Roles..................................................................................................................... 138
Configuring Roles................................................................................................................ 138
Deleting Roles......................................................................................................................139
Scenario: Limiting Request Comment............................................................................................139
Restricting Request Comment to a Limited Set of Users................................................... 139
Enabling Request Comment for a User Group................................................................... 139
Disabling Request Comment for a User Group.................................................................. 139

8

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

About Job Functions.......................................................................................................................140
Chapter 12: Configuring MarkView Menus...........................................................................................147
About Menu Items.......................................................................................................................... 147
Adding a Menu Item.......................................................................................................................149
Modifying a Menu Item...................................................................................................................149
Removing a Menu Item..................................................................................................................149
Assigning Menu Items to User Groups..........................................................................................150
Chapter 13: Setting Up a MarkView Approval Hierarchy....................................................................152
Setting Up Hierarchy Components.................................................................................................152
Maintaining Approval Organizations....................................................................................152
Maintaining Job Titles..........................................................................................................153
Maintaining Approval Users.................................................................................................154
Creating Hierarchies....................................................................................................................... 156
Maintaining An Approval Hierarchy................................................................................................156
Updating a Hierarchy...........................................................................................................157
Deleting a Job Assignment................................................................................................. 157
Deleting a Job Assignment and Subordinate Assignments................................................ 157
Assigning a Different User to a Job....................................................................................158
Deleting User Association to a Job.....................................................................................158
Changing the Supervisor/Subordinate Relationship............................................................158
Updating an Approval Limit for a Job................................................................................. 158
Introducing a New Level in a Hierarchy........................................................................................ 158
Chapter 14: Maintaining MarkView Add-On Products.........................................................................160
Setting Up the MarkView Export Server........................................................................................ 160
Setting Up the Export Server.............................................................................................. 160
Batch Printing.......................................................................................................................161
MarkView DTM............................................................................................................................... 163
Configuring DTM for the Application Server....................................................................... 163
Self-Service Invoice........................................................................................................................ 165
Setting Invoice Header and Line Fields.............................................................................. 166
Managing Follow-Up Documents........................................................................................ 168
Maintain Supplier Information..............................................................................................170
Chapter 15: Migrating Environments.................................................................................................... 171
Migration Utility: Configuring an Existing Non-Production Environment........................................ 171
Using the Migration Utility................................................................................................... 171
Refreshing a New Non-Production Environment........................................................................... 173
Chapter 16: Configuring Automated Actions.......................................................................................174
Chapter 17: User Authentication........................................................................................................... 177

9

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Oracle E-Business Suite Authentication........................................................................................ 177
MarkView Internal Authentication...................................................................................................177
Microsoft Active Directory...............................................................................................................178
Oracle Internet Directory................................................................................................................ 178
General LDAP Server.....................................................................................................................179
Custom Authentication....................................................................................................................180
Chapter 18: Invoice Audit...................................................................................................................... 181
Configuring the Invoice Audit Utility............................................................................................... 181
Invoice Audit .csv File Format.............................................................................................181
Invoice Audit Security Considerations.................................................................................182
Invoice Audit Performance Implications.............................................................................. 182
Using Invoice Audit.........................................................................................................................182
Sample Invoice Audit Report...............................................................................................182
Chapter 19: Using MarkView Preferences............................................................................................183
Preference Attributes...................................................................................................................... 183
Changing Preference Settings....................................................................................................... 187
Changing Settings through Organization Setup.............................................................................187
Administration Preferences.............................................................................................................188
Logging Level Preferences.............................................................................................................188
Chapter 20: MarkView Preferences....................................................................................................... 190
MarkView for Accounts Payable Preferences................................................................................190
MarkView Administration Preferences........................................................................................... 207
MarkView Applications Preferences............................................................................................... 216
MarkView Approval/Rejection by Email Preferences..................................................................... 216
MarkView Audit Preferences.......................................................................................................... 217
MarkView AUSS Preferences........................................................................................................ 217
MarkView Authentication Preferences........................................................................................... 218
MarkView Bar Code Generator Preferences................................................................................. 222
MarkView Bar Code Server Preferences....................................................................................... 222
MarkView Components Preferences.............................................................................................. 222
MarkView Connector Preferences..................................................................................................223
MarkView Database Objects Preferences..................................................................................... 225
MarkView Document Library Preferences......................................................................................228
MarkView DTM Preferences.......................................................................................................... 230
MarkView e-Invoice Preferences....................................................................................................235
MarkView Expense Management Preferences.............................................................................. 236
MarkView Export Server Preferences............................................................................................ 238
MarkView Folder Desktop Edition Preferences............................................................................. 238

10

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

MarkView Folder Preferences........................................................................................................ 239
MarkView for Oracle Applications Preferences..............................................................................239
MarkView Invoice Audit Preferences............................................................................................. 240
MarkView Mobile Preferences........................................................................................................240
MarkView Process Administration Preferences............................................................................. 241
MarkView Process Monitor Preferences........................................................................................ 243
MarkView Receipt Invoice Verification Preferences.......................................................................246
MarkView Self-Service Invoice Preferences.................................................................................. 246
MarkView User Display Preferences..............................................................................................249
MarkView Viewer Preferences....................................................................................................... 250
MarkView Web Folder Preferences............................................................................................... 254
MarkView Web Inbox Preferences.................................................................................................255
MarkView Web Inquiry Preferences...............................................................................................257
Chapter 21: Troubleshooting Guidelines............................................................................................. 259
Solving Issues with User Functions............................................................................................... 259
Identifying Common AP Entry Mistakes.........................................................................................259
Resolving Email, Fax, and Print Issues......................................................................................... 260
Email.................................................................................................................................... 260
Investigating Workflow Issues........................................................................................................ 260
Addressing Performance Issues.................................................................................................... 260
Verifying the State of MarkView and the Viewer........................................................................... 261
Viewer Displays an Error About the Number of Pages.......................................................261
Finding a Lost Invoice.................................................................................................................... 261
Viewing Expense Reports After an AP Import...............................................................................261
Logging Resources.........................................................................................................................261
Capture and Output Components....................................................................................... 261
Fax Server........................................................................................................................... 262
Applications Log...................................................................................................................262
MarkView Installation........................................................................................................... 262
Clearing Log Files................................................................................................................262
Synchronizing Password Changes.................................................................................................262
Updating the MarkView Schema Password on the WebLogic Application Server.............. 263
Updating the MarkView Schema Password on the WildFly Application Server.................. 263
Updating Capture and Output Component Passwords....................................................... 263
Chapter 22: Component Performance Tuning..................................................................................... 266
Performance Issues and Measurements....................................................................................... 266
Using Performance Monitoring Tools.............................................................................................266
Starting Points................................................................................................................................ 267

11

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Database Tuning............................................................................................................................ 267
Database Transactions........................................................................................................ 267
User Session Transactional Timeline..................................................................................267
Appendix A: Synchronous and Asynchronous Events...................................................................... 269
Asynchronous Events..................................................................................................................... 269
Synchronous Events.......................................................................................................................269
Changes in MarkView Process Manager.......................................................................................269
Appendix B: Removing MarkView from the Oracle E#Business Suite..............................................271
Removing MarkView from Oracle Internet Expenses.................................................................... 271
Replacing Modified Oracle Forms....................................................................................... 271
Removing Integration Points from the APEXP Workflow.................................................... 271
Removing Integration Points from the OIE Regions........................................................... 273
Removing MarkView Customizations from the APPS.AP_WEB_OA_CUSTOM_PKG
package...........................................................................................................................274
Appendix C: Third-Party License Agreement...................................................................................... 275

12

Preface
The Kofax MarkView Administrator's Guide, Volume 1, describes how to administer the MarkView system.
This guide describes how to configure and maintain the applications, solutions, and users that make
up the MarkView suite. The guide also describes how MarkView influences the administration of other
servers and software that interface with MarkView applications.
The MarkView Administrator should be well-versed in database administration, application server setup,
tuning and maintenance and so forth, or should know where to get such information. The administrator's
guide does not replicate this information, but conveys MarkView product-specific information.

Who Should Read This Guide
The following audiences should use this guide:
• MarkView Administrators, who are responsible for day-to-day administration of the MarkView suite.
Although these administrators may be familiar with enterprise software administration, they may not be
familiar with MarkView.
• Oracle Database Administrators, who perform the core database object installation and configuration.
These administrators should be familiar with Oracle database conventions and be comfortable
running and editing PL/SQL scripts. The MarkView Administrator's Guide, Volume 2 covers advanced
administration tasks.
Before using this guide, the administrator should have completed MarkView Level 1 training.

Where to Find Answers
Information Category

Where to Look

Questions Answered

System Maintenance

Performing System
Maintenance on page 17

What level of experience should I have to perform
which tasks?
What must I do on a daily, weekly, or monthly basis?
What are the correct shut down and start up
sequences to use?
How do I repair or remove server software for different
MarkView components?
How do I update the MarkView system or apply
patches?

Initial MarkView Setup

Setting Up Organizations on
page 48

How do I add organizations to MarkView?
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Information Category

Where to Look

Questions Answered

MarkView Setup
Management

Maintaining Organizations on
page 48

How do I change the workflow for an organization?
How do I define Sub Types?
How do I adjust the percentage of invoices that
undergo reviews?
How do I change the high-dollar amount that requires
an invoice to undergo review?
How can I reduce the possibilities of fraud?
How can I keep my system secure?

Configuring AP Settings on
page 79

How do I change the frequency of MarkView
notifications?
How do I change what appears on the MarkView cover
page?

Setting Up the MarkView
Viewer on page 92

How do I give a user group access to the viewer?

Configuring MarkView for
How do I add instructions to the interface for
Expense Management on page employees to follow when submitting expense reports?
100
Monitoring Queues with the
Process Monitor on page 113

How do I create configurations in the Process Monitor
to monitor queues?
How do I ensure that invoices on hold do not get
stuck?

Managing MarkView
Users

Managing MarkView Users,
User Groups, and Roles on
page 128

What is a MarkView User Group?
What is a MarkView Role?
What are the default MarkView User Groups and
Roles?
How do I add users to MarkView and why?
How do I add user groups and roles to MarkView and
why?
How do I assign users to user groups and roles?
How do I set up alternate users when an employee is
out unexpectedly?

Configuring MarkView Menus
on page 147

How do I control which menu options a MarkView user
sees?
How do I manage what actions a MarkView user can
take in the MarkView viewer?

Add-On Product
Maintenance

Setting Up a MarkView
Approval Hierarchy on page
152

How do I set up a MarkView Approval Hierarchy?

Maintaining MarkView Add-On
Products on page 160

How do I set up and configure the Self-Service Invoice
application?
How do I set up MarkView to print batches of invoices?

Utilities

Invoice Audit on page 181

How do I use the Invoice Audit utility?
What format should I use when creating the csv file?
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Information Category

Where to Look

Questions Answered

Preferences

Using MarkView Preferences
on page 183

When should I change a preference and which ones
am I most likely to change?
What is the difference between a system-level
preference, a group- or role-level preference, and a
user-level preference?

MarkView Preferences on page Where can I find the preference settings to use?
190

Related Documentation
For more information about Kofax MarkView products, see:
Kofax MarkView Features Guide
Use this guide to learn about the features included and options available with MarkView; to become
familiar with MarkView products; and to decide which are important to the business challenges you face
and best suit your site. This guide includes information about how features impact the workflow, the
interaction between features, the touch points with the ERP system, and how features address business
problems.
Kofax MarkView Planning Guide
Use this guide to learn about the prerequisites for implementing MarkView products. This guide includes
system information, such as the protocols required for communication between servers, hardware and
software prerequisites, and minimum RAM requirements.
Use this guide in conjunction with the Technical Specifications document on the Kofax website to prepare
a site for product installation.
Kofax MarkView Installation Worksheet
Use this worksheet to collect and record the information to install or upgrade MarkView products before
you begin to install or upgrade.
Kofax MarkView Installation Guide
Use this guide in conjunction with the Kofax MarkView Installation Worksheet to install and configure
MarkView products and to configure third-party products that integrate with MarkView.
Kofax MarkView Upgrade Guide
Use this guide in conjunction with the Kofax MarkView Installation Worksheet to upgrade and configure
MarkView products.
Kofax MarkView Reintegration Guide for Upgrades to Oracle E-Business Suite R12 or 12.2
Use this guide to reintegrate MarkView after an upgrade to Oracle E-Business Suite R12.
Kofax MarkView Administrator's Guide, Volume 2
Use this guide to maintain MarkView components that are administered outside of the MarkView interface.
This guide includes advanced administrative tasks and describes MarkView Custom Packages and Join
Points.
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Kofax MarkView Release Notes
Use this document to learn what is new with the latest MarkView release, identify outstanding defects and
work-around solutions where applicable, and learn which defects the release fixes.

Getting Help for Kofax Products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.
To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.
Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com/support.
The Kofax Support page provides:
• Product information and release news
Click a product family, select a product, and select a version number.
• Downloadable product documentation
Click a product family, select a product, and click Documentation.
• Access to product knowledge bases
Click Knowledge Base.
• Access to the Kofax Customer Portal (for eligible customers)
Click Account Management and log in.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.
• Access to support tools
Click Tools and select the tool to use.
• Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.
Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.
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Chapter 1

Performing System Maintenance
This chapter describes the administration tasks needed to maintain and optimize MarkView system
performance.

Administrative Tasks
Identifying Administrative Tasks
Although some of the following tasks are completed as part of the initial MarkView installation and
configuration, you may need to perform the tasks again or use administration features to maintain the
MarkView system.
To minimize disruption to MarkView users, perform system administration and maintenance when the
system is quiet. Also, be aware of your company’s change-management processes when making changes
to the MarkView system. For example, first make your change in a non-production environment, have an
appropriate user validate the change, then coordinate with the appropriate parties before migrating the
change to the production environment.

Basic Administrative Tasks
Tasks that you are likely to perform frequently include:
• Performing regular system maintenance (see Maintaining the System).
• Assigning Alternate users (see Managing Alternate Users).
• For MarkView for Accounts Payable, creating messages for return reasons (see Configuring Invoice
Return Reasons on page 70).
Tasks that you will perform infrequently are usually part of initial system setup and include:
• Setting up organizations (see Setting Up Organizations).
• Mapping Automatic User Setup and Synchronization (AUSS) users.
• Granting menu authorization to groups (see Assigning Menu Items to User Groups on page 150).
• Creating Sub Types and assigning users to the associated roles (see Defining Sub Types).
• Configuring status notifications (see Changing the Frequency of Web Inbox Notifications).
• Maintaining MarkView for Accounts Payable by:
• Mapping Accounting Details to a an organization (see Mapping Accounting Details).
• Setting up hold routing (see Routing PO Holds).
• Configuring MarkView hierarchies if you are not using the Oracle hierarchy and need to set up a
hierarchy (see Setting Up a MarkView Approval Hierarchy).
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For configuring options, provide expense report submission instructions (see Providing Submission
Instructions).

Advanced Administrative Tasks
The following administrative tasks are also performed infrequently, but require a higher level of MarkView
knowledge and training than that required for completing basic administrative tasks.
• Adding user groups (see Managing MarkView User Groups).
• Adding users to MarkView (see Managing Users on page 132).
• Adding roles (see Managing User Roles on page 138).
• Configuring Form Block Functions (see Assigning ERP Responsibilities to MarkView Organizations on
page 66).
• Configuring how work items open (see Controlling How Work Items Open).
• Creating menus (see Configuring MarkView Menus).
• Setting up the Document Library (see Setting Up the MarkView Document Library on page 103)
• Revising the bar code cover page setup (see the Kofax MarkView Administrator's Guide, Volume 2,
Chapter 1, MarkView Custom Packages, "MVRM_BAR_CODE_CUSTOM").

Menus for Performing Administrative Tasks
Administration Menu
Menu Option

Description

User Admin

• Change Password: Lets MarkView users change passwords.
• Alternate User Assign: Lets you or the MarkView user reassign work items to
another MarkView user.

MarkView Admin

Create and maintain MarkView users and user groups, and configure MarkView
platforms, volumes, and preferences.

Process Admin

Administer the MarkView workflows including creating and maintaining process
users and roles.

Module Admin

Administer business modules such as MarkView Accounts Payable,
Organization, and Sub Type setup. These pages provide administrative access
to database tables that exist outside the MarkView database objects.

Verify MarkView

Ensures that the Application Server is properly installed and that users can
retrieve documents from the Document Server.

Work Item Details

Access the history and attributes of a work item.

Approval Hierarchy Admin

Manage the approval hierarchy within MarkView.

Load Hierarchy Data

Add MarkView hierarchy data from a .csv file. For the best results, use the AUSS
feature instead of loading hierarchy data. For more information, see Setting Up
MarkView Users with AUSS on page 28.

AUSS Mapping Administration

Set up Automatic User Setup and Synchronization (AUSS) to automate the
process of maintaining MarkView users and user groups based on changes
made in the ERP.
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Menu Option

Description

Migration Utility

Update the environment specific MarkView URLs and design time data after a
database migration.

Automated Actions

Configure the system to automate some tasks associated with the invoice
workflow.

Authentication Configuration

Configure the authentication method for MarkView:
• MSAD: Microsoft Active Directory
• OID: Oracle Internet Directory
• LDAP: General LDAP Server

Utilities Menu
Menu Option

Description

Process Monitor

Provides a graphical view of the current status of business processes, and
spreadsheet style views of the history and results of work performed to date.

Bar Code Generation

Creates bar code cover pages for document images being entered into the
MarkView system.

Scan Batch Cover Page

Creates a standard page to accompany all batches scanned into the system.

System Status

Displays the results of status queries. To view the system status, the user must
be a member of the Module Administrator user group.

Apps Version

Shows the version numbers of Oracle applications installed on the system.

Interactive Queries

Generates online reports.

Web Inbox Menu
Menu Option

Description

AP Invoices

Displays items currently in the Web Inbox for AP invoices.

Supplier Documents

Lets the Web Inbox owner handle supplier documents routed to them.

Exception Documents

Lets the Web Inbox owner handle exception documents (such as rescan, manual
review, and so forth) routed to them.

Web Inquiry Menu
Menu Option

Description

AP Invoices

Lets a user run queries to locate invoices in the ERP system.

Returned Invoices

Lets a user search for invoices that were returned to the supplier.

Prev Entered Menu
Menu Option

Description

Working Folder

Displays previously entered working folder documents and lets users attach
documents to one or more existing invoices.
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Document Library Menu
Menu Option

Description

Home

From the Document Library > Home page, lets users upload and search for
documents to use in the MarkView system.

Admin

Lets the library administrator create and maintain user profiles, user groups
and object types, modify object type properties, assign preferences and
authorizations, and define search fields.

Maintaining the System
About Administrative Roles
As a MarkView Administrator, you must complete the correct level of technical training and have the
skill set required to administer the system. Each person who takes part in MarkView administration must
complete the Level I technical training offered by Kofax.
Some administrative tasks require a higher level of training. Kofax offers Level II and Level III training to
meet those requirements. For information about training, contact Kofax Education Services.
MarkView administrative roles that might be filled by one person or by multiple people include:
• Business Analyst: Primary point of contact for the MarkView system.
• Database Administration (DBA): The administrator of the database that contains the MarkView
database schema and who has the ability and authority to perform database administration.
• ERP System Administrator: The administrator who performs general maintenance and updates on the
ERP system that integrates with MarkView.
• Server Administrator: The administrator who maintains and updates the server environments that
support MarkView.
• Desktop Administrator: The administrator who maintains and updates the Windows-based server
environments supporting MarkView, and the desktop environments for the MarkView users.

About the Required Skill Sets
The following table identifies the skills required to administer the MarkView system. Depending on your
organization, these skills may be performed by one person, or by multiple people in different roles.
Because each organization is unique, the following table identifies skills for a suggested role. The roles in
your organization may differ.
MarkView System Administration
Skill Set

Business
Analyst

DBA

ERP

Thoroughly understands the ERP setup

x

x

x

Server
Administrator

Desktop
Administrator
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Skill Set

Business
Analyst

DBA

ERP

Server
Administrator

Desktop
Administrator

Capable of understanding the MarkView
architecture including basic technical aspects
and communication protocols between
MarkView components

x

x

x

x

x

Knowledgeable about the current ERP
business rules and MarkView business
process workflows

x

x

Capable of taking responsibility for MarkView
data setup and MarkView administration

x

x

Capable of serving as facilitator/coordinator
for various IT projects and issue resolution

x

Capable of determining the resolution path
x
and who to involve regarding MarkView issues
and questions
Capable of understanding of the integration
points between the ERP and MarkView

x

Capable of managing MarkView Server
applications

x

x

x

x

x

Capable of installing the MarkView viewer on
the end-user desktops

x

Capable of managing the MarkView schema
and the database where the schema resides;
able to run database scripts to gather
information
Completed MarkView Level I Training

x

x

x

x

x

x

Performing Routine Maintenance
Perform the tasks defined in this section on a regular basis to keep the system running smoothly. In
addition to recurring tasks that you perform daily, weekly, and monthly, also perform the additional tasks
required for applying patches.
The tables in the following sections identify the administrative role with the skill set to perform the tasks
and the frequency at which to complete the tasks.
Regular maintenance also helps with troubleshooting efforts by serving as a benchmark. Some of the
tasks that you should perform regularly include:
• Gather MarkView schema statistics to chart demand and performance trends. Do this weekly or as
frequently as the DBA recommends.
• Configure your application server logging in accordance with your company requirements.
• For MarkView Capture and Output components, set the event log to a fixed, self-purging size, or to your
company requirements.
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Daily Tasks
Daily Administration Tasks
Skill Set

Business
Analyst

DBA

ERP

Server
Administrator

Desktop
Administrator

Thoroughly understands the ERP setup.

x

x

x

x

x

Identify issues related to MarkView. For
example, a user unable to process documents
or problems with MarkView email.
Respond to questions about the product, such
as:
• Capture and output
• Approval and Approval Hierarchies
• Document routing based on workflow
configuration
• Hold Routing
Use the tools that Kofax provides for
researching and identifying issues. For
example, use SupportWeb to search for
answers about messages, keywords, and
MarkView component issues.
As needed, log an issue with Technical
Support.
Identify work items that fail to process in a
x
workflow. For example, look for work items
that fail to move from a queue. Run Support
Diagnostic Tools to identify the problem. Take
Return-To Actions.
As needed, log an issue with Technical
Support.
If not using Automated User Synchronization
and Set-up (AUSS), manually add new users
to the MarkView system and add them to the
appropriate groups.

x

x

Review, monitor, and act (as appropriate)
on MarkView System Status Over Limit
notifications.

x

x
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Weekly Tasks
Weekly Administration Tasks
Skill Set

Business
Analyst

DBA

ERP

Server
Administrator

Desktop
Administrator

Collect statistics in the MarkView schema
using the recommendations by Technical
Support

x

x

x

x

x

Review, monitor, and act (as appropriate)
on MarkView System Status Over Limit
notifications.

x

x

Monthly Tasks
Installing Patches
• Read the patch notes that accompany the patch.
• Update your test environment.
• Install the patch on your test environment. Coordinate and perform system tests and user acceptance
tests (UAT) after installing the patch.
• Install the patch on your development environment.
Monthly Administration Tasks
Skill Set

Business
Analyst

DBA

ERP

Server
Administrator

Desktop
Administrator

Coordinate patch installations and ensure that x
all environments remain up-to-date.
Review, monitor, and act (as appropriate)
on MarkView System Status Over Limit
notifications.

x

x

Archive all MarkView logs, including:
• All Application Server logs
• All DBMS job logs
Install the latest patches and fixes for
MarkView components. (See the Kofax
Customer Portal for current patchset and fix
information.)

x

x

x

x

Study the impact of third-party patches and
updates.

x

x

x

x

As needed, apply patches to maintain thirdparty components. Third-party components
can include database, ERP, operating system,
and operating system security updates.
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Skill Set

Business
Analyst

Ensure that the test and production
environments are at the same revision levels
(both MarkView and the ERP) to facilitate
testing.
Coordinate and perform system testing
and User Acceptance Testing (UAT) after
applying changes or patches to the MarkView
environment.

DBA

ERP

Server
Administrator

x

x

x

Desktop
Administrator

x

Shut Down and Restart Sequences
Shutting Down the System
Note If you shut down your ERP system for maintenance, stop the MarkView system before stopping
the ERP system.
Use the following sequence when shutting down MarkView for maintenance:
1. Stop the MarkView Schema Database User DBMS_JOBS.
2. Stop the Capture and Output Components and stop Kofax Capture services.
3. Stop the MarkView Application Server.

Restarting the System
Note If you shut down your ERP system for maintenance, restart the ERP system before restarting the
MarkView system.
Use the following sequence when restarting your MarkView environment:
1. Start the MarkView Application Server.
2. Start the Capture and Output Components and Kofax Capture services.
3. Start the database DBMS_JOBs.

Maintaining Kofax MarkView Export Connector
Repairing Kofax MarkView Export Connector
1.
2.
3.
4.
5.

On the Windows server where Kofax Capture runs, select Start > Control Panel.
Select Add or Remove Programs.
Right-click Kofax MarkView Export Connector and select Change.
Select Repair and click Next.
Follow the instructions that appear on the screen to repair Kofax MarkView Export Connector.
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Removing Kofax MarkView Export Connector
To remove Kofax MarkView Export Connector, complete the procedures described next in the sequence
shown.

Removing the Kofax MarkView Workflow Agent
1. In the Kofax Capture Administration module, select the Batch tab.
2. Right-click the batch class and select Properties.
3. Select the Workflow Agents tab.
4. Under Selected Workflow Agents, select Kofax MarkView AutoSplit and click Remove.

Removing Kofax MarkView Export Connector from a Batch Class
1. In the Kofax Capture Administration module, select the Batch tab and expand the batch class to view
associated document classes.
2. Right-click the document class and select Release Scripts.
3. Under Assigned Release Scripts, select Kofax MarkView Export Connector and click Remove.

Removing Kofax MarkView Export Connector from the Release Scripts Manager
1. In the Kofax Capture Administration module, select Tools > Release Script Manager.
2. Select Kofax MarkView Export Connector and click Remove.

Removing Kofax MarkView Export Connector
1.
2.
3.
4.
5.

On the Windows server where Kofax Capture runs, select Start > Control Panel.
Select Add or Remove Programs.
Select Kofax MarkView Export Connector and click Change.
In the Application Maintenance window, select Remove and click Next.
Follow the instructions that appear on the screen to remove Kofax MarkView Export Connector.

Establishing Disaster Recovery Strategies
Use the guidelines in this section to prepare for unplanned system shutdowns or a compromise in
datacenter operation. Implement these recommendations in accordance with your site policies and
procedures regarding backup and recovery mechanisms.
The MarkView database and document servers contain run-time data and should have a backup strategy
in place. For the best results, schedule database server and document server backups to occur at the
same time as the ERP database backup. Back up the following:
• MarkView database schema: Make this part of a backup strategy that encompasses the financials
database.
• MarkView document server: Include the file system of stored images (often on an SAN or LAN) and any
required access components, such as an http server.
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Taking an image of the following machines for backup is sufficient. However, if you update or change the
server, update the backup image as well.
• MarkView Capture and Output servers (Fax, Bar Code, Print, and so forth), including a ghost image of
the operating system. If you use MarkView OCR Invoice with Kofax, Kofax recommends re-imaging the
Kofax OCR machine whenever you make a Kofax project change on the machine.
• MarkView Application Server and the file system that contains the application server configuration.
As an example of what you might be faced with in the aftermath of a system disaster, consider the
following:
• Server failures affecting the database server and the document server occur at 2:00 PM.
• The database is restored to 1:59 PM.
• The document server is restored to 11:00 PM the previous night.
In this a scenario, any documents added to the document server between 11:00 PM and 1:59 PM would
not be available because the TIFF images do not exist. The documents must be re-entered and the
associated work items recycled. This is because the database records are newer than the documents.
The best way to eliminate or reduce this recovery effort is to synchronize as closely as possible the
respective backups of the database server and the document server. Ideally, this should occur during a
quiet period for the document server when no new images are being entered.
For the best results, have full mirrored systems for all machines. Or, have images of the Capture and
Output hosts, and complete full backups of the document server and the database server to use to restore
the servers on other machines.

Recovering from a Database Failure
1. Stop Import Server instances to prevent the server from trying to import documents when the
database is unavailable.
2. Stop Capture and Output and Kofax Capture components.
3. Stop MarkView Application Server applications.
4. Resolve the database issues and restart the Oracle database server.
5. Restart all MarkView Application Server applications.
6. Restart Import Server instances.
You do not need to restart the following components after a database restart because they reconnect to
the database automatically:
• Import Server
• Bar Code Server
• Fax Export Server
You do not need to restart the following components because they do not connect to the database:
• MarkView Fax Server service
• Any Kofax services
Note If you configured Kofax Capture to leverage a schema on the Oracle database, you must restart
Kofax Capture if the database restarts.
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Recovering from an Application Server Failure
1. Stop the following components:
• Import Server instances
• Bar Code Server service
• Fax Export Server service
2. Resolve the application server issues.
3. Restart the MarkView Application Server.
4. Restart the following components:
• Any DBMS jobs that failed when the application server stopped
• Import Server instances
• Bar Code Server service
• Fax Export Server service

Verifying System Restart
1.
2.
3.
4.
5.

Confirm that startup did not generate any alert logs in the database.
Confirm that MarkView Application Server applications are running.
Confirm that DBMS jobs are running.
Confirm that all MarkView Capture and Output services started without error events.
Confirm that all Kofax Capture services started without error events.

27

Chapter 2

Setting Up MarkView Users with AUSS
Automated User Setup and Synchronization (AUSS) maps user Source System Groups to corresponding
MarkView Groups and Roles through MarkView Profiles. This mapping provides MarkView users with
privileges required for the tasks they perform in MarkView. Thus, AUSS leverages user information
from Oracle E-Business Suite or Microsoft Active Directory Service without requiring an administrator
to recreate it in MarkView. You can also use MarkView Profiles to add users to default user groups
associated with organizations.
Ensure that every MarkView user has a corresponding Oracle HR record with a valid email address.
Oracle users without email addresses cannot participate in MarkView workflows.
When integrated with Oracle Source System, the MarkView user must have an entry in the FND_USER
and PER_ALL_PEOPLE_F tables in the Oracle APPS database schema. The FND_USER and
PER_ALL_PEOPLE_F tables are joined by the EMPLOYEE_ID and PERSON_ID fields.
The following table contains terms and definitions used in the AUSS interface.
Term

Description

Source System

The system from which AUSS loads the user profiles into MarkView.
Your options are Oracle E-Business Suite (Oracle) and Microsoft Active
Directory Service (Active Directory).

Source System Group

The AUSS term for Oracle Application Responsibilities and Active Directory
Groups.

MarkView Profile

The profile that maps the Source System Groups to MarkView Groups and
MarkView Roles.

MarkView Group

The group that determines user access to MarkView documents and
related privileges in MarkView.

MarkView Role

Workflow functions the user can access.

Oracle Application Responsibility

The Oracle Source System Group to which AUSS maps MarkView Profiles.

Active Directory Group

The group in the Active Directory server to which AUSS maps. The users in
Active Directory are members of security groups.

LDAP Search Filters

Search filters select the entries on the LDAP server to be returned for a
search operation.

LDAP Attributes Mapping

Values that can be mapped to MarkView user attributes. Set Active
Directory Attributes to manage Active Directory filter results.
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About MarkView Profiles
MarkView Profiles let you define the MarkView functionality available to users with different Source
System Groups.
The following diagram shows the relationship between the Source Systems and MarkView. In this
simplified diagram, the source system group is mapped to one profile; however, a source system group
can be mapped to more than one profile.
Mapping Groups and Users to Profiles

AUSS includes 22 profiles with MarkView Groups and Roles already set up or you can create a profile.
See Creating or Editing a Profile. For example, a user assigned to the AP Entry Profile can process new
invoices. That user can look at invoice images, enter invoices into Oracle, and request that the invoice be
returned to the supplier or re-scanned.
MarkView provides the following default profiles.
Default Profiles
Profile

Description

Actions Manager

Responsible for performing Automated or Manual Escalate, Reassign, and Increase
Priority actions.

AP Entry

Performs Invoice Entry for the Pre-Approved, Non-PO, PO, and Previously Entered
Invoices workflows. This user can enable and disable roles for these entry functions
through the User Role Select form in Oracle Applications.

AP Exception

The AP Exception user is responsible for processing items that were routed to
an exception queue from invoice entry (such as Recycle and Returned Invoices).
This includes processing items that were returned to AP from the Coding/Approval
process (such as asking questions or rejecting payment). This user also reviews AP
Invoice Follow-up item errors.

AP Invoice Coder

Required only when the coding process is distinct from the invoice approval process
and coders must manually select the first approver after completing coding through
Accounting Details. This is not a typical configuration.
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Profile

Description

AP Manager

Responsible for ensuring the AP workflows are being processed effectively (through
Process Monitor). This user is also responsible for assigning alternates to users
when they are out of the office as well as reviewing potential invoice entry violations.

AP Resolution

Reviews items routed to AP due to an AP-related hold to be investigated and
resolved in Oracle Applications. This includes responding to items that were
returned to AP by other hold-resolution processing roles (such as Purchasing and
Receiving).

Audit

Responsible for processing items in the Senior Financial Audit Required queue.

Confidential

Responsible for placing redaction annotations (blackout/whiteout) over sensitive
data on document images to prevent users (not associated with this profile) from
seeing that portion of the image.

Everyone

Implicitly maps to all source system groups in AUSS.
When AUSS initially imports a user, the user's Source System Group is
automatically associated with this profile.
If you edit MarkView Groups or MarkView Roles for Everyone, AUSS automatically
updates MarkView Groups and MarkView Roles for all users.
When you use AUSS, all users are members of the Everyone profile, which includes
the COMMENTER role. The COMMENTER role gives all members the ability to
request and respond to comments.
Note Do not explicitly map the Everyone profile to a Source System Group or
change the name or description of the Everyone profile. You cannot delete the
Everyone profile.

Expense Manager

Responsible for viewing all expense documents.

Invoice Approver

Responsible for approving Non-PO Invoices for payment, including the ability to
enter coding from the viewer.

MarkView Admin

Administers the MarkView system through the following interfaces:
• Module Admin
• MarkView Admin
• Process Admin
• Alternate User Assignment
• Interactive Queries
Through Process Monitor, this user also reviews and corrects issues with work items
that encounter errors and are routed to the Workflow Administration queue.

Process Monitor

A profile for users outside the MarkView Admin or AP Manager profiles who require
access to Process Monitor to display in-process work items.

Purchasing

Responds to purchasing questions that arise during the PO Invoice Entry process
and investigates and resolves purchasing related holds.

Review - Additional

Responsible for processing items in the Review Required queue.

Review - Freight

Responsible for processing items in the Freight Review Required queue.

Review - QA

Responsible for processing items in the QA Required queue.

Review - Tax

Responsible for processing items in the Tax Review Required queue.
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Profile

Description

Scan

Responsible for processing items in the Re-scan Review and Manual Review queue.
This profile also grants access to the Bar Code Generation Utility.

SSI Users

Self-Service Invoice invoice requesters. This is valid for Oracle environments with
SSI enabled only.

Supplier

Processes scanned documents to initiate the entry of a new supplier. This user
responds to supplier-related questions including setup and changes to the supplier
and site during the invoice entry process. This user also reviews Supplier Follow-up
items that did not correctly attach.

Web Inquiry

A profile for users outside the MarkView Admin or AP Manager profiles who conduct
invoice inquiry with MarkView.

Active Directory Source System Connection Information
If you select Active Directory as a source system, you will need to specify the LDAP data.
Use this list as a reference for all fill-in fields in the Source System tab for Active Directory.
Field

Description

Active Directory Connection
LDAP connection
URL

<protocol>://<host>:<port>/<root>
Where:

<protocol> is the LDAP protocol, such as ldap or ldaps
<host> is the LDAP server name or IP address
<port> is the LDAP server port to which AUSS connects. Default: 389
<root> is the root entry of the LDAP server you are connecting to, such as dc=AUSS,dc=local
User name

LDAP admin user DN (Distinguished Name), such as CN=Administrator, DC=local

Password

LDAP admin user password

LDAP Search Filters
User base DN(s)

The base Distinguished Name (DN) subtree that is used when searching for user entries on the
LDAP server.

User search filter

Filter string for objectclasses required by AUSS: (objectClass=person)

Group base DN(s) The base Distinguished Name (DN) subtree that is used when searching for group entries on
the LDAP server.
Group search filter Filter string for objectclasses required by AUSS: (objectClass=group)
LDAP Attributes Mapping
(Objects such as Last Name are described by LDAP attributes. MarkView uses Attributes to filter Active Directory
users for AUSS.)
User name

LDAP user attribute for Common Name (CN) or logon account name (sAMAccountName)

First name

LDAP user attribute for first name (givenName)

Last name

LDAP user attribute for last name (SN)
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Field

Description

Email

LDAP user attribute for email address (mail)

Source group

LDAP user attribute for user group (memberOf)

Running the MarkView AUSS Setup Wizard
1. Navigate to Administration > AUSS Mapping Administration.
The MarkView AUSS Setup Wizard opens.
2. Follow the prompts of the MarkView AUSS Setup Wizard.
3. If you have the AUSS configuration backup file, click the corresponding link to upload it.
With this file, you upload the information about your source system settings, initial user options,
MarkView profiles, synchronization schedule, and notifications. When prompted to select the source
system, continue with the previously used source system.
For Active Directory Source System, the backup file fills in the source system connection information
fields automatically.
4. For Active Directory Source System only: After you fill in the source system connection information
fields (see Active Directory Source System Connection Information), click Test connection.
• If you see an error message, verify if the field settings are correct.
• If the test is successful, click Next and then apply changes.
5. Review the steps to complete the configuration and click Go to AUSS Home.

AUSS Interface
• Current Status: Displays the current AUSS status on near real-time basis. The visual refresh occurs
every 10 seconds. See Current Status.
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• Source System: Accesses Source System Groups information for both Active Directory and Oracle.
If you use Active Directory as a source system, Source System also displays the Active Directory
Connection tab, LDAP Search Filters, and LDAP Attributes Mapping. See Source System.

• MarkView Profiles: Lists available MarkView Profiles. See About MarkView Profiles for a list of the
default profiles. See MarkView Profiles for information about adding, editing, importing and exporting
profiles.

• AUSS Options: Opens the window in which you can set up synchronization schedules, set passwords,
create backup files, configure notifications, and set up queues. See AUSS Options.
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• Synchronization: Enables manual synchronization of user information between AUSS and the Source
System. See Synchronization.

• Journal: Displays the synchronization process history and changes. See Journal for information about
the Journal tab.
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Configuring AUSS
Perform the following tasks to configure AUSS:
1. Configure the source system as described in Source System.
2. Navigate to AUSS Options > Initial User Options to set up the user options. Follow the instructions
in Initial User Options.
3. Configure MarkView Profiles. See MarkView Profiles.
4. In AUSS Options > Sync Schedule and Options, set up the synchronization schedule. See
Synchronization Schedule and Options.
5. If you want to run the first synchronization manually, see Synchronizing for the First Time.

Source System
Select the source system that you use to supply user data and follow the required configuration
procedure:
• Microsoft Active Directory Service Source System
• Oracle E-Business Suite Source System
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Microsoft Active Directory Service Source System
If you use the Active Directory source system, see Active Directory Source System Connection
Information for the source system connection details.
1. On the Source System tab, open Active Directory Connection, enter or verify the LDAP
connection information, and click Test connection.
• If you see an error message, confirm the field settings.
• If the test is successful, click Save changes.
2. Open LDAP Search Filters, configure the LDAP search filters using the context sensitive help, and
click Check filter.
• If you see an error message, confirm the field settings.
• If the test is successful, the search results are displayed.
• Click Save changes.
3. Open LDAP Attribute Mapping, type a user personal information and a source group, and click
Check mapping.
• If you see an error message, confirm the field settings.
• If the test is successful, click Save changes.
4. Use Source System Groups to limit the scope of AUSS users by selecting specific groups from the
user's Source Systems.
AUSS allows mapping of the selected groups in Source System with MarkView Profile.

Oracle E-Business Suite Source System
If you use the Oracle E-Business Suite source system, add Source System Groups.
1. On the Source System Groups tab, click Add or Remove Source Groups.
2. From the drop-down list, select an application.
3. To display the available Source Groups, enter characters in the Filter field.
4. Select Source System Groups that contain MarkView users and click Add selected.

Initial User Options
Use the Initial User Options tab to configure the default setup for all synchronized users.
1. On the AUSS Options tab, click Initial User Options.
2. Change the default Initial user password, if required.
3. Select Print queue, Fax queue, and Export queue assigned for work item processing.
4. Click Save changes.

MarkView Profiles
The MarkView Profiles screen displays MarkView profiles with configured MarkView Groups and Roles.
Use the MarkView Profiles tab to review a brief description of the selected MarkView Profile with the list
and the count of associated MarkView Groups, MarkView Roles, and Source System Groups.
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You can add, delete, or edit profiles. Select a profile to add Source System Groups, MarkView Groups,
and MarkView Roles and to map multiple groups from User Source Systems to MarkView Groups and
MarkView Roles.

Creating or Editing a Profile
Edit the existing profiles or create new profiles and map MarkView Groups, Roles, and Source Groups
before you import users.
1. In the MarkView Profiles tab:
• To add a profile, click New.
• To edit a profile, select the profile and click Edit or double-click the profile.
2. To create a new profile, you must enter the Profile Name and Profile Description and add at least
one MarkView group or role.
3. Select MarkView Groups:
1. In the MarkView Groups tab, click Add.
The Select MarkView Groups window opens.
2. To filter the list of Groups, enter text in the Filter field.
3. Click Add selected.
4. (Optional) Select Auto-populate MarkView Roles based on MarkView Groups.
When you select Auto-populate, MarkView Roles with the same names as the MarkView User
Groups are automatically made part of this profile. However, each role name must be unique within
MarkView.
5. If you did not select Auto-populate, select MarkView Roles now:
1. In the MarkView Roles tab, click Add.
The Select MarkView Roles window opens.
2. To filter the list of Roles, enter text in the Filter field.
3. Click Add selected.
6. Click Save changes to save the new profile.
7. Select Source Groups:
1. In the Source System Groups tab, click Add.
The Select Source Groups window opens.
2. To filter the list of Source System Groups, enter text in the Filter field.
3. Click Add selected.
4. Click Save changes to edit the profile.
5. To verify that the source system group is mapped to the profile, navigate to Source System >
Source System Groups.

MarkView Profile Export and Import
The AUSS Import/Export feature enables bulk updates to profile mappings. An Administrator can:
• Export selected profiles to a comma separated value file (CSV)
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• Edit the CSV file.
• Import the updated CSV file into AUSS.
AUSS then processes the imported CSV file and updates the profiles.

The CSV File Format
The CSV file format is identical for both export and import purposes. The first line of the CSV file must be
the field names in the order specified later. All fields in the CSV file are required for both importing and
exporting. All field names and values, except for MarkView Group names, are case insensitive.
The following table lists the CSV file fields and their content.
Order

.csv Field Name

Field Content

1

AUSS Profile

Profile name (1–100 single-byte characters)

2

Description

Profile description (0–1000 single-byte characters)

3

Source Group

Source group name (1–100 single-byte characters)

4

Source Application

Source application name

5

Source System

Source system type (Oracle or Active Directory)

6

MarkView Group

A MarkView group name (1–200 single-byte characters)

7

MarkView Role

A MarkView role name (1–200 single-byte characters)

8

User Controllable

User controllable flag for MarkView Role (Y or N)

If a profile has multiple associated source groups or MarkView groups and roles, you can add additional
rows in the CSV file to represent the one-to-many relationship of the MarkView profile to its source groups
or MarkView groups and roles.
Tips for CSV files:
• Before you import or export, check your file path to ensure that you have read/write/modify access.
• Imported profiles are identified by the name.
• If the profile name does not exist, AUSS adds the new profile name.
• If the profile name exists, AUSS overwrites the profile information with the imported values from the
CSV file including the mapping for that profile. The values in the CSV file replace the values for that
profile in the database.
• If a profile name is not in the imported CSV file, AUSS does not make any changes to that profile.
Importing a CSV file does not delete any profiles.

Exporting Profile CSV Files from AUSS
You must be a user in the AUSS Mapping Administrator user group to perform this task.
1. Select the MarkView Profiles to export and click Export.
Note If you do not select specific profiles, AUSS exports all profile data.
2. Follow the prompts to download the CSV file. Validate the path and file name to ensure that you have
access to the exported file.
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Editing the CSV File
1. Make a backup copy of the exported CSV file. If editing errors exist, you can reimport this backup file
to revert to the pre-edited profile settings.
2. Open the exported CSV file in Microsoft Excel or a text editor.
3. Edit the profile lines.
4. Save the file as a CSV file. If you save the file in another format, you cannot import the data back into
AUSS.

Importing Profile CSV Files to AUSS
1. Log in to MarkView with administrator privileges and select Administration > AUSS Mapping
Administration > MarkView Profiles.
2. Export your profile data to a backup CSV file. See Exporting Profile CSV Files from AUSS. Validate
the path and file name to ensure that you can recover your backup data.
3. Click Import and select the CSV file to import.
4. Correct any errors reported. See Troubleshooting AUSS on page 46.
5. If no errors exist, the changes made to the CSV file appear in the MarkView Profiles.

Synchronizing for the First Time
To complete the initial AUSS setup, run the synchronization for the first time. Either follow manual steps
in this section, or configure AUSS automatic synchronization schedule as described in Synchronization
Schedule and Options.
1. Ensure that your Source System Group to MarkView Profile mappings are correct and complete.
2. On the Synchronization tab, click Synchronize... to synchronize users.
The Start Manual Synchronization window opens.
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3. In the Start Manual Synchronization window, select Override manually created MarkView users.
Note If you do not select Override manually created MarkView users now, AUSS will not
modify users manually created in MarkView. After this initial synchronization, all subsequent
synchronizations are incremental and only capture changes since this initial synchronization. User
information missed by this initial synchronization is not re-captured the next time you synchronize
even if you use the Override manually created MarkView users option, unless you select the
Force full synchronization option or reset your configuration.
4. Select a synchronization method:
• Synchronize all Source System users: Adds all new users (since the last synchronization) from
your Source System.
• Synchronize only AUSS managed users: Adds only new users (since the last synchronization)
in all Source System Groups that are configured in AUSS.
5. For the initial synchronization, do not select Force full synchronization.
For more information about this option, see Manually Synchronizing the Source System and
MarkView After Initial Synchronization.
6. Click Start sync to start synchronization.

Using AUSS
With Kofax MarkView AUSS, you can map your Source System Group users to corresponding MarkView
Groups and Roles through MarkView Profiles.
In addition to the AUSS settings specified in Configuring AUSS, use the following AUSS options:
• View the information about the current AUSS state and analyze synchronization data in near real time.
• Create a backup file with the current AUSS configuration data.
• Reset AUSS configuration and revert to initial setup.
• Enable email notifications about successful or unsuccessful synchronization.
• Configure the synchronization schedule and options.
• Review the synchronization history and track changes.

Current Status
The Current Status screen displays the overview information about the current AUSS state. Open the
Current Status tab to review and analyze the following near real-time data. The data updates every 10
seconds.
• Synchronization Status: Displays current synchronization progress including the AUSS state in
general (success, failure, or unknown after the first upgrade), the date and time of last successful and
unsuccessful synchronization with the synchronized users count and the duration of the process.
If required, download log files to view the synchronization details.
• Current Synchronization: Displays the information about current synchronization status including the
percentage value of the process completeness, the start time and duration, synchronization options,
and the synchronized users count. If sync is started, a user may see the process by clicking the link
View process log.
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During the synchronization process, you may view the process log.
• System Statistics: Displays general information about synchronization statistics including MarkView
profiles count and source system groups count. Click the corresponding links to review the full list of
profiles and groups. System Statistics provides the maximum memory data and the schedule details.
Click Edit schedule to configure the synchronization schedule.
The System Statistics information remains if you clear the configuration.

AUSS Options
Use the following additional options to set up AUSS:
• Set the initial password that users need when logging in to MarkView for the first time on the Initial
User Options tab.
• Define print, fax, and export queues to use for AUSS.
• Enable automatic synchronization. See Synchronization Schedule and Options.
• Back up your current AUSS configuration or reset the configuration information.
• Configure email notifications about successful or failed jobs.

Configuration Management

In Configuration Management, you can create a backup file with your AUSS configuration data. Use this
file if Running the MarkView AUSS Setup Wizard.
The backup file includes the information about a source system, MarkView profiles, a synchronization
schedule and options, notifications, and initial user options.
Use Configuration Management to delete the AUSS configuration. MarkView AUSS will only keep the
Journal and System Statistics information. Before you click Reset configuration, verify that you backed
up your current AUSS configuration.
Note Once you click Reset configuration, your Source System Groups, Initial User Options, MarkView
Profiles, Synchronization Schedule and Options, and Notifications will be deleted.
After you reset the configuration, MarkView AUSS Setup Wizard starts. For details, see Running the
MarkView AUSS Setup Wizard.
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Notifications
Use the AUSS Notifications tab to configure email notifications that indicate if the synchronization process
is a success or a failure.
To send email notifications, select Enable the Successful Job notification and Enable the Failed
Job notification. Customize the email address from which notifications are sent, email recipients, email
subject and content.
The From field is filled in automatically according to the MVFC_OUTBOUND_SMTP_USER preference
value.
Do not use spaces in the To field for email recipients.
If you enable the Failed Job notification, you can also select the option to attach a log file that does not
exceed 10 MB to the notification. After you verify the settings, save changes.
After you fill in all required fields, you may type a test email address in the To field and click Verify to
receive the example of notification immediately.

Synchronization
AUSS synchronization adds new users to MarkView from the source system and updates groups and
roles to which users are assigned.
The initial AUSS synchronization moves the group and user data from the source system to MarkView.
AUSS assigns users to the appropriate MarkView Groups and Roles, based on MarkView Profile
mappings. After running the initial load and synchronization, you can set AUSS to keep Oracle users
and responsibility assignments synchronized with MarkView through their MarkView Profiles. To enable
automatic synchronization, see Synchronization Schedule and Options.
AUSS performs synchronization in one direction only: from Source System to MarkView. Do not maintain
users in MarkView that you manage with AUSS. Manual changes in MarkView might be overwritten the
next time you synchronize users.
Note If a user record is deleted in your source system, AUSS disables the MarkView user record. AUSS
does not delete MarkView user records.
If the synchronization is running, the Synchronization window displays manual synchronization status,
including the time when the process was started, the user who started it, the synchronization duration,
options, and processed users count. The window also displays the last lines of a log file as they appear
in a real-time mode. The Synchronize one user and Synchronize buttons are disabled during the
synchronization. If the synchronization is not running, you may start the synchronization for a selected
user or for all users with the required options.
The synchronization process varies depending on your situation:
• For the first synchronization after a new MarkView installation, see Synchronizing for the First Time on
page 39.
• For the first synchronization after an upgrade, see Manually Synchronizing the Source System and
MarkView After Initial Synchronization on page 43.
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• To set up periodic synchronization, see Synchronization Schedule and Options.

Synchronization Schedule and Options
Use Sync Schedule and Options to enable automatic synchronization.
1. In AUSS Options, click Sync Schedule and Options.
2. Select the required synchronization options from the list.
1. Select or clear Override manually created MarkView users.
Note If you do not select Override manually created MarkView users now, AUSS will not
include your MarkView users. After the initial synchronization, all subsequent synchronizations
are incremental and only capture changes since this initial synchronization. User information
missed by this initial synchronization is not re-captured the next time you synchronize, even if
you use the Override manually created MarkView users option.
2. Select a synchronization method:
• Synchronize all source system users: Adds all new users (since the last synchronization)
from all Source System Groups.
• Synchronize only AUSS managed users: Adds only new users (since the last
synchronization) in all Source System Groups that are configured in AUSS.
3. In the synchronization schedule, select one of the following options and configure the
synchronization time if required:
• One-Time: From the drop-down list, select the HH:MM value that increments by 30 minutes.
The synchronization starts in HH:MM.
• Daily: From the drop-down list, select the HH:MM value that increments by 30 minutes.
The synchronization starts every day at HH:MM.
• Periodically: In the Time interval (hours) field, specify the time period over which the
synchronization repeats.
Select the Starting point field if you want to set the time of the day when the synchronization
starts. The synchronization starts when the next time interval is reached.
• Disable: Select to disable automatic synchronization schedule.
4. Click Save changes to apply the synchronization settings.

Manually Synchronizing the Source System and MarkView After Initial
Synchronization
To synchronize MarkView users with AUSS:
1. Ensure that your Source System Group to MarkView Profile mappings are correct and complete.
2. If you want to synchronize all users manually, click Synchronize.
1. Determine whether or not to overwrite your manually created MarkView user information with
user information from Active Directory or Oracle. If you select Override manually created
MarkView users, this option replaces the MarkView user information with the Source System
user information provided that the following conditions are met:
• A user exists in both MarkView and Active Directory or Oracle
• A user is enabled and active in Source System
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To overwrite your MarkView user information, select Override manually created MarkView
users. The synchronization replaces the MarkView user information with the Source System
user information for any user who appears in both places.
To keep your existing MarkView user information, clear Override manually created MarkView
users. The synchronization keeps the MarkView user information for any user who appears in
both places.
2. Select a synchronization method:
• Synchronize all Source System users: Adds all new users (since the last synchronization)
from all Source Systems.
• Synchronize only AUSS managed users: Adds only new users (since the last
synchronization) in all Source System Groups that are configured in AUSS.
3. Select Force full synchronization if required.
Note After the initial synchronization, all subsequent synchronizations are incremental and
capture changes since this initial synchronization. If any user information is missed and is not
re-captured the next time you synchronize, use Force full synchronization to synchronize all
the users starting from the initial synchronization according to the current AUSS settings.
3. To manually synchronize a specified user, click Synchronize one user.
1. In the Start User Manual Synchronization window, start typing the name of the user you want
to synchronize and select the user from the drop-down list.
You can only synchronize one user at a time.
2. Determine whether or not to overwrite your manually created MarkView user information with
user information from Active Directory or Oracle. If you select Override manually created
MarkView users, this option replaces the MarkView user information with the Source System
user information provided that the following conditions are met:
• A user exists in both MarkView and Active Directory or Oracle
• A user is enabled and active in Source System
To overwrite your MarkView user information, select Override manually created MarkView
users. The synchronization replaces the MarkView user information with the Source System
user information for any user who appears in both places.
To keep your existing MarkView user information, clear Override manually created MarkView
users. The synchronization keeps the MarkView user information for any user who appears in
both places.
4. Click Start sync to start synchronization.

Triggering Email Notification of Synchronization Errors
To trigger automatic email notification if synchronization fails, set the following preferences from
Administration > MarkView Admin > Preferences:
• MVERP_MAINTENANCE_EMAIL_ADDRESS: Specify the To or From email addresses for the
administration email. If you leave this preference blank, MarkView does not send email notifications.
• MVFC_OUTBOUND_SMTP_SERVER: Specify the SMTP server to send email. If you leave this
preference blank, MarkView does not send email notifications.
• MVFC_OUTBOUND_SMTP_PORT: Specify the SMTP port (default 25).
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• MVFC_OUTBOUND_SMTP_CONNECTION_SECURITY: Specify if authentication is required.
• MVFC_OUTBOUND_SMTP_USER: Specify the SMTP username if authentication is required.
• MVFC_OUTBOUND_SMTP_PASSWORD: Specify the SMTP password associated with the SMTP
username if authentication is required.
If the synchronization fails, the MarkView Administrator can also select the option to attach a log file that
does not exceed 10 Mb to the notification.

Journal

The Journal tab displays the synchronization history and change tracking.
The Sync History table includes the following data:
• Started by: The user who started the synchronization.
• Result: The actual status of the synchronization. For example, Finished.
• Started on: The date and time when the synchronization started.
• Stopped: The date and time when the synchronization ended.
• User count: The number of synchronized users.
• Options: The synchronization method and the Override manually created MarkView users option
selection.
Use additional Sync History options to refresh the page, to export the information to a XLS file, or to
remove records.
The Change History table displays:
• Action: Added, Changed, or Deleted
• Area: The area where the change took place.
• Element: The item that was changed. This field can include MarkView Groups and MarkView Roles, fillin fields in AUSS Options.
• Old value: If the item was added, the column is blank.
• New value: If the item was deleted, the column is blank.
• User name: The user who performed the action.
• Date: The date and time when the action was performed.
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It may help to troubleshoot some issues. The administrator user can export the information to a XLS file.

Troubleshooting AUSS
To recover from a catastrophic error, you can replace your AUSS data with a historic exported CSV
profile file. See MarkView Profile Export and Import on page 37. After that, select the Force full
synchronization option when running the synchronization.
Note This does not replace regularly backing up your system.

Export or Import Fails
If the import or export fails:
• Check the CSV file data for invalid values in source system type, application name, source group,
MarkView group name or MarkView role name.
• Check the profile name. Since AUSS identifies imported profiles by name, if you change the profile
name when you edit the CSV file, you risk unexpected results when you import the CSV file.
• Check the path and file name to ensure that you have read/write/modify access to the file.

Inconsistency Between User Rights and the Everyone Profile Groups and
Roles
If you have inconsistencies between user rights and the Everyone profile groups and roles, do the
following:
1. After you upgrade MarkView, on the AUSS user interface, delete all groups and roles from the
Everyone profile, save changes, and recreate roles and groups.
2. Resynchronize users.

Log File
In case of unexpected results, check the usermgmt.log file.

End-Dated User Authorization in MarkView
When integrated with Oracle Source System and if the WEBCLNT_SEC_AUTH_TYPE preference is set
to MV, the end-dated user may still have access to MarkView before the synchronization. The end-dated
user can be authorized in MarkView within 24 hours regardless of the synchronization schedule. If the
synchronization occurs after 24 hours, the user access is disabled.
You can disable the end-dated user access immediately by setting the Disable Date value in MarkView
Admin > User Profiles.
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User Not Synchronized after Scheduled Synchronization
Two common causes:
• The user profile was created manually. Check the settings. Run the synchronisation using the Override
manually created MarkView users option with the selected Force full synchronization option. See
Synchronization.
• The user's source group is not in AUSS. For information about adding source system groups, see
Source System.

Adding MarkView Users to User Groups
All users must be assigned to groups that are authorized to open documents for an organization. Assign
MarkView users to a user group associated with an organization by:
• Using AUSS to add users to org-related groups that MarkView creates by default, such as MVERPORGNAME.
• Updating existing groups to include Org Authorization, through MarkView Admin.
Note Although you can manually assign MarkView users, running AUSS overwrites the manual
assignments. For the best results, use AUSS.
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Chapter 3

Maintaining Organizations
This chapter describes how to modify and maintain your organizations using optional setup tasks and
features. You may not need to perform any of these tasks after completing the required setup tasks
described in Setting Up Organizations on page 48.
To minimize disruption to those who use the system, perform system administration and maintenance
when the system is quiet.
MarkView lets you configure some settings at a global level or at an organizational level. Global settings
apply to all organizations in the company. Organizational settings apply to only the organization.
Organizational settings override global settings.
For example, you might enable the MarkView integration with Expense Management at a global level, but
disable the integration for an organization that does not require receipt approval through MarkView
For the best results, configure global settings first, which lets you establish default settings for all
organizations. Then, configure organization-specific settings to override global settings as needed.

Setting Up Organizations
Note Organization is equivalent to Operating Unit or Business Unit in Oracle.
MarkView lets you control workflow processes by organization and document type. You can configure
workflows differently for each organization or specify global settings that apply to all organizations.
Organization-specific settings override global MarkView settings for the affected organizations.
When you add an organization, MarkView creates a MarkView User Group associated with the
organization. You control what documents a MarkView user accesses by adding the user to the
organization-related user group. MarkView users who are not part of the user group have no access to the
documents for that organization.
MarkView also lets you enable or disable the MarkView integration with Expense Management by
organization.

Prerequisites
Before adding organizations to MarkView, verify the following:
• MarkView for Accounts Payable is installed.
• If using Expense Management, MarkView for Expense Management is installed.
• Organizations exist in Oracle for the organizations being set up in MarkView.
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• In Oracle:
• Responsibilities are set up and configured to access organizations.
• Users are assigned to these responsibilities.
• Oracle Forms are set up (part of MarkView post-installation).
Before adding and configuring organizations in MarkView, set up default GL accounts in Oracle. Configure
a default GL account for an organization, which is used to create dummy lines on a Non-PO Invoice when
it is created in Oracle. For more information, see the Kofax MarkView Installation or Upgrade Guides.

Required Tasks
Setting up organizations in MarkView requires that you:
1. Add organizations defined in the ERP to MarkView (see Adding an Organization to MarkView on
page 51).
(Optional) If you use Sub Types, you can simplify configuration by adding the Sub Types immediately
after adding the Organization (see Defining Sub Types on page 60).
2. Using one of the following methods, assign MarkView users to the MarkView User Group for the
organization:
• For the best results, use Automatic User Setup and Synchronization (AUSS) to map ERP
responsibilities to MarkView user groups. (See Setting Up MarkView Users with AUSS on page
28.) AUSS allows synchronization between MarkView privileges and privilege sets from the ERP
or Active Directory.
MarkView creates a user group when you add the organization.
• Manually assign users to the MarkView User Groups (see Assigning Users Manually on page
133) and add users to the appropriate MarkView roles (see Adding Users to a Role on page
134).
If you create a group that you do not map to ERP responsibilities and you assign users to that
group, running AUSS does not overwrite those assignments.
If you do not use AUSS, you must also modify Form Block Functions to associate the ERP
responsibilities with newly added organizations. (If you use AUSS, you do not need to modify
Form Block Functions.) See Assigning ERP Responsibilities to MarkView Organizations on page
66.
Note Running AUSS synchronization may overwrite some manual assignments.
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The following figures illustrate the sequence of steps needed to complete Organization Setup with and
without using AUSS.
Organization Setup Using AUSS

1. Install and configure MarkView.
2. In MarkView, add and set up organizations.
2a—If using Sub Types, add and set up Sub Types.
3. Using AUSS, map ERP responsibilities to MarkView User Groups and roles.
4. Schedule and run the AUSS synchronization to add users to MarkView.
Organization Setup without Using AUSS

1. Install and configure MarkView.
2. In MarkView, add and set up organizations.
2a—If using Sub Types, add and set up Sub Types.
3. For each user who needs access to MarkView, assign users to MarkView User Groups.
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4. For each user who needs access to MarkView, assign users to MarkView Roles.
5. Through the Form Block Functions feature, assign ERP forms and responsibilities to MarkView
functions.

Adding an Organization to MarkView
For the best results, configure global settings first, which lets you establish default settings for all
organizations. Then, configure organization-specific settings to override global settings as needed.
1. Log in to MarkView with administrative privileges.
2. Select Administration > Module Admin
3. From the menu on the left, select Organizations.
The Org Admin window opens.

4. Click Add.
The Org Admin - Create a New Org Record form appears.

5. From the Org Name list, select the organization to add.
Note You cannot add an organization that is not defined in Oracle.
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6. Enter a new Org Short Name or accept the default Org Short Name, which MarkView populates
with the name specified in Oracle. (If you use lowercase letters, MarkView converts them to
uppercase.)
MarkView uses the Org Short Name to more efficiently retrieve information. An Organization Name
can have up to 260 characters with spaces and special characters, whereas the Org Short Name is
limited to 8 alphanumeric characters with no spaces.
7. (Optional) To use the configuration of an existing organization as the configuration for the new
organization, select an organization under Copy Configuration From.
For example, if your shared service center has 15 organizations that will follow the same workflow
processes and have the same Sub Types, you can fully define and configure one organization and
copy that configuration to the other 14 when you add them to MarkView.
8. Click Insert.

Assigning Users
When you add an organization to MarkView, MarkView creates a new MarkView user group for the new
organization. By convention, the name created is "MVERP - Org", where Org is the unique organization
Short Name. For example, if you create an organization with the short name "VISOP", the user group
name is MVERP - VISOP.
After adding an organization to MarkView, you must assign users to the related user group (through AUSS
or manually) to make the organization available.
If you set up AUSS, the synchronization process automatically adds new users associated with
responsibilities to MarkView organizations, User Groups, and Roles. If you add users to MarkView
manually, the AUSS process may overwrite your updates.
After adding the organization to MarkView, run AUSS synchronization to add the MarkView users to
the new organization user group. (For information about setting up and running AUSS, see Setting Up
MarkView Users with AUSS on page 28.)
Note Avoid using both AUSS and manual assignments.
If you do not use AUSS, assign users manually as described in Assigning Users Manually on page 133.

Giving All MarkView Users Access to an Organization
To give all MarkView users across all organizations access to the new organization, add organization
authorization to the All Users group. For example, your AP department may be small and you need
everyone using MarkView to have access to all document types for an organization.
1. After configuring an Org, go to MarkView home.
2.
3.
4.
5.
6.
7.

Select Administration > MarkView Admin and select the User Groups tab.
Search for the group called All Users and click Details next to the group name.
Select the User Group Org Auth tab.
Click Add.
Enter the MVERP - OrgShortName to which all users should have access.
Click Save.
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Optional Setup Tasks
After setting up your system initially, you might need to modify the Organization Setup for your MarkView
solution. For information about optional setup tasks, see Maintaining Organizations on page 48.

Optional Organization Setup Tasks
The setup tasks presented in the following sections are in the order that you are most likely to use.
However, you can perform only those tasks that you need and you can perform them in any order you
choose.
Information about how to perform a task appears on the page referenced. Some tasks apply only to sites
that do not run AUSS.
MarkView applies global settings to all organizations in MarkView. However, settings that you make at the
organizational level override global settings for an organization.
1. Configure workflow settings by answering a series of questions that change underlying MarkView
preference values (see Configuring the Workflow on page 53). Set globally or by organization.
2.
3.
4.
5.

6.
7.
8.
9.
10.

Add Sub Types (see Defining Sub Types on page 60). Set globally or by organization.
Configure global settings for all organizations (see Configuring Global AP Settings on page 62).
Configure MarkView Roles (see Setting Role Configuration for All Organizations on page 64).
For Oracle MarkView solutions where you do not use the AUSS feature, configure form
responsibilities and Form Block Functions for the organization and ERP group (see Assigning ERP
Responsibilities to MarkView Organizations on page 66). Set globally or by organization.
For Kofax Transformation Modules, set the default GL Account for Invoice Transformation, Hierarchy,
and Instance (see Setting Workflow Preferences on page 54). Set globally or by organization.
Set up Accounting Details Global and Reference Mapping (see Mapping Accounting Details on page
68).
Set business controls (see Setting Business Controls on page 69).
Configure invoice return reasons (see Configuring Invoice Return Reasons on page 70). Set
globally or by organization.
Define PO holds and routing (see Adding PO Holds on page 71 and Routing Based on PO Holds
on page 72).
You can authorize MarkView User Groups by organization. Because the process centers on user
groups, the information appears in Assigning Permissions to User Groups on page 136.

Configuring the Workflow
MarkView controls workflows through a series of preference settings. By answering questions in
Organization Setup, you specify whether invoices, receipts, or supplier documents are subject to reviews,
verification, audits and more during processing. Your answers give MarkView direction about handling
MarkView documents.
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Information about answering the questions that set workflow preferences appear in Setting Workflow
Preferences on page 54. A complete list of the questions that you answer appears in Organization
Setup Questions and Affected MarkView Preference Names on page 56. See the Kofax MarkView
Features Guide for descriptions of workflows, invoices processing, and configuration options.

Determining the Impact of Your Answers on the Workflow
• Reviews—review questions let you control when an invoice undergoes additional reviews. For
example, your company might want all invoices over a certain amount, like $10000, to undergo
additional review. Enabling reviews transitions an invoice to the appropriate review queue. Review
types include the following:
• Tax Review
• Freight Review
• Additional Review
• QA Review
• Receipt Verification—2-way matching questions let you specify that an employee verify 2-way match
PO invoices to confirm that your company received the goods or services for which the company was
charged.
Work items transition to the Verification Process for PO Invoices queue where the employee can take
action.
• Approval Hierarchy—approval hierarchy questions for Non-PO workflows let you control how
MarkView evaluates approval limits for an employee, the approval hierarchy to use, and the controls
available.
• Approve Action Validation—approval questions let you specify when to allow the Approve action
relative to distributions:
• At any time.
• Only if the invoice is fully distributed.
• Approval and Coding Queue or Approval Queue—approval questions let you direct a Non-PO work
item to transition to the Approval and Coding queue by default when a MarkView user takes a Non-PO
Entry Complete action on the work item.
• Return to Supplier Actions—AP processor questions let you control when and how MarkView users
can return invoices to suppliers to resolve issues or answer questions.
• Splitting Documents—AP processor questions let you determine if AP processors are allowed to split
documents into separate documents or if this function is limited to capture review users.

Setting Workflow Preferences
1. From MarkView home, select Administration > Module Admin.
2. To configure the workflow:
• For all Organizations, click Global Configurations.
• For an individual Organization, locate the organization for which to add control and click
Configuration.
The Organization Setup Preferences page opens showing the current settings. If you do not
change a setting, MarkView uses the global setting.
For example, if the percentage of invoices subject to QA Review is 0, no invoices go for QA Review.
If you change the setting to 5, five percent of the invoices go for QA Review.
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3. Click Update to change the answers and thereby change the workflow.
If you update the settings for an organization, MarkView displays the global values next to the fields
where you make your selections.
The following example shows fields for setting values for the Vision Operations (ID 204) organization.
The fields under the 204 Value column set values for the organization. The global value appears in
the Global Value column.

Answering these questions implements the MarkView behavior that you specify by changing
MarkView preference values.
Detailed preference descriptions appear on the pages specified in the table, Organization Setup
Questions and Affected MarkView Preference Names on page 56.
4. Click Update to save your changes.
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Organization Setup Questions and Affected MarkView Preference Names
When you answer the questions that configure organizations, your answers set values for MarkView
preferences. You can also change preference values through MarkView administration pages. To access
preferences through the administration pages, you use the preference name.
Question

MarkView Preference Name

AP Invoice Creation: Should connector pass invoice
freight data from KTM to the ERP?

MVAP_ENABLE_CONNECTOR_FREIGHT

AP Invoice Creation: Should connector pass invoice tax MVAP_ENABLE_CONNECTOR_TAX
data from KTM to the ERP?
AP Invoice Creation: Should invoices be routed to entry MVAP_ENTRY_ROUTE_WHEN_NO_DIST
when distributions are not created? (Oracle R12 only)
AP Invoice Creation: To which GL account should
connector assign captured Non-PO Invoice
distributions?

MVAP_ITEM_DEFAULT_ACCOUNT

AP Invoice Creation: To which GL account should
connector assign captured Pre-Approved Invoice
distributions?

MVAP_PREAPP_DEFAULT_ACCOUNT

AP Invoice Creation: To which GL account should
connector assign captured freight distributions?

MVAP_FREIGHT_DEFAULT_ACCOUNT

AP Invoice Creation: To which GL account should
connector assign captured tax distributions?

MVAP_TAX_DEFAULT_ACCOUNT

Comment Request: Should notification emails be sent
for items which are recalled, re-routed, or timeout?

MV_COMMENT_NOTIFY_EMAIL_ENABLED

Expenses: Is MarkView Expense enabled?

MVEXP_ENABLED

Fax: Which document ID should MarkView use for the
outbound fax cover page?

FAX_COVER_PAGE_DOCUMENT

Invoice Retrieval: Require the AP processor who
entered the invoice to handle additional AP tasks?

MVAP_AUTO_RETRIEVE_FOR_OWNER

Invoice Review, Additional: Amount (in the base
currency) which triggers Additional Review?

MVAP_DEFAULT_REVIEW_THRESHOLD

Invoice Review, Additional: Review should be
conducted by a single user or a group?

MVAP_DEFAULT_REVIEW_BY

Invoice Review, Additional: Supply the name of the
user who should conduct the review

MVAP_DEFAULT_REVIEW_USER

Invoice Review, Freight: Freight percentage on an
invoice over which Freight Review is triggered?

MVAP_FREIGHT_REVIEW_PCT_THRESHOLD

Invoice Review, Freight: Invoice freight amt (in the base MVAP_FREIGHT_REVIEW_AMOUNT_THRESHOLD
currency) that should trigger Freight Review?
Invoice Review, Freight: Percentage of invoices which
should be sent for Freight Review?

MVAP_FREIGHT_REVIEW_SAMPLING_PERCENTAGE
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Question

MarkView Preference Name

Invoice Review, Freight: Review should be conducted
by a single user or a group?

MVAP_FREIGHT_REVIEW_BY

Invoice Review, Freight: Supply the name of the user
who should conduct the freight review.

MVAP_FREIGHT_REVIEW_USER_ID

Invoice Review, QA: Percentage of invoices which
should be sent for QA Review?

MVAP_DEFAULT_QA_REVIEW_PERCENT

Invoice Review, QA: Review should be conducted by a
single user or a user group?

MVAP_DEFAULT_QA_REVIEW_BY

Invoice Review, QA: Supply the name of the user who
should conduct the review

MVAP_DEFAULT_QA_REVIEW_USER

Invoice Review, Senior Financial Audit: Can invoices
be routed for a Senior Financial Audit review?

MVAP_ALLOW_SFA_REQUEST

Invoice Review, Tax: Invoice tax amount (in the base
currency) over which Tax Review is triggered?

MVAP_TAX_REVIEW_AMOUNT_THRESHOLD

Invoice Review, Tax: Percentage of invoices which
should be sent for Tax Review?

MVAP_TAX_REVIEW_SAMPLING_PERCENTAGE

Invoice Review, Tax: Review should be conducted by a MVAP_TAX_REVIEW_BY
single user or a group?
Invoice Review, Tax: Supply the name of the user who
should conduct the Tax review

MVAP_TAX_REVIEW_USER_ID

Invoice Review, Tax: Tax percentage on an invoice
over which Tax Review is triggered?

MVAP_TAX_REVIEW_PCT_THRESHOLD

Invoice Routing, Additional Review: What queue should MVAP_NON_PO_REVIEW_COMPLETE_QUEUE
Non-PO Invoices go to after Additional Rev?
Invoice Routing, Additional Review: What queue should MVAP_PO_REVIEW_COMPLETE_QUEUE
PO Invoices go to after Additional Review?
Invoice Routing, Additional Review: What queue should MVAP_PRE_APP_REVIEW_COMPLETE_QUEUE
Pre-Approved Invoices go to after Additional Review?
Invoice Routing, Approval: What queue should Non-PO MVAP_NON_PO_APPROVE_QUEUE
Invoices go to after Approval?
Invoice Routing, Entry Complete: What queue should
Non-PO Invoices go to after Entry Complete?

MVAP_NON_PO_ENTRY_COMPLETE_QUEUE

Invoice Routing, Entry Complete: What queue should
PO Invoices go to after Entry Complete?

MVAP_PO_ENTRY_COMPLETE_QUEUE

Invoice Routing, Entry Complete: What queue should
Pre-Approved Invoices go to after Entry Complete?

MVAP_PRE_APP_ENTRY_COMPLETE_QUEUE

Invoice Routing, Freight Review: What queue should
Non-PO Invoices go to after Freight Review?

MVAP_NON_PO_FRT_REVIEW_COMPLETE_QUEUE

Invoice Routing, Freight Review: What queue should
PO Invoices go to after Freight Review?

MVAP_PO_FRT_REVIEW_COMPLETE_QUEUE

Invoice Routing, Freight Review: What queue should
Pre-Approved Invoices go to after Freight Review?

MVAP_PRE_APP_FRT_REVIEW_COMPLETE_QUEUE

57

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Question

MarkView Preference Name

Invoice Routing, QA Review: What queue should NonPO Invoices go to after QA Review?

MVAP_NON_PO_QA_COMPLETE_QUEUE

Invoice Routing, QA Review: What queue should PO
Invoices go to after QA Review?

MVAP_PO_QA_COMPLETE_QUEUE

Invoice Routing, QA Review: What queue should PreApproved Invoices go to after QA Review?

MVAP_PRE_APP_QA_COMPLETE_QUEUE

Invoice Routing, Recycle: Require review when AP
processors recycle an image?

MVAP_REVIEW_RECYCLE

Invoice Routing, Supplier: Can AP processors return an MVAP_ALLOW_RETURN_ATTACHED
entered invoice to a supplier?
Invoice Routing, Supplier: Require review when AP
processors return an invoice to the supplier?

MVAP_REVIEW_RETURN

Invoice Routing, Tax Review: What queue should NonPO Invoices go to after Tax Review?

MVAP_NON_PO_TAX_REVIEW_COMPLETE_QUEUE

Invoice Routing, Tax Review: What queue should PO
Invoices go to after Tax Review?

MVAP_PO_TAX_REVIEW_COMPLETE_QUEUE

Invoice Routing, Tax Review: What queue should PreApproved Invoices go to after Tax Review?

MVAP_PRE_APP_TAX_REVIEW_COMPLETE_QUEUE

Invoice Routing: Can AP processors route an
unattached invoice for comment?

MVAP_ALLOW_UNATTACHED_COMMENT

Invoice Routing: Can AP processors split documents
during entry?

MVAP_ALLOW_SPLIT_DURING_DATA_ENTRY

Non-PO Invoice, Approval Hierarchy: How should
MarkView determine a user's spending limit? (Oracle
only)

MVAP_HIERARCHY_RULE_LIMIT

Non-PO Invoice, Approval Hierarchy: How should
MarkView handle credits (negative invoices)?

MVAP_ENFORCE_NEGATIVE_AMOUNT_ROUTING

Non-PO Invoice, Approval Hierarchy: What hierarchy
control or document type should MarkView use?
(Oracle only)

MVAP_HIERARCHY_CONTROL

Non-PO Invoice, Approval Hierarchy: What hierarchy
name should MarkView use? (Oracle Positional only)

MVAP_POSITIONAL_NAME

Non-PO Invoice, Approval Hierarchy: What hierarchy
type should be used to verify authority?

MVERP_HIERARCHY_TYPE

Non-PO Invoice, Approval: Against what value does
MarkView compare the approval limit?

MVAP_HIERARCHY_INVOICE_AMOUNT

Non-PO Invoice, Approval: Does an invoice need to be
fully distributed in order to be approved?

MVAP_NON_PO_APPROVE_REQUIREMENT

Non-PO Invoice, Approval: What authority does the
alternate user have when approving invoices?

MVERP_USE_ALTERNATE_AUTHORITY

Non-PO Invoice, Approval: Can approvers route work
items for comment?

MVAP_ALLOW_COMMENT_ROUTING
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Question

MarkView Preference Name

PO Invoice, 2-Way Matching: Enable 2-Way Receipt
Review in MarkView?

MVAP_PO_REQUIRE_RECEIPT_ON_2_WAY_MATCH

PO Invoice, 2-Way Matching: Which PO line requestor
should review invoices marked as 2-Way match?

MVAP_PO_VERIFICATION_USER_DETERMINED_BY

PO Invoice, Routing: Can AP processors route PO
Invoices to the Purchasing Group?

MVAP_ALLOW_ROUTE_TO_PURCHASING

Pre-Approved Invoice, Entry: Does an invoice need to
fully distributed in order to complete entry

MVAP_CHECK_DISTRIB_PREAPP_INV_ENTRY

SSI, Follow-up Doc expiration: How many hours before
SSI Invoice request expires in Non-PO workflow?

SSI_AUTO_EXPIRE_HOURS

SSI, Follow-up Doc expiration: What action should be
taken when SSI invoice expires?

SSI_FOLLOWUP_EXPIRATION_ACTION

SSI, Follow-up Doc reminder: How many hours before
first reminder email is sent?

SSI_FOLLOWUP_REMINDER_01

SSI, Follow-up Doc reminder: How many hours before
second reminder email is sent?

SSI_FOLLOWUP_REMINDER_02

SSI, Follow-up Doc reminder: How many hours before
third reminder email is sent?

SSI_FOLLOWUP_REMINDER_03

SSI, Follow-up Doc: Require follow-up be sent before
SSI Invoice goes to approval?

SSI_REQUIRE_FOLLOWUP_FOR_APPROVAL

SSI, Follow-up Doc: What email address should be
used when sending in follow-up documents?

SSI_EMAIL_ADDRESS

SSI, Follow-up Doc: What fax number should be used
when sending in follow-up documents?

SSI_FAX_NUMBER

SSI, Follow-up Doc: Send email to requestor when
follow-up has been attached to invoice?

SSI_ENABLE_FOLLOWUP_CONFIRMATION

SSI, Import: Send email to requestor when invoice
import fails?

SSI_ALERT6_ON_IMPORT_FAILS

SSI, Supplier Maint: Can SSI requestors request
creation of suppliers and supplier sites?

SSI_ALLOW_SUPPLIER_CREATE

SSI, Supplier Maint: Can SSI requestors request
supplier site changes?

SSI_ALLOW_SUPPLIER_MODIFY

SSI, Supplier Maint: Send email to requestor when
Supplier Maintenance has been completed?

SSI_ALERT_AFTER_SUPPLIER_MAINT

SSI: Is the Auto Calculate Tax check box selected by
default, or use Supplier Site setting?

SSI_AUTO_CALC_TAX_DEFAULT

SSI: What type of tax-related fields are displayed
during entry?

SSI_TAX_ENTRY_MODE
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Defining Sub Types
Sub Types give you a finer level of control over which types of documents your MarkView users can view
and with which they can interact.
For example, Company X needs different groups of AP processors to handle different types of Non-PO
invoices within the US Organization. One group of processors will process Facilities invoices, another
group will process Utilities invoices, and a third group will process all the general Non-PO invoices. The
MarkView administrator creates three Sub Types—one for Facilities, one for Utilities, one for General—
that apply to the US organization. The administrator then assigns the appropriate users to a Sub Type
role for each. The unique combination of the Document Type (Non-PO invoices), the Organization (US),
and the Sub Type name (either General, Facilities, or Utilities) lets you separate and control the Non-PO
invoice processing.
Taking this example a step further, Company X authorizes employee 12345 to use the Process Monitor
to view all Non-PO invoices in the US Organization. Company X then authorizes employee 67890 to view
only outstanding Facilities Non-PO invoices within the US Organization.
Because employee 12345 is a member of an organization-specific role, employee 12345 can view all
invoices belonging to the US Organization, including facilities invoices. Employee 67890 can view only
Facilities Non-PO invoices.
You can create:
• Global Sub Types that are available to every organization in your company
• A Sub Type specific to an Organization.
• One or more Sub Types for any combination of Document Type and Organization assignment.

Sub Type Requirements
• To use a Sub Type, you must have at least one Organization defined in MarkView.
• In AUSS, you must map and configure new Oracle responsibilities to the new roles that Sub Types
creates, or manually add users to the new roles .
After you create a new Sub Type, MarkView automatically:
• Enables the Web Inquiry results to show the Sub Type.
• Enables the Viewer Invoice Header column (in the MarkView viewer only) to show the Document Type
and Sub Type.
• Adds Sub Type roles in MarkView that mirror the roles assigned to the Organization (Sub Type roles
have no users assigned).
• Adds a new bar code cover page property for the document type that depends on the Organization
property. Adding Sub Types changes how a scan operator completes the Bar Code Cover page
information.

Adding Sub Types
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
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3. To create a Sub Type:
• For all Organizations, click Global Configurations, which creates Sub Types that are available to
every organization in your company.
• For an individual Organization, locate the organization for which to add Sub Types and click
Configuration.
4. Select Document Sub Types. The Document Sub Types setup window opens.
5. Click Add. Complete the fields in the Add Sub Types window as follows:
• Document Type—Select one or more document types for the Sub Type, for example, Non-PO
invoice.
• Sub Type Name—Enter a unique name for the Sub Type using up to 30 alphanumeric characters
and no spaces.
• Sub Type Description—Enter a description of the Sub Type using up to 255 characters.
• Sub Type Display Name—Enter a unique display name for the Sub Type using up to 30
alphanumeric characters.
This name appears on the Bar Code Cover page, in the invoice header, and when you use
interactive queries.
6. Click Insert.

Associating Sub Type Roles with MarkView Users
To use AUSS to associate MarkView users with Sub Type roles:
1. In Oracle Apps, create a new Oracle responsibility for the Sub Type.
2. Assign users to the new Oracle responsibility.
3. Map the new Oracle responsibility to the MarkView Profile.
You can associate an Oracle responsibility to more than one profile.
If a MarkView user belongs to multiple Sub Type roles, you can configure MarkView to allow the user
to control which Sub Type role to activate.
For information about using AUSS, see Setting Up MarkView Users with AUSS on page 28.
To manually assign users to Sub Type roles, see Adding Users to a Role on page 134.

Changing the Default Sub Type Selection
When you create a Sub Type, MarkView updates the Bar Code Cover page creation windows. When a
scan operator creates a new bar code, the operator must select a Sub Type for any Organizations and
Document Types that have Sub Type.
Sub Types are only available for selection when creating and using a Bar Code Cover Page. If you
use Kofax Capture without a cover page, MarkView assigns the default Sub Type associated with
Organization and Document Type.
To change the default Sub Type assignment:
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
• For a global Sub Type associated with all organizations, click Global Configurations.
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3.
4.
5.
6.

• For a Sub Type associated with an organization, locate the organization with the Sub Type and
click Configuration.
Select Document Sub Types. The Document Sub Types setup window opens.
Locate the Sub Type to change and click Update.
From the Default list, select Y.
Click Update.
Completing this procedure changes the default setting for the original Sub Type to N. You cannot
change the original Sub Type to N. You must select another Sub Type as the default. MarkView
then changes the original Sub Type default setting to N.

Disabling Sub Types
Although you cannot delete Sub Types, you can disable them. Disabling a Sub Type removes:
• The Sub Type from the list of available Sub Types in the Bar Code Generator.
• Any roles related to the Sub Type.
If an organization has multiple Sub Types for a document type, you cannot disable the Sub Type that
serves as the default. Specify a different Sub Type as the default, then disable the first Sub Type.
If the organization and document type combination has no other Sub Types defined, you can disable a
Sub Type that serves as the default.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
• For a global Sub Type associated with all Organizations, click Global Configurations.
• For a Sub Type associated with an Organization, locate the organization with the Sub Type and
click Configuration.
3. Select Document Sub Types. The Document Sub Types window opens.
4. Locate the Sub Type to disable and click Update.
5. From the Enable list, select N.
6. Click Update.

Configuring Global AP Settings
This option lets you configure global settings for MarkView for Accounts Payable, such as the date and
time format to appear in the Process Monitor, or the email address that should receive system alerts.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. Select Global Configurations > AP Settings.
4. Click Update.
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5. Change your settings as follows:
Setting

Value

Date/Time Format for Process Monitor

Select the format that MarkView uses to show the
date and time in the Process Monitor. (default: DDMON-YYYY HH:MI:SS AM)

E-mail Address to receive system alerts

To receive system alerts, enter an email address
for the administrator or administration group to
receive the email. When a component exceeds the
preset limit, MarkView will send an alert to the email
specified. (default: none)

E-mail Address to send system alerts from

Enter the email address to identify from where the
system alerts are sent. (default: none)

Application Name associated with Payables
Responsibilities

Specify the Oracle application name associated
with the Accounts Payables responsibility (default:
SQLAP).

Is the Fax Server used by this installation?

Controls what appears in the MarkView viewer.
Yes—displays a fax icon that allows the user to fax a
document from the viewer.
No (default)—does not display the fax icon.

Is the Print Server used by this installation?

Controls what appears in the MarkView viewer:
Yes—provides an option that lets the user print to the
MarkView Print server as well as print directly to a
printer.
No (default)—does not provide the option to print to
the server.
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Setting

Value

Is the Manual Review Workflow used by this
installation?

Yes (default)—specifies that you use the manual
review workflow.
No—specifies that you do not. This setting disables
the Uncategorized Document document type,
Bar Code Server status checks, and emails in
MVT_Status.

Are Accounts Payable Follow-up documents used by
this installation?

Yes (default)—specifies that you use AP Invoice
follow-up documents.
No—specifies that you do not use AP Invoice followup documents.

Are Supplier Follow-up documents used by this
installation?

Yes (default)—specifies that you use Supplier followup documents.
No—specifies that you do not use Supplier follow-up
documents.

Are Supplier documents segregated by organization?

Lets you segregate inbound Supplier documents by
organization. Doing so lets you to divide supplier entry
work between supplier entry groups.
To use this function, have a process in place for
separating inbound documents (as in the mail room)
to allow for specifying the proper organization during
capture.
Yes—specifies that Supplier documents are assigned
by organization. Lets you segregate incoming supplier
entry work to specific supplier entry groups and users
by organizations.
No (default)—specifies that Supplier documents
are assigned globally. Lets any supplier entry user
process any supplier document; the work is not filtered
or segregated by organization.

6. Click Update again to save your settings.

Setting Role Configuration for All Organizations
Most administrators never need to change the default settings for role configuration. The Role
Configuration option streamlines the process of adding a role for all organizations or customizing how
MarkView addresses roles when you create an organization.
Only change role configuration under the direction of Kofax Technical Support.
Role configuration settings work as follows:
• APP_FUNCTION—makes existing roles available to all organizations that have the specified
functionality granted through the Role Queue Privileges.
• NEW_ROLE—creates a new role for each organization, which allows you to customize the Role Queue
Privileges by organization.
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For example, if you set the configuration setting for AP ENTRY NON-PO to NEW_ROLE, MarkView
creates a separate role for each organization in your system. You can then enable or disable the role
functionality by organization. When you create a new organization, MarkView creates a new role for that
organization.
If you set the role AP ENTRY PO to APP_FUNCTION, all organizations, including new ones that you
create, have access to the functions for that role, like Invoice Entry or Security Examination.
Using a new role can provide more granular control over user permissions, but requires additional user
setup.

Adding a Role Configuration
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations.
Select Global Configurations > Role Configuration.
Click Insert and select role settings:
• Role ID
• Configuration Type
Org—to associate the role with organizations
Sub Type—to associate the role with Sub Types
• Configuration Setting
Application Function—creates one role that is available to all organizations
New MarkView Role—creates a separate role for each organization
• (Optional) Document Type.
5. Click Insert to save the change.

Modifying the Role Configuration Setting
1.
2.
3.
4.
5.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations.
Select Global Configurations > Role Configuration.
Locate the line with the role to configure and click Update.
Select the Configuration Setting to use.
• APP_FUNCTION—creates one role that is available to all organizations
• NEW_ROLE—creates a separate role for each organization
6. Click Update to save the change.
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Assigning ERP Responsibilities to MarkView Organizations
By default, MarkView expects AUSS to automatically assign ERP Responsibilities to MarkView functions.
You can override the defaults and assign Oracle ERP responsibilities to specific MarkView organizations.
1. From MarkView home, select Administration > Module Admin.
2. Select Organizations.
3. Continue as follows:
• To map functions for a single organization, locate the organization and click the associated
Configuration button.
• To map functions across all organizations, click Global Configuration. The Global Preferences
page opens.
4. Click Form Block Function Mappings.
The XXX Form Block Function window opens, displaying assigned responsibilities. (XXX is either the
Org Short Name or the word "Global," indicating whether the mapping applies to all organizations or
a specific organization.)

5. Continue as follows:
• To map a new function.
1. Click Add.
2. Select a form from the preconfigured Form list or enter a unique name for the form to add
and click Open.
• To modify an assigned function
1. Locate the function to modify.
2. Click Update.
6. The Add XXX Form Block Function mapping window opens, where XXX is the Org Short name or the
word "Global" indicating a global mapping that applies to all organizations.
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Although the form contains many columns, you may only need to change the Responsibility Name.
7. Complete the fields as follows:
Field Name

Description

Responsibility Name*

From Oracle, the name of the responsibility to map to the selected organization or
globally to all organizations.

Form/Page Name*

From Oracle, the name of the form or page.

Block Name

From Oracle, the name of the block within a form (only applies when From/Page
Name is the name of a form).

Function*

From MarkView, the task to map to this responsibility, for example, examine
workflow queues for the VISTEST1 organization

Button Label*

The text to appear on the Oracle zoom button.

Item Name

From Oracle, the document entity.

Property Name

From MarkView, the Work Item Class and property name that stores the value.

Zoom Style

Indicates what appears on the Oracle button after completing the integration with
MarkView.
Default: Standard view
If Standard does not work, select Override.

*Required fields

8. Click Insert.
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Mapping Accounting Details
Accounting Details features in MarkView let you associate Oracle responsibilities with an organization
or project, and specify the account numbers to use for charging organizations. The Accounting Details
associated with an invoice appear in the MarkView viewer when the invoice is displayed.

Mapping Accounting Details to All Organizations
1.
2.
3.
4.
5.

From MarkView home, select Administration > Module Admin.
Select Organizations > Global Configuration.
Select Accounting Details - Global Mappings.
Click Insert.
On the Add Accounting Detail Mappings page, select values for the following:
• ACD Tool Name—Enter the action type to map. Action types that appear in the list depend on
those defined in your system configuration, for example, Distributions or Project Distributions.
• Responsibility—Select a Responsibility Key to define the coding privileges for the Organization
being configured. For Oracle R12, the Responsibility you select must be configured using the MO:
Operating Unit profile option relevant to the Organization.
• Application—Select the application associated with the Responsibility selected (for example,
SQLAP).

MarkView applies the tools and responsibilities you add to all organizations.
6. Click Insert.

Mapping Accounting Details to an Organization
1.
2.
3.
4.
5.
6.

From MarkView home, select Administration > Module Admin.
Select Organizations.
Locate the organization for which to map accounting details and click Configuration.
Select Accounting Detail Mappings.
Click Add.
On the Add Accounting Detail Mappings page, select values for the following:
• ACD Tool Name—Enter the action type to map to the organization. Action types that appear in
the list depend on those defined in your system configuration, for example, Distributions or Project
Distributions.
• Responsibility—Select a Responsibility Key to define the coding privileges for the Organization
being configured. For Oracle R12, the Responsibility you select must be configured using the MO:
Operating Unit profile option relevant to the Organization.
• Application—Select the application associated with the Responsibility selected (for example,
SQLAP).

MarkView applies the tool and responsibility you specify to the selected organization and application.
7. Click Insert.
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Setting Up Accounting Details Reference Mappings for All Organizations
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
Select Organizations > Global Configuration.
Select Accounting Detail - Reference Mappings.
Click Insert.
Note Do not change the values of any unused fields.
• Reference Type: Select the invoice line field used to derive the context value for Descriptive
Flexfields.
• Line Type
• Line Type Lookup Code
• Organization ID
• Tax ID
• Tax Name
• Reference Field: Not used.
• Is Context

• Yes: MarkView automatically determines the Descriptive Flexfield context value based on the
Reference field.
• No: A MarkView user selects the context when acting on the invoice.
• Require Subform
• Yes (Required if using Reference Type): Requires the user to enter data for Descriptive
Flexfields using a subform in the Accounting Details.
• No: Allows the user to enter data for Descriptive Flexfields directly on the main form in the
Accounting Details.
5. Click Insert.

Setting Business Controls
You can configure MarkView to prevent and log violations that occur when a MarkView user performs an
action that can be interpreted as a segregation of duties violation or conflict of interest, both of which can
result in fraud.
For example, if you enable "invoice entry user should not equal supplier entry user," MarkView requires
the invoice to undergo an extra review step.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. To set business controls:
• For all Organizations—click Global Configurations.
• For an Organization—locate the organization for which to set controls and click Configuration.
4. Select Business Controls.
5. Click Update.

69

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

6. For each control, select the settings to implement:
• Enabled—enables or disables the business control that controls an action.
• Yes—Enables the control
• No—Disables the control
• Audited—specifies whether or not to log violations to an audit table in the database.
• Yes—Logs violations
• No—Does not log violations
Control Description

Control Setting

Final invoice approver should not be an invoice coder. Moves the work item to next person in the hierarchy to
approve.
Invoice approver should not equal invoice entry user.

Prevents the approver from taking the Approve action.

Invoice approver should not equal supplier entry user.

Prevents the approver from taking the Approve action.

Invoice coder should not equal supplier entry user.

Prevents the invoice coder from saving distributions.

Invoice entry user should not equal supplier entry
user.

Allows the user to complete the entry, but routes the
invoice to the Invoice Entry Review queue.

7. After making your changes, click Update.

Configuring Invoice Return Reasons
Before configuring an invoice return reason for an organization, the return reason must already exist. To
create an invoice return reason, see Creating Return to Supplier Reasons on page 80.
1. From MarkView home, select Administration > Module Admin > Organizations.
2. Continue as follows:
• If assigning invoice return reasons for a selected organization, locate the organization and click
Configuration.
• If assigning invoice return reasons for all organizations, select Global Configuration.
3. Select Invoice Return Reasons.
The page displays the reasons already assigned to the organization.
4. Click Add and select the Message Name to add.
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5. Repeat this procedure for each reason to include in the Return Reason list of values.

Adding PO Holds
The ERP system contains PO Holds that you can make available for use in MarkView workflows. When
you add a PO Hold, you select from the list of defined PO Holds, and set the order of processing.

Adding a PO Hold Definition to MarkView
Hold definitions are defined across all organizations.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations > Global Configuration.
Note You can only add Holds through Global Configuration although you can route Holds through
specific organizations.
3. Click PO Hold Definition. The PO Hold Definition Admin page opens.
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4. Click Add.

5. Select the name of the Hold to add. Only holds defined in the ERP system appear in the list.
6. Enter a positive number to designate the order that MarkView will use to process the hold. (The
number appears under the column heading "Priority.") The lower the number, the sooner in the
sequence that MarkView processes the hold. The MarkView hold must the first one processed.
Note Verify that the MarkView Hold has the highest number in the list.
7. Click Insert.
8. Repeat this procedure for each PO Hold to add to MarkView.

Changing the Order of PO Hold Processing
1.
2.
3.
4.
5.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations > Global Configuration.
Click PO Hold Definition. The PO Hold Definition Admin page opens.
Locate the name of the Hold to change and click the Update link in that line.
Change the number and click Update.
The number appears under the column heading "Priority." The lower the number, the sooner in the
sequence that MarkView processes the hold.The MarkView hold must the first one processed. You
cannot change the order of the MarkView hold.

Removing a PO Hold from MarkView
1.
2.
3.
4.
5.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations > Global Configuration.
Click PO Hold Definition. The PO Hold Definition Admin page opens.
Locate the name of the Hold to remove and click the Delete link in that line.
Click Delete again.

Routing Based on PO Holds
Routing that you establish at the global level, you can modify at the organization level. To be available at
the organization level, you must have the hold defined at the global level.
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Setting Up Global Routing
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. Select Global Configurations and PO Hold Routing.

The fourth column, ERP System Source, displays the user or user group to handle this kind of PO
hold. The value of Source falls into one of the following categories:
• NONE.NONE—routes a work item with a hold to the AP group.
• Value other than NONE.NONE—identifies a table and column with the Oracle Payables database.
The table/column combination identifies the user responsible for handling this work item.
For example, the PO NOT APPROVED row is set to PO_HEADERS_ALL.AGENT_ID. When the
system detects a PO NOT Approved hold, the system routes the invoice to the user named in the
PO_HEADERS_ALL.AGENT_ID column for this work item.
4. Click Add. The page opens.

5. Complete the form as follows:
• Hold Name—select the name of the hold to assign. Only holds defined in the ERP system and in
MarkView PO Hold Definitions appear in the list.
• Order—enter a positive number to designate to which role the hold is routed first.
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Note Verify that the MarkView Hold has the highest rank in the list.
• Role—select the MarkView Role to which MarkView routes the invoice.
6. Click Insert.
7. Repeat this procedure for each PO Hold to assign.
For more information about the available roles and groups, see the Hold Resolution section of the Kofax
MarkView Features Guide for Oracle E-Business Suite.

Setting Up Routing by Organization
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations.
Locate the organization line and click Configuration.
Select PO Hold Routing.

“170_SYSTEMS_HOLD” under the Hold Name column identifies to whom the invoice should go
for MarkView 2-way receipt verification. The ERP System Source column displays the user or user
group to handle this kind of PO hold. The system controls what appears in this column.
The value of Source falls into one of the following categories:
• NONE.NONE—routes the work item to the AP group.
• Value other than NONE.NONE—identifies a table and column with the Oracle Payables database.
The table/column combination identifies the user responsible for handling this work item.
For example, the PO NOT APPROVED row is set to PO_HEADERS_ALL.AGENT_ID. When the
system detects a PO NOT Approved hold, the system routes the invoice to the user named in the
PO_HEADERS_ALL.AGENT_ID column for this work item.
5. Click Add. The PO Hold Definition Admin page opens.
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6. Complete the form as follows:
• Hold Name—select the name of the hold to assign. Only holds defined in the ERP system and in
MarkView PO Hold Definitions appear in the list.
• Order—enter a positive number to designate the order in which the hold is processed. The lower
the number, the higher the processing priority. The higher the number, the lower the processing
priority. MarkView processes holds with the highest priority first. The MarkView hold must the last
one processed.
Note Verify that the MarkView Hold has the highest priority number in the list.
• Role—select the MarkView Role to which MarkView routes the invoice.
7. Click Insert.
8. Repeat this procedure for each PO Hold to assign.

Removing a Hold Routing Globally
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. Select Global Configurations and PO Hold Routing.

4. Locate the hold to remove and click Delete.
5. To confirm the removal, click Delete again.
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Removing a Hold Routing by Organization
Note You can only delete a hold by organization if the hold was only added to the organization.
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
From the menu on the left, select Organizations.
Locate the <organization line> and click Configuration.
Select PO Hold Routing Routing.

5. Locate the line with the hold routing and click Delete.
6. To confirm the removal, click Delete again.

Changing an Organization Configuration
Changing the organization configuration modifies the workflow behavior.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations. The Org Admin page opens.
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3. Locate the organization to configure and click Configuration. The Preferences page for the
organization opens.
4. Click Update, which makes preference options available and shows the global settings for each
option. If you leave an option blank, MarkView uses the global setting.
5. From the lists and fields, specify the values to use.
6. Click Update.

Copying a Configuration from Another Organization
Applying the configuration from another organization changes the following:
• Accounting Details Mapping
• Business Control Settings
• Default GL Account, Hierarchy, and Instance
• Document Sub Types
• Invoice Return Reasons
• PO Hold Routing
• Preference values
To use the configuration from another organization:
1. From MarkView home, and select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. Locate the organization to configure and click Replace Configuration with new Template.
4. Select the organization template to copy and click Update.

Removing an Organization
Deleting an organization removes all organization configuration records, including any associated
MarkView hierarchy. You can only delete an organization when
• The Organization User Group has no users assigned as members
Note You can delete an organization that has Organization Roles with assigned members.
• All associated work items are in one of the following end-state queues:
• Archive
• Cancelled
• Completed
• Complete Expense Reports
• Complete Packets
• Deleted Expense Reports
• Recycle Bin
• Redirected Work Items
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• Rescan Complete
• Returned Invoices
To delete an organization that meets the preceding requirements:
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
3. Locate the organization to remove and click Delete.
4. In the confirmation window, click Delete.

Adding Organizations to MarkView User Groups
To give a MarkView User Group authorization to process documents for one or more organizations, add
the organization to the user group as follows:
1. From MarkView home, select Administration > MarkView Admin.
2. Click User Groups.
3. Locate the group for which to add organization authorization and click Details.
4. Select the User Group Org Auths tab.
5. Click Add to list the available organizations.
6. Select the Organization to add to the group and click Save.

Supporting Multiple Organizations
MarkView supports the Oracle multi-organization feature, which lets you use Oracle Applications
responsibilities to control documents and functions that users in different organizations can access.
For example, a company could have an AP organization in London and another in Boston. You can set up
MarkView so that users in the AP organization in London interact only with British documents and the AP
organization in Boston interacts only with the New England documents.
To establish multi-organization support, use the Organization menu options
• Add Organizations to MarkView (see Adding an Organization to MarkView on page 51).
• If not using AUSS, map Form Block Functions to Oracle Applications Responsibilities (see Assigning
ERP Responsibilities to MarkView Organizations on page 66). Use the Global Configuration settings
to configure default settings for multiple organizations.
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Configuring AP Settings
MarkView for Accounts Payable helps you streamline your accounts payable processes. In addition to
capturing electronic images of invoices, MarkView associates the captured image to the existing Oracle
record document. MarkView lets a user view the captured image, act on the work item to move it through
the workflow, and track the progress of the work item.
Some of the settings described in this chapter require you to change MarkView preferences. See
Changing Preference Settings on page 187 for information about changing preferences.

Setting Recycle Review Options
The manual review process lets an employee send a captured image to the recycle bin, or have a second
employee review the image quality. The second employee can accept or reject the recycle request and
transition the document accordingly.
To enable recycle review, set the MVAP_REVIEW_RECYCLE preference to TRUE.

Changing the Frequency of Web Inbox Notifications
Employees who have items in their MarkView Web Inbox receive regular email notification. Configure the
frequency of these notifications and the message content.
By default, MarkView sends notifications once a day.
To alert employees every time a work item arrives in their Web Inbox, set the MVAP_EMAIL_OPTION to
PER_ITEM.
For more information about Web Inbox email notifications, see the following preference descriptions in
MarkView Preferences on page 190:
• MVT_MAIL_FROM
• MVT_MAIL_FROM_NAME
• MVERP_MAINTENANCE_EMAIL_ADDRESS
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Setting Up Advanced-Search Capabilities for Web Inquiry
MarkView lets you enable advanced-search capabilities for some or all of your MarkView users. When
you enable this feature, those who have permission can select a basic search page or one that contains
additional fields.
Web Inquiry allows you to search the ERP system for invoices. This option is available when an employee
uses MarkView Web Inquiry - AP Invoices or MarkView Web Inquiry - My History to perform a search.

Creating Return to Supplier Reasons
You can create return invoice reasons that meet your business needs. By default, the system provides the
following return reasons:
• Invalid Invoice
• Duplicate Invoice
• Purchase Order Number Required on Invoice
• Contact Name Number Required on Invoice
To create values for the LOV for the Return Reason field:
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Messages tab.
3. Click Add and complete the form as follows:
• Component—From the list, select MVAP_RETURN_REASON.
• Message Name—Enter a name, Not_Our_Supplier, for example.
• Message Type—From the list, select Label.
• Description—(Optional) Enter a description.
• Retain?—From the list, select Yes.
• Changeable?—From the list, select Yes.
• Style—(Optional). This field does not require a value.
4. Click Save.
5. Select and complete the Message Text Translations subtab for the message:
• Language Name—From the list, select the appropriate language.
• Text Translation—Enter a description of the reason for the return, for example, "We no longer do
business with this supplier."
6. Click Save.
You do not need to complete the other subtabs.
7. Repeat this procedure for each reason to include in the Return Reason list of values.
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Controlling How Work Items Open
The work item (WI) Class Opener and WI Class Opener Param pages control what happens when an
employee opens an invoice from the Working Folder.
Because the WI Class Opener and WI Class Opener Param pages are specific to Oracle Applications,
only someone knowledgeable about the ERP should add WI Class Openers.

The Work Item Class Opener page displays the following information.
Field

Description

Work Item Class

Shows the name of the work item class.

Existing/New Flag

Does not apply to Oracle sites.

Apps (non 170) Form Name

Shows the name of the Oracle Applications Form for MarkView to use
for the specified Work Item Class. For example, if you are configuring the
Oracle Invoice Workbench, select APXINWKB.

ERP Type

Reserved for future use.

Block Name

Shows the name of the block in the Apps Form Function for the system
to populate. Data from a specified record populates the selected Block
Name.

170 Function

Specifies the MarkView Process function for the system to use when
retrieving a MarkView document that belongs to this Work Item Class.
When configuring MarkView for Accounts Payable, you often select a
Working Folder function.

Replace Where (not shown)

Y—enables the system to run a query using the designated function and
information in the WI Class Open Param form to find a record to load into
Oracle Applications. Most sites use this setting.
N—keeps the system from running a query using anything other than the
default Replace Where clause.
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Field

Description

Apps Form Function

Shows the name of the Oracle Applications Form function. For example,
if you are configuring MarkView for Accounts Payable to open the Invoice
Workbench form, select AP_APXINWKB.

(not shown)

Changing or Adding a WI Class Opener
1. From MarkView home, select Administration > Module Admin.
2. Click WI Class Opener. The Work Item Class Opener Admin page opens.
3. Continue as follows:
• To change a WI Class Opener, select the row to change and click Update.
• To add a WI Class Opener, scroll to the bottom of the window and click Insert.
4. After making your changes or additions, click Update or Insert, as appropriate.
5. Continue to the next section, Changing or Adding WI Class Opener Parameters on page 82, to
complete the process.

Changing or Adding WI Class Opener Parameters
Assign one or more parameters to the new Work Item Class Opener row.
1. From MarkView home, select Administration > Module Admin.
2. Click WI Class Opener Param. The Work Item Class Opener Param Admin form opens.

3. Continue as follows:
• To change a WI Class Opener Param, select the row to change and click Update.
• To add a WI Class Opener Param, scroll to the bottom of the window and click Insert.
4. Complete the Work Item Class Opener Param Admin form.
Field

Description

Work Item Class

Enter the value to use when creating a Work Item Class Opener.
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Field

Description

Function

Specify the value specified in the Function column when creating a Work Item
Class Opener.

Form Param

Y—enable the system to pass one or more parameters to the function
N—prevent the system from passing parameters to the function. If the function
does not accept parameters, set this field to N.

Param Name

Enter the name of the parameters to pass; for example, if you are configuring
the Oracle Invoice Workbench, enter INVOICE_ID.

Param Seq

Enter the parameter sequence in the function call. For example, if a function
receives two parameters, set Param Seq to 1 for the first parameter and Param
Seq to 2 for the second parameter.

Constant Value

If you set Form Param to Y, place a value in either Constant Value or WI
Class Prop, but not in both.
To pass the same constant to each invocation of the function, enter a value in
the Constant Value field.

WI Class Prop

If you set Form Param to Y, place a value in either Constant Value or WI
Class Prop, but not in both.
To pass a different value to each invocation, specify the name of a work item
class property in the WI Class Prop field.

5. After making your changes or additions, click Update or Insert, as appropriate.

Setting How Workflows Process Invoice Status
The Invoice Status Processing option defines and automates how the workflow handles certain invoice
statuses.
Because the MarkView installer adds the required Oracle Applications invoice statuses with the
appropriate workflow behavior, you should rarely need to use this menu. Contact Kofax Technical Support
to guide you through this menu if all of the following conditions are true:
• Your company upgrades Oracle Applications.
• Your company does not upgrade the MarkView system.
• The new version of Oracle Applications contains new invoice status values.
If the preceding conditions are true:
1. From MarkView home, select Administration > Module Admin.
2. Click Invoice Status Processing.
3. Click Insert. The TSC Admin - Create a New Transition Status Code Record form opens.
4. Add new Invoice Status name and select the workflow behavior to activate.
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5. Click Insert. Usually, you need to add only one or two rows.
The following table lists the values that the MarkView installer installs:
Invoice Status

Workflow Behavior

APPROVED

PASS

AVAILABLE

PASS

FULL

PASS

NEEDS REAPPROVAL

NO_DECISION

NEVER APPROVED

NO_DECISION

PERMANENT

NO_DECISION

REJECTED

FAIL

UNAPPROVED

NO_DECISION

UNPAID

PASS

Mapping Responsibilities to User Groups and Roles
The Responsibility Group and Responsibility Role menus enable you to map Oracle Application
responsibilities to MarkView user groups and roles.
• For the best results, use AUSS, which lets you set up automatic assignments. For information about
AUSS, see Setting Up MarkView Users with AUSS on page 28.
• For information about manually mapping responsibilities, see Managing MarkView Users, User Groups,
and Roles on page 128.
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Managing Document Types
MarkView lets you create new document types. For example, you might need a document type that lets
you provide a read-only view to a particular user group, or you might need a non-MarkView document
type, for example, contracts, to save in the MarkView Document Library.
Note Creating a document type for inclusion in a MarkView workflow requires the creation of a workflow
infrastructure to support the new document type. Because creating a workflow infrastructure is not part
of MarkView system administration, this guide contains no instructions for doing so.

Creating Document Types
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Document Types tab and click Add.

3. Complete the page as follows.
Field

Description

Document Type Name

Enter a unique name for the document type, for example,
InsuranceClaimForms.

Description

Enter a description to identify the purpose of the document type, for
example, "Needed for a MVDL implementation."

Enable Date

Enter a date to start the document type availability on a specific date.

Disable Date

Enter a date to stop the document type availability on a specific date.

Detail Description Label

Enter a short description to appear in the viewer when a user opens a
document.

Associated Application

• MarkView—Specifies that the document type is related to MarkView
processing.
• Non-MarkView—Specifies that the document type is unrelated to
MarkView processing.
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Field

Description

Default Bar Code Configuration

Assigns a default bar code configuration to the document type. You
must have the bar code configured in MarkView before it appears for
selection.

4. Click Save.
5. To make the document type accessible to users, add user group authorization as described in the
following section.

Adding User Group Authorization
1. From the Document Type window, select the Privilege Group Auths tab.
2. Click Add.

3. Complete the page as follows.
Field

Description

User Groups

Select the User Group for whom to allow access.

Privilege

Select the type of access that the user has. For example, give the user access by
selecting Access Document.

Authorization Type

Enter a date to start the document type availability on a specific date.
Select an Authorization Type that matches the options available for the selected
Privilege.
Privileges with {Y|N} option:
• Yes—Allows the user to use the privilege specified
• No—Prevents the user from using the privilege
Privileges with {OWN|ALL} option:
• Own—Allows the user to exercise the privilege only on documents the user
owns
• All—Allows the user to exercise the privilege on all documents

4. Click Save.

Modifying Document Types
1. From MarkView home, select Administration > Module Admin.
2. Select the Document Types tab.
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3. Locate the document type to modify and click the Details button next to the type name.
4. Make your changes and click Save.

Disabling Document Types
For the best results, disable a document type by changing permissions instead of deleting the document
type.
Although you can delete document types, doing so can disrupt audit-trail requirements for MarkView
documents that completed processing. You also need to remove every transaction related to the
document type before deleting the document type.

Disabling an Unused Document Type
If you create a document type and discover that you made a typographical error in the name, and no one
has used the document type:
1. Locate the Document Type name and click the Details button next to the name.
2. Click Delete.

Managing View Types
View Types let you control the type of access that users have to a group of annotations on a document.
When an administrator sets the Default Rights for a view type, all users accessing the view type inherit the
security privileges specified.
For example, if the View Type Administrator selects Mandatory as the Default Rights option for the Fax
View, the annotations will always be visible to the user opening a document with the Fax View type.

Adding View Types
1. From MarkView home, select Administration > > MarkView Admin.
2. Select the View Type tab.
The View Type page displays the view types already defined in MarkView. To modify an existing
type, click the Details button next to the view type name.
3. Click Add.
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4. Complete the page as follows.
Field

Description

View Type Name

Enter a unique name for the view type.

Administrator User ID

Enter the ID of the user who will administrator the view type. The administrator
you select can change the default rights for the view type.

Default Rights

• Use Tool Rights: Use the default MarkView tool set.
• Administrator: Lets users show, hide, move, edit, and delete tools that they
create or place on a document.
• Optional: Hides the tool by default. Lets the user show, but not move, edit, or
delete the tool.
• Default: Displays the tool by default. Lets the user hide, but not move, edit,
or delete the tool.
• Mandatory: Makes the tool always visible. The user cannot hide, move, edit,
or delete it.
• None: Hides the tool always. Does not let the user show, move, edit or
delete the tool.

5. Click Save.

Modifying View Types
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
Select the View Type tab.
Locate the View Type to change and click the Details button next to the name.
Make your changes and click Save.

Deleting View Types
1.
2.
3.
4.

From MarkView home, select Administration > Module Admin.
Select the View Type tab.
Locate the View Type to delete and click the Details button next to the name.
Click Delete.
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Invoice Deletion and Cancellation
MarkView for Accounts Payable runs an automated process daily that moves work items associated with
canceled or deleted invoices to the appropriate workflow queues.
You can manually initiate this process by executing the MVAP_utility.InvoiceSweep procedure.
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Preparing for Mobile Access
Use the following procedure as a guideline to set up your system to allow user access to the MarkView
viewer through mobile devices.
1. Install and configure MarkView for Accounts Payable.
2. Contact your mobile device users and instruct them to do the following on their mobile browsers:
1. Enable Cookies.
2. Disable Private Browsing.
If your company uses reverse proxy for security purposes, you may need to perform additional mapping
in the reverse proxy. For the mobile user to view document images, they need access to the MarkView
document server.
If you mapped the proxy server on the MarkView server, you do not need to perform any additional setup.

(Optional) Information for Adding a Bookmark
Most users will follow a link in an email notification to access invoices in the mobile viewer. However,
you might have users who want to add a bookmark to their mobile devices for easy access to their Web
Inboxes.
To allow users to create a bookmark, give them:
• The MarkView mobile-access URL, such as http://IP_address:port/mobile
• The host name, for example, http://<host>:<port>/mobile
The URL or host name must access the MarkView Application Server. Access can be through wireless
connection or through a VPN connected to the your network. The system setup must be able to accurately
translate the server name to an IP address to allow access.
Giving users the mobile-access URL or host name is not required for mobile access. However, users need
the mobile-access URL or host name to create bookmarks on their mobile devices.

Configuring What Appears on the Mobile Device
MarkView lets you control what appears when a mobile user accesses their Web Inbox or views an
invoice in the viewer. Settings that you establish for viewing on a mobile device affect what appears on all
mobile devices that access the system. However, the settings for mobile do not affect the settings that you
establish for desktop access to the Web Inbox and viewer.
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Use the following procedure as a guideline for configuring mobile devices. Details about using Module
Admin appear throughout this guide, depending on what you are doing. For example, Configuring
MarkView Menus on page 147 describes how to set the order in which items appear.
1. Log in to MarkView as an ADMIN user.
2. From MarkView home, select Administration > Module Admin.
3. Continue as follows:
• To configure what a mobile user sees in their Web Inbox, see Configuring What Appears in the
Web Inbox on page 91.
• To configure what a mobile user sees when they view an invoices in the mobile viewer, see
Configuring What Appears in the Viewer.

Configuring What Appears in the Web Inbox
By default, MarkView ships with a number of fields visible in the Web Inbox, such as the Invoice Number.
1. From the list on the left side of the Module Admin window, click Display Type.
2. Under Name, locate the option to make visible in the mobile Web Inbox, scroll to the Query Page
column, and click Show Query.
3. Locate the line with the field name to appear, scroll to the far right, and click Update.
4. Under Include in Mobile, select Y to display the field, or select N to hide the field.
5. Under Mobile Display Order, enter a number to specify where in the order of fields the field will
appear.
6. Click Update.
When a user accesses the Web Inbox, the fields that you selected appear.

Configuring What Appears in the Viewer
By default, MarkView ships with a number of fields associated with detail types visible when a user views
an invoice in the viewer, such as the Supplier Name in the Invoice Details section.
1. From the list on the left side of the Module Admin window, click Detail Type.
2. Under Detail Name, locate the option to make visible in the mobile Web Inbox, scroll to the Layout
Page column, and click Show Layout.
3. Locate the line with the field name to appear, scroll to the far right, and click Update.
4. Under Layout Query, click Show Query.
5. Locate the field name to appear, scroll to the far right, and click Update.
6. Under Include in Mobile, select Y to display the field or N to keep from displaying the field.
7. Under Mobile Display Order, enter a number to specify where in the order of fields the field will
appear.
8. Click Update.
When a user views an invoice in the MarkView viewer, the field containing the information that you
configured appears as part of the invoice details.
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Setting Up the MarkView Viewer
This chapter describes MarkView viewer administration, which you control through MarkView preferences.

Minimum MarkView Viewer Requirements
• Adobe Flash Player—If you do not have Flash Player installed or you are running an earlier version,
MarkView gives you access to the Adobe download site. If you are not allowed to download software
from the Internet, contact your IT department to obtain Adobe Flash Player.
To have all MarkView users at your company use the same version of the player, change the default
setting in the VIEWER_FLASH_VERSION preference to the version to use. If a MarkView user does
not have a minimum of the version specified, MarkView prompts them to upgrade the player version.
For information about changing preferences, see Changing Preference Settings on page 187.
• Popup Blocking—Disabled.
• Adobe Reader 5—To allow viewing PDFs created through the MarkView viewer.
Check the Technical Specifications document on the Kofax website for the latest software requirements.

Setting Up a User Group
Set the preference VIEWER_AUTO_PROCEED_MODE to CURRENT at the group level for the MarkView
user groups that need to access the viewer.

Using Accounting Details
When using MarkView Accounting Details, you associate configurations with a MarkView Organization.
Some companies run multiple MarkView Accounting Details configurations, which are defined and created
as part of their MarkView solution.
For example, a company might have:
• A US Organization that uses project distributions cost centers.
• A UK Organization that uses non-project (traditional general ledger) distributions.
Invoice processors would mark invoices associated with the US Organization with one MarkView
Accounting Details configuration and invoices associated with the UK Organization with the other
MarkView Accounting Details configuration.
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If your MarkView solution has multiple Organizations that use the same MarkView Accounting Details
configuration, associate each Organization with the same configuration.
Note For information about associating configurations with an Organization, see Mapping Accounting
Details on page 68.

Configuring the Email Document Feature
The Email Document feature adds an Email Document button to the viewer. This feature lets an employee
send an invoice PDF to another employee or external contact, like a supplier, to resolve questions. The
invoice assignment remains with the employee sending the document.
For example, an employee looking at an invoice might want to double-check the invoice amount with
the supplier. Using the Email Document feature, the employee can email the invoice PDF to the supplier
without having the invoice reassigned to another employee.
By default, this feature is enabled upon installation or upgrade. However, you set a default email address
in the MarkView MVT_MAIL_FROM preference. MarkView uses the email address in the Mail From field if
the sender has no assigned email address or if a server malfunction prevents including the identification of
the sender.
Other preferences that let you customize the implementation include:
• VIEWER_INCLUDE_EMAIL—set this preference to TRUE to include an email request button on the
toolbar.
• VIEWER_INCLUDE_PDF_EXPORT—set this preference to TRUE to let the user select the option to
email a PDF attachment from the viewer.
• VIEWER_EMAILDOC_INTERNAL_DOMAINS—(optional) specify the domains of the internal contacts
to whom an employee can send document links only.
• MVT_HISTORY_SHOW_EMAILDOC_HISTORY—specify whether or not the email history of a
document appears when viewing Document History.
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MarkView Viewer Data Flow
The data flow process involves exchanges between several components to display a document in the
viewer. Numbers following the figure correspond to those in the figure.
MarkView Viewer Data Flow

1. An employee clicks an item in the Working Folder to view.
2. The viewer retrieves ERP data from the database, which includes the URL for the image.
3. The viewer calls the DTM to retrieve the TIFF file from the Document Server. The DTM authenticates
the user who initiated the request.
4. The DTM retrieves the TIFF file. The combination of volume path and workstation serial number
determines the method used. For the best results, co-locate DTM and Document Server on the same
host.
5. The DTM returns the TIFF file to the viewer.
6. The viewer renders the TIFF image as a PNG, combines it with the ERP data from Step 2, and
presents it within the viewer.
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Setting Up Kofax Capture and Kofax
Transformation Modules for MarkView
About Auto-Categorization
Auto-Categorization allows MarkView batch classes to bypass categorization in Kofax Capture to allow
Kofax Transformation Modules to perform the categorization. Depending on the batch class property
setting specified for RequireCategorizationInCapture, Kofax Capture handles batch classes as follows:
• 1 (ON): Prevents documents in the batch classes from moving out of Kofax Capture unless they are
completely categorized.
• 0 (OFF): Allows documents in the batch classes to continue from Kofax Capture without being
categorized.
If a document that has no categorization reaches Kofax Transformation Modules, Kofax Transformation
Modules tries to categorize the document automatically based on extracted values.
Prerequisites:
• Minimum Kofax Transformation Modules version 5.5
• Kofax Transformation Modules validation station connected to the MarkView database

Setting the Default Document Type for Invoices without PO Numbers
1.
2.
3.
4.

Open the KTM Project Builder.
Open your KTM-MarkView project and select Script Variables.
Near the bottom of the script variables table, locate DefaultNonPODocumentType.
Set the value to use as the default document type for invoices that enter the system without a PO
number. Supported values include:
• NON-PO INVOICE
• PRE-APPROVED INVOICE

By default, KTM uses NON-PO INVOICE, which you can override.
5. Click OK.
6. Save the project.
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Setting the RequireCategorizationInCapture Property
The RequireCategorizationInCapture property specifies how Kofax Capture processes MarkView batch
classes.
1. Open Kofax Capture Administration.
2. Right-click the MarkView Invoice or MarkView Document batch class and select Properties.
3. Select the General tab and look in the Batch Fields table to locate
RequireCategorizationInCapture.
4. Set the Default setting to one of the following:
• 1 (ON) (default)—requires categorization
• 0 (OFF)—does not require categorization
Note Batch class properties route documents from capture to MarkView. For a batch class that
goes through KTM, the KTM extraction and validation process categorizes any documents in
the batch class that are not categorized. For a batch class that does not go through KTM (for
example, the MarkView Document batch class), any documents that are not categorized during
capture must be manually categorized in the Uncategorized Documents workflow.
5. Click OK.
6. Save the batch class and proceed as follows:
• For a MarkView Invoice batch class only, synchronize the batch class to the project and publish
the batch class.
• For a MarkView Document batch class, publish the batch class.

About the MarkView Workflow Agent
The MarkView Workflow Agent enables Kofax Capture to handle MarkView batches introduced through
non-scan Kofax Capture products in the same way that Kofax Capture handles batches introduced
through Kofax Scan.
Kofax Capture processes MarkView batches based on the batch class settings. For example, in a batch
imported through Kofax Import Connector:
• If the Workflow Agent cannot communicate with MarkView, Kofax Capture routes the batch to the
Quality Control queue.
• If AlwaysStopForReview specifies that all documents go to review, Kofax Capture routes all imported
batches to the configured review queue.
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Workflow Agent Batch Class Properties
Two MarkView batch class properties define how Kofax Capture processes MarkView batch classes
imported through an application other than Kofax Scan. These properties do not affect MarkView batch
classes imported through Kofax Scan.
• AlwaysStopForReview: When enabled, routes every document in the batch to review in Kofax Capture,
whether or not the documents have a valid bar code.
• Disable (default): 0 (False)
• Enable: 1 (True)
• ReviewQueue: Specifies the review queue to which Kofax Capture routes documents in the batch that
need review.
• Scan (default): Routes documents to the Scan queue
• QC: Routes documents to the Quality Control queue
To change how Kofax Capture processes a MarkView batch imported through an application other than
Kofax Scan, edit the batch class properties for the destination associated with the connection. Workflow
Agent properties appear on the Batch fields tab.
Note If you access the Document fields tab and change or add a value for the BarCode or
Kofax.Separation.BarCodeValue fields, the Kofax.Separation.BarCodeValue always takes precedence.
See the Kofax Import Connector documentation for information about editing the destination.

Interaction Between Kofax Capture and Workflow Agent Batch Class
Properties
The combination of batch class settings that you use determines how Kofax Capture processes nonscanned MarkView Invoice batch classes.
• If you set AlwaysStopForReview to 1 (ON), non-scanned documents always stop for review in the
defined review queue.
• If you set AlwaysStopForReview to 0 (OFF) and RequireCategorizationInCapture to 1 (ON), nonscanned documents only stop for review if Kofax Capture cannot decode the bar code value.
Note For MarkView batch classes imported through an application other than Kofax Scan, the
RequireCategorizationInCapture property appears on the Batch Fields tab of the destination that
handles the batch.

About Kofax Capture Batch Class Templates
The following batch class templates are available when imported:
• MarkView Document: Used to separate documents that do not go through Kofax Transformation
Modules.
• MarkView Invoice: Used to separate documents that go through Kofax Transformation Modules.

97

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

The batch class templates are set up with batch fields based on Kofax Capture Values, such as Batch
Name, Batch ID, Batch Creation Date, Batch Creation Time, and Scan Operator.

Importing the Batch Class Templates
1. Log in to Kofax Capture as an administrator.
2. Select Import.
Note For Kofax Capture 9, select File > Import.
3.
4.
5.
6.
7.
8.
9.

In the Open window, select C:\KTM\MarkView\Markview.cab and click Open.
In the Import/Export window, click OK when the unpacking is completed.
In the Import window, click Add All.
Select Save duplicates to new name.
Click Import.
Follow the prompts to save the batch classes to a new name.
Click OK when the import is completed.

Preparing the Batch Class Templates
1. Highlight the MarkView Document batch class.
2. Select Properties.
3. On the Separation and Form Identification tab, select Custom. From the list, select MarkView Bar
Code Separators and click Edit Profile.
The Custom Separation and Form Identification Profiles window opens.
4. Enter the following values:
• Enable Bar Code.
• From the list, select MarkView Bar Code.
• Set Found on stand-alone separator sheet as follows:
• To discard the bar code cover sheet after import, select this option.
• To keep the bar code cover sheet with imported documents, deselect this option.
• In the Search Text field, enter:
^(CP|DT)ID• Enable Treat search as regular expression.
5. Click Save and Close.
6. Click Apply.
7. Select the MarkView Invoice batch class and repeat steps 2 through 6.

Preparing Kofax Import Connector to Use MarkView Bar Code Separators
1. From Kofax Capture Administration, highlight the MarkView Document batch class.
2. Expand the batch class to import through Kofax Import Connector until you see Sample Page 1 with
a bar code.
3. Right-click Page Level Bar Codes and select Properties.
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4. From the Available Fields panel, select BarCode, click Add, and click Apply to add the Bar Code
index field.
5. Highlight the MarkView Document batch class.
6. Select Properties.
7. On the Separation and Form Identification tab, select Custom. From the list, select MarkView Bar
Code Separators12 and click Edit Profile.
The Custom Separation and Form Identification Profiles window opens.
8. Enter the following values:
• Enable Bar Code.
• From the list, select MarkView Bar Code12.
• Set Found on stand-alone separator sheet as follows:
• To discard the bar code cover sheet after import, select this option.
• To keep the bar code cover sheet with imported documents, deselect this option.
• In the Search Text field, enter:
^(CP|DT)ID• Enable Treat search as regular expression.
9. Click Save and Close.
10. Click Apply.
11. Select the MarkView Invoice batch class and repeat steps 2 through 10.
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Configuring MarkView for Expense
Management
MarkView for Expense Management integrates with Oracle Internet Expenses, giving you online access to
your receipts. Using a MarkView Process workflow, a manager can review, audit, and approve employee
expenses. All receipts are stored within Oracle and viewable with the MarkView viewer.

Enabling and Disabling Expense Management
If your company purchases MarkView for Expense Management, the installation process enables the
application system-wide by default. However, MarkView lets you enable and disable the application by
organization.
For example, your company might decide to pilot an expense management process in the U.S.
organization before rolling it out to your European organization. Using MarkView Organization Setup, you
can disable Expense Management for the European organization and keep the application enabled for the
U.S. organization. Once the pilot program proves successful, you can return to Organization setup and
enable MarkView Expense Management for the European organization.
1. From MarkView home, select Administration > Module Admin.
2. From the menu on the left, select Organizations.
The Org Admin page opens.
3. Locate the organization to configure and click Configuration.
The Preferences page for the organization opens.
4. Click Update to make preference options available.
5. Locate the question Expenses: Is MarkView Expense enabled?.
6. Select the setting to use:
• Yes—enables expense management.
• No—disables expense management.
7. Click Update.

Providing Submission Instructions
MarkView stores four lines of default submission instructions that appear as messages when an
employee submits an expense report. MarkView saves the default lines in 4 message repositories,
SUBMIT_INSTRUCTION_DEFAULT_LINE_XX (01 to 04). You can override the default message lines,
but you cannot modify or delete them.
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By default, the confirmation page contains the following instructions:
If there are any receipts associated with this expense
report tape them to standard sheets of paper.
Print this cover page from your browser and place it on
top of the receipt packet.
* Fax the entire packet to
{MVEXP_EXPENSES_FAX_NUMBER}.
Your manager (or specified approver) will be notified
requesting approval for this expense report.

If you localize text for custom messages, MarkView uses only the custom messages. For example,
if you create 2 custom lines of localized instructions, SUBMIT_INSTRUCTION_LINE_01 and
SUBMIT_INSTRUCTION_LINE_02, MarkView only displays the 2 lines. MarkView does not display any of
the default lines.

Adding Invoice Submission Instructions
1.
2.
3.
4.
5.
6.

From MarkView home, select Administration > MarkView Admin.
Select the Messages tab.
Locate the SUBMIT_INSTRUCTION_LINE_XX (01 to 03) message and click Details.
Select the Message Text Translations tab and click Add.
Select the language to use, for example, select "American" for American English.
In the Text Translation text box, add the information to display:
1. To add text, enter the text of the message.

2. To add a fax number, include the attribute {MVEXP_EXPENSES_FAX_NUMBER}.
7. Click Save.

Sending Receipt Reminders to Employees
When an employee submits an expense report that requires receipts, but does not submit
receipts, the system sends an Oracle Notification to remind the employee. Configure the number
of reminders and the frequency with which they are sent through the MarkView preference
MVEXP_RECEIPTS_REMINDER_XX, where XX is a number from 01 to 99 that indicates the number of
reminders to send. The value for the preference is the number of hours before the reminder is sent. For
example:
Preference Name

Value

MVEXP_RECEIPTS_REMINDER_01

4

MVEXP_RECEIPTS_REMINDER_02

24

MVEXP_RECEIPTS_REMINDER_03

48
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In this example:
• If no receipts are received for the expense report, the system sends a reminder to the preparer after 4
hours.
• If no receipts are received after 24 hours, the system sends a second reminder.
• If no receipts are received after 48 hours, the system sends a third reminder.
To send more reminders, add more preferences.

Setting Up Receipt Requirements
Using preferences, you can configure MarkView to make an expense report available for processing
without the required receipts. Or, configure MarkView to put an expense report on hold until the employee
submits receipts.
Note For information about setting preferences, see Changing Preference Settings on page 187.
The following preferences control MarkView Expense Management behavior in a non-customized Oracle
iExpense workflow.
• MVEXP_RECEIPTS_REQUIRED_FOR_AP_ONLY—Controls whether MarkView makes an expense
report available for manager approval before the employee attaches receipts to the report.
• Y—MarkView makes the expense report available for manager approval without the required
receipts attached.
• N (default)—MarkView puts the expense report on hold and thereby prevents the manager from
seeing the report until the employee attaches the required receipts.
• MVEXP_SKIP_LINES_WITH_MISSING_RECEIPTS—When determining if an expense report requires
receipts, specifies whether MarkView skips lines requiring receipts if the employee enabled the Receipt
Missing check box next to those lines in Oracle iExpense.
• Y—MarkView notifies the manager that an expense report needs approval if an employee who is
missing receipts enables the Receipts Missing check box. MarkView does not require the employee
to submit the missing receipts.
• N—MarkView does not notify the manager that an expense report needs approval if an employee
who is missing receipts enables the Receipts Missing check box. MarkView requires the employee to
submit the missing receipts or supporting documentation first.
For example, an employee’s company configured Oracle iExpense to require receipts for expenses
that exceed $25.
• If the employee’s expense report does not contain any lines above $25, MarkView routes the
expense report directly to the manager for approval.
• If the expense report contains one or more lines that exceed the $25 limit, MarkView does not
route the expense report to the manager, regardless of the status of Receipts Missing check box.
MarkView requires the employee to submit receipts or supporting documentation first.
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Setting Up the MarkView Document Library
The MarkView Document Library (MVDL) lets an employee store different types of non-MarkView
documents and related metadata in a central repository. The MVDL provides permissions-based retrieval
of documents stored in the library.
Paper documents must be converted to electronic documents. Once converted, employees can upload
documents from their desktop.
Non-MarkView documents are stored in their native file format. For example, an employee can store PDF
files, spreadsheet files, and other document types in the document library.
An employee must belong to the right role and user group to add or retrieve documents from the
document library.
To set up the library for basic use, the MarkView Administrator:
• Creates Document Types to use in the MVDL.
• Creates Object Types that provide a framework with which to associate document types.
• Creates Object Properties to facilitate indexing and searching the library.
• Associates Document Types with Object Types.
• Gives MarkView User Groups authorization to access Object Types and Document Types.
• Assigns users to the user group that will have access to the MVDL.
Object types, document types, and privileges are interrelated to facilitate easy storage and access.

Scenario
Your company recently acquired an insurance firm and you need to set up the document library to track
auto insurance claims.
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1. The document type helps you categorize the paperwork that you expect to receive. For example,
Claims can be assigned to insurance claims forms.
2. The object type, Auto Insurance Claims, acts as the container for all auto insurance claims. You
could have another object type for Home Insurance Claims.
3. Through Object Type properties, you define the type of information that you need to store in the
document library for the Object Type. This example shows a company that is storing Claims
documents, therefore, "Claim # " is one of the properties defined.
The properties defined help those using the Document Library quickly locate the needed documents.
To see object properties, a Document Library user does not need to open the document itself.
4. To create a link between them, you associate the object type with the document type.
5. Lastly, you specify which MarkView User Groups can access the object type and specify what
actions members of the group can take.
If you have other documents, like reports and legal paperwork, to associate with claims, you create a
document type for each. When you create the related Object Type, include properties that match some
those of the Claims object type, for example, "Claim # ". The Document Library user can then enter the
claim number and search by the property value for all documentation related to that claim number.

Creating Object Types
When you create an object type, the object type inherits a set of standard properties, which include:
• CREATION_TIMESTAMP (Creation Timestamp)
• FILENAME (Filename)
• IS_DELETED (Is Document Deleted?)
• NAME (Name)
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• OBJECT ID (Unique ID)
• ORIGINATOR (Owner)
1. From MarkView home, select Document Library > Admin.
2. Select the Objects Types tab and click Add.

3. Complete the form as follows.
Field

Description

Object Type Name

Enter a unique name for the object type.

Attach Documents Yes/No?

Specify whether a user can attach documents to the Object Type.

Searchable

Specify whether a user can search on the content of this field.

Pre View Rule

Not used

Pre Update Rule

Not used

4. Click Save.
MarkView displays a message stating that the Object Type was saved.
5. Click List to return to the Object Type page and continue to step 3 in Adding Object Type Properties
to add properties.

Adding Object Type Properties
1.
2.
3.
4.

From MarkView home, select Document Library > Admin.
Select the Object Type tab.
Locate the Object Type for which to add properties and click Details.
Select the Object Type Properties tab and click Add.
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5. Complete the page as follows.
Field

Description

Property Name

Enter a unique name for the property. This name appears
in uppercase, regardless of what you enter. For example,
"Claim_Number" appears as CLAIM_NUMBER.
Note Property Names cannot contain spaces.

Property Label

Enter text to appear as the field name for the property. This text
appears in the case that you use. For example, "Insurance Claim"
appears as" Insurance Claim."

Data Type

Identify the data type that the property will accept:
• String: Accepts a string of alphanumeric characters
• Date: Accepts a date
• Number: Accepts digits
• Timestamp: Accepts a timestamp
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Field

Description

Data Length

Specify how many characters the field accepts.

Display Sequence

Specify where in the sequence this property appears in relation to
other properties.

Multiple Values

• Yes: Allows the user to enter multiple values for the property
• No: Prohibits the entry of multiple values

Mandatory

• Yes: Makes the property a required value
• No: Makes the property optional

Editable

• Yes: Allows the user to enter and change property content
• No: Prevents the user from changing the value

Label Changeable

• Yes: Allows the user to change the label name
• No: Does not allow the user to change the label name

Uniqueness Within Parent

Specify if values for this property must be unique across all objects
of the same type. If you require a unique value, specify whether the
system will consider case when determining the uniqueness of the
value.
• None
• Case Sensitive
• Case Insensitive

Multiline

• Yes: Allows the entry to be more than one line
• No: Does not allow the entry to be more than one line

Searchable

• Yes: Allows the user to search the Object Type
• No: Does not allow the user to search the Object Type

Visible

• Yes: Shows the Object property
• No: Does not show the Object property

Search Results Order

Specify whether this property value is used when putting search
results in order.
For example, the Claim Date property has a Search Results Order
of 1 and Claim Number has a Search Results Order of 2. After
a search, MarkView shows the Claim Date first and the Claim
Number second.

Default Value

Displays the default value of the property.

Long LOV

Allows the list of values to respond to query. Requires customization.

6. Click Save.
7. To associate document types with the object type, continue to step 4 in the next section.
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Associating an Object Type and Document Type
You can only associate an existing document type with an object type. To create a document type, see
Creating Document Types on page 85.
1. From MarkView home, select Document Library > Admin.
2. Select the Object Type tab and locate the Object Type with which to associate a document type.
3. Click Details.
4. Select the Object Type Document Types tab and click Add.

5. From the Document Type list, select the document type to associate with the Object Type and click
Save.
The list displays document types that are defined in MarkView.
You can associate more than one document type with an Object Type.
6. To authorize user groups to access the object type, continue to step 4 in Adding Object Type
Privileges.

Adding Object Type Privileges
Users who are members of the ARCHIVE user group can create and modify documents throughout the
library, assign users to the ARCHIVE user group, and grant permission to create top-level documents.
1. From MarkView home, select Document Library > Admin.
2. Select the Object Type tab and locate the Object Type to which to add privileges.
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3. Click Details.
4. Select the Privilege Group Auths tab and click Add.

5. Complete the form as follows.
Field

Description

User Group

Select the MarkView User Group to allow access to the Object Type.

Privilege

Select the type of action that the user can perform on this Object Type.
• Can Create Folder
• Can Delete Object
• Can Delete Object’s Children
• Can File into Obj Children
• Can File into Object
• Can Freeze Object
• Can Freeze Object’s Children
• Can Refile Object
• Can Refile Object’s Children
• Can Transfer Object
• Can Transfer Object’s Children
• Can Update Object
• Can Update Object’s Children
• Can View Object
• Can View Object’s Children
• Create Folder Object’s Child
• Is Vital Record
• MVRM Edit Metadata Logic
• Rest View Obj Objects’ Child
• Restrict View Object
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Field

Description

Authorization
Type

Select whether to allow privileges to members of the user group.
• Yes: Allows the user to use the privilege specified
• No: Prevents the user from using the privilege
• Own: Allows the user to exercise the privilege only on documents the user owns
• All: Allows the user to exercise the privilege on all documents

6. Click Save.

Adding Search Fields
You can add custom fields to the Document Library Search page to enhance the search capability for
users. You associate the custom search field with an object property. By default, Document Library
examines all object types for a matching property.
Limit the number of custom search fields that you add to three (3). Adding more than three custom fields
can degrade system performance.
When you add a search field, you link the field to an object property. The search returns results from every
object type, or class, that contains the named property.
Setting the ADMIN_ACCESS_MVRM_SEARCH preference to ALL enables custom search field
administration. For more information, see MarkView Document Library Preferences on page 228.
1. From MarkView home, select Document Library > Admin.
2. Select the Search Fields tab.
3. Click Add to open the new search field page.
4. Click Select Property to open a list from which to select a Property Name.
The LOV, Active Object Types, includes a column that shows how many object types contain a
property of the same name. Click the selection button next to the property. Doing so returns you to
the add page.
5. Enter a Property Label in the text box provided. This label appears on the search page.
6. Enter the Display Order as an integer in the text box provided. This number indicates where this
custom field appears on the search page relative to other custom fields.
7. Click Save.
By default, custom search fields appear between the Name and the Filename fields on the search
page.
The following example shows two custom fields, Company and Department, added to the search
page.
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If you change the property name in the object type, manually update the custom search field entry to
reflect the change. You must do this because there is no direct tie between the search field property
name and the object types where the properties exist.

Excluding an Object Type from the Search
Custom search fields are joined with the other fixed search fields on the page so that all criteria must be
satisfied to return a match (Boolean AND).
1. Click the top-level Object Types tab to display the object types list.
2. Click Details next to the object type to exclude.
3. From the Searchable list on the Edit page, select No.
4. Click Save.

Creating Object Type Children
Through the Object Type Properties subtab, you can link other object types as children to an object type.
The child object type inherits the properties of the parent.

Uploading Documents
A user creates library documents by uploading a document into the library. Once a document is uploaded,
it becomes a library document, consisting of the document itself and the document metadata.
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The following documents reside in the MVDL:
• System Document: The top document in the document library, the System Document, provides search
capability that starts at a single point. Users cannot see the System Document nor can you assign
privileges at this level. The System Document is required. Do not edit or delete this document.
• Documents: Documents make up the MarkView Document Library. Users can search for and retrieve
documents and their metadata.
• Filed Documents: A document is filed once all of its mandatory property values are specified and it is
placed in the library. When a document has been filed, it leaves the unfiled documents queue, and
appears in the document library.
• Non-Electronic Documents: MarkView treats non-electronic documents in the same manner as other
documents. The only difference is that there is no electronic image associated with the document.
Instead, the MarkView Document Library stores a description of the physical location of the document,
as well as the document metadata. A user can attach an electronic image later.
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Monitoring Queues with the Process Monitor
The MarkView Process Monitor lets you view real-time information about queues and work items within
queues. You can monitor queues across multiple workflows and monitor multiple work item classes within
multiple queues. With the Process Monitor, you can:
• Monitor all of the queues that comprise a workflow.
• Determine how many work items are currently in each queue.
• Identify which work items are in a queue.
• View work item history and properties, and, with the correct authorization, view the document image in
the MarkView viewer.
Process Monitor lets you view a subset of work items in the queue. For example, using filters, you can
identify high-value invoices, high-priority contracts, or purchase orders from an organization.
This chapter describes how to create MarkView Process Monitor configurations to monitor selected
workflows and queues, and how to change your view of what appears in the process monitor.
Note Accessing the MarkView Process Monitor requires that you log in using MarkView credentials. To
change the log-in method to single sign-on, see the MarkView Installation Guide.

Working with Monitor Views
The MarkView Process Monitor interface consists of a toolbar and a display area. The makeup of the
toolbar and the contents of the display area change, based on the activity you initiate. The display area
can contain the following:
• Bar graph (queue-level display)
• List of work items (queue-item display)
• Work item details (history and properties)
• Preferences and configuration windows

Working with Configurations
The MarkView Process Monitor includes prepackaged configurations that you can use as is, edit for a
single use, or use as a template to create additional configurations. The MarkView Process Monitor stores
configurations in the database where they are available from any client computer.
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You can monitor any number of workflows, any number of queues in the workflow, and any number of
work item classes. However, you can only monitor workflows, queues, and work item classes that already
exist in MarkView.

Scenario
The AP Manager uses the Process Monitor to check the work assignments within the AP group. The
manager looks at the PO invoice entry queue and sees that the queue contains a backup of pending
items, including a large number of invoices for one particular organization. The manager takes corrective
action by assigning AP processors to work on the invoices for that organization.
While using the Process Monitor, the AP Manager looks to see if Business Users are actually taking
action on invoices that were forwarded to them for processing (for example, for approval, coding,
comment). By checking queues that contain work items for the business users to process, the Manager
can determine if their queues contain old invoices that need immediate attention.
Use the Process Monitor to look at the Workflow Admin queue to ensure that no invoices or documents
are stopped due to errors and require your attention.

Creating a Configuration
1. From MarkView home, select Utilities > Process Monitor.

2. On the toolbar, click one of the following New Queue buttons.
• New Queue Level Display: Creates a view that displays a bar graph of aggregate data (one bar
for all of the work items in each queue).
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• New Queue Items Display: Creates a list of work items, showing the current queue where the
work item is located, and providing links to access more work item details.

3. From the Queue Configuration > Workflows page, select the workflow to monitor. By default,
MarkView monitors all workflows.
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Ctrl-click or Shift-click to select multiple workflows.
4. Click Select Queues.
5. On the Queue Configuration > Queues & Work Item Classes page:
1. From the left-hand panel, select at least one queue to monitor. You can monitor multiple
queues.
Only those queues used by the workflows you selected on the workflows page appear in the
panel.
Note To change the workflow selection, click Select Workflows.
In the list, the queue name appears to the left of the hyphen and the queue filter to the right.
The default filter, All Items, includes all available items in the queue. If you configured Sub
Types, additional queues will be available by Sub Type and Organization.
For example, in the entry Non-PO Invoice Entry - All Items, "Non-PO Invoice Entry" is the
queue name, and "All Items" is the work item class for that queue.
2. From the right-hand panel, select the work item classes to monitor.
A workflow can have more than one authorized work item class, which enables you to monitor
a subset of classes across the set of queues. By default, MarkView monitors all work item
classes.
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6. When you finish, click Show Queue Levels or Show Queue Items. (The button available depends
on the type of display you selected.)

Note To change the queues and work item classes being monitored from the bar graph page, click
the name or number on the horizontal axis of the graph, or click the queue label in the Legend.
7. Click Save Configuration.

117

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

A Configuration Details page opens.

8. Complete the Configuration Details page with the following information.
Setting

Description

Save As Existing

Select to overwrite or modify a configuration.

Save As New

Select and enter a name to save the configuration as a new configuration.

Description

Enter text that helps identify the purpose of the configuration.

Assign to Role

From the list, select a role that has authorization to open or modify the
configuration. The following fields establish the authorization parameters.

Can Be Opened By

Select who can open the configuration:
• Public: Any MarkView Process Monitor user
• Role: Any user assigned to the role selected in the Assign To Role field
• User (Private): Only the user who created the configuration

Can Be Modified By

Select who can modify the configuration:
• Public: Any MarkView Process Monitor user
• Role: Any user assigned to the role selected in the Assign To Role field
• User (Private): Only the user who created the configuration
You cannot allow someone to modify the configuration without first granting
them authorization to open the configuration.

9. Click Save Configuration.
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Editing a Configuration
1.
2.
3.
4.

On the toolbar, click Open Configuration.
Select the configuration to open and click Open Configuration.
Edit the configuration criteria.
Click Save Configuration.
• Create a new configuration by selecting Save as New and entering a new name.
• Modify the configuration you opened by selecting Save as Existing.
5. Click Save Configuration.

Deleting a Configuration
1. On the toolbar, click Delete Configuration.
2. From the list, select the configuration to delete, and click Delete Configuration.
A confirmation window opens.
3. Click Delete Configuration to confirm the deletion.

Monitoring Multiple Queues in One Bar
1. Click a bar label in the queue-level display.
2. On the Queue Configuration: Queue & Work Item Classes page, select the queues to monitor in
the current bar. Ctrl-click or Shift-click to make multiple selections.
3. Click Show Queue Levels to generate a new queue level display.
Note Remember to change the bar label when you change the queue or set of queues that the bar
represents.
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Working in the Bar Graph View
To see a queue-level display (which shows the bar graph), open a Process Monitor Configuration and
click Show Queue Levels. A display similar to the following opens.
Sample Queue Level Display

1. Process Monitor buttons
2. The number of work items in the queue for the work item class
3. Queue number
4. The queue label corresponding to the queue number

Changing the Bar Graph Appearance
1. To change the layout of the bar graph display, go to the toolbar and click Edit Queue Level Layout.
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2. Edit the Graph Title and Vertical Axis Label to describe monitoring activities. The defaults are
Queue Levels and Work Items, respectively.
For example, if the graph monitors only queues within Non-PO Invoice workflow, name the graph
"Non-PO Invoices".
3. To control the scale of the bar graph, set the Width and Height.
4. To change the labels used in the legend for each queue, modify the label.
5. To delete a queue and the associated label, select the Delete check box.
6. Click Update Queue Level Layout.
7. To save your changes, click Save Configuration and complete the Save window.

Adding a Bar to the Graph
1. Click Add Bar on the toolbar.
The Queue Configuration: Workflows page opens.
2. Select the queues and work item classes to monitor and click Show Queue Levels.
The queue level display appears with the new bar appended on the right of the graph, irrespective of
alphabetical order. If you select multiple queues, the single bar includes them all.
When you create a new queue level display in which you select multiple queues, the resulting bar
graph has a bar for each queue, in alphabetical order. To create a queue level display in a specific
order, in which each queue has its own bar, add bars one a time in the preferred order.

Deleting a Bar from the Graph
1. Click Edit Queue Level Layout.
2. Select the check boxes next to the bars to delete.
3. Click Update Queue Level Layout.
The queue level display is refreshed with the bars removed.
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Accessing Details About Work Items in a Queue
From a Queue Level Display bar graph, see the work items that are currently in a queue by clicking the
queue bar in the bar graph. Clicking the bar opens a Queue Item Display list.

Working with a Queue Items Display List
A Queue Items Display list shows which work items are currently in a queue. For example, the following
figure shows the work items in the Non-PO Invoice Entry queue.
Queue Items Display List

1. Process Monitor buttons
2. Queue name and the number of work items in the queue for the work item class and page controls
3. Work item list with icons to access details
In the queue list view:
• When you access the list view from a queue-level graph that monitors multiple queues, the process
monitor displays the name of the queue that occurs first alphabetically.
• Page controls let you page forward or backwards, a page at a time, or to the last or first page. If all
items fit on a single page, the page control does not appear.
• A control on the right lets you adjust the number of items per page. Enter a number in the text box and
click Apply to change the display.
To reorder the list appearance, click a column heading.
To sort in ascending order or descending order, click the column heading. A yellow arrow identifies the
sort column and order.

Accessing Work Item Details
1. Open the Queue Items Display List.
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2. Click an icon to the left of the work item description.
The table describes the details that each icon displays.
Work Item Details
Icon

Description
Displays the work item history. Each line represents a queue that the work item visited in the
course of a workflow. The work item history header provides the same paging and sorting
capabilities as the queue items display (see Working with a Queue Items Display List on page
122). The following is an item history example.

Displays the selected work item properties and attributes. To view work item properties, scroll
through the list. The following is an item properties example.

Opens the corresponding MarkView document in the MarkView viewer.

Editing a Queue Items Display
1. On the toolbar, click Edit Queue Item Display.
2. On the Queue Configuration: Queues & Work Item Classes page, change your selections as
appropriate.
3. To change the workflows selection, click Select Workflows to go back to the Queue Configuration:
Workflows page.
4. When you finish making your selections, click Show Queue Items to display the updated version.

Using Toolbar Buttons
Toolbar buttons drive activity and let you navigate in MarkView Process Monitor. As you move between
pages in the MarkView Process Monitor, the toolbar changes to reflect what you can do in that particular
view. The following table describes the buttons that appear in the toolbar as you change views. Not all
buttons appear in every view.
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Note Use toolbar buttons for refresh and paging activities instead of the browser buttons.
Toolbar Buttons and Actions
Button

Description
Opens the Queue Configuration pages to display a new queue bar graph.

Opens the Queue Configuration pages to display a new queue items view.

Adds a single bar to the current queue level display.

Displays a list of stored queue configurations from which to select one to open.

Saves the current queue level or items display as a stored configuration in the database.

Displays a list of stored queue configurations from which to select one to delete.

Changes the wording and appearance of the queue level display.

Sets preferences for monitoring frequency and date formats in item detail displays.

Refreshes the data in the current queue level or item display.

Begins periodic refresh activity at the specified polling frequency. Click this button to toggle
the Stop Monitoring button.
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Button

Description
Stops periodic refresh activity. Click this button to toggle the Monitoring Continuously button.
Kofax recommends that you stop monitoring continuously when you no longer require
refreshed data.
Returns to the previous queue level display from an queue items display or drill-down view.

Returns to the previous queue items displayed from a drill-down view.

Switches to the work item properties view from the history view for the currently selected
work item. Clicking this button toggles the Work Item History button.

Switches to the history view from the work item properties view for the currently selected
work item. Click this button to toggle the Work Item Properties button.

Displays the MarkView document image linked to the currently selected work item from the
work item properties or history view.

Returns to the Queue Configuration: Workflows page from the Queue Configuration: Queues
& Work Item Classes page.

Changes the configuration of the current queue items display.

Reverts changes made in the Queue Configuration pages to the previous queue items
display.

Closes the current page and return to the previous view.

Changing Process Monitor Characteristics
1. Click Edit General Preferences on the toolbar to open the General Preferences window.
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2. Make your changes.
Setting

Description

Monitoring Preferences > Polling Period

Set the frequency at which MarkView refreshes the data
displayed during continuous monitor mode.
Note Click Monitor Continuously on the toolbar to set
the mode.
Use any combination of hours, minutes, and seconds
(default: 30 seconds).

Queue Item Preferences > Date Format

Select the date format to use in the queue item displays.

Item History Preferences > Date Format

Select the date format to use in work item history lists.

Item History Preferences > Display Detailed
Item History

Select this option to include the complete set of available
columns tracked in a work item history. The default displays a
standard set of columns. Additional columns include:
• Queue ID
• Requeued
• Even Occurrences
• Out Transition ID

3. Click Update Preferences.
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The following preferences control the default date and time formats that appear in the Process
Monitor lists. To change the format, change the preference settings.
• MONITOR_HISTORY_DATE_FORMAT
• MONITOR_WORKITEMS_DATE_FORMAT

Displaying UTF-8 Characters
Configure the MarkView Process Monitor to display UTF-8 characters, which might be used in localized
versions of the application.
To display UTF -8 characters, your computer must have the Arial Unicode MS font installed, which is
installed by Microsoft Office.
1. From MarkView home, select Administration > Process Admin.
2. Select the Preferences tab.
3. In the Preferences list view, filter on the preference MONITOR_WEB_I8N_STYLESHEET.
4. Select the System Preferences tab and click Add.
5. Set the preference value to TRUE and click Save.
The preference uses Arial Unicode MS to display UTF-8 characters.

Monitoring Special Cases
You may need monitoring to extend beyond standard practices. For example, you might want to display a
bar graph, where each bar shows items in the same queue, differentiated by a specific work item property.
Do this by setting up different role queue privileges to filter the item property value.
Use Automatic User Setup and Synchronization (AUSS) to map the role to users and to verify that the
appropriate responsibility maps to both the user group and the role. See Setting Up MarkView Users with
AUSS on page 28 for information about AUSS.
For information about creating roles and assigning roles to users manually, see Managing MarkView
Users, User Groups, and Roles on page 128.
1. Create a role for monitoring purposes and call it "MONITOR ON PROPERTY."
2. Create a filter to verify a filter parameter against the work item property to monitor.
3. Set up role queue privileges on the queue to monitor for the role you created.
Use the filter created in the preceding step with a privilege code of Examine and a filter parameter
equal to the item property value. Do this for each property value defined.
4. Assign the role you created to the users who monitor the queue.
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Managing MarkView Users, User Groups, and
Roles
Note This section describes manual processes for adding users to user groups and roles and should
be used by customers who do not use Automatic User Setup and Synchronization (AUSS). If your
company uses AUSS, the AUSS synchronization process overwrites many manual assignments. AUSS
ignores manual assignments to user groups and roles that do not have related responsibilities in the
ERP system.
The manual processes here are used to help clarify how users, user groups, and roles interact. If your
company does not use AUSS, these manual assignments only change if someone modifies them.
This chapter describes the MarkView principles behind users, user groups, and roles; how users, user
groups and roles work together; and how to ensure that users have the access and tools they need do
their jobs.
• MarkView Users—Each person who uses MarkView is a MarkView user and requires a profile in
MarkView. The user profile is a MarkView record that includes:
• MarkView user name
• Date when the MarkView user first has access to MarkView
• Print, fax, and export queues the user has assigned for work item processing
• Date when access to MarkView should end, if applicable
• MarkView User Groups—A user group contains sets of privileges and authorizations that typically
match those of a job function in a company, for example, Accounts Payable Clerk. A user group gives
members access to MarkView:
• Document types
• Menus and tabs
• Toolsets
• Viewer
Note MarkView users must be members of the All Users user group to access MarkView. You can
add users through AUSS or manually if your company does not use AUSS.
User groups allow members access to specific document types and views of the document. For
example, a user group might give members read-only access to Administration tabs. The user group
also controls which tools the user has available.
You can associate a user group with an individual organization or globally with all organizations. (For
information, see Setting Up Organizations on page 48.)
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A user can be a member of many user groups; a user group can have many members. Members of a
user group inherit the privileges granted to that group.
Note LOCALE user groups display the interface in the localized language. For example, LOCALE_de
displays MarkView in German; LOCALE_fr displays MarkView in French. Therefore, if a user belongs
to more than one LOCALE user group, the interface appears in only one language. MarkView uses
the language with the lowest ID number.
• MarkView Roles—Roles provide members with the authority needed to access workflow queues from
which they can retrieve work items. Roles can be global or associated with an organization.
A user can be a member of many roles. A role can have many members. A role may or may not be
associated with a user group.
Three areas of MarkView administration work together to give MarkView User Groups and Roles
functionality and security.
• MarkView Administration—lets you assign a set of preferences to a user group for advanced access
security.
• MarkView Process Administration—lets you create and configure view and retrieval access for a set of
queues for a role, or a set of preferences for a role.
• MarkView Module Administration—lets you authorize which menus a user group can see. This module
provides security by ensuring that the user who wants to act on a document belongs to both the right
user group and role.
The following figure shows the interaction in MarkView.

129

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Giving MarkView Users Access to MarkView
MarkView requires that users be assigned to user groups for access to the MarkView interface, and to
roles for access to queues and the authority to retrieve and act upon work items in those queues.
• A user assigned to only a user group cannot retrieve documents because the user has no access to the
queues where the documents wait, nor does the user have authority to retrieve documents.
• A user assigned to only a role can retrieve documents from a queue, but cannot see the MarkView
interface required to do so.
The installation process adds default MarkView User Groups and Roles to the system. The user groups
and roles are assigned basic toolsets and privileges. For information about installed user groups, roles,
and responsibilities, see the table under About Job Functions on page 140.

Scenario: Separating Tasks
Your Accounts Payable department has MarkView users who process PO Invoices. You want to separate
them into groups that handle invoice entry and review. To save time, you want members of each group to
see only those invoices that are ready to undergo the processing specialty of that group.
To do so:
• Add MarkView users to the PO entry user group (AP ENTRY PO) and role (AP ENTRY PO)
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Note When the MarkView User Group and MarkView Role have the same name (AP ENTRY PO),
you do not need to add the user to the MarkView Role. MarkView automatically associates user
groups and roles with each other and grants all role authorizations and actions to members of the
user group with the same name.
Members of the AP ENTRY PO user group and role can retrieve and examine invoices from PO Invoice
Entry queues.
• Add MarkView users to the approval user group (AP RESOLUTION PO APPROVAL) and role (AP
RESOLUTION PO APPROVAL)
Members of the AP RESOLUTION PO APPROVAL user group and role can retrieve and examine
invoices from PO Invoice Approval Resolution queues.
Note The user groups and roles named in this scenario are default roles provided during MarkView
installation.
A PO Invoice entry group member enters the invoice, identifies the invoice entry as completed, and moves
the invoice to the next queue, which is the Review Required queue. Until the invoice moves to the Review
Required queue, no one in the review user group can see or retrieve the invoice. Nor does anyone in the
approval queue see the invoice.
A review user group member completes the invoice review and moves the invoice to a Verify AP Process
Complete system queue.

Scenario: Restricting Access to MarkView
Your management team has given you an additional resource to handle day-to-day MarkView User
management tasks, like setting an alternate user for someone who is absent from the office unexpectedly.
You want your assistant to see only those menu items that relate to user management. To do so:
• Create a new user group, for example, MarkView userAdmin
• Add the following user group preferences and set each to ALL
• ADMIN_ACCESS_MV_USER_GROUP
• ADMIN_ACCESS_MV_USER_GROUP_MEMBER
• ADMIN_ACCESS_MV_USER_PREFERENCE
• ADMIN_ACCESS_MV_USER_PROFILE
• Give the user group authorization to view MarkView menu items through Module Admin (see Assigning
Menu Items to User Groups).
• Administration: MarkView Admin
• Administration: Process Admin
• Create a new role (see Creating Users).
Although your assistant does not need to access documents in workflow queues, you must create a
related role to limit what the assistant can access.
Add the following role preferences and set each to ALL:
• ADMIN_ACCESS_SF_USER_PROFILE
• ADMIN_ACCESS_SF_USER_ROLE_GRANT
• Assign a user to the new user group and the new role.
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MarkView User ID and Password Requirements
Under the following conditions, MarkView supports the ISO-8859-1 character set in User IDs and
passwords for Western European and US locales.
• If a user name or password contains Western European characters, the user's workstation locale must
be set to either a US or Western European locale to log in to MarkView.
For example, a user whose login name contains Norwegian characters can only log in from a
workstation that uses a Western European or US locale. The user cannot log in from a workstation
using another locale like Russian.
• When using the Safari browser, a user whose name or password contains non-English characters must
enable the option "remember my password" when logging in to MarkView.
• Users logging into sites that use the MarkView Authorization schema (WEBCLNT_SEC_AUTH_TYPE)
cannot use non-English characters in their passwords. This includes the MarkView ADMIN user.
• MarkView supports the same special characters in a user ID that the ERP system supports, except for
the hash (#).
• MarkView supports the same special characters in a password that the ERP system supports, except
for the colon (:).

Managing Users
Note Ensure that every MarkView user has a corresponding Oracle HR record with a valid email
address. Users without email addresses cannot participate in MarkView workflows.

Creating Users
MarkView requires that user IDs be all uppercase with no spaces. Do not try to distinguish user IDs based
on capitalization. When matching an ERP operator ID to a MarkView user ID, MarkView performs a caseinsensitive comparison and cannot distinguish between users with the same ID in different cases.
For example, although jsmith, JSmith and JSMITH might be different operators in the ERP system,
MarkView sees them as the same person.
Once saved, add the user to MarkView user groups and roles to give them permission to view and
process work items. Also, users who you create in MarkView Administration will appear in Process
Administration windows. To appear in Web Inquiries, the user must belong to MarkView user groups and
roles.
1. From MarkView home, select Administration > MarkView Admin.
2. Select the User Profiles tab.
The User Profiles page opens, listing existing users.
3. Click Add.
4. On the Add page, complete the new user information and click Save.
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Disabling Users in MarkView
Before disabling a user in the ERP system, set a permanent alternate user (who has no end date) in the
MarkView system. Failure to set the alternate user in MarkView first can cause you to lose access to inprocess documents assigned to the user to disable. For more information, see Handling Termination
Cases on page 136.
You cannot delete a user who has interacted with any MarkView documents. This allows MarkView to
retain an accurate history of the document process. However, you can disable a user and therefore stop
access to MarkView.
1. From MarkView home, select Administration > MarkView Admin.
2. Select the User Profiles tab.
The User Profiles page opens, listing existing users.
3. Locate the user to disable and click the Details button next to the user name.
4. In the Disable Date field, enter the date when access to MarkView should stop.
5. Click Save.
MarkView displays a message confirming the change.

Deleting Users
You cannot delete a user who has interacted with any MarkView documents. This allows MarkView to
retain an accurate history of the document process. You can delete users who have not accessed any
MarkView documents. For example, if you create a user and misspell the name, you can create a new
user with the correct name spelling and remove the misspelled user.
1. From MarkView home, select Administration > MarkView Admin.
2. Select the User Profiles tab.
The User Profiles page opens, listing existing users.
3. Locate the user to disable and click the Details button next to the user name.
4. Click Delete.
MarkView displays a message confirming the deletion.

Assigning Users Manually
Note AUSS synchronization may overwrite manual assignments made to MarkView users who are
mapped to ERP responsibilities. AUSS does not overwrite user and user group assignments created
and maintained exclusively in MarkView. AUSS synchronization does not remove a user from a user
group that was manually assigned.
Use the following procedures to manually add MarkView Users to groups and roles. Users must already
exist in the MarkView system before you can assign them.

Adding Users to User Groups
1. From MarkView Admin, select the User Groups tab.
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The User Groups page opens, listing existing user groups.
2. Locate the MarkView User Group and click the Details button next to the name.
The User Group Edit page opens.
3. Select the User Group Members tab.
4. Click Add.
5. Do one of the following to add a user:
• Enter the User ID.
• Click Select User Profile to browse through a list of users.
• Next to the user name to add, click the angle arrow.
6. Click Save.
The user is added to the group.
7. For each MarkView user to add, repeat steps 4 to 6.

Adding Users to a Role
Note If your company does not use AUSS for user, user group, and role mapping, you must assign ERP
responsibilities to MarkView organizations. Otherwise, the users you assign will be unable to process
documents in MarkView.
1.
2.
3.
4.
5.
6.
7.
8.

From MarkView home, select Administration > MarkView Process Admin.
Select the Roles tab.
Locate the role to assign to the user and click Details.
Select the User Role Grants tab and click Add.
Click Select User Profile and locate the user to add to the role.
Click Select in the row to the left of the User ID.
Click Save.
For each MarkView user to add, repeat steps 3 to 7.

Managing Alternate Users
As the MarkView Administrator, you might need to assign an alternate user to handle the tasks for a
MarkView user who is currently unavailable or who has left the company.
• To assign an alternate user for someone else, you must be a member of the ALTERNATE USER
ADMINISTRATION group.
• The alternate you assign must belong to the same MarkView groups and roles as the original user and
have authority to perform the same actions.
MarkView supports a single level of alternate users only. For example, Anna’s alternate user is Donna,
and Donna’s alternate user is Jon. If both Anna and Donna are out, Anna’s invoices will go to Donna’s
inbox and remain there. MarkView does not route Anna’s invoices to Jon.
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Finding a Qualified Alternate User
To assign an alternate user who is qualified to perform the duties of the original user, determine the
privileges, roles, groups for both users.
1. From MarkView home, select Utilities > Interactive Query > Compliance and Controls.
2. Select User Privileges.
This query helps track privileges assigned to employees.
3. Enter the search criteria, when prompted. All of the fields are optional, but at least one must contain
data.
• User ID
• Group
• Role
If searching for a user ID, MarkView returns a line of data for each group and role assignment
granted to that user. The results indicates if the role is enabled. For example, the following figure
shows information for User ID CHORTON.

Adding an Alternate User Assignment
1. From MarkView Home, select Administration > User Admin > Alternate User Assign.

2. In the User ID field, enter the User ID for whom to assign an alternate user, or click the Select User
button to the right of the field.
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3. In the Alternate User ID field, enter the User ID of the person who will serve as the alternate user, or
click the Select Alternate User button next to the field.
4. To specify a start and end date for the assignment, enter or select the start and end dates.
5. Click Submit.

Removing an Alternate User Assignment
1. From MarkView home, select Administration > User Admin > Alternate User Assign.

2. Locate the alternate user assignment to remove and select the Unassign check box.
3. Click Apply.

Handling Termination Cases
Because the Alternate User assignment interface only shows users who are active in ERP, always assign
a permanent alternate user in MarkView before disabling a user in the ERP. The alternate user who has
no end date is considered permanent.

Managing MarkView User Groups
To assign menus to MarkView User Groups, see Assigning Menu Items to User Groups on page 150.

Creating User Groups
1. From MarkView home, select Administration > MarkView Admin.
2. Select the User Groups tab.
The User Groups page opens, listing existing user groups.
3. Click Add.
4. Enter the name of the new user group and click Save.
You can now add users and assign permissions to the group.

Assigning Permissions to User Groups
1. From MarkView home, select Administration > MarkView Admin.
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2. Select the User Groups tab.
The User Groups page opens, listing existing user groups.
3. Click Details next to the group to update.
4. Click the tab for the authorization to change:
1. Document Privilege Auths—For the selected document type, specify the action that members
can take, for example, allow group members to enter self-service invoices.
2. Document Toolset Auths—For the selected document type, specify the toolset available to
group members, for example, allow group members to take an Increase Priority action on a
document.
3. User Group Org Auths—Specify the MarkView organizations for which members can view
documents.
4. Tool Privilege Auths—For the selected document type, specify additional tools available to
group members.
5. Edit the permissions and click Save.

Authorizing User Groups Access by Organization
To give all MarkView users access to an organization, add organization authorization to the All Users
group. For example, if you work for a small company with only one MarkView organization, you may need
to give all MarkView users access to that organization. (For information about setting up organizations,
see Setting Up Organizations.)
1. From MarkView home, select Administration > User Groups.
2. Search for the group called All Users and click Details next to the group name.
The User Groups page opens, listing existing user groups.
3. Select the User Group Org Auths tab.
4. Click Add.
5. Enter the Org Short name to which all users should have access.
6. Click Save.

Deleting User Groups
You cannot delete a user group that has the following:
• User Group Members
• Document Privileges Authorizations
• User Group Organization Authorization
• Tool Privileges Authorization
1. From MarkView home, select Administration > MarkView Admin.
2. Select the User Groups tab.
The User Groups page opens, listing existing user groups.
3. Locate the user group to remove and click the Details button next to the user name.
4. Click Delete.
MarkView displays a message confirming the deletion.
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Managing User Roles
Roles provide members with the authority needed to access workflow queues from which they can
retrieve work items. Roles can be global or associated with an organization.

Creating Roles
1. From MarkView Home, select Administration > MarkView Process Admin.
2. Select the Roles tab and click Add.
3. In the Role ID field, enter a role name.
Note If you give the role the same name as a MarkView User Group, MarkView assigns the role
authorizations and actions to member of the User Group. However, each role name must be
unique within MarkView.
4. Click Save.

Configuring Roles
When you configure a role, you establish how role members can interact with what they view. For
example, you can specify that role members have view-only access to the Process Monitor. Assigning the
Role Preference, MONITOR_READ_ONLY, lets role members use existing configurations in the Process
Monitor, but prohibits them from creating new configurations.
1. From the Roles list, locate the line with the role to configure and click Details.
2. Add users to the role as follows:
1. Select the User Role Grants tab and click Add.
2. Locate the row with the user to add and click the angle arrow next to the User ID.
3. Click Save.
3. Configure Role Preferences as follows:
1. Select the Preferences tab and click Add.
2. Locate the row containing the preference to add and click the angle arrow.
3. Select the setting to use and click Save.
4. Specify queues that role members can access:
1. Select the Role Queue Privileges tab and click Add.
2. Select the queue, actions that the role members can take, and the items on which the role
members can act.
3. Click Save.
Note MarkView no longer uses two tabs that might appear—Role Routable Queues and
Role Action Auths.
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Deleting Roles
1.
2.
3.
4.

From MarkView home, select Administration > MarkView Process Admin.
Select the Roles tab.
Locate the role to remove and click the Details button next to the user name.
Click Delete.

Scenario: Limiting Request Comment
For example, your company uses AUSS and wants to limit the users who can request and respond
to comments. Because all users are members of the AUSS Everyone profile, which includes the
COMMENTER role, all users have the ability to request and respond to comments.

Restricting Request Comment to a Limited Set of Users
1. Remove the COMMENTER role from the AUSS Everyone Profile.
2. Add the COMMENTER role to an existing profile, for example, AP Manager, or create a new profile
to which to add the role.
Note If you do not use AUSS, add the COMMENTER role to those users who will be available for
commenting.

Enabling Request Comment for a User Group
1.
2.
3.
4.
5.
6.
7.

From MarkView home, select MarkView Admin > User Group.
Locate the line for the <group> to award Request Comment privileges and click Details.
Select the Document Toolset Auths tab.
Click Add.
Select the <Document Type>.
Select the Comment Request toolset.
Click Save.

Disabling Request Comment for a User Group
1. From MarkView home, select MarkView Admin > User Group.
2. Locate the line for the <group> that has Request Comment privileges to remove and click Details.
3. Select the Document Toolset Auths tab.
4. Locate the <Document Type> from which to remove the Request Comment privileges and click
Details.
5. Select the Comment Request toolset and click Delete.
6. Click Save.
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About Job Functions
The table lists default MarkView User Groups, MarkView Roles, and job functions.
User Group and Role Job Functions
User Group

Role

Job Function

ACTIONS ADMINISTRATOR

Provides access to the Automated
Actions menu item and Automated
Actions Configuration window.

ACTIONS MANAGER

Enables a user to perform actions on
invoices.

ALTERNATE USER
ADMINISTRATOR

Enables a MarkView user
to administer alternate user
assignments.

AP CODING PROJECT
ACCOUNTING

Enables a MarkView user to assign
distribution lines based on project
data.

AP ENTRY NON-PO

AP ENTRY NON-PO

Enables a MarkView user to
enter non-PO invoices. When
implemented, the Sub Type feature
lets a MarkView user enter invoices
based on the Sub Types to which
they have access.

AP ENTRY PO

AP ENTRY PO

Enables a MarkView user to enter
PO invoices. When implemented, the
Sub Type feature lets a MarkView
user enter invoices based on the Sub
Types to which they have access.

AP ENTRY PRE-APPROVED

AP ENTRY PRE-APPROVED

Enables a MarkView user to enter
pre-approved invoices. When
implemented, the Sub Type feature
lets a MarkView user enter invoices
based on the Sub Types to which
they have access.

AP ENTRY SUPPLIER

AP ENTRY SUPPLIER

Enables a MarkView user to enter
supplier information.

AP INVOICE CODER

AP INVOICE CODER

Enables a MarkView user to code an
invoice by adding accounting details.

AP INVOICE COMMENT

AP INVOICE COMMENT

Provides access to non-PO invoices
that require comment.

AP INVOICE ENTRY REVIEW

AP INVOICE ENTRY REVIEW

Enables a MarkView user to review
invoices that fail the entry-complete
check point.
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User Group

Role

Job Function

AP INVOICE FOLLOW-UP

AP INVOICE FOLLOW-UP

Enables a user to review a followup document that failed because
the attachment did not attach to the
invoice document record.

AP INVOICE FOLLOW-UP
COMMENT

AP INVOICE FOLLOW-UP
COMMENT

Enables a user to provide insight
about a follow-up document
attachment that failed.

AP PO COMMENT

AP PO COMMENT

Enables a user to provide insight
about a PO invoice.

AP PRE-APPROVED COMMENT

AP PRE-APPROVED COMMENT

Provides access to pre-approved
invoices that require comment.

AP RESOLUTION

AP RESOLUTION

Provides access to all items in the
AP Resolution queue and enables
an AP user to resolve AP invoice
issues. When implemented, the Sub
Type feature lets an AP user access
items based on the Sub Type roles to
which they are assigned.

AP RESOLUTION NON-PO

AP RESOLUTION NON-PO

Provides access to non-PO work
items requiring AP intervention during
the non-PO approval process.
When implemented, the Sub Type
feature lets a MarkView user access
items based on the Sub Type roles to
which they are assigned.

AP RESOLUTION NON-PO
APPROVAL

AP RESOLUTION NON-PO
APPROVAL

Provides access to non-PO work
items in the AP resolution queue.

AP RESOLUTION PO

AP RESOLUTION PO

Provides access to PO work items in
the AP resolution queue.
When implemented, the Sub Type
feature lets a MarkView user access
items based on the Sub Type roles to
which they are assigned.

AP RESOLUTION PO MATCH
ERROR

AP RESOLUTION PO MATCH
ERROR

Provides access to PO work items in
the AP resolution queue.
When implemented, the Sub Type
feature lets a MarkView user access
items based on the Sub Type roles to
which they are assigned.

AP RESOLUTION PO
PURCHASING

AP RESOLUTION PO
PURCHASING

Provides access to invoices with
purchasing holds.

AP RESOLUTION PO RECEIVING

AP RESOLUTION PO RECEIVING

Provides access to invoices with
receiving holds.

AP RESOLUTION PRE-APPR
COMMENT

AP RESOLUTION PRE-APPR
COMMENT

Provides access to invoices requiring
AP intervention during the preapproved comment process.
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User Group

Role

Job Function

AP RESOLUTION PRE-APPROVED

AP RESOLUTION PRE-APPROVED

Provides access to pre-approved
work items in the AP Resolution
queue.

AP RESOLUTION PREVIOUSLY
ENTER

AP RESOLUTION PREVIOUSLY
ENTER

Provides access to previously
entered work items in the AP
Resolution queue.

AP RETURNED INVOICE
RECOVERY

Enables a MarkView user to recover
returned invoices using the Recover
Invoice action.

AP SENIOR FINANCIAL AUDIT

AP SENIOR FINANCIAL AUDIT

Provides access to work items in the
Senior Financial Audit queue.

AP VERIFY PO INVOICE RECEIPT

AP VERIFY PO INVOICE RECEIPT

Provides access to PO work items
requiring receipt verification, such as
2-way matched invoices.

AP VIEW ALL DOCUMENTS

Allows a MarkView user to bypass
the document/workflow security rules
for AP invoice documents.

AP VIEW SUPPLIER DOCUMENTS

Allows a MarkView user to bypass
the document/workflow security rules
to view documents.

APPROVAL HIERARCHY ADMIN

Enables the system administrator to
configure the MarkView hierarchy.

ARCHIVE

Enables a MarkView user to archive
selected document types to the
Document Library.

All Users

Provides access to basic tools and
documents. This group is the default
MarkView user group. You must
add this group to all MarkView suite
users.
COMMENTER

CONFIDENTIAL

Allows users to respond to a Request
Comment action. By default, all
MarkView users are assigned to this
COMMENTER role.
Allows a MarkView user to mark an
invoice as Confidential using the
Confidential action.

CONNECTOR ADMIN

Enables a MarkView user to monitor
all connector workflow queues.

CONNECTOR EXPORT MONITOR

Enables a MarkView user to monitor
work items in connector export
queues.

CONNECTOR IMPORT MONITOR

Enables a MarkView user to monitor
work items in connector import
queues.
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User Group

Role

Job Function

CONNECTOR REVIEW

CONNECTOR REVIEW

Enables a MarkView user using
quick invoices to retrieve connector
work items for review. The
CONNECTOR_REVIEW role must
have a valid email address.

CONNECTION VALIDATION
MONITOR

Enables a MarkView user to
monitor workflow items in connector
validation queues.

COPY DOCUMENT

Provides access to the Copy
Document action. Enables a
MarkView user to create duplicates of
the document image.

EMAIL DOCUMENT

Enables a MarkView user to send
email containing a link to the
document image.

EMAIL DOCUMENT ATTACHMENT

Enables a MarkView user to send
email containing an attached
document image.

EXP VIEW ALL DOCUMENTS

Allows a MarkView user to bypass
the document/workflow security rules
to view expense documents.

EXTERNAL APPROVER

Allows MarkView users to review
Connector invoices sent to them
through the Request External Review
action.

FAX EXPORT

Allows group members to see all
document views, thereby enabling
members to be configured as the
admin user for the MarkView Fax
Export Server or the MarkView
Document Export Server.
Only assign this group to a MarkView
user who is configured to connect
from the Fax and Document Export
Server processes.

FREIGHT REVIEW NON-PO

FREIGHT REVIEW NON-PO

Provides access to non-PO invoices
in the Freight Review Required
queue.

FREIGHT REVIEW PREAPPROVED

FREIGHT REVIEW PREAPPROVED

Provides access to pre-approved
invoices in the Freight Review
Required queue.

FREIGHT REVIEW PO

FREIGHT REVIEW PO

Provides access to PO invoices in
the Freight Review Required queue.

INTERACTIVE QUERIES

Provides access to Interactive
Queries.
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User Group

Role

Job Function

INVOICE APPROVER

INVOICE APPROVER

Enables users to approve non-PO
invoices. To let users assigned
to this group or to this role
approve multiple invoices, set
MVT_WIB_ALLOW_APPROVE =
TRUE for the group or role.

INVOICE AUDIT

Enables users to access the Invoice
Audit utility and all MarkView
document types.

LOCALE_de

Specifies German as the interface
language for group members.

LOCALE_en

Specifies US English as the interface
language for group members.

LOCALE_es_ES

Specifies Castilian Spanish as
the interface language for group
members.

LOCALE_fr

Specifies French as the interface
language for group members.

LOCALE_ja

Specifies Japanese as the interface
language for group members.

LOCALE_it

Specifies Italian as the interface
language for group members.

LOCALE_pl

Specifies Polish as the language that
group members see in the interface.

LOCALE_pt_BR

Specifies Brazilian Portuguese as
the interface language for group
members.

LOCALE_zh_CHS

Specifies Simplified Chinese as
the interface language for group
members.

MANUAL REVIEW

MANUAL REVIEW

Provides access to the
Uncategorized Document queue.
Enables a MarkView user to
recategorize documents.

MarkView Administration Group

Used by the default system-assigned
user (MVFAX) only. Not required by
other MarkView users.

MarkView RECORDS MGMT
ADMINISTRATOR

Enables a MarkView user to
administer the MarkView Document
Library.

MarkView WEB ADMINISTRATOR

Provides access to MarkView Web
Administration.

MODULE ADMINISTRATOR

Enables a MarkView user to
administer MarkView business
modules.

144

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

User Group

Role

MVCN VIEW ALL DOCUMENTS

PO INVOICE REVIEW PURCHASING

Job Function
Allows a MarkView user to bypass
the document/workflow security rules
for transformation and e-Invoice
document types.

PO INVOICE REVIEW PURCHASING

Enables a MarkView user to assign
PO numbers to invoices that the AP
user could not process.

PREVIOUSLY ENTERED INVOICES PREVIOUSLY ENTERED INVOICES Provides access to the Previously
Entered Web application.
PROCESS MONITOR

PROCESS MONITOR

Enables MarkView users to access to
the Process Monitor.

PROCESS WEB ADMINISTRATOR

Provides access to Process
Administrator functions.

QA

QA

Provides access to all document
types to attach document images to
existing ERP records.

QA NON-PO

QA NON-PO

Provides access to non-PO
documents to attach document
images to existing ERP records.

QA PO

QA PO

Provides access to PO documents to
attach document images to existing
ERP records.

QA PRE-APPROVED

QA PRE-APPROVED

Provides access to pre-approved
documents to attach document
images to existing ERP records.

RECYCLE REVIEW

RECYCLE REVIEW

Provides access to work items in the
Recycle Requested queue.

RESCAN

RESCAN

Enables a MarkView user to rescan
document images.

RETURNED INVOICE REVIEW

RETURNED INVOICE REVIEW

Provides access to work items in the
Return to Supplier Requested queue.

REVIEW

REVIEW

Provides access to all work items in
the Review Requested queue.

REVIEW NON-PO

REVIEW NON-PO

Provides access to non-PO work
items in the Review Requested
queue.

REVIEW PO

REVIEW PO

Provides access to PO work items in
the Review Requested queue.

REVIEW PRE-APPROVED

REVIEW PRE-APPROVED

Provides access to pre-approved
work items in the Review Requested
queue.

REVIEW PRE-APPROVED
COMMENT

REVIEW PRE-APPROVED
COMMENT

Provides access to pre-approved
work items that require comment.
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User Group

Role

Job Function

SQL*FLOW ADMINISTRATION

Provides access to work items in the
Workflow Administration queue.

SQL*FLOW MAIL GATEWAY

MarkView Process Mail Gateway
uses this role. Do not assign this role
to users.

SAVE ROTATION USERS

Enables users to save image
rotations.

SCAN USERS

Provides settings and privileges
needed for a MarkView user to
scan documents into MarkView and
validate documents in KTM.

SUPPLIER FOLLOW-UP

SUPPLIER FOLLOW-UP

Enables a MarkView user to review
a follow-up document that failed
because the attachment did not
attach to the supplier record.

SUPPLIER FOLLOW-UP COMMENT SUPPLIER FOLLOW-UP COMMENT Provides access to supplier follow-up
invoices that require comment.
SUPPLIER MAINTENANCE

SUPPLIER MAINTENANCE

Provides access to work invoices in
the Supplier Maintenance queue.

SUPP SENIOR FINANCIAL AUDIT

SUPP SENIOR FINANCIAL AUDIT

Provides access to Web Inbox menu
Supplier Documents. MarkView users
can retrieve and review supplier work
items in the Senior Financial Audit
queue.

TAX REVIEW NON-PO

TAX REVIEW NON-PO

Provides access to non-PO invoices
in the Tax Review Required queue.

TAX REVIEW PRE-APPROVED

TAX REVIEW PRE-APPROVED

Provides access to pre-approved
invoices in the Tax Review Required
queue.

TAX REVIEW PO

TAX REVIEW PO

Provides access to PO invoices in
the Tax Review Required queue.

WORKFLOW ADMINISTRATOR

Enables MarkView users to monitor
the Workflow Administration queue in
all workflows.

WORKFLOW ADMINISTRATION

Enables MarkView users to access
the Recycle Bin queue.

WEB INQUIRY
WORKFLOW ADMINISTRATOR
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Chapter 12

Configuring MarkView Menus
This section describes how to control the menu items that appear in the MarkView interface and the
behavior of items accessed through MarkView.
Note Only use MarkView Business Module menu items not described in this guide under the direction of
Kofax Professional Services or Technical Support.

About Menu Items
You can configure the menu items that appear in MarkView Home and submenu items that appear under
primary menus. Use Module Admin to rename, delete and add menu items, or change what happens
when a user selects an item.
Note Keep track of menu changes you make. Applying patches or upgrading the system could revert
those changes.

Each column defines the characteristics of a row entry and each row defines a menu item.
• Menu Description: Shows the menu name and the names of all menus that have submenu items.
For example, the MarkView Home page has a menu item "Administration." Under Administration is a
submenu item, "User Admin," which has two submenu items of its own.
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Because both Administration and User Admin have submenus, they appear in the Menu Description
column. The submenus associated with them appear in the Default item Label column.

• Menu Sequence (Order): Shows the order in which submenu items appear. In the main menu, lower
numbers push a menu item further to the left. In submenus, lower numbers push a menu item higher.
For example, in the preceding figure, number 1 specifies that Change Password appears first, followed
by the submenu item with the sequence assignment of 2, Alternate User Assign.
MarkView sorts menus items first by the Menu Description, then by Menu Sequence number.
• Default Item Label: Shows the default name that appears in the interface.
• Item Label Message: Shows the localized message that appears when the user accesses a localized
interface.
• Item Type: Specifies if the item is a menu or submenu item, or a link to the URL page.
• MENU: Generates a submenu when a user selects the item. Set the Item Value to the name of the
menu. When a user clicks the menu, a submenu pops up.
• URL: Triggers an action when a user selects the item. Set the Item Value to one of the following:
• A full URL, such as http://aphost.nonesuch.com:8889/sfasmm. When a user clicks Load Hierarchy
Data, the system accesses the specified URL.
• The full name of a PL/SQL procedure or an argument that passes to the PL/SQL procedure using
CGI format.
When a user selects Verify MarkView, no submenu appears; instead the system invokes the
following PL/SQL procedure:
MVW_Folder.ShowFolder
Because the system uses CGI format to pass arguments (FolderID=1) to the target PL/SQL
procedure, the Item Value is set to the following:
MVW_Folder.ShowFolder?FolderID=1
• Item Value: Provides the value that connects the menu item to page defined by the menu item or to the
URL link.
• MarkView Home Aware: Determines how the window refreshes.
• Y (yes): Retains the current MarkView top frame; does not refresh the window. Used for partial URLs
that usually call a procedure.
• N (no): Redraws the MarkView top frame. Used for fully qualified URLs.
To edit a menu item, click Update.
To delete a menu item, click Delete.
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Adding a Menu Item
When you add a menu item, the item remains inactivate until you assign it to a user group (see Assigning
Menu Items to User Groups on page 150).
1. From MarkView home, select Administration > Module Admin.
2. Select Menu Item.
3. Scroll to the bottom of the page, and click Insert.
4. Complete the form and click Insert again. (See About Menu Items on page 147 for detailed
descriptions about the following:
• Menu Name: Select a menu name
• Menu Sequence: Enter a number to specify where the item appears in the menu:
• In the main menu, lower numbers to push a menu item to the left.
• In submenus, lower numbers push a menu item higher in the list.
• Item Type: Specify if the item is a menu item, a link to the URL page, or a command sequence.
• MENU: Generates a submenu when a user selects the item. Set the Item Value to the name of
the menu. When a user clicks the menu, a submenu pops up.
• URL: Triggers an action when a user selects the item. Set the Item Value to a full URL or a PL/
SQL procedure.
• Default Item Label: Enter the default name that appears in the interface.
• Item Label Message: Leave this field blank unless you already have a MarkView Message to use
for the menu item label.
• Item Value: Provides the value that connects the menu item to page defined by the menu item or
to the URL link.
• MarkView Home Aware: Accept the default value.
5. Assign the menu item to the appropriate user groups (see Assigning Menu Items to User Groups on
page 150).

Modifying a Menu Item
1.
2.
3.
4.

From MarkView home, select Administration > MarkView Module Admin.
Select Menu Item.
Locate the line containing the item to change and click Update.
Complete the form and click Update again.

Removing a Menu Item
You cannot remove a menu if submenu items are associated with it, if the menu is assigned to any user
groups, or if the menu item has foreign relationships configured.
1. From MarkView home, select Administration > MarkView Module Admin.
2. Select Menu Item.

149

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

3. Locate the line containing the item to remove and click Delete.
4. Click Delete again to confirm the deletion.

Assigning Menu Items to User Groups
Before a new menu or submenu item becomes activated, the item must be assigned to a user group.
User groups have different sets of menus based on the tasks the user group performs. For example,
Administrative groups access a different set of menus than Invoice Approver groups.
Note Assign menu items to user groups, not to individual users.
The Module Administrator user group can view a full set of menus. Other user groups can view only
the Change Password menu (other user groups may need access to additional menus). Enable the
appropriate set of menus for each user groups.
1. From MarkView home, select Administration > Module Admin.
2. Click Menu Item Group Auth.

3. Click Insert.
4. At the bottom of the page, locate the Default Item Label list and select the Item Label for the menu
item to assign.
5. From the Group Name list, select the Group for which to authorize the menu item.
For example, the following shows how to enable everyone in the MarkView Web Administrator user
group to see the Utilities > Process Monitor menu:

6. Click Insert again.
7. If you assign a submenu item to a user group, also assign the parent menu item to the user group.
Otherwise, the user group cannot view the menu item.
For example, you need to give a user group access to the interactive query that lets members see
working folder details.
The MarkView System Administrator can allow access to each inquiry based on user permissions.
For example, the company controller can access the Unprocessed Invoice Liability query, which
provides the total value of invoices the AP department is processing. However, the controller does
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not need access to User Working Folder Detail, a query that provides detail of individual employee
Working Folders.

To allow access, you need to run the process 4 times to award the user group access to each of the
following menu items:
• Utilities
• Interactive Queries
• Operational Performance
• User Working Folder Details
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Chapter 13

Setting Up a MarkView Approval Hierarchy
If your company does not use an ERP approval hierarchy, you can create and deploy one in MarkView.

Setting Up Hierarchy Components
Approval hierarchies consist of Organizations, jobs (assignments and supervisor assignments), and users.
You can create instances of these components and maintain existing components.

Maintaining Approval Organizations
Organizations fall into two categories: ERP and non-ERP. ERP Organizations are defined in Module
Administration (see Configuring MarkView Menus). All non-ERP Organizations are categorized under a
single ERP Org ID, -1 .

Creating an Approval Organization
1. From MarkView home, select Administration > Approval Hierarchy Admin.
2. From the menu on the left, select Approval Organization.
The Approval Organization Admin page opens. Organizations that are already set up for approval
appear in a list below the page.
3. From the list, select an ERP Org ID.
The list is populated with Organizations defined in Module Administration. The –1 (Non-ERP) option
is reserved for non-ERP Organizations.
4. Click Insert.
The ERP Org ID that you set up appears in the approval list.
5. Next to the ERP Org ID name, click Update.
6. Select how the hierarchy determines the approval limit:
• By User—MarkView users each have an approval limit assigned to them and they can approve up
to that approval limit.
• By Job—MarkView users who are assigned to a job title can approve up to the approval amount
assigned to the job title.
7. Click Update.

Updating Approval Organizations
1. On the Approval Organization Admin page, click the Update link to the right of the Organization to
update.
The Approval Organization Admin - Update page opens.
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2. On the Update page, change the Org Name or Authorization and click Update.

Deleting Approval Organizations
You can only delete an Organization that has no current job assignments.
1. On the Approval Organization Admin page, click the Delete link to the right of the Organization to
delete.
The Approval Organization Admin - Delete page opens.
2. Confirm the deletion by clicking Delete.Main

Maintaining Job Titles
A job title is a specific designation of a post within an organization and is normally associated with a job
description that details the tasks and responsibilities of the job. In MarkView, each job title becomes part
of a reporting structure that includes supervisory job titles.
Once you assign a job title to a reporting structure for the first time, the job title is locked into that reporting
structure. You cannot then assign the job title to a superior in a different structure. For example, your
company might have many Executive Assistants who report to managers who are not part of the same
reporting structure as shown in the following figure.

In the first chain, the CEO can have an Executive Assistant, the CTO can have an Executive Assistant,
and the VP can have an Executive Assistant. In the second chain, the CFO can have an assistant who
has a different job title, for example, "Executive Assistant B."
When creating a new job title, you also assign a supervisor, as applicable.

Creating a Job Title
1. From MarkView home, select Administration > Approval Hierarchy Admin.
2. From the menu on the left, select Job Title.
The Job Title Admin page opens. Jobs that are set up for approval appear in a list below the page.
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3. From the list, select a Supervisor, or keep the default No Supervisor.
4. In the text field, enter a Job Title that is unique within the hierarchy subsystem.
5. Click Insert.

Updating Job Titles
1. From the list on the Job Title Adminpage, click the Update link to the right of the job title to update.
The Job Title Admin - Update page opens.
2. In the update page, change the Job Title or Supervisor Assignment, as appropriate.
3. Click Update.

Deleting a Job Title
You can only delete a job title if no subordinate users are assigned.
1. On the Job Title Admin page, click the Delete link to the right of the job title to delete.
The Job Title Admin - Delete page opens.
2. Confirm the deletion by clicking Delete.

Maintaining Approval Users
You set up approval users from available MarkView User IDs. Approval users must be members of the
MarkView Invoice Approvers user group to receive invoices for approval.
Add users who will be approvers in the hierarchy to the Invoice Approvers user group before or after
creating an approval hierarchy. See Setting Up a MarkView Approval Hierarchy, to use AUSS or Adding
Users to User Groups on page 133 to add users manually.

Creating Approval Users
1. From MarkView home, select Administration > Approval Hierarchy Admin.
2. Select Approval User.
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The Approval User Admin page opens. Users who are already set up for approval appear in a list
below the page.
To reduce the list, enter a partial user ID in the Filter field and click Filter.

3. Click Select Available User.
The Approval User Admin - Select User page opens.
4. As needed, use the filter field to narrow the scope of the list:
1. Type a partial name to filter the list to a subset of user IDs.
2. Use a percent sign (%) as a wild card to match zero or more characters following the string that
you type.
3. Click Filter after you enter the filtering criteria.
Adjust the number of rows that appear by typing a number in the box provided and clicking Apply.
5. From the list of MarkView users, click the user to assign as an approval user.
Selecting the user returns you to the Approval User Admin page, where the user name appears the
User ID field.
6. Enter the user’s email address.
7. Click Insert.
The user becomes available for inclusion as part of an approval hierarchy. The user ID no longer
appears in the list of available MarkView users.

Updating Approval Users
1. From the list on the Approval User Admin page, locate the user to update and click the Update link
to the right of the user.
The Approval User Admin - Update page opens.
2. On the update page, change the user’s email address.
3. Click Update.
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Deleting Approval Users
1. From the list on the Approval User Admin page, locate the user to delete and click the Delete link
to the right of the user.
The Approval User Admin - Delete page opens.
2. Confirm the deletion by clicking Delete.
The user ID returns to the pool of available MarkView users.

Creating Hierarchies
A user hierarchy associates a M user to an Organization and job title, allocates an approval limit, and
optionally assigns a supervisor. Each level in a hierarchy requires you to complete a 2-step process.
1. From MarkView home, select Administration > Approval Hierarchy Admin.
2. From the menu on the left, select User Hierarchy.
The User Hierarchy Admin - Insert (Step 1 of 2) page opens.
3. To complete step 1:
1. Select an Org Name from the list.
2. Select a Job Title from the drop-down list. The job title must be authorized for the selected
Organization, and there must be an assignment available for the job title.
3. Click Next.
The User Hierarchy Admin page opens.
4. To complete step 2:
1. Select the Supervisor, if applicable, appropriate for the Job Title selected previously.
If only one person qualifies as a supervisor, the field is preselected. Each selection identified the
MarkView user ID, job title, and approval limit.
2. Click Select User to open the Approval Hierarchy Admin - Select User page.
The list displays all approval users in the selected job who are not yet assigned. Clicking a user
ID in the list populates the User field and associates a MarkView user ID with the job.
3. Enter a positive number that represents a whole currency amount to assign an Approval Limit to
the user. The amount cannot be greater than the approval limit of the supervisor.
4. Click Insert.
If no conflicts exist between users and job assignments in the Organization, the new user
hierarchy is created.

Maintaining An Approval Hierarchy
Hierarchy maintenance consists of updating the supervisor, user, and the user’s approval limit, as
appropriate, for the selected job and Organization. Maintenance also involves the deletion of job
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assignments, and an assignment hierarchy, where a supervisor assignment and all subordinate
assignments are removed.
1. From MarkView home, select Administration > Approval Hierarchy Admin.
2. Select Query Hierarchy from the menu on the left.
The Query Hierarchy page opens.
3. Enter selection criteria:
1. Select search criteria for any or all of the respective categories: Org Name, Job title, User ID by
clicking the respective button and selecting from the available lists.
2. Select Maximum Depth from the list, where the number selected represents the depth of the
hierarchy to display relative to the selected Job Title or user ID.
• When searching by Job Title, depth is displayed for both upward and downward directions in
the hierarchy.
• When searching by User ID, the depth displayed is relative to the selected user and
subordinates. For example, if you select a maximum depth of 3, the displayed hierarchy
shows the selected user, any subordinates, and any subordinate subordinates.
The default for Maximum Depth is "all."
4. Click Query.
The Query Hierarchy page is refreshed to show the results of the query.

Updating a Hierarchy
1. In the query results list, click the Update link to the right of the hierarchy to update.
The User Hierarchy Admin (Step 2 of 2) page opens.
2. Change the Supervisor, User, and Approval Limit, as appropriate.
3. Click Delete.
The list displays the updated hierarchy.

Deleting a Job Assignment
1. In the query results list, click the Delete link to the right of the job to delete.
The User Hierarchy Admin - Delete page opens.
2. Confirm the deletion by clicking Delete.
The deletion releases the user ID and a job assignment (count) back to the pool of availability for use
in other hierarchies within the Organization.
Note You cannot delete a supervisor who has subordinates assigned.

Deleting a Job Assignment and Subordinate Assignments
1. In the query results list, click the Delete Hierarchy link to the right of the job hierarchy to delete.
The User Hierarchy Admin - Delete Hierarchy page opens.
2. Confirm the deletion by clicking Delete.
The deletion releases the user ID, a job assignment (count), and subordinate job assignments back
to the pool of availability.
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Assigning a Different User to a Job
1.
2.
3.
4.

Select Approval Hierarchy Admin > Query Hierarchy.
Enter search criteria to locate the job, and click Query.
Click the Update link for the job.
Click Select User to display the list of available users, and select the User ID of the user to assign to
the job.
5. Click Update.

Deleting User Association to a Job
1.
2.
3.
4.

Select Approval Hierarchy Admin > Query Hierarchy.
Enter search criteria to locate the job, and click Query.
Click the Delete link next to the user association.
Confirm the deletion by clicking Delete.

Changing the Supervisor/Subordinate Relationship
1.
2.
3.
4.
5.

Select Approval Hierarchy Admin > Job Title.
In the Job Titles list, click the Update link for the job.
On the Update page, select a new supervisor from the list.
Click Update.
To reassign jobs affected by the change, select Query Hierarchy and update the affected jobs.

Updating an Approval Limit for a Job
1.
2.
3.
4.

Select Approval Hierarchy Admin > Query Hierarchy.
Enter search criteria to locate the job, and click Query.
Click the Update link for the job to change.
Change the approval limit.
An approval limit of a subordinate cannot exceed that of the supervisor.
5. Click Update.

Introducing a New Level in a Hierarchy
1. Select Approval Hierarchy Admin > Job Title.
2. Create a job title for the new level to add to the approval hierarchy.
For example, create an AP Director who will report to the VP. The VP wants the managers who
currently report to the VP to report the AP Director.
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3. Click Insert.
The new position appears in the job title list.
4. From the job list, locate the Manager job title and click Update.
5. Change the Manager’s supervisor from the VP to the AP Director and click Update.

6. Select User Hierarchy.
7. On the first Insert page, select the Org Name where the new job title belongs, select the new job title,
and click Next.
8. On the second Insert page:
1. Select the supervisor to whom the new job title reports.
2. Click Select User and select the user who will fill the new job title.
3. Specify an approval limit, if appropriate.
4. Click Insert.
9. Use the Query Hierarchy feature to perform a query on the job title you created. Update the
supervisor assignments for all users who will report to the new job title.

159

Chapter 14

Maintaining MarkView Add-On Products
This section describes how to set up and maintain optional MarkView products, and answers the following
questions.
• How do I set up and configure the Self-Service Invoice application?
• How do I set up MarkView to print batches of invoices?

Setting Up the MarkView Export Server
This chapter describes how to set up Export Server instances in MarkView, including setting up one to
handle batch print requests.
Setting up the MarkView Application Server Export Server enables employees to:
• Email a PDF or TIFF image from the viewer to a user outside of MarkView
• Apply the Return to Supplier action to email a PDF to the supplier.
• Write PDF or TIFF copies of MarkView documents to a local file system.
• Create batch print jobs.
To let employees see the email button in the viewer and allow them to send email, verify the following
preferences are set to TRUE:
• VIEWER_INCLUDE_EMAIL
• VIEWER_INCLUDE_PDF_EXPORT

Setting Up the Export Server
An Export Server is an application server servlet with access to an SMTP server. The MarkView
installation process adds a default export server (DEFAULT_EXPORT_SERVER) and export queue
(DEFAULT_EXPORT_QUEUE), which you can use with minimal configuration changes.
Use MarkView Administration to modify or add an export server. Adding a server creates a record and
registers the server with database objects. After adding an export server, also add an export queue.
Assigning the export queue to the export server allows the components to communicate with each other
and for items in the queue to be recognized for processing.

Adding an Export Queue
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Export Queues tab and click Add.
3. Enter a Queue Name and Description.
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4. Click Save.

Adding an Export Server
1.
2.
3.
4.
5.
6.

From MarkView home, select Administration > MarkView Admin.
Select the Export Servers tab and click Add.
Enter a Server Name and Description.
Enter the Location.
Click Save.
Assign the server to the Export Queue you created as follows:
1. Select the Queue Assignments tab.
2. Complete the fields as follows.
Field

Description

Queue Name

Enter the name of the export queue or click Select Export Queue to select
a queue from the list.

SMTP Address

Enter the SMTP address of the SMTP server that you use to send exported
document images. This applies only if this Export Server instance is also
handling email requests.

Priority

Reserved for future use.

Servlet Address

Enter the URL location of the MarkView Export servlet. The URL must be in
the following format:
http://server:port/viewer/view/exportDocument

Servlet Username

Enter the user name that MarkView uses to identify itself to the servlet, or
click Select User Profile to select a user from the list.
This user must be able to authenticate against the MarkView schema.
This user must have optional access to any views and document types for
export, for example, ADMIN.

SMTP User

Enter the user name if you use mail authentication on the SMTP server.

SMTP Password

Enter the password associated with the SMTP User for mail authentication
on the SMTP server.

Confirm SMTP Password If you enter a password, retype the password for verification.

7. Click Save.

Batch Printing
The batch printing option enables employees to print some or all of the documents displayed in a Web
Inquiry page. Enabling batch printing requires the purchase of a separate license.
Setting up an instance of the MarkView Export Server as a batch print server involves:
• Setting up an export server and queue (see Setting Up the Export Server)
• Setting up a print server and queue (see Setting Up a Print Server)
• Assigning the export queue and the print queue you added to the print server (see Assigning the
Queues to the Print Server on page 162).
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• Setting the MVT_WIQ_API_BATCH_PRINT preference to a value such as ALL. By default, batch
printing is disabled.
Note If a single server reaches maximum capacity, have the system administrator scale the number of
JVMs per server or use clusters across servers.

Setting Up a Print Server
Adding a Print Server
1. From MarkView home, select Administration > MarkView Admin.
2.
3.
4.
5.

Select the Print Servers tab and click Add.
Enter a <Server Name> and <Description>.
Enter the <Location> of the server.
Click Save.

Adding a Print Queue
1.
2.
3.
4.

From MarkView home, select Administration > MarkView Admin.
Select the Print Queues tab and click Add.
Enter a <Queue Name> and <Description>.
Click Save.

Assigning the Queues to the Print Server
1.
2.
3.
4.
5.

From MarkView home, select Administration > MarkView Admin.
Select the Print Servers tab.
Locate the Print Server and click the Details button next to the server name.
Select the Queue Assignments tab and click Add.
Complete the fields as follows:
Field

Description

Queue Name

Enter the name of the print queue, or click Select Print Queue to select a queue
from the list.

Printer Name

Add the printer name, which must include the full path by which the printer is
known on the machine where Document Export is running.

Priority

Reserved for future use.

Export Queue Name

Enter the name of the export queue, or click Select Export Queue and select a
queue from the list.

6. Click Save.
Associate only one Print Server and one printer per print queue. Otherwise, the Export Server cannot
handle print requests.
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MarkView DTM
The MarkView Document Transport Module (DTM) provides a secure means to transport image
information from your database to the document server.
Use the information in this chapter to modify the authorization method that the system uses.
For information about maintaining the DTM, see MarkView Administrator's Guide, Volume 2.

Configuring DTM for the Application Server
After installing the MarkView DTM, configure database preferences to enable communication between the
DTM and the database server. For information about these preferences, which begin with MVAS_DTM,
see MarkView DTM Preferences on page 230.
The installation process sets defaults for most of these preferences, which you can review and modify as
needed to optimize performance.

Volume Path Set Up
The volume path ties the logical volume where MarkView document pages reside to an access platform
and the associated workstation. The workstation is a client machine or other component seeking
document access. The combination of these values determines access to and location of MarkView
documents.

Setting the Volume Path for the DTM
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Platforms tab.
3. Locate the platform to map (for example, HTTPS_TO_DTM), and click the Details button next to the
name.
4. Select the Volume Paths tab and click Add.
5. Click Select Volume and select the volume path to add.
6. Enter the Path URL using the following format:
dtm:https://<server:port>/<mvasdtm/markview>
Where server:port is the URL of the application server process, and mvasdtm/markview is the root of
the DTM map location.
Note Use the prefix dtm for the path.
7. Click Save.

Setting Up a Workstation for Applications
You can set up any number of workstations to allow the DTM to communicate with different applications.
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Workstations tab.
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3. Click Add and complete the page as follows:
1. Enter a descriptive workstation name.
2. Enter a serial number, for example, WEB_CLIENT. This value maps to the
WEBCLNT_WKSTN_SERIAL_NO preference.
3. Click Select Platform and select HTTPS_TO_DTM from the LOV.
4. Click Save.

Configuring the Volume Path for the Document Server
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Platforms tab.
3. If you plan to store the documents on the file system, specify the document server for your operating
system:
• UNIX—Click Details next to UNIX_FS_TO_DOC_SERVER.
• Windows—Click Details next to WINDOWS_FS_TO_DOC_SERVER.
4. If you plan to store the documents using network transfer protocol, select one of the following
document servers and click Details:
• FTP_TO_DOC_SERVER
• HTTP_TO_DOC_SERVER
• HTTPS_TO_ DOC_SERVER
Note If you plan to store the documents on HTTP or HTTPS server, create the x/x/x/x/ directory
structure,
where x is a numeric value from 0 to 9 with each folder containing 10 subfolders.
For example, the full paths of the saved documents will be as follows:
http://docserver:welcome01@engrhel5.kofax.com:8080/0/0/0/0/00000000.tif
http://docserver:welcome01@engrhel5.kofax.com:8080/0/1/7/1/00000171.tif
http://docserver:welcome01@engrhel5.kofax.com:8080/9/9/9/9/00009999.tif
5. Select the Volume Paths tab.
6. Locate the volume (for example, PRODUCTION), and click the Details button next to the name.
7. In the Path field, specify the path:
• UNIX_FS_TO_DOC_SERVER—Set Path to a local directory, for example, /export/home/
working_dir/kofaxmarkview/docserver/

• WINDOWS_FS_TO_DOC_SERVER—Set Path to a local folder, for example, C:\kofaxmarkview
\docserver\

• FTP_TO_DOC_SERVER—Set Path to the FTP Server, for example, ftp://
docserver:welcome01@engrhel5.kofax.com/

where docserver:welcome01 is the login and password to the http server
• HTTP_TO_DOC_SERVER—Set Path to the HTTP Server, for example, http://
docserver:welcome01@engrhel5.kofax.com:8080/
where docserver:welcome01 is the login and password to the http server, and
engrhel5.kofax.com:8080/ is http server url
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• HTTPS_TO_DOC_SERVER—Set Path to the HTTPS Server, for example, https://
docserver:welcome01@engrhel5.kofax.com:8080/
where docserver:welcome01 is the login and password to the https server, and
engrhel5.kofax.com:8080/ is https server url
8. Click Save.

Setting Up a Workstation for the Platform
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Workstations tab.
3. Click Add and complete the pages as follows:
1. Enter a descriptive workstation name.
2. Enter a serial number, for example, MVAS_DTM_1. This value maps to the
MVAS_DTM_WORKSTATION_SERIAL_NO preference.
3. Click Select Platform and select the server where you plan to store the documents. For
example, select UNIX_FS_TO_DOC_SERVER, WINDOWS_FS_TO_DOC_SERVER,
HTTP_TO_DOC_SERVER, or FTP_TO_DOC_SERVER.
4. Click Save.

Authorizing Document Types
1.
2.
3.
4.

In MarkView Administration, locate the volume with path that you set and click Details.
Select the Document Type Auths tab.
Add or edit the document types to authorize for this volume.
Click Save.

Self-Service Invoice
Self-Service Invoice (SSI) enables MarkView users to generate invoices from their desktops. The invoices
go to the Accounts Payable department, where they are imported into the Oracle E-Business Suite
Accounts Payable module. SSI includes a best practices workflow that guides the created invoices
through the appropriate processes and payment channels.
Note The instructions in this section assume that you have installed and configured MarkView for
Accounts Payable and SSI according to the instructions in the MarkView Installation Guide or MarkView
Upgrade Guide.
Access SSI administration windows from MarkView home, by selecting Administration > Module
Admin > Organization > Self-Service Invoice, where Organization could be Global Configuration or
configuration for an Organization.
Note Changing global settings changes system-level values. If an Organization has values set, the
Organization settings override the global settings. As a best practice, use global settings for default
values shared by most organizations. Use organization-level settings to customize values different from
the defaults.
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The SSI administration windows list these options:
• Invoice Header Fields and Invoice Line Fields- See Setting Invoice Header and Line Fields on page
166.
• Invoice Header DFF Fields and Invoice Line DFF Fields- See Managing Descriptive Flexfields (DFFs)
on page 168.
• Follow-Up Document Submission See Managing Follow-Up Documents on page 168.
For information about setting SSI preferences, see SSI Preferences

Setting Invoice Header and Line Fields
The configuration settings on the Module Administration pages control which fields are visible on the
SSI Invoice and Invoice Line user windows. You can set both global values and organization-specific
overrides. The Administration pages show:
Description
A description of the field. This matches the field name on the SSI user window.
Show/Hide
Indicates whether the field appears on the SSI user window. The Show/Hide field is not updated to show
the result of the join point call; it always shows the value defined in the configuration UI.
Customized?
The join point type for any field customization.
Click Update to enable the Show/Hide settings for your organization. You cannot edit certain fields like
Invoice Amount which are always on the SSI user windows.
Note The format of the Date fields is based on the date format set in MarkView.

SSI Invoice Header and Line Fields
These are the default values for the Invoice Header and Invoice Line fields. Use the SSI interface to
configure which optional fields are visible on the SSI user interface:
Default Invoice Header Settings
Description

Definition

Show/Hide

Approver

The name of the Accounts Payable user who will verify that
this invoice is payable after it is submitted.

Show

Auto-Calculate Tax

Optional. Auto Calculate Tax specifies that Oracle
automatically calculates the tax amount for this invoice.

Show

Description

An optional description that will appear in the header for this
invoice. Although Description always appears, this field can
be left blank.

Show*

Exchange Rate

The exchange rate used for payment calculations.

Hide

Exchange Rate Date

The date associated with this exchange rate.

Hide
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Description

Definition

Show/Hide

Exchange Rate Type

Additional information about the exchange rate.

Hide

Invoice Amount

The total cost for this invoice.

Show*

Invoice Currency

The currency for the charges on the invoice.

Show

Invoice Date

The date on which the invoice was issued.

Show*

Invoice Number

The unique invoice number. The system may generate a
default value.

Show*

Invoice Received Date

The date on which the invoice was received.

Hide

Pay Alone

Optional. Specifies that only one check should be issued for
this invoice. Otherwise, this invoice may be paid in a batch
with other invoices for this supplier.

Hide

Pay Group

Optional. The group with which this invoice is associated.
In most cases the pay group determines when and how the
invoice is paid.

Hide

Payment Currency

The currency used to pay the invoice.

Show

Payment Method

The method used to pay the invoice.

Hide

Terms

The terms for payment of the charges on this invoice.

Hide

*Not editable.

Default Invoice Line Settings
Description

Definition

Show/Hide

Account

The payment account for this invoice.

Show

Accounting Date

The date the invoice was entered into accounting. This
date can differ from the Invoice Date.

Show*

Description

The optional user-supplied description of the line item. For Show*
example, "laser printer".

Distribution Amount

The <cost> of the distribution for this invoice line. The field Show*
name displays the currency for this invoice.

Distribution Set

The name of this distribution.

Show

Line Set

The list of line items and relative percentages for this
distribution.

Show*

Project Master lines

Additional custom fields.

Hide

*Not editable.

Descriptive Flexfield Pages
Descriptive Flexfields (DFFs) collect additional information during invoice entry as part of the invoice
header or invoice line. DFFs are specific to your organization; the pages you see may not include
any DFFs. For more information about entering data into the DFFs for your organization, contact your
Accounts Payable department.
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Managing Descriptive Flexfields (DFFs)
DFFs are optional invoice header or invoice line fields to collect additional information during invoice entry.
DFFs are specific to your organization and are set up by your Accounts Payable Department in Oracle.
To show or hide individual DFFs on the SSI user screens:
1. From the SSI administration screen, click either Invoice Header DFF Fields or Invoice Line DFF
Fields.
The DFF Configuration window opens and lists the available DFF fields and their current Show/Hide
settings.
2. Click Update to open the Update SSI DFF Configuration window.
3. Edit the Show/Hide settings for each DFF.
4. Click Update to save the new settings or click Cancel to return to the DFF Configuration window.

Tax Fields
The SSI_TAX_ENTRY_MODE preference controls the type of tax fields that appear on the SSI user
windows. See MarkView Preferences on page 190 for information about maintaining preferences. See
MarkView Self-Service Invoice Preferences for more information about the tax fields.

Managing Follow-Up Documents
Depending on your configuration, an SSI user can submit follow-up documents via Fax, Scan, or Email. If
Enable Fax/Scan or Enable Email is set to Yes, MarkView stores these values:
Fax/Scan Text
Specifies the message name that contains the default instructions for scanning or faxing follow-up
documents. The default message name is COVER_PAGE_FAX_SCAN_TEXT_DEFAULT. See Updating
Fax/Scan and Email Instructions on page 169 for information about changing the message text.
Fax Number
The default fax number for follow-up document submission. The preference that controls this number is
SSI_FAX_NUMBER. See Changing Preference Settings on page 187 for information about changing
the fax number preference setting.
Email Text
Specifies the message name that contains the instructions for sending follow-up documents in an email
message. The default is COVER_PAGE_EMAIL_TEXT_DEFAULT. See Updating Fax/Scan and Email
Instructions on page 169 for information about changing the message text.
Email Address
Specifies the default email address for follow-up document submission. The email address is stored in
the SSI_EMAIL_ADDRESS preference. See Changing Preference Settings on page 187 for information
about changing the email address preference setting.
From the SSI administration windows, click Follow-Up Document Submission to open the SSI
Configuration for Follow-Up Document Submission window and review the current settings.
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MarkView Self-Service Invoice System Requirements for Email Submission
If you plan to enable MarkView Self-Service Invoice (SSI) users to submit follow-up documents in email
messages, Kofax Import Connector (KIC) must be installed with the MarkView system and the SSI user's
client machine must have an email client installed.

Enabling Fax/Scan or Email
1. From the SSI Configuration for Follow-Up Document Submission window, click Update.
The Update SSI Configuration for Follow-Up Document Submission window opens.
You see these fields:
• Enable Fax/Scan – Specifies whether a user can submit follow-up documents via fax or scan. The
default setting is Yes.
• Fax/Scan Text – Specifies the message name that contains the Fax/Scan instructions. The
default is COVER_PAGE_FAX_SCAN_TEXT_DEFAULT.
• Enable Email – Specifies whether a user can submit follow-up documents in email messages.
The default setting is No.
• Email Text – Specifies the message name that contains the Fax/Scan instructions. The default is
COVER_PAGE_EMAIL_TEXT_DEFAULT.
2. Select the correct values from the lists and click Update again to save the settings.
The SSI Configuration for Follow-Up Document Submission window reopens.
See Updating Fax/Scan and Email Instructions on page 169 for information about changing the text of
the instruction messages.

Updating Fax/Scan and Email Instructions
1. From theSSI Configuration for Follow-Up Document Submission window, click Update Scan
and Fax Instructions or Update Email Instructions.
The Messages > List window opens and shows the current Instruction message information.
2. Click Details to edit the message.
3. Select the Message Text Translations tab and click Details.
4. Select the language to use, for example, select American for American English.
5. In the Text Translation text box, enter the Fax/Scan instructions:
1. To add text, enter the message text.
2. To add a fax number, include the attribute {your_fax_number_here}.
3. To add the invoice number to an email message, include the attribute {invoice_number}.
6. Click Save.
The new message appears in the Message Test Translations > List. When you return to theSSI
Configuration for Follow-Up Document Submission window, you see the updated text.
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Maintain Supplier Information
Your company must choose a strategy for maintaining supplier information such as company name and
addresses:
• Your team can allow self-service invoice creators to request the addition or modification of supplier
information. The Accounts Payable department approves and makes the changes or denies the
request.
• Your team can keep self-service invoice creators from requesting the addition or modification of
supplier information. Using this option implies that another organization, such as the Accounts Payable
department, maintains supplier information.
If invoices come from a new supplier or new supplier sites where an established purchase agreement or
supplier setup has not been made, allowing invoice creators to add or modify supplier information can
streamline supplier maintenance.
If SSI invoice creators cannot find a Supplier or Supplier Site, or if Supplier data has changed, they can
submit create or update requests when they create invoices. The MarkView workflow routes the supplier
and invoice information to Supplier Maintenance personnel. The Supplier Maintenance personnel can
update the Supplier data and return the invoice to the invoice creators with instructions for using the new
supplier information and resubmitting the invoice. For companies with frequent supplier maintenance
issues, this workflow processing is typically much faster than out-of-band, manual correspondence or
Supplier Maintenance Request faxes.
For companies with mostly established suppliers, SSI can be configured to not allow Supplier
Maintenance Requests and instead maximize the simplified invoice entry user interface.

170

Chapter 15

Migrating Environments
Migrate your MarkView production environment to a non-production environment to test new functionality,
train new users, or troubleshoot issues which you might encounter in your production environment. Use
a third-party tool to clone the MarkView production database. Then, use the MarkView Migration utility to
generate an SQL script to update the environment-specific MarkView URLs and design-time data on the
non-production environment.
Also, you can use the MarkView Migration utility to move to a new application server without upgrading
MarkView.
To migrate Kofax Analytics for MarkView from a production to non-production environment, additional
setup is required. For more information, see the Kofax Analytics for MarkView Administrator's Guide.
• Migrating Data to Existing Non-Production Environments: If you already have a functioning nonproduction environment, refresh the database with a more recent copy of the production environment.
See Migration Utility: Configuring an Existing Non-Production Environment .
• Migrating Data to New Non-Production Environments: To migrate data to a new non-production
environment, see Refreshing a New Non-Production Environment on page 173. To configure a new
non-production environment, see the Kofax MarkView Installation Guide or Kofax MarkView Upgrade
Guide.

Migration Utility: Configuring an Existing Non-Production
Environment
Follow these steps before you use the Migration Utility:
1. Copy your production database schema to your non-production database.
2. Copy your production document server to your non-production document server.
3. Log in to a working MarkView environment (for example, your production environment) as an
Administrator who is a member of the MODULE ADMINISTRATOR group.
4. Select Administration > Migration Utility.

Using the Migration Utility
1. Complete the values for your site using the following information.
Section

Field Name

Description

Application Server Post
Migration

Application Server

• WebLogic
• JBoss (use for WildFly and JBoss EAP)

171

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Section

Configuration to be
Updated to Reference
Application Server Post
Migration

Field Name

Description

Fully Qualified Hostname

Enter the fully qualified hostname of the
target application server.

HTTP Port

Enter the HTTP port of the target
application server.

Preferences

Select to update the MarkView preference
URLs to use the target application server.

Volume Paths

Select to update the MarkView volume
paths to use the new application server.

Volume Path To Leave Open

If you select Volume Paths, select the
Volume Path To Leave Open from the
list. Values include:
• Close All
• DEVELOPMENT
• PRODUCTION
• TEST

Data Cleanup Tasks

Menu Items

Select to update the MarkView menu item
URLs to use the new application server.

Export Server Queue
Assignments

Select to update the MarkView export
queue assignments to use the new
application server.

Enable SSL (HTTPs) on
Application Server

Select to update the MarkView URLs
to use HTTPs. This option also
generates the SQL to update the
WEBCLNT_HTTP_TYPE to the correct
value (http or https) depending on whether
SSL is enabled.

SSL Wallet Location

If you select Enable SSL (HTTPs) on
Application Server, enter the SSL Wallet
Location. (Required for SSL wallets only.)

SSL Wallet Password

If you select Enable SSL (HTTPs) on
Application Server, enter the SSL Wallet
Password. (Required for SSL wallets only.)

Clear Pending Export Requests

Select to clear the pending export
requests.

Route New Mail to Complete Mail
Queue

Select to route the new mail items to the
Complete Mail queue.

Override Outbound E-mail
Destination

Select to update the MarkView
Outbound Destination email
address override preference,
MVT_TEST_EMAIL_ADDRESS, to use a
new email address.
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Section

E-Mail Import
Configuration

Field Name

Description

E-mail Address

If you select Override Outbound E-mail
Destination, enter the email address
(required). The email address must
meet the RFC2822 standards for valid
syntax. See http://tools.ietf.org/html/
rfc2822#section-3.4.1 for more information
about the RFC2822 standards.

The fields in this section are no longer supported.

2. Select Generate SQL to generate the script and direct where to save the script.
3. Execute the script against the MarkView schema on the target database.

Refreshing a New Non-Production Environment
For information about configuring a new non-production environment, see the Kofax MarkView Installation
Guide or Kofax MarkView Upgrade Guide.
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Configuring Automated Actions
This chapter describes how to configure the system to automate some tasks.
Use the automated workflow actions to manage workflow productivity. The automated actions
automatically increase the priority of an invoice or escalate an invoice work item based on particular
conditions and are configurable for each workflow queue.
Navigate to Kofax MarkView Administration > Automated Actions to enable, disable, and configure
parameters to define rules that enable MarkView to initiate workflow actions (Escalate) or increase the
priority of an invoice (Increase Priority) without any human intervention.
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1. Select or clear the required automated action rule to enable or disable parameters.
If you disable a rule, the inputs associated with that action are disabled. The user cannot enter a
value until they select the Enable check box. For example, if you select the first check box, the field
associated with "days before the invoice due date, increase the priority of any work item" is enabled.
2. Use the provided user interface tables to increase the priority of any work item or escalate any work
item that remains in the designated queue for more than the number of hours specified.
Each table contains all MarkView queues. Enable and disable automated actions for individual
queues by selecting or clearing the check box in the first column of the table. If you mark a queue,
make sure that you set the value in the Hours column for the selected queue. Otherwise, you will
see the error message, after you click OK. Select the Enable column header check box to mark all
queues.
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3. Use the "Automated actions hours to run" section to set the time when the system automatically
escalates invoices or increases the priority for the invoices that meet the configured criteria.
In the "Automated actions hours to run" section, the default values for automated actions are 0800,
1200, and 1600 (8am, 12 noon, and 4pm). Select at least one check box in this section. Otherwise,
you will see the error message, after you click OK.
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User Authentication
To validate the identity of users and prevent unauthorized use of a user name, you can authenticate users
by using any combination of the methods described in this chapter.
Note For the authentication feature to work correctly, verify that a user enables browser cookies.
Kofax MarkView supports the following authentication methods:
• Oracle E-Business Suite Authentication
• MarkView Internal Authentication
• Microsoft Active Directory
• Oracle Internet Directory
• General LDAP Server
• Custom Authentication

Oracle E-Business Suite Authentication
If you select the Oracle E-Business Suite Authentication method, MarkView performs the authentication
against Oracle E-Business Suite instance calling the standard FND_WEB_SEC.VALIDATE_LOGIN
function.
To configure this authentication method, navigate to MarkView Admin > Preferences and set the
WEBCLNT_SEC_AUTH_TYPE preference value to ERP. You can set this preference at the system,
group, or user level.

MarkView Internal Authentication
If you select the MarkView Internal Authentication method, MarkView performs the authentication against
the internal user database without any calls to external systems.
To configure this authentication method, navigate to MarkView Admin > Preferences and set the
WEBCLNT_SEC_AUTH_TYPE preference value to MV. You can set this preference at the system,
group, or user level.
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Microsoft Active Directory
To configure the Microsoft Active Directory authentication method, you must fill in the required
fields in Administration > Authentication Configuration and set the corresponding
WEBCLNT_SEC_AUTH_TYPE preference value.
1. Navigate to Administration > Authentication Configuration and click the Microsoft Active
Directory Configuration tab.
2. Enter values in the following fields:
• MSAD Server URL: Set the URL address of the Domain Controller server, such as:
ldap://dc.example.com:389

• Connection user name: Set the user name used to check the connection to the MSAD server,
such as:
cn=manager,dc=example,dc=com

• Connection password: Set the user password used to check the connection to the MSAD server.
• Domain Root DN: Set the root DN for this connection in the following format:
cn=Users,dc=example,dc=com

The Distinguished Name (DN) attribute refers to a user account and its position in the Active
Directory tree hierarchy.
• Domain name: Set the target domain name, such as:
example.com

3.
4.
5.

6.

• Connection note: Enter a short description for the MSAD connection.
Use the Clear Configuration option to clear the manually entered configuration data and reset the
field parameters to the default values.
Use the Test Connection option to test your system connection using the provided information.
Click Save and Publish to save the configuration to a database schema and to create the
corresponding authentication provider in the MarkView authentication subsystem.
A message indicates that Microsoft Active Directory was successfully configured.
Navigate to MarkView Admin > Preferences and set the WEBCLNT_SEC_AUTH_TYPE
preference value to MSAD.
You can set this preference at the system, group, or user level.

Oracle Internet Directory
To configure the Oracle Internet Directory authentication method, you must fill in the required
fields in Administration > Authentication Configuration and set the corresponding
WEBCLNT_SEC_AUTH_TYPE preference value.
1. Navigate to Administration > Authentication Configuration and click the Oracle Internet
Directory Configuration tab.
2. Enter values in the following fields:
• OID Server URL: Set the OID server or servers connection string value, such as:
ldap://ldapserver.example.com:389/dc=example,dc=com
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Use a semicolon (:) as a path delimiter.
• Connection user name: Set the user name used to connect to the OID server, such as:
cn=manager,cn=users,dc=example,dc=com

• Connection password: Set the user password used to connect to the OID server.
• User DN(s): Set a pattern used to build the user DN, such as:
cn={0};uid={0}

Make sure that you enter the key {0} that is substituted with the username. Use a semicolon (;) as
a path delimiter.
• User Search Base DN: Set the user search base DN, such as:
cn=Users

The user search base DN is used to locate a user if a simple bind authentication failed. For
example, if you enter a wrong user DN.
• User Search Filter: Set the OID search filter, such as:
(&(objectClass=user)(userPrincipalName={0}@example.com))

3.
4.
5.

6.

The OID search filter is used to locate a user if a simple bind authentication failed.
• Connection note: Enter a short description for the OID connection.
Use the Clear Configuration option to clear the manually entered configuration data and reset the
field parameters to the default values.
Use the Test Connection option to test your system connection using the provided information.
Click Save and Publish to save the configuration to a database schema and to create the
corresponding authentication provider in the MarkView authentication subsystem.
A message indicates that Microsoft Active Directory was successfully configured.
Navigate to MarkView Admin > Preferences and set the WEBCLNT_SEC_AUTH_TYPE
preference value to OID.
You can set this preference at the system, group, or user level.

General LDAP Server
To configure the General LDAP Server authentication method, you must fill in the required
fields in Administration > Authentication Configuration and set the corresponding
WEBCLNT_SEC_AUTH_TYPE preference value.
1. Navigate to Administration > Authentication Configuration and click the General LDAP
Configuration tab.
2. Enter values in the following fields:
• LDAP Server URL: Set the LDAP server or servers connection string value, such as:
ldap://ldapserver.example.com:389/dc=example,dc=com

Use a semicolon (:) as a path delimiter.
• Connection user name: Set the user name to connect used to the LDAP server, such as:
cn=manager,cn=users,dc=example,dc=com

• Connection password: Set the user password used to connect to the LDAP server.
• User DN(s): Set a pattern used to build the user DN, such as:
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cn={0};uid={0}

Make sure that you enter the key {0} that is substituted with the username. Use a semicolon (;) as
a path delimiter.
• User Search Base DN: Set the user search base DN, such as:
cn=Users

The user search base DN is used to locate a user if a simple bind authentication failed. For
example, if you enter a wrong user DN.
• User Search Filter: Set the LDAP search filter, such as:
(&(objectClass=user)(userPrincipalName={0}@example.com))

3.
4.
5.

6.

The LDAP search filter is used to locate a user if a simple bind authentication failed.
• Connection note: Enter a short description for the LDAP connection.
Use the Clear Configuration option to clear the manually entered configuration data and reset the
field parameters to the default values.
Use the Test Connection option to test your system connection using the provided information.
Click Save and Publish to save the configuration to a database schema and to create the
corresponding authentication provider in the MarkView authentication subsystem.
A message indicates that Microsoft Active Directory was successfully configured.
Navigate to MarkView Admin > Preferences and set the WEBCLNT_SEC_AUTH_TYPE
preference value to LDAP.
You can set this preference at the system, group, or user level.

Custom Authentication
If you select the Custom Authentication method, MarkView performs the authentication calling a custom
PL/SQL function MVW_Authenticate_Custom.Authenticate from the MarkView database schema.
To configure this authentication method, navigate to MarkView Admin > Preferences and set the
WEBCLNT_SEC_AUTH_TYPE preference value to CUSTOM. You can set this preference at the system,
group, or user level.
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Invoice Audit
The Invoice Audit utility processes user-supplied .csv files representing a list of invoices, and batch-prints
all associated MarkView documents. The .csv files must be in a specific format. The batch print requests
are stored in a special batch print queue so they do not interfere with normal print operations. You can
send the printed documents to the appropriate tax authorities or to an independent accountant for review.
If the .csv file refers to an invoice with no attached MarkView document, no document is printed. However,
the utility generates a summary message of how many invoices it successfully processed, as well as a
detailed list of any invoices it was unable to process. If an invoice has multiple MarkView attachments, the
utility prints them all.
If the .csv file includes deleted invoices, Invoice Audit still batch-prints all MarkView documents associated
with the deleted invoices.

Configuring the Invoice Audit Utility
1. Assign users to the INVOICE AUDIT user group. This enables users to access the Invoice Audit
utility and all MarkView document types. See Managing MarkView User Groups on page 136.
The next time the users log in to MarkView, they see the Invoice Audit utility under Utilities.
2. Check the default settings for the new Invoice Audit preferences. See MarkView Invoice Audit
Preferences on page 240.
3. Configure the Queue Assignment for the Print Queue DEFAULT_BATCH_QUEUE. See Batch
Printing on page 161.

Invoice Audit .csv File Format
The .csv file must contain the following header row and all data rows must match the order of the header
row. Capitalization and underscores must all match the data lines. The utility only supports spaces
contained in data within double quotes.
INVOICE_NUMBER,ORGANIZATION_ID,VENDOR_NAME

For example:
INVOICE_NUMBER,ORGANIZATION_ID,VENDOR_NAME
"CPS-001","204","Advantage Corp"
"CPS-101","458","G.E. Capital"
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Invoice Audit Security Considerations
The INVOICE AUDIT user group automatically grants members the Access Ignore Security privilege for
ALL MarkView Document Types in the system.

Invoice Audit Performance Implications
As a batch processing utility, Invoice Audit can consume considerable system resources while locating
and printing invoices. Be aware of this behavior when processing large batches.

Using Invoice Audit
Supply a .csv file through an interface, have the file return a report on what invoices in the .csv can be
printed, and batch print those invoices.

Sample Invoice Audit Report

1. The date and time when the report ran.
2. The number of invoices successfully processed and the total number of invoice rows in the .csv file.
3. The .csv row for any invoice that was not successfully processed. In this example, row 3 contained
invalid invoice information.
4. The name of the .csv file, OracleInvoiceList.csv.
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Using MarkView Preferences
Preferences let you configure MarkView suite components at the system level, group level, or user level.
You cannot add preferences through MarkView or the Process Monitor using the MarkView
Administration. You can only configure Preferences using seed data scripts that come with the MarkView
suite or through MarkView API commands.
When you set up the system, the questions that you answer change the settings for most of the
preferences that you need. Other types of preferences that you might change include:
• MAIL preferences for email options
• URL preferences to accommodate export configuration changes
• Fax number preferences

Preference Attributes
Preferences configure MarkView characteristics and behavior. Each preference uses attributes that
determine how the preference interacts with MarkView.
The attributes displayed in the Details page of MarkView or the MarkView Process Administration are set
by the MarkView Installation application.
For the best results, leave shipped preferences in their existing configurations.
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The following image shows a typical preference and attributes.
MarkView Window for Setting Preference Attributes

ID
The preference ID is an integer used by MarkView to identify the preference. The MarkView installer
generates this number, which is visible only in the Administration interface.
Preference Name
The name of the preference, such as VIEWER_FLASH_VERSION.
Description
A brief description of the preference and its purpose in MarkView. This field can contain up to 200
characters. For example, the VIEWER_FLASH_VERSION description states that the attribute determines
the minimum Flash version needed to open the viewer.
System Level YN
This attribute specifies whether the preference is available at the system level. System level preferences
affect all users across the system. Use this attribute to set broad system defaults. If you set this attribute
Y, you, as the administrator, can set system-level values. If you set this attribute to N, you cannot set
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system-level values. In the event of a conflict, group/role and user level preferences override system level
preferences.
Group or Role Level YN
This attribute specifies whether or not the preference is available at the MarkView group or role level.
Group level preferences affect users in a specific group; role level preferences affect users assigned to a
specific role. For example, an AP user group might have preference settings that differ from a Purchasing
user group. If you set this attribute to Y, then you, as the administrator, can set different values for
different groups or roles. If you set this attribute to N, then you cannot set different preference values
for different groups or roles. In cases where a user belongs to multiple groups or is assigned to multiple
roles with conflicting preference settings, MarkView resolves the conflict using the Group|Role Resolution
Method attribute.
User Level YN
This attribute specifies whether or not the preference is available at the user level. If you set this attribute
to Y, then you, as the administrator, can set different values for different users. If you set this attribute to
N, then you cannot set different preference values for different users. User level preferences are the most
granular level of preference. They affect only a specific user, and they override all group or role level and
system level preference settings.
Changeable YN
This attribute specifies whether or not the administrator can edit the preference value. The MarkView
installer permanently sets some preference values at installation. If you set this attribute to Y, you can
later change the value for this preference at all available levels. If you set this attribute to N, the installer
sets a permanent value for this preference.
For example, SCAN_FILENAME_EXT sets the default file extension for MarkView document image files
to TIF; this cannot be changed.
Use Default Value YN
Specifies whether or not to use the default preference value if no value is specified for the preference. If
you set this attribute to Y, the preference uses the default value specified in the Default Value attribute. If
you set this attribute to Y and leave the default value blank, the default value is NULL.
Default Value
If set to Y, the default value derives from this attribute. Default values that the MarkView installer sets
are generally either typical values or examples of the correct form for the preference value. Kofax
recommends that you leave the default value as an example of the correct form or typical setting for this
preference, and apply system wide values using the System Level Value attribute.
System Level Value
Specifies the default system-level value for the preference. If no preference value is set on the System,
Group, or User level subtabs, this value is used.
Group or Role Level Priority YN
Value priorities are numeric values attached to each potential preference value. This attribute specifies
whether to use the value priorities to resolve group or role level conflicts when you specify a Group|
Role Resolution Method attribute of 1 (Value). The MarkView installer specifies value priorities within the
database; they are not visible in the Administration interface.

185

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Group or Role Resolution Method
Specifies how to resolve conflicts between group or role level values. When a user belongs to multiple
groups or is assigned to multiple roles with different values for the same preference, MarkView resolves
the conflict using the method represented by one of the following values:
• 1 (Value): Resolve conflicts by comparing the priority values assigned to the preference
values. Use the preference value having the greatest priority value. When the domain is
GENERIC_BOOLEAN_TRUE_DOMINATES, use TRUE, as the higher priority value of the two possible
preference values TRUE and FALSE, to resolve conflicts.
• 2 (Least): MarkView orders the preference values from low to high based on the ASCII
order of the preference value and chooses the lowest value. When the domain is
GENERIC_BOOLEAN_TRUE_DOMINATES, use FALSE, as the lower priority value of the two possible
preference values TRUE and FALSE, to resolve conflicts.
• 3 (Greatest): MarkView orders the preference values from low to high based on the
ASCII order of the preference value and chooses the highest value. When the domain is
GENERIC_BOOLEAN_TRUE_DOMINATES, use TRUE, as the higher priority value of the two possible
preference values TRUE and FALSE, to resolve conflicts.
• 4 (Random): Of the possible values, MarkView selects one at random. MarkView uses this
method of conflict resolution to load balance URL values. When the preference domain is
GENERIC_BOOLEAN_TRUE_DOMINATES, random selection between TRUE and FALSE over the
course of ten iterations results roughly in five conflicts resolved with TRUE, and five resolved with
FALSE.
Preference Domain Name
This attribute specifies the range of acceptable values for the preference. For example, the preference
domain ADMIN_ACCESS_SELECT_ALL_NONE allows only three possible values: SELECT, ALL, and
NONE. The preference domain LEGACY_FREE_TEXT allows a user-specified text string.
Although preference domain names are generally descriptive, the actual values specified within the
domain are defined within the database. To view a preference domain’s allowable values, you must query
your database.
Data Type
This attribute specifies the type of data used to represent the preference value. For example, a preference
that specifies a URL would have a Data Type of character. Possible values are:
• 1 (Character): Preference requires alphanumeric values.
• 2 (Number): Preference requires numeric values.
• 3 (Date): Preference requires date values.
Allow Null Value YN
This attribute specifies whether or not the preference can have a null value.
Range Low Value
For preferences that allow free text, this attribute specifies the low end of a range of valid ASCII
characters. For example, for a preference that requires a number from 1 to 7, the low end would be 1. You
can use ranges to constrain the entry to valid preference values.
Range High Value
For preferences that allow free text, this attribute specifies the high end of a range of valid ASCII
characters. For example, for a preference that requires a number from 1 to 7, the high end would be 7.
You can use ranges to constrain the entry to valid preference values.
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Maximum Text Length
For preferences that take an alphanumeric value, this attribute specifies the maximum number of
characters allowed in the preference value. This attribute is applicable to all Data Types. In the case of
VIEWER_DEBUG_MODE, this attribute is limited to four, the number of characters needed to spell out
PIPE, the longest possible value.
Domain Values YN
This attribute specifies whether or not the preference is limited to a predefined list of values specified
within the preference domain. A preference domain specifies the range of acceptable values for the
preference. For example, a URL might allow unrestricted text values, whereas a list of actions would be
limited to those that ship with MarkView

Changing Preference Settings
1. Log in to MarkView home with administrative privileges.
2. Select Administration > MarkView Admin and select the Preferences tab.
3. Search for the preference to change and click Details in the preference row.
The Details page opens showing tabs for the level of preference implementation. Not all preferences
provide tabs or settings for all levels.
• System Preferences—affect users system-wide. System preferences override default values.
• Group Preferences—affect all users in a MarkView User Group. Group preferences override
system preferences.
For example, if a system preference establishes a threshold of 24 hours, a group preference can
override the setting and establish a threshold of 12 hours.
• Organization Preferences—affect all users in an organization. Organization preferences override
Group and System preferences.
• User Preferences—affect the user. User preferences override system, group, and organization
preferences.
4. Select the tab for the level of implementation to use and continue as follows:
• To change a preference, click Details, make the changes, and click Save.
• To add a setting, click Add, complete the required fields, and click Save.
Preferences used by the Application Server may require that you restart the related server for the settings
to take effect. For example, Capture and Output preference changes require that you restart the server to
take effect.
Preferences used by MarkView home and the database do not require a restart.
If you are unsure about a preference, change the preference in a non-production environment to see if the
change takes effect without restarting the service.

Changing Settings through Organization Setup
The responses that you provide on the Organization Setup Preferences pages may differ from the values
shown from the administration preferences tab. For example, the answer to the following question is
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"yes" or "no." However, the preference value is "TRUE" or "FALSE." If you change the answer to "no," the
preference value changes to "FALSE."
• Organization Setup question: 2-Way Matching, PO Invoice: should MarkView enforce additional 2-way
match receipting? (Yes, No)
• Preference: MVAP_PO_REQUIRE_RECEIPT_ON_2_WAY_MATCH (TRUE, FALSE)
For information about changing settings through Organization Setup, see Setting Workflow Preferences.

Administration Preferences
The ADMIN% preferences configure the MarkView Administration and Administration. The
ADMIN_ACCESS% preferences are the subset of ADMIN% preferences that control access to sections
of the administration applications. The ADMIN_IMG% and ADMIN_WEB% preferences configure the user
interface for the MarkView Administration and MarkView Process Administration Web Edition.
Top-level preferences control access to the corresponding top-level tab (the web page for administering
that entity). Detail level preferences control access to the corresponding subtab (the web page for
administering that entity). To use a subtab, a user must have SELECT or ALL access to the subtab as
well as to its parent top level tab. When a user has only SELECT access to a tab or subtab, the user does
not have access to the following buttons: Add, Save, and Delete. When a user with SELECT access drills
down to the single document view, no fields can be updated.
As shipped, all ADMIN_ACCESS% preferences have a default of NONE, which means no access.
Preferences for the MarkView Web Administrator group, however, are set to ALL or SELECT, on
individual ADMIN_ACCESS% preferences. These settings take precedence over the preference definition
default value.Kofax recommends that you use group preferences to control administrative access to toplevel preferences.

Logging Level Preferences
Using MarkView preference settings, you can change the logging levels for a number of MarkView
components without having to stop and restart the system or a service. After changing and saving the
logging level, the new level goes into effect after a few minutes.
Logging level preferences that you can change interactively include the following:
• ABOUT_SERVICE_LOGGING_LEVEL
• ANALYTICS_ACTIONABLE_LOGGING_LEVEL
• ANALYTICS_CORE_LOGGING_LEVEL
• ANALYTICS_MARKVIEW_LOGGING_LEVEL
• CMSYNC_LOGGING_LEVEL
• CORDA_LOGGING_LEVEL
• DOCSERVER_LOGGING_LEVEL
• ERP_ORACLE_LOGGING_LEVEL
• HELP_LOGGING_LEVEL
• MIGRATION_LOGGING_LEVEL
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• MOBILE_LOGGING_LEVEL
•
•
•
•
•
•
•

MVAS_BCG_LOGGING_LEVEL
MVAS_DTM_LOGGING_LEVEL
MVERP_SERVICE_LOGGING_LEVEL
PLSQLSERVLET_LOGGING_LEVEL
PROCESS_MONITOR_LOGGING_LEVEL
SSI_LOGGING_LEVEL
USERMGMT_LOGGING_LEVEL

• VIEWER_LOGGING_LEVEL
For more information about each logging level preference, see MarkView Preferences.
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MarkView Preferences
This chapter lists the preferences available to MarkView suite components and solutions. Preferences are
listed alphabetically by the affected component. If a component is not installed, you not have access to the
component preferences.
Note Do not change the settings for MarkView preferences not described in this chapter without the
guidance of a Kofax employee. Doing so can negatively impact system performance and functionality.

MarkView for Accounts Payable Preferences
DOCSERVER_LOGGING_LEVEL
Specifies the level of logging to use for tracking activity on the MarkView Document server. Specifies what
appears in the docserver.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
KTM_INVOICE_RECEIVED_DATE
For systems that use Kofax Transformation Modules, configures the setting that MarkView uses as the
date when the invoice was received. An empty value is not accepted.
The capture date for invoices processed through Kofax Transformation Modules is the moment when the
batch is created.
If an invoice arrives by email and is processed by Kofax Import Connector, you can set the capture
date to the date when the email was received. To do so, map the import connector property,
KFS:KfxMessageTimePosted, to the Date Received field for the MarkView invoice.
Values:
• Equal to the current date: Uses the current date as the default invoice received date. If the KTM server
and MarkView are in different time zones, the current date is based on the KTM server time zone.
• Equal to the capture date (default): Uses the date when the invoice was captured as the date received.
• Equal to the invoice date: Uses the invoice date as the default date received.
MVAP_ALLOW_COMMENT_ROUTING
When set to TRUE, enables users to route work items for comments using the Request Comment action.
This applies only to invoices in the AP Non-PO Invoice workflow.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
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MVAP_ALLOW_RETURN_ATTACHED
Specifies whether invoices that are already attached can be routed through Returned Invoices processing.
Returning attached invoices is possible only for invoices that are still in the Invoice Entry queue. You can
set this preference at the system, organization, group, and user levels.
Values: TRUE (default), FALSE
MVAP_ALLOW_ROUTE_TO_PURCHASING
Specifies whether an AP employee can route invoices to the Purchasing group.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
MVAP_ALLOW_SFA_REQUEST
Specifies whether an AP employee can request an additional audit step.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
MVAP_ALLOW_SPLIT_DURING_DATA_ENTRY
When this preference is set to TRUE, enables users to use the New Document action and the Manual
Review Complete action on pages of a multipage document in the following queues:
• Non-PO Invoice Entry
• PO Invoice Entry
• Pre-Approved Invoice Entry
• Supplier Setup Entry
• Attachment Review
• Previously Entered Invoices
These actions let you to break a single document into smaller documents.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
MVAP_ALLOW_UNATTACHED_COMMENT
Specifies whether invoice entry users can take the Request Comment action on a work item while it is in
the entry queue before a document image is attached to the invoice. When set to TRUE, this preference
makes the Request Comment action available.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
MVAP_AUTO_RETRIEVE_FOR_OWNER
Specifies whether MarkView for Accounts Payable returns work items to the previous owner’s working
folder when an item re-enters the workflow. For example, if a work item is rejected, this preference returns
the item to the working folder of the last user who worked with that item. When set to false, this preference
sends items re-entering the workflow to the working folder of the next available user.
You can set this preference at the system or organization level.
Values: TRUE, FALSE (default)
MVAP_CHECK_DISTRIB_PREAPP_INV_ENTRY
Determines what conditions a pre-approved invoice must meet before it can accept the Complete Entry
action.
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You can set this preference at the system or organization level.
Values:
• NONE: Enables an invoice entry user to take the Complete Entry action at any time after the invoice
arrives in the user’s MarkView Web Inbox.
• FULLYDISTRIBUTED (default): Enables an invoice entry user to take the Complete Entry action if the
invoice is fully distributed. To be fully distributed, the total of any distributions on the invoice must equal
the total of the invoice.
MVAP_DEFAULT_QA_REVIEW_BY
Specifies whether a group or a user performs the review if the workflow is configured to submit invoices
for QA review. By default, QA review is disabled.
You can set this preference at the system or organization level.
Values:
• GROUP (default): Specifies that a group will perform the review. The group must be authorized to
retrieve items from the QA required queue. These groups are QA, QA NON-PO, QA PO, and QA PREAPPROVED.
• USER: Use the MVAP_DEFAULT_QA_REVIEW_USER preference to identify the particular user.
MVAP_DEFAULT_QA_REVIEW_PERCENT
Specifies a percentage of invoices that are randomly submitted if your workflows are configured to submit
invoices for QA review. Set this preference at the system, organization, group, and user level. By default,
QA review is disabled.
Consider the following if setting this preference at the user level. If someone other than the designated
user alerts the AP Determine QA rule, the work item that transitions to the QA Required queue is linked to
the user who sent the alert and not to the user set by the preference. The user preference only links the
work item to the specified user if that user caused the work item to transition to the QA Required queue.
Values: A number from 0 to 100, no default
MVAP_DEFAULT_QA_REVIEW_USER
Identifies the user to perform the review if your workflows are configured to submit invoices for QA review
and the MVAP_DEFAULT_QA_REVIEW_BY preference is set to USER. Set this preference at the
system, organization, group, and user level. By default, QA review is disabled.
Values: MarkView User ID, no default
MVAP_DEFAULT_REVIEW_BY
Specifies if a group or a user should perform the review if your workflows are configured to submit
invoices for additional review. By default, additional review is disabled.
You can set this preference at the system or organization level.
Values:
• GROUP (default): Specifies those groups authorized to retrieve from the respective queues to which
the invoices are submitted for additional review. As shipped, these groups are REVIEW, REVIEW
NON-PO, REVIEW PO, and REVIEW PRE-APPROVED
• USER: Use the MVAP_DEFAULT_REVIEW_USER preference to identify the user.
MVAP_DEFAULT_REVIEW_THRESHOLD
Triggers an additional review when an invoice amount exceeds a set threshold (in the prevailing
currency), and your workflows are configured to submit invoices for additional review. By default,
additional review is disabled.
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You can set this preference at the system or organization level.
Values: 999999 (default)
MVAP_DEFAULT_REVIEW_USER
Identifies the user who is to perform the review if your workflows are configured to submit invoices
for additional review and the MVAP_DEFAULT_REVIEW_BY preference is set to USER. By default,
additional review is disabled.
You can set this preference at the system or organization level.
Values: MarkView User ID, no default
MVAP_EMAIL_OPTION
Specifies how often AP users receive email notifications of work items entering their working folders
Values:
• PER_DAY (default): Users receive an automated email once per day, notifying them of new work items.
• PER_ITEM: Users receive an automated email as each new work item enters their working folders,
notifying them of new work items.
MVAP_ENABLE_CONNECTOR_FREIGHT
Specifies whether MarkView Connector passes freight data from KTM to the ERP.
You can set this preference at the system or organization level.
Values: FALSE, TRUE (default)
MVAP_ENABLE_CONNECTOR_TAX
Specifies whether MarkView Connector passes tax data from KTM to the ERP.
You can set this preference at the system or organization level.
Values: FALSE, TRUE (default)
MVAP_ENFORCE_NEGATIVE_AMOUNT_ROUTING
Works in conjunction with MVAP_HIERARCHY_INVOICE_AMOUNT to specify whether to convert a
negative amount to a positive amount.
If the amount determined by MVAP_HIERARCHY_INVOICE_AMOUNT is negative, the
MVAP_ENFORCE_NEGATIVE_AMOUNT_ROUTING preference determines whether or not to convert
the value. MarkView then compares the value against employee’s spend limit to determine if the
employee has appropriate approval authority for the invoice.
You can set this preference at the system or organization level.
Values: TREAT AS POSITIVE (default), IGNORE
MVAP_FREIGHT_DEFAULT_ACCOUNT
Specifies the ERP account to which MarkView assigns newly entered freight line items.
You can set this preference at the system or organization level.
Values: A valid ERP accounting code, no default
MVAP_FREIGHT_REVIEW_AMOUNT_THRESHOLD
Triggers a review when the freight amount on an invoice exceeds the set threshold (in the prevailing
currency), and your workflows are configured to submit invoices for freight review. By default, freight
review is disabled.
You can set this preference at the system or organization level.
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Values: A number > 0, no default
MVAP_FREIGHT_REVIEW_BY
Specifies whether a group or a user performs the review if the workflow is configured to submit invoices
for Freight review. By default, review is disabled.
You can set this preference at the system or organization level.
Values:
• GROUP (default): Specifies that a group will perform the review. The group must be authorized to
retrieve items from the Freight required queue.
• USER: Specifies the user authorized to perform the review. To specify the user, use the
MVAP_DEFAULT_FREIGHT_USER_ID preference.
MVAP_FREIGHT_REVIEW_PCT_THRESHOLD
Triggers a review when the freight percentage on an invoice exceeds the set threshold (in the prevailing
currency), and your workflows are configured to submit invoices for freight review.
• MarkView calculates the amount in the base/local currency.
• When possible, MarkView considers debit and credit indicators (debit adds amounts; credit subtracts
amounts).
• For posted PO and non-PO Invoices, MarkView does not calculate freight.
The percentage is calculated as follows:
Freight Amount/(Invoice Amount – Freight)=%
$16/($100 – $16) =19%
You can set this preference at the system or organization level.
Values: A number from 0 to 100, no default
MVAP_FREIGHT_REVIEW_SAMPLING_PERCENTAGE
Specifies the percentage of invoices to send for random freight review.
You can set this preference at the system or organization level.
Values: A number from 0 to 100, no default
MVAP_FREIGHT_REVIEW_USER_ID
Identifies the user assigned to perform the freight reviews. By default, freight review is disabled. If this
preference has no value set, MarkView routes invoices to a user group that can perform the review.
You can set this preference at the system or organization level.
Values: MarkView User ID, no default
MVAP_HIERARCHY_CONTROL
Specifies which positional controls are available to the user based on the context:
• Finding the next approver:
• If MVERP_HIERARCHY_TYPE is set to ES_BSNS_GRP or ES_ORG, configure this preference
to use the appropriate PO control function defined in the Oracle E-Business Suite environment, for
example, Approve Purchase Requisitions.
• If MVERP_HIERARCHY_TYPE is set to ES_SIMPLE, this preference is ignored.
• Approval limit: MarkView uses the value set for MVAP_HIERARCHY_CONTROL to find the approval
limit for the specific user.
You can set this preference at the system or organization level.
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Values: Approve Purchase Requisitions (default), a string of up to 200 characters from the app table
MVAP_HIERARCHY_INVOICE_AMOUNT
Determines what value is used to represent the invoice amount as referenced in the hierarchy.
You can set this preference at the system or organization level.
Values:
• STANDARD (default): The maximum value between the invoice amount and the sum of invoice
distributions is used.
• INVAMOUNT: The invoice amount is used.
• NETAMOUNT: The net invoice amount is used. The net amount is calculated using the following
formula: Invoice Amount * (1—[ Tax Amount / Invoice Amount ] )
• SUMDIST: The sum of invoice distributions is used.
• MAXDIST: The maximum amount of a single distribution line is used.
MVAP_HIERARCHY_RULE_LIMIT
Specifies how a user’s spend limit is derived. This limit is compared to the invoice amount specified by the
configuration of the preference MVAP_HIERARCHY_INVOICE_AMOUNT.
You can set this preference at the system or organization level.
Values:
• DOCUMENTTOTAL (default): The DOCUMENT_TOTAL signing limits are used.
• FIRSTDIST: The code combination of the first distribution line determines the spend limit the user has
on a specific ACCOUNT_RANGE.
• MAXDIST: The code combination of the distribution line with the greatest monetary amount determines
the spend limit the user has on a specific ACCOUNT_RANGE.
• CUSTDIST: Not implemented for non-PO invoices
• WEB: Not implemented for non-PO invoices.
MVAP_INCLUDE_COVER_PAGE_ON_RETURN
Specifies whether or not MarkView for Accounts Payable automatically generates a fax cover page for
invoices that are marked Return to Supplier.
Values: TRUE (default), FALSE
MVAP_ITEM_DEFAULT_ACCOUNT
Specifies the ERP account to which MarkView assigns Non-PO Invoice line items.
You can set this preference at the system or organization level.
Values: A valid ERP accounting code, no default
MVAP_NON_PO_APPROVE_QUEUE
Determines which queue Non-PO invoices enter once they are approved.
You can set this preference at the system or organization level.
Values:
• Determine Tax Review Requirement (default): Approved invoices transition to the Determine Tax
Review Requirement queue.
• Determine Freight Review Requirement: Approved invoices transition to the Determine Freight Review
Requirement queue.
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• Determine Review Requirement: Approved invoices transition to the Determine Review Requirement
queue.
• Determine QA Requirement: Approved invoices transition to the Determine QA Requirement queue.
• Return Control to ERP: Approved invoices transition to the Return Control to ERP queue.
• Verify AP Process Complete: Approved invoices transition to the verify AP Process Complete queue.
MVAP_NON_PO_APPROVE_REQUIREMENT
Determines the conditions a Non-PO invoice must meet before it can accept the Approve action.
You can set this preference at the system or organization level.
Values:
• NONE: Lets an approver take the Approve action any time after the invoice is in the approver’s
MarkView Web Inbox.
• DFMPLACED: Although this option appears in the list, it is no longer a valid value.
• FULLYDISTRIBUTED (default): Lets an approver take the Approve action if the invoice is fully
distributed. To be fully distributed, the total of distributions on the invoice must equal the invoice total.
MVAP_NON_PO_ENTRY_COMPLETE_QUEUE
Determines where Non-PO invoices enter the workflow once they receive the Complete Entry action.
You can set this preference at the system or organization level.
Values:
• Approval and Coding (default): Work items transition to the Approval and Coding queue. In this
configuration, invoice approval and invoice distribution can occur independently of one another.
• Approval: Work items transition to the Approval queue. This scenario assumes that the entry usercoded invoice distributions prior to routing the invoice for approval.
• Coding: Work items transition to the Coding queue. Users must code invoice distributions before the
work item can advance in the workflow.
• Verify AP Process Complete: Work items transition to the Verify AP Process Complete queue.
MVAP_NON_PO_FRT_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes Non-PO invoices once they finish Freight review.
You can set this preference at the system or organization level.
Values:
• Determine Review Requirement (default): MarkView determines if the invoice requires Additional review
and routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_NON_PO_QA_COMPLETE_QUEUE
Specifies the queue for non-PO workflow items that completed an additional QA process.
You can set this preference at the system or organization level.
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Values:
• Return Control to ERP (default): Work items transition to the Return Control to ERP queue.
• Verify AP Process Complete: Work items transition to the Verify AP Process Complete queue.
MVAP_NON_PO_REVIEW_COMPLETE_QUEUE
Specifies the queue to which reviewed Non-PO work items transition.
You can set this preference at the system or organization level.
Values:
• Determine QA Requirement (default): Invoices that complete the additional review process transition
to the Determine QA Requirement queue. In the Determine QA requirement queue, work items are
subject to additional QA review.
• Return Control to ERP: Invoices that complete the additional review process transition to the Return
Control to ERP queue.
• Verify AP Process Complete: Invoices that complete the additional review process transition to the
Verify AP Process Complete queue.
MVAP_NON_PO_TAX_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes Non-PO invoices once they finish Tax review.
You can set this preference at the system or organization level.
Values:
• Determine Freight Review Requirement (default): MarkView determines if the invoice requires Freight
review and routes the invoice accordingly.
• Determine Review Requirement: MarkView determines if the invoice requires Additional review and
routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_NON_PO_TRANSITION_ON_ATTACH
When TRUE, transitions Non-PO work items immediately after the document is attached to the ERP
record.
Changing this setting without complete and thorough testing could cause all items to route to the workflow
administration queue or to get stuck in a single workflow processing queue. Contact Kofax Technical
Support for help in updating this preference.
Values: TRUE, FALSE (default)
MVAP_PO_ENTRY_COMPLETE_QUEUE
Determines where PO invoices enter the workflow once they receive the Complete Entry action.
You can set this preference at the system or organization level.
Values:
• Determine Tax Review Requirement (default): Invoices transition to the Determine Tax Review
Requirement queue.
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• Determine Freight Review Requirement: Invoices transition to the Determine Freight Review
Requirement queue.
• Determine Review Requirement: Invoices transition to the Determine Review Requirement queue.
• Determine QA Requirement: Invoices transition to the Determine QA Requirement queue.
• Return Control to ERP: Invoices transition to the Return Control to ERP queue.
• Verify AP Process Complete: Invoices transition to the Verify AP Process Complete queue.
MVAP_PO_FRT_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes PO invoices once they finish Freight Review.
You can set this preference at the system or organization level.
Values:
• Determine Review Requirement (default): MarkView determines if the invoice requires Additional review
and routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_PO_QA_COMPLETE_QUEUE
Specifies the queue for PO workflow items that have completed an additional QA process.
You can set this preference at the system or organization level.
Values:
• Return Control to ERP (default): MarkView transitions invoices to the Return Control to ERP queue.
• Verify AP Process Complete: MarkView transitions invoices to the Verify AP Process Complete queue.
MVAP_PO_REQUIRE_RECEIPT_ON_2_WAY_MATCH
Determines whether the Receipting process is activated. By default, items go through the Receipting
process. If the invoice is matched to a PO that has at least one item that is not expecting a receipt, such
as a service, the work item is routed to an approver in the Verification Process for PO Invoices queue.
By disabling the system receipt, PO invoices with a 2-way match do not require approval.
Values: TRUE (default), FALSE
MVAP_PO_REVIEW_COMPLETE_QUEUE
Specifies the queue to which reviewed PO work items transition.
Values:
• Determine QA Requirement (default): Invoices that complete the additional review process transition
to the Determine QA Requirement queue. In the Determine QA requirement queue, work items are
subject to additional QA review.
• Return Control to ERP: Invoices that complete the additional review process transition to the Return
Control to ERP queue.
• Verify AP Process Complete: Invoices that complete the additional review process transition to the
Verify AP Process Complete queue.
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MVAP_POSITIONAL_NAME
Specifies which positional hierarchy to use when a Positional Oracle Purchasing hierarchy is in effect for
non-PO approval.
You can set this preference at the system or organization level.
Values: Stores free text values, no default
Use the following query in Oracle Applications to determine supported values:
SQL> select name from per_position_structures;

MVAP_PO_REQUIRE_RECEIPT_ON_2_WAY_MATCH
Specifies whether a receipt is required when an invoice matches a purchase order. The receipt can serve
as documentation that the item or service purchased was delivered.
You can set this preference at the system or organization level.
Values: TRUE (default), FALSE
MVAP_PO_TAX_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes PO invoices once they finish Tax review.
You can set this preference at the system or organization level.
Values:
• Determine Freight Review Requirement (default): MarkView determines if the invoice requires a Freight
review and routes the invoice accordingly.
• Determine Review Requirement: MarkView determines if the invoice requires Additional review and
routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_PO_TAX_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes PO invoices once they finish Tax review.
You can set this preference at the system or organization level.
Values:
• Determine Freight Review Requirement (default): MarkView determines if the invoice requires a Freight
review and routes the invoice accordingly.
• Determine Review Requirement: MarkView determines if the invoice requires Additional review and
routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
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MVAP_PO_TRANSITION_ON_ATTACH
When TRUE, transitions PO work items immediately after the document is attached to the ERP record.
Changing this setting without complete and thorough testing could cause all items to route to the workflow
administration queue or to get stuck in a single workflow processing queue. Contact Technical Support for
assistance in updating this preference.
Values: TRUE, FALSE (default)
MVAP_PO_VERIFICATION_USER_DETERMINED_BY
By default, hold reasons on an invoice are processed in the order identified in PO Hold Definition
Business Module Administration.
If the same holdblocking reason is identified on two different lines on the same invoice, this preference
determines which line to process first.
Setting the value to MAX_DIST_LINE_AMT changes the hold resolution order to resolve the lines that are
held because of quantity issues first. Lines with quantity issues are resolved in sequence.
You can set this preference at the system or organization level.
Values:
• MAX_DIST_LINE_AMT (default)
• MIN_DIST_LINE_NUMBER
MVAP_PREAPP_DEFAULT_ACCOUNT
Specifies to which GL Account MarkView assigns captured Pre-Approved Invoice distributions. If set,
the value must be a valid GL Account Code combination. If not set, invoice lines without an account at
validation are sent to Quick Invoices.
You can set this preference at the system or organization level.
Values: A valid GL Account Code combination, no default
MVAP_PRE_APP_ENTRY_COMPLETE_QUEUE
Determines where Pre-Approved invoices enter the workflow once they receive the Complete Entry
action.
You can set this preference at the system or organization level.
Values:
• Determine Tax Review Requirement (default): Invoices transition to the Determine Tax Review
Requirement queue.
• Determine Freight Review Requirement: Invoices transition to the Determine Freight Review
Requirement queue.
• Determine Review Requirement: Invoices transition to the Determine Review Requirement queue.
• Determine QA Requirement: Invoices transition to the Determine QA Requirement queue.
• Return Control to ERP: Invoices transition to the Return Control to ERP queue.
• Verify AP Process Complete: Invoices transition to the Verify AP Process Complete queue
MVAP_PRE_APP_FRT_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes Pre-approved invoices once they finish Freight Review.
You can set this preference at the system or organization level.
Values:
• Determine Review Requirement (default): MarkView determines if the invoice requires Additional review
and routes the invoice accordingly.
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• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_PRE_APP_QA_COMPLETE_QUEUE
Specifies the queue for Pre-Approved workflow items that have completed an additional QA process.
You can set this preference at the system or organization level.
Values:
• Return Control to ERP (default): Invoices transition to the Return Control to ERP queue.
• Verify AP Process Complete: Invoices transition to the Verify AP Process Complete queue.
MVAP_PRE_APP_REVIEW_COMPLETE_QUEUE
Specifies the queue to which reviewed Pre-Approved work items transition.
You can set this preference at the system or organization level.
Values:
• Determine QA Requirement (default): Invoices that complete the additional review process transition
to the Determine QA Requirement queue. In the Determine QA requirement queue, work items are
subject to additional QA review.
• Return Control to ERP: Invoices that complete the additional review process transition to the Return
Control to ERP queue.
• Verify AP Process Complete: Invoices that complete the additional review process transition to the
Verify AP Process Complete queue.
MVAP_PRE_APP_TAX_REVIEW_COMPLETE_QUEUE
Determines where MarkView routes Pre-approved invoices once they finish Tax review.
You can set this preference at the system or organization level.
Values:
• Determine Freight Review Requirement (default): MarkView determines if the invoice requires a Freight
review and routes the invoice accordingly.
• Determine Review Requirement: MarkView determines if the invoice requires Additional review and
routes the invoice accordingly.
• Determine QA Requirement: MarkView determines if the invoice requires QA review and routes the
invoice accordingly.
• Return Control to ERP: MarkView transitions the invoice to the Return Control to ERP queue when the
review is completed.
• Verify AP Process Complete: MarkView transitions invoices that complete the review process to the
Verify AP Process Complete queue.
MVAP_PRE_APP_TRANSITION_ON_ATTACH
When TRUE, transitions pre-approved work items immediately after the document is attached to the ERP
record.
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Changing this setting without complete and thorough testing can route all items to the workflow
administration queue or send them to a single workflow processing queue where they could get stuck.
Contact Technical Support for help when updating this preference.
Values: TRUE, FALSE (default)
MVAP_PRE_APPROVED_ALLOW_COMMENT
Allows users to route pre-approved work items for comments using the Request Comment action.
Values:
• TRUE (default): Allows users to route pre-approved work items for comments.
• FALSE: Prevents users from routing pre-approved work items for comments.
MVAP_PREV_ENT_TRANSITION_ON_ATTACH
When TRUE, transitions previously entered work items immediately after the document is attached to the
ERP record.
Changing this setting without complete and thorough testing can route all items to the workflow
administration queue or to a single workflow processing queue where they can get stuck. Contact
Technical Support for help when updating this preference.
Values: TRUE (default), FALSE
MVAP_REVIEW_RECYCLE
When TRUE, turns document recycling into a 2-step approval process. Step 1 requires entry users to take
the Request Recycle action on invoices to delete. Request Recycle documents enter the Recycle Bin
Review queue.
The Recycle Bin must have sufficient space available.
In this queue, a recycle review user performs step 2 by verifying that the document should be recycled.
If confirmed for recycling, the reviewer takes the Recycle Complete action and sends the document to the
Recycle Bin queue.
If denied for recycling, the reviewer takes the Reject Recycle action and returns the document to the
Invoice Entry queue.
The default setting requires only that the entry user take the Recycle action to send the document to the
Recycle Bin queue.
You can set this preference at the system or organization level.
If you configure the preference for one accounts payable workflow within the system or organization, it
applies to all workflows in the system or organization.
Values: TRUE (default), FALSE
MVAP_REVIEW_RETURN
When TRUE, turns invoice returns into a 2-step approval process. Step 1 requires that entry users take
the Return to Supplier action on invoices to return. Return to Supplier documents enter the Returned
Invoice Review queue.
In this queue, a return review user performs step 2 by verifying that the document should be returned to
the supplier.
If confirmed for return, the review user takes the Complete Return to Supplier action, which sends the
document to the Returned Invoices queue.
If denied for return, the review user takes the Reject Return to Supplier action, which returns the
document to the Invoice Entry queue.
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The default setting requires only that the entry user take the Return to Supplier action to send the
document to the Returned Invoices queue.
You can set this preference at the system or organization level.
If you configure the preference for one accounts payable workflow in the system or organization, the value
applies to all workflows in the system or organization.
Values: TRUE (default), FALSE
MVAP_SUPPLIER_TRANSITION_ON_ATTACH
Specifies whether supplier work items transition immediately after the document is attached to the ERP
record.
Changing this setting without complete and thorough testing could route all items to the workflow
administration queue or a single workflow processing queue, where it can get stuck. Contact Technical
Support for help when updating this preference.
Values: TRUE (default), FALSE
MVAP_TAX_AUTO_CALCULATE_FOR_ORG
Specifies whether or not the ERP calculates the tax. If the KTM validation user enables the Autocalculate
Tax check box, MarkView ignores this preference.
You can set this preference at the organization level.
Values: True (default), False
MVAP_TAX_DEFAULT_ACCOUNT
Specifies the ERP account to which MarkView assigns newly entered tax line items.
You can set this preference at the system or organization level.
Values: A valid ERP accounting code, no default
MVAP_TAX_REVIEW_AMOUNT_THRESHOLD
Triggers an additional review when the tax amount on an invoice exceeds the set threshold (in the
prevailing currency), and your workflows are configured to submit invoices for tax review.
You can set this preference at the system or organization level.
Values: A number > 0, no default
MVAP_TAX_REVIEW_BY
Specifies whether a group or a user performs the review if the workflow is configured to submit invoices
for Tax review. By default, review is disabled.
You can set this preference at the system or organization level.
Values:
• GROUP (default): Specifies that a group will perform the review. The group must be authorized to
retrieve items from the Tax required queue.
• USER: Specifies the user authorized to perform the review. To specify the user, use the
MVAP_DEFAULT_TAX_USER_ID preference.
MVAP_TAX_REVIEW_PCT_THRESHOLD
Triggers an additional review when the tax percentage on an invoice exceeds the set threshold (in the
prevailing currency), and your workflows are configured to submit invoices for tax review. By default, tax
review is disabled.
MarkView calculates the amount in the base/local currency.
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For posted PO and non-PO Invoices, MarkView does not calculate tax.
You can set this preference at the system or organization level.
Tax Amount/(Invoice Amount – Tax)=%
For example, if the product price is $100, the tax is $6 and the total invoice amount is $106, the percent
calculation is:
$6/($106 – $6) =6%
Values: A number from 0 to 100, no default
MVAP_TAX_REVIEW_SAMPLING_PERCENTAGE
Specifies the percentage of invoices to send for random tax review.
You can set this preference at the system or organization level.
Values: A number from 0 to 100, no default
MVAP_TAX_REVIEW_USER_ID
Identifies the user to perform the tax reviews. By default, tax review is disabled. If this preference has no
value set, MarkView routes invoices to a user group with authorization to perform the review.
You can set this preference at the system or organization level.
Values: MarkView User ID, no default
MVAP_USE_MARKUP_APPROVER
Reserved for future use. Do not change this preference value without explicit instructions from Kofax.
When set to TRUE, this preference enables you to select the approver for an Approve action from a list of
values.
Values: TRUE, FALSE (default)
MVERP_INITIAL_USER_PASSWORD
Sets the password assigned to users who are created using the MarkView Load User Data utility. For
security purposes, change the password value from the default.
Values: WELCOME (default)
MVERP_GETPOLIST_FILTER_CONDITION
Filters the list of POs with Releases returned by the mvapi_erp_po.GetPOHeaderWithReleaseList
function. Releases specify the delivery date and quantity for the delivery.
The preference is limited to 2000 characters.
Filter the list by the following set of predefined fields.
• any column of 'po_lookup_codes' table with prefix plc.
• any column of 'po_headers_all' table with prefix poh.
• any column of 'po_releases_all' table with prefix por.
Default value:
"poh.type_lookup_code in ('STANDARD', 'BLANKET', 'PLANNED') and poh.pcard_id is null
and (poh.closed_code is null or poh.closed_code != 'FINALLY CLOSED')"

To additionally exclude any finally closed Releases from the result set, use the value such as:
"poh.type_lookup_code in ('STANDARD', 'BLANKET', 'PLANNED')
and poh.pcard_id is null

and (poh.closed_code is null or poh.closed_code != 'FINALLY CLOSED')
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and (por.closed_code is null or por.closed_code != 'FINALLY CLOSED')"

Note You can reduce memory consumption by commenting out unused fields in
mvapi_erp_po.GetPOHeaderWithReleaseList.
If you comment out fields, also update the mvapi_erp_po version string to include the word CUSTOM so
that Kofax Technical Support knows the package was modified.
By default, only PONUMBER, TYPELOOKUPCODE, and RELEASENUM fields are configured in
getPOsAll2tsv.xsl to be used by KTM.
MVERP_GETVENDORSITES_FILTER_CONDITION
Filters the list of vendor sites by a set of predefined fields:
vendor_id, vendor_name, enabled_flag, vendor_name_alt, vat_registration_num, invoice_currency_code,
tax_reporting_name, num_1099, active_flag, auto_tax_calc_flag, vendor_site_id, vendor_site_code,
phone, fax, email_address, address_line1, address_line2, address_line3, city, state, country, zip, org_id,
pay_site_flag, inactive_date, bank_account_num, bank_or_branch_number, IBAN.
For example, set up the vendor_id value to filter vendors by ID. Double the internal quotation marks as
follows.
vendor_id in (select vendor_id from po_vendors where PAY_GROUP_LOOKUP_CODE not in
( select lookup_code from apps.fnd_lookup_VALUES where lookup_type =
''MVC_VENDOR_DATA_EXPORT_EXCLUDE'' ))

MVERP_MAINTENANCE_EMAIL_ADDRESS
Sets an email address as a collection point where the Mail Gateway can send maintenance mail in the
absence of a user email address. This is a system-level preference.
Values: A site email address (for example, unknown@dexco.com)
MVERP_HIERARCHY_TYPE
Determines the hierarchy used to derive the next approver to whom the invoice is routed if an approver
does not have authority to approve the invoice. An additional option, CUSTOM, is available. For the best
results, only use the CUSTOM option under the direction of Technical Support.
You can set this preference at the system or organization level.
Values:
• MarkView (default): The workflow uses the MarkView suite hierarchy.
• ES_SIMPLE: The workflow uses a simple Employee-Supervisor Oracle Purchasing hierarchy. This
method uses the default supervisor assigned to the employee.
• POS_SIMPLE: The workflow uses a simple Positional Oracle Purchasing hierarchy. This method
assumes that only one employee is assigned to any position and determines the supervisor based on
the position of the current employee and the position hierarchy structure.
• ES_BSNS_GRP: The workflow uses a Business Group-dependent Employee-Supervisor Oracle
Purchasing hierarchy. This method determines the supervisor for the employee based upon the
Business Group of the invoice and the supervisor assigned to the assignment the user has in the
specific Business Group.
• ES_ORG: The workflow uses an Org-dependent Employee-Supervisor Oracle Purchasing hierarchy.
This method determines the supervisor for the employee based upon the Org ID of the invoice and the
supervisor assigned to the assignment the user has in the specific Org ID.
• ES_WEB: The workflow uses a self-service (Web) hierarchy you have configured for use in approving
AP invoices. Selecting this option requires changes to the hierarchy custom package, as no ES_WEB
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hierarchy is configured in the default implementation. Your system integrator can provide additional
information.
MVERP_POLIMLOC_FILTER_CONDITION
Contains a boolean expression to filter the list of PO lines in the MVAP_PO_LIM_LOC_MV table returned
by the mverp_po.RefreshLimLocTable procedure. The preference can be currently applied to the Oracle
EBS systems only and is limited by 2000 characters.
The following set of predefined fields can be used in the expression:
• any column of 'po_headers_all' table with prefix 'poh.'
• any column of 'po_lines_all' table with prefix 'pol.'
• any column of 'po_releases_all' table with prefix 'por.'
• any column of 'mvt_org' table with prefix 'mo.'
Default value:
"poh.type_lookup_code in ('STANDARD', 'BLANKET', 'PLANNED') "

For example, if you want to additionally exclude any closed and finally closed PO lines from the result set,
you can use the following value:
"poh.type_lookup_code in ('STANDARD', 'BLANKET', 'PLANNED') and
nvl(por.closed_code,'OPEN') not in ('CLOSED','FINALLY CLOSED')"

MVERP_USER_INFO_SOURCE
Specifies the source that MarkView uses to retrieve email addresses for the associated user ID. The
Email Document feature uses this setting to populate the list of email addresses available for the sending
employee to use.
Values: ERP, MarkView (default)
MVT_COVER_PAGE_ENABLE_FAX_ONLY_PROPS_YN
When set to Y, MarkView allows you to define cover page properties as "fax only," which lets you set
cover page properties to appear only on fax cover pages. For example, you might specify your return
fax number as a fax only property. You can define fax only cover page properties using the Module
Administration component of MarkView home.
Values: Y, N (default)
MVT_COVER_PAGE_LOV_MAX_VALUES
Specifies the maximum number of records accessible for supplier LOVs. The system displays an error
message if the number of available records exceeds the maximum.
Values: A number
MVT_COVER_PAGE_SHOW_FAX_ONLY_PROPS_YN
When set to Y, automatically generated fax cover pages display only properties that you specified as fax
only in MarkView Home.
MVT_COVER_PAGE_ENABLE_FAX_ONLY_PROPS_YN must be set to Y for this preference to take
effect.
Values: Y, N (default)
MVT_MAIL_FROM
Specifies an email address to use as the sender of global email reminders sent to users with open items
in their working folders. Also used by the Email Document feature if the sender has no email address
specified or if a server malfunction prevents the identification of the sender.
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This is a system-level preference.
Values:
• An email address for your site (for example, reminder@dexco.com)
• MarkView (default)
MVT_MAIL_FROM_NAME
Specifies a name to use as the sender of global email reminders sent to users with open items in their
working folders. This is a system-level preference.
Values: Site name, MarkView (default)
MVT_RE-CREATE_DOCUMENT_PRIORITY_INCREASE
Adjusts the priority of a new work item that an employee creates using the re-create document process.
The priority of the new work item is the initial priority of the original work item plus the value specified by
this preference.
Values: 5 (default), a numeric value of 0 or higher

MarkView Administration Preferences
ADMIN_ACCESS_MV_ATTRIBUTE
Specifies the type of access an administrator has to overall message attribute administration.
Values: ALL, SELECT, and NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_CONF_SEP_TYPE
Specifies the type of access an administrator has to bar code configuration separator type administration.
Values: ALL, SELECT, and NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_CONF_TYPE
Specifies the type of access an administrator has to bar code configuration type administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_CONFIGURATION
Specifies the type of access an administrator has to bar code configuration administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_QUEUE
Specifies the type of access an administrator has to bar code queue administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_QUEUE_ASSIGNMT
Specifies the type of access an administrator has to bar code queue assignment administration.
Values: ALL, SELECT, NONE (default)
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ADMIN_ACCESS_MV_BAR_CODE_REQUEST
Specifies the type of access an administrator has to bar code request administration.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_BAR_CODE_SERVER
Specifies the type of access an administrator has to bar code server administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_COMPONENT
Specifies the type of access an administrator has to message component administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_DATABASE_OBJECT
Specifies the type of access an administrator has to view database objects.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_DOCUMENT_TYPE
Specifies the type of access an administrator has to document type administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_DOC_TYPE_VOLUME_AUTH
Specifies the type of access an administrator has to document type volume authorization administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_EXP_QUEUE
Specifies the type of access an administrator has to export queue administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_EXP_QUEUE_ASSIGNMENT
Specifies the type of access an administrator has to export queue assignment administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_EXP_REQUEST
Specifies the type of access an administrator has to export request administration.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_EXP_SERVER
Specifies the type of access an administrator has to export server administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_FAX_QUEUE
Specifies the type of access an administrator has to fax queue administration.
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Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_FAX_QUEUE_ASSIGNMENT
Specifies the type of access an administrator has to fax queue assignment administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_FAX_REQUEST
Specifies the type of access an administrator has to fax request administration.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_FAX_SERVER
Specifies the type of access an administrator has to fax server administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_GROUP_PREFERENCE
Specifies the type of access an administrator has to group preference administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_LANGUAGE
Specifies the type of access an administrator has to message language administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_LOV
Specifies the type of access an administrator has to list of values administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_LOV_BIND_CONTROL
Specifies the type of access an administrator has to bind controls to list of values.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_LOV_COLUMN
Specifies the type of access an administrator has to connect a list of values to a database column.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_MESSAGE
Specifies the type of access an administrator has to message administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_MESSAGE_ATTRIBUTE
Specifies the type of access an administrator has to individual message attribute administration.
Values: ALL, SELECT, NONE (default)
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ADMIN_ACCESS_MV_MESSAGE_TEXT_TL
Specifies the type of access an administrator has to message text translation administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_MESSAGE_TYPE
Specifies the type of access an administrator has to message type administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PLATFORM
Specifies the type of access an administrator has to platform administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PREFERENCE
Specifies the type of access an administrator has to preference administration. You cannot insert and
delete preferences using MarkView Administration. You can change the default value if the value of this
preference is 'ALL' and if changeable is 'Y'.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PRINT_QUEUE
Specifies the type of access an administrator has to print queue administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PRINT_QUEUE_ASSIGNMENT
Specifies the type of access an administrator has to print queue assignment administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PRINT_REQUEST
Specifies the type of access an administrator has to print request administration.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_PRINT_SERVER
Specifies the type of access an administrator has to print server administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_PRIVILEGE_GROUP_AUTH
Specifies the type of access an administrator has to privilege group authorization administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_SYSTEM_PREFERENCE
Specifies the type of access an administrator has to system preference administration.
Values: ALL, SELECT, NONE (default)
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ADMIN_ACCESS_MV_TOOL
Specifies the type of access an administrator has to tool administration.
Values: SELECT, NONE (default)
ADMIN_ACCESS_MV_TOOLSET
Specifies the type of access an administrator has to toolset administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_TOOLSET_GROUP_AUTH
Specifies the type of access an administrator has to toolset group authorization administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_TOOLSET_TOOL
Specifies the type of access an administrator has to toolset tools administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_USER_GROUP
Specifies the type of access an administrator has to user group administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_USER_GROUP_MEMBER
Specifies the type of access an administrator has to user group member administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_USER_PREFERENCE
Specifies the type of access an administrator has to user preference setting administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_USER_PROFILE
Specifies the type of access an administrator has to user profile administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_VIEW_TYPE
Specifies the type of access an administrator has to view type administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_VIEW_TYPE_GROUP_AUTH
Specifies the type of access an administrator has to view type group authorization administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_VOLUME
Specifies the type of access an administrator has to volume administration.
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Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_VOLUME_PATH
Specifies the type of access an administrator has to volume path administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MV_WORKSTATION
Specifies the type of access an administrator has to workstation administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVS_REPOSITORY
Specifies the type of access an administrator has to SaveSet repositories.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVT_QUEUE_MESSAGE
Specifies the type of access an administrator has to administer queues and work item classes associated
with messages.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVT_TOOL_MESSAGE
Specifies the type of access an administrator has to administer tools and document types associated with
messages.
Values: ALL, SELECT, NONE (default)
ADMIN_DOC_BASE_URL
Specifies the URL where the online documentation elements of the MarkView Administration, such as
content pages and graphics, is stored. If this value is not set correctly, MarkView Administration can still
function, but the context-sensitive help is not available.
Values: A string of up to 400 characters, no default
ADMIN_IMG_BASE_URL
Specifies the URL where the GUI elements of the MarkView Administration, such as style sheets and
button graphics, are stored. If this value is not set correctly, the MarkView Administration can still function,
but the graphical elements on the page use the broken image symbol of your browser, and text may
appear in a different font than usual.
Values: A string of up to 400 characters, no default
ADMIN_LAUNCH_SF_ADMIN_HOME_URL
Specifies the URL for starting the MarkView Process Administration from MarkView Administration.
Values: A string of up to 400 characters, no default
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ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
Controls optional Alt Text that can be displayed when a MarkView Administration user places the mouse
over the customer logo. This preference is ignored when no customer logo URL is set.
Values: A string of up to 400 characters, no default
See Also:
ADMIN_WEB_CUSTOMER_LOGO_URL
ADMIN_WEB_CUSTOMER_LOGO_LINK
ADMIN_WEB_CUSTOMER_LOGO_LINK
Specifies the URL for the page to which the MarkView Administration user is sent when he or she clicks
the customer logo. This preference is ignored when no customer logo URL is set.
Values: A string of up to 400 characters, no default
See Also:
ADMIN_WEB_CUSTOMER_LOGO_URL
ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
ADMIN_WEB_CUSTOMER_LOGO_URL
Specifies whether a logo is displayed in the upper right corner of the MarkView Administration window.
Verify that the logo used for this purpose is exactly 30 pixels in height. To display the logo, set this
preference to the complete URL for the location of the image. For example, a logo URL might look like this
example:
http://your.server.com:81/images/logo.gif
Values: A string of up to 400 characters, no default
See Also:
ADMIN_WEB_CUSTOMER_LOGO_LINK
ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
FAX_COVER_PAGE_DOCUMENT
Specifies the MarkView Document ID for the document that MarkView should use as the outbound fax
cover page.
Values:
• A string of up to (15) numbers >0
• 3 (default)
HELP_LOGGING_LEVEL
Specifies the level of logging to use for tracking access to the MarkView help system. Specifies what
appears in the help.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
MIGRATION_LOGGING_LEVEL
Specifies the level of logging to use for tracking activity in the Migration utility. Specifies what appears in
the migration.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
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MV_COMMENT_NOTIFY_EMAIL_ENABLED
Specifies whether MarkView notifies those who were sent a request for comment if the requester recalls
or reroutes the request, or if the request times out.
Values: TRUE, FALSE (default)
MVT_ALT_USER_CHECK_PERMISSION
Limits the list of alternate users available to users who have the same permissions as the person for
whom they will provide coverage.
Values: TRUE (default), FALSE
MVT_ALT_USER_COLOR
Specifies the color used for the MarkView Alternate User Assignment Web Pages.
Values: 0071B9 (default)
MVT_ALT_USER_SHOW_LOV
Displays the list of available alternate users to assign.
Values: TRUE (default), FALSE
MVT_FAQ_HTTP_ADDR
Displays a FAQ link in the header (optional). When a user clicks the link, the company FAQ web page is
displayed. For example, if you set this preference to http://www.mycompany.com/InvoiceFAQ, this page
would be displayed. Specify the HTML content of the FAQ page and place the page on your Web site. If
the preference is not set, the FAQ link is not displayed in the header.
Values: A string of up to 200 characters
MVT_HELP_DESK_MAIL_ADDR
Displays an email address for help with an optional subject (optional). A user clicks the Help Desk link in
the MarkView header to send an email message to your company’s help desk. For example, if you set
the preference to administrator@mycompany.com?subject=Help Desk, clicking the link displays an email
window with the email address administrator@mycompany.com. The subject is initially set to Help Desk.
To omit a default subject, do not specify “?subject=.”
The user fills in the email message details. If you do not set the preference, no help desk link appears in
the header.
Values:
• Corporate Help Desk email address
• Option: ?subject=
MVT_WEB_STARTUP_URL
Specifies the URL of MarkView home. The default location is in the format:
http://host:port/markview/MVT_MV_Home.Home
Where host and port are the hostname and port number of the Oracle RDBMS.
The value of this preference is set automatically during a new installation of MarkView Application Server.
After a migration, you must set the preference manually. You can set this preference at the system, group,
and user level.

214

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Values: A URL of up to 2000 characters
SECURITY_PASSWORD_CASE_SENSITIVE
Specifies if the password is case sensitive. When TRUE, passwords are case-sensitive.
Values:
• TRUE: Case sensitive
• FALSE (default): Not case sensitive
SECURITY_PASSWORD_CHECK_METHOD
Specifies password security settings when a new MarkView user is created or the existing MarkView
user's password is changed. You can set this preference at the system, group, and user level.
Values:
• STRICT: Specifies that a password must be between 8 and 30 characters and contain at least one
Latin letter, one digit, and one special character (~`!@#$%^&*()_-+=[{]}\|;,<.>/?"').
• DEFAULT: No restrictions.
When a new user is created, password settings must be consistent with the system level value of the
preference. If SECURITY_PASSWORD_CHECK_METHOD system level value is set to STRICT, the
AUSS initial password must be consistent with the STRICT rules.
Note MarkView does not support the following special characters for the User Admin password: < > "
SECURITY_PASSWORD_ENCRYPTION_SCHEME
Specifies whether or not MarkView passwords are stored as encrypted data. Kofax recommends that you
not alter this setting once it is configured. Any changes can invalidate existing passwords.
Values:
• PLAINTEXT: Stores passwords as plain text
• SECURE (default): Encrypts passwords
This preference affects only passwords that are created subsequent to system setup. So, for example, if
you port existing users to a new system where the default SECURE is in effect, the existing passwords
not be encrypted. To encrypt existing passwords, use the Change Password subtab off the User Profile
tab in MarkView Administration. You can use the same password; that is, you do not have to change the
actual password content.
USERMGMT_LOGGING_LEVEL
Specifies the level of logging to use for tracking user activity, for example, authentication or authorization.
Specifies what appears in the following log files:
• usermgmt.log: Contains all user management related log messages, including authentication failures
and successful logins, as well as all other messages from authentication services, such as LDAP or
MSAD.
• usermgmt-auth.log: Contains error messages related to login process only, including authentication
failures, successful logins, and messages about temporary locked users.
• usermgmt-cas.log: Contains error messages related to a login portal application (cas.war), including
errors occurred during the login process.
• usermgmt-auss.log: Contains error messages related to AUSS.
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Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL

MarkView Applications Preferences
GRAPHICS_IMG_BASE_URL
Specifies the directory from which MarkView accesses icons and images used by MarkView components.
Default: http://${hostname}:${port}/graphics
PLSQLSERVLET_LOGGING_LEVEL
Specifies the level of logging to use for tracking MarkView messages in the PLSQL Servlet.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL

MarkView Approval/Rejection by Email Preferences
MVAP_APPROVAL_REJECTION_EXPIRATION_DATE
Specifies the number of days until the option to approve or reject an invoice expires. Setting this value to
zero (0) keeps the option from expiring.
You can set this preference at the system, group, or user level.
Values: Number of days, 14 (default)
MVAP_CONTROL_EMAIL_ADDRESS
Specifies the email address from which the Mail Gateway sends approval and rejection emails.
You can set this preference at the system, group, or user level.
Values: An SMTP email address (no default)
MVAP_EMAIL_ATTACHMENT_SIZE
Specifies the size limit, in KB, for attachments. A value of 0 prevents email attachments.
You can set this preference at the system, group, or user level.
Values: Number in kilobytes, 10000 (default)
MVAP_ENABLE_APPROVAL_REJECTION_EMAIL
Enables the feature to approve and reject work items by email. TRUE enables the feature.
You can set this preference at the system, group, or user level.
Values: TRUE, FALSE (default)
MVAP_ENABLE_NOTIFICATION_EMAIL_CUSTOM
Allows a MarkView administrator to customize the email text.
You can set this preference at the system, group, or user level.
Values: TRUE, FALSE (default)
MVAP_ENABLE_SUCCESS_MESSAGE
Allows the system to send success messages. TRUE enables this feature.
You can set this preference at the system, group, or user level.
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Values: TRUE, FALSE (default)
MVAP_SERVLET_USERNAME
Specifies the username used by the Mail Gateway to render PDF invoice images for Approval/Rejection
emails if the email approval process is used.
Accepted values include built-in MarkView accounts, such as Admin, SQLFlow, SQLFlow_Mail. If you use
an ID for an account that is set up in the ERP, the user ID must also exist in MarkView. The password
must be identical in the ERP and MarkView.
The user must have the correct privileges and right to render PDFs. (Admin has these rights by default.)
You can set this preference at the system, group, or user level.
Values: Admin (default), user ID

MarkView Audit Preferences
MVT_RETAIN_MARKUP_HISTORY_MESSAGES
Specifies whether to save a history of the events associated with an action.
Values:
• ALL: Default for new installations
• NONE: Default for upgrades
MVT_RETAIN_WORKFLOW_HISTORY_MESSAGES
Specifies whether to save a history of the events associated with business rule processing.
Values:
• ALL: Default for new installations
• NONE: Default for upgrades

MarkView AUSS Preferences
MVERP_AUSS_MAPPING_LANGUAGE
Specifies the language used to map data management for user and responsibility synchronization.
Values:
• String of up to 2000 characters
• US (American English) (default)
MVFC_OUTBOUND_SMTP_CONNECTION_SECURITY
Specifies if security authorization is required.
Values: None (default), SSL
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MVFC_OUTBOUND_SMTP_PASSWORD
Specifies the password used to authenticate with the SMTP server when sending outbound email
messages. If the SMTP server does not require authentication, leave this preference blank. During
installation, the installer sets this password.
MVFC_OUTBOUND_SMTP_PORT
Identifies the TCP/IP port used to communicate with the SMTP server when sending outbound email
messages. Most SMTP servers use port 25.
Values: 25 (default), a valid port number
MVFC_OUTBOUND_SMTP_SERVER
Identifies the name of the SMTP server used when sending outbound email messages. If blank, no
outbound emails are sent.
MVFC_OUTBOUND_SMTP_USER
Specifies the username used to authenticate with the SMTP server when sending outbound email
messages. If the SMTP server does not require authentication, leave this preference blank. If you entered
the SMTP server address during the MarkView installation, the preference value is set to this SMTP
server address.
A user can enable notifications in AUSS only if MVFC_OUTBOUND_SMTP_USER has a valid SMTP
server address.

MarkView Authentication Preferences
AUTH_ACCOUNT_TEMP_LOCK_TIME
Specifies how many minutes to lock the user if the maximum number of login attempts has been reached.
If you reset this value, you must restart the MarkView application for the value to take effect.
You can set this preference at the system level.
Values: An integer greater than or equal to zero, 5 (default)
AUTH_HIDE_LOGOUT_LINK
When TRUE, removes the Logout link from the MarkView toolbar menu.
You can set this preference at the system level.
Values: TRUE, FALSE (default)
AUTH_LOGIN_HTTP_URL
Specifies the HTTP URL of the authentication point for the MarkView applications or the SSO entry point
URL.
You can set this preference at the system level.
Values: /../cas/login.do
AUTH_LOGOUT_HTTP_URL
Specifies the HTTP URL to log out the MarkView applications.
You can set this preference at the system level.
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Values: logout.do (default)
AUTH_LOGOUT_LANDING_URL
Before you configure AUTH_LOGOUT_LANDING_URL, set the
AUTH_SSO_SAML_ENABLE_LOGOUT_SUPPORT to TRUE.
The preference specifies the URL to a corporate logout landing page, such as:
http://corporate.example.com/main.jsp

MarkView redirects to this URL address after you click the Logout link to end the MarkView session but
keeps the rest of the SSO sessions running.
The value must be an absolute URL address or a relative URL address starting from the slash symbol (/),
such as:
/../cas/logouted.do

If you reset this value, you must restart the MarkView application for the value to take effect.
You can set this preference at the system level.
AUTH_MAX_FAILED_LOGINS_ALLOWED
Specifies the maximum number of failed login attempts allowed before authentication service temporarily
locks the user.
You can set this preference at the system level.
Values: An integer greater than or equal to zero, 5 (default)
AUTH_SSO_SAML_CERT_NAME
Specifies the name of the certificate in the Java keystore.
You can set this preference at the system level.
Values: saml (default)
AUTH_SSO_SAML_CERT_PASSWD
Specifies the password associated with the certificate in the Java keystore.
You can set this preference at the system level.
AUTH_SSO_SAML_ENABLE_LOGOUT_SUPPORT
When TRUE, enables single logout for all running SSO sessions.
When FALSE, you must also configure either AUTH_HIDE_LOGOUT_LINK to hide the logout link for all
MarkView pages or AUTH_LOGOUT_LANDING_URL to specify the URL to redirect to after the Single
Logout operation.
If you reset this value, you must restart the MarkView application for the value to take effect.
You can set this preference at the system level.
Values: TRUE, FALSE (default)
AUTH_SSO_SAML_ENABLE_SUPPORT
When TRUE, enables SAML SSO integration.
You can set this preference at the system level.
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Values: TRUE, FALSE (default)
AUTH_SSO_SAML_IDP_METADATA_PATH
Specifies the path to the IDP metadata file.
You can set this preference at the system level.
Set the value in the following format:
file:/projects/mvhome/markview/saml/idp-metadata.xml

AUTH_SSO_SAML_KEYSTORE_PASSWD
Specifies the password associated with the Java keystore.
You can set this preference at the system level.
AUTH_SSO_SAML_KEYSTORE_PATH
Specifies the path to the Java keystore.
You can set this preference at the system level.
Set the value in the following format:
file:/projects/mvhome/markview/saml/saml.jks

AUTH_SSO_SAML_LOGIN_ERROR_URL
Specifies the HTTP URL address to redirect to if a user authentication fails.
You can set this preference at the system level.
Values: /../cas/error.do (default)
AUTH_SSO_SAML_USER_ATTRIBUTE_NAME
Specifies the SAML principal attribute name that contains a user ID. Identifies a user in the internal
database.
You can set this preference at the system level.
Values: urn:oid:0.9.2342.19200300.100.1.1 (default)
AUTH_SSO_USER_CREDENTIALS_COOKIE_NAME
Specifies the name of the cookie that contains the username and password.
You can set this preference at the system level.
Values: SM_USER (default)
If you set the preference to the default value, the MarkView server ignores this cookie. If you enter any
other value, the cookie value is used as a user password to log in.
AUTH_SSO_USER_CREDENTIALS_HEADER_FIELD
Specifies the name of the request header that contains the credentials (password).
You can set this preference at the system level.
Values: SM_USER (default)
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If you set the preference to the default value, the MarkView server ignores this header field. If you enter
any other value, the MarkView server uses the header value as a password to log in.
AUTH_SSO_USERNAME_COOKIE_NAME
Specifies the name of the cookie that contains the username.
You can set this preference at the system level.
Values: SM_USER (default)
AUTH_SSO_USERNAME_HEADER_FIELD
Specifies the name of the request header that contains the username.
You can set this preference at the system level.
Values: SM_USER (default)
AUTH_USER_SESSION_TIMEOUT
Specifies (in minutes) how much time must elapse between user requests and actions before MarkView
invalidates the inactive session.
Note If users are inactive for the specified period of time, they are automatically logged out. If users do
not click Logout before closing the browser window, they remain logged on to MarkView. If users have
multiple MarkView windows open and click Logout once, the current session is ended in every window.
We recommend that you set this value to no more than 720 minutes (or 12 hours).
If you set the value to 0 (zero), the default value is used.
If you change this preference value, the new value does not apply to all current sessions. Start a new
session to activate the change.
You can set this preference at the system level.
Values: An integer greater than or equal to zero, 30 (default)
MV_ENABLE_SINGLE_SIGN_ON
When TRUE, enables Single-Sign-On integration. For example, SiteMinder or another single sign-on
application passes a username over the http header or cookie.
If you reset this value, you must restart the MarkView application for the value to take effect.
You can set this preference at the system level.
Values: TRUE, FALSE (default)
WEBCLNT_SEC_AUTH_TYPE
Specifies the authentication method for all MarkView servlet applications.
You can set this preference at the system, group, and user levels.
Values:
• CUSTOM: Allows for custom validation. Requires code in MVW_Authenticate_Custom package.
• ERP: Authenticates against the Oracle E-Business Suite username and password.
• MV: (default) Authenticates against the MarkView username and password.
• MSAD: Authenticates against the Microsoft Active Directory username and password.
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• OID: Authenticates against the Oracle Internet Directory username and password.
• LDAP: Authenticates against the General LDAP Server username and password.
• PSE: (obsolete)Authenticates against the PeopleSoft Enterprise username and password.

MarkView Bar Code Generator Preferences
MVAS_BCG_BASE_URL
Specifies the base URL for the MarkView Application Server bar code Generator. MarkView Expense
Management requires this URL to generate bar codes for its cover sheets.
The URL takes the following form:
http://server:port/servlet/MarkView.bar code.
Values: A string of up to 200 characters, no default
MVAS_BCG_BUFFER_SIZE
Sets the size of the memory buffer for the MarkView Bar Code Generator.
Values: An integer that is greater than zero (0), no default
MVAS_BCG_LOGGING_LEVEL
Specifies the level of logging to use for tracking activity in the Bar Code Generator. Specifies what
appears in the mvbcg.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL

MarkView Bar Code Server Preferences
BAR_CODE_MAINTAIN_HISTORY
If set to Yes (Y), maintains a history and status of bar code requests in the database. This record is useful
if you are trying to configure or debug the bar code server.
If you change the value of this preference, you must restart the bar code Server Windows service to
begin or terminate the logging of bar code requests. The bar code Server and the bar code Generator are
different applications. Restarting the bar code Generator application server process on the application
server has no effect on the logging of bar code requests.
Values: Y, N (default)

MarkView Components Preferences
ABOUT_SERVICE_LOGGING_LEVEL
Specifies the level of logging to track for information concerning activity in the About menu in MarkView.
Specifies what appears in the about-service.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
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WEBCLNT_WKSTN_SERIAL_NO
Specifies the workstation serial number ID associated with a MarkView component. To see a list of valid
workstation serial number values, select the Workstations tab in MarkView Administration. The Serial
Number column in the Workstations > List page identifies the serial number IDs currently defined in your
system.
The workstation serial number works with the associated platform, volume, and volume path values to
locate and access MarkView documents.
For the best results, do not set WEBCLNT_LOGON_STYLE to VERBOSE.
Values: The following table lists workstation serial number conventions for MarkView components.
Conventional Workstation Serial Numbers
Component

Conventional Serial Number

Capture and Output Applications

SN1234

Document Transport Module (DTM)

MVAS_DTM

MarkView Connector Preferences
CONNECTOR_ADMIN_EMAIL
Specifies the email address that receives Administrative Notifications if a work item moves to the
Workflow Administration queue in any of three Connector workflows.
Values: An email address for the site
CONNECTOR_DEBUG_MODE
Specifies whether method debugging messages are captured in the mvcn_operation_debug table. Also,
this preference controls whether the interface function invocation is captured in the mvcn_interface_debug
table.
Values: TRUE (default), FALSE
CONNECTOR_REVIEW_IMG_BASE_URL
Specifies the path to the graphics used on the Connector Review windows.
Values: The full URL of the Connector/Graphics directory, with a trailing slash at the end:
For example: http://GraphicsServerHost:GraphicsServerPort/graphics/connector/
MVCN_AP_TERMS
Defines the terms to use when paying the invoice.
Values:
• BEST: Use the best available terms to pay this invoice.
• INVOICE: Use the terms specified on this invoice.
• SUPPLIER: Use the terms associated with the supplier.
• SUPPLIER_SITE: Use the terms associated with the supplier site.
• PO: Use the terms associated with the purchase order.
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MVCN_AP_TERMS_RANK_DFF_COLUMN
Defines the name of the column in the ap_terms table that determines the relative rank of a term.
The system only uses this preference when MVCN_AP_TERMS is set to BEST.
Values: The column name from the ap_terms table
MVCN_AUTOCREATE_NONPO_LINE
Specifies whether MarkView Connector creates a dummy line for Non-PO invoices.
Values:
• TRUE: MarkView Connector creates a dummy line for Non-PO invoices if either of the following
conditions exist:
• The line items in the invoice do not add up to the invoice total. In this case, MarkView Connector
adds a line item with an amount that equals the difference between existing line items and the grand
total. The dummy line cannot contain a negative amount.
• There are no line items in the invoice; there is only a grand total. MarkView Connector adds a line
item with an amount equal to the grand total.
• The created dummy line has the account ID defined for the Organization in Module Administration.
• FALSE (default): MarkView Connector does not create a dummy line for Non-PO invoices.
MVCN_AUTOCREATE_PO_LINE
Specifies whether MarkView Connector creates a dummy line for PO invoices.
Values:
• TRUE: Creates a dummy line if:
• The invoice line items do not add up to the invoice total. MarkView Connector adds a line item with
an amount that equals the difference between the existing line items and the grand total. The dummy
line cannot contain a negative amount.
• The invoice has no line items but has a grand total. MarkView Connector adds a line item with an
amount that equals the grand total.
• The created dummy line has the account ID defined for the Organization in Module Administration.
• FALSE (default): Does not create a dummy line.
MVCN_AUTOMATCH_RECEIPTS_STATUSES
Generates a comma-separated list of invoicing statuses that are used during automatic matching to
receipts in MarkView Connector. Only receipts with defined statuses are taken into account.
Values: OPEN (default), FULLY INVOICED, OVER INVOICED, PARTIALLY INVOICED
MVCN_AUTOCREATE_PREAPPROVED_LINE
Specifies whether MarkView Connector creates a dummy line for Non-PO, and PO, and Pre-Approved
invoices.
Values:
• TRUE: Creates a dummy line for pre-approved invoices if:
• The line items in the invoice do not add up to the invoice total. In this case, MarkView Connector add
a line item whose amount equals the difference between the existing line items and the grand total.
The dummy line cannot contain a negative amount.
• There are no line items in the invoice; there is only a grand total. MarkView Connector adds a line
item with an amount equal to the grand total.
• The created dummy line has the account ID defined for the Organization in Module Administration.
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• FALSE (default): Does not create a dummy line for PO invoices.

MarkView Database Objects Preferences
MV_DATE_FORMAT
Sets the default format of the date that appears in Web Inbox, Web Inquiry, and MarkView Viewer.
Values:
• DD-MON-YYYY (default)
• A string of up to 80 characters
The date value can consist of hyphens, slashes, dots, and spaces as delimiters. If alphabetic symbols
are used, the format string error occurs.
MV_ENABLE_SINGLE_SIGN_ON
Specifies the authentication page that a single-signon-protected DTM uses.
Values:
• TRUE: Uses the value of the MV_SINGLE_SIGN_ON_URL preference to authenticate a login session
when a MarkView Capture and Output component attempts to access a document server that uses a
DTM protected by a single-signon server.
• FALSE (default): Redirects authentication to an SSO login page, which Capture and Output
components cannot display. Upon receiving an invalid response from the DTM, the Capture and Output
component displays an error noting the login failure.
MV_LANGUAGE_ABBREV
Sets the default language for MarkView applications that can be localized, provided a translated version is
available for that language. Kofax strongly recommends that you assign users to a language user group
(LOCALE_xx) in MarkView Administration instead of changing this preference value.
Values:
• de: German
• en (default): American English
• es_ES: Castilian Spanish
• fr: French
• it: Italian
• ja: Japanese
• pl: Polish
• pt_BR: Brazilian Portuguese
• zh_CHS: Simplified Chinese
MV_LOG_DATE_TIME_FORMAT
Sets the default format of the date-time stamp that appears in log messages, if included in the log
message format.
For example, 2008/01/01 12:00:59 AM, or the first of January 2008, at 59 seconds past midnight.
Values:
• MM/DD/YYYY HH:MI AM
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• DD/MM/YYYY HH:MI AM
•
•
•
•
•
•
•

DD-MON-YYYY HH:MI AM
MM/DD/YYYY HH24:MI
DD/MM/YYYY HH24:MI
DD-MON-YYYY HH24:MI
MM/DD/YYYY
DD/MM/YYYY
DD-MON-YYYY

•
•
•
•
•
•
•

HH24:MI:SS
HH24:MI
MM/DD/YYYY HH:MI:SS AM
DD/MM/YYYY HH:MI:SS AM
DD-MON-YYYY HH:MI:SS AM
HH:MI:SS AM
YYYY/MM/DD HH:MI:SS AM (default)

MV_LOG_DESTINATION
Defines the mechanism to use to write log messages. When you finish testing and debugging, set the
MV_LOG_LEVEL preference to OFF to stop writing log messages. This is especially important in a
production environment.
Values: A string of up to 30 characters:
• TABLE: Directs MV_LOG to write messages to the mv_log_output database table. After testing and
debugging, purge the table contents and set MV_LOG_LEVEL to OFF to keep the table from growing
unnecessarily large.
• FILE: Directs MV_LOG to use the UTL_FILE package to write messages to a file in a directory that
is accessible to the database server. Set the database parameter UTL_FILE_DIR to one or more
directories to enable writing to files. The MV_LOG_FILE_PATH preference is typically set to one of
these directories. After testing and debugging, delete the message file and set MV_LOG_LEVEL to
OFF to prevent the file from growing unnecessarily large.
• PIPE: Directs MV_LOG to use the DBMS_PIPE package to write messages to a pipe. Set
MV_LOG_LEVEL to OFF to stop writing to the pipe; close the pipe after testing and debugging by
calling MV_LOG.Close(Destination).
• DBMS_OUTPUT (default): Directs MV_LOG to use the DBMS_OUTPUT package to write messages.
If you use SQL*plus to monitor messages, increase server output as follows: SQL> set serveroutput on
size 1000000. The default of 2000 characters is typically inadequate to accommodate the output that
being generated.
• HTML: Directs MV_LOG to use HTP.P to write messages. The procedure must be called from
an appropriate context—for example, from a web page generated using the PL/SQL Toolkit—for
messages to be seen in the web browser as they occur.
MV_LOG_FILE_NAME
Sets the default filename when logging to a file.
Values: A string of up to 80 characters, mv_message.txt (default)
MV_LOG_FILE_PATH
Sets the default path location of the log file when logging to a file.
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Values: A string of up to 200 characters, /temp/MarkView/logs (default)
MV_LOG_IGNORE_ERROR
If TRUE (the preferred setting in a production environment), this preference instructs the logging
mechanism to ignore errors that occur in the MV_LOG procedure (for example, failures in attempting to
write log messages to a file or pipe due to lack of space). A value of FALSE causes the mechanism to try
to report the problem by flagging the condition.
Values: TRUE (default), FALSE
MV_LOG_LEVEL
Specifies the level of logging to use for tracking debug data from PL/SQL packages in the database. See
MV_LOG_DESTINATION for more information.
Values: OFF (default), FATAL, ERROR, WARN, INFO, DEBUG, TRACE, ALL
MV_LOG_MESSAGE_FORMAT
Defines the default format of messages written to the log. A message can consist of the values shown in
the following table:
Message Log Values
Value

Description

#D

Include a date-time stamp of the format indicated in the MV_LOG_DATE_FORMAT
preference.

#U

Include the user ID.

#L

Include the importance level of the message.

#S

Include the source or origin of the message; typically, package.procedure_name.

#C

Include the message category.

#M

Include the message itself.

If the preference does not account for an element, the element does not appear in a logged message.
Text not replaced by a # value substitution is output exactly as it appears in the preference value.
Values: A string of no more than 80 characters, #D - #M (default, which sets the date, followed by a
space, a dash, a space, and the message content)
MV_LOG_PIPE_NAME
Sets the default pipe name when logging to a pipe.
Values: A string of up to 80 characters, MV_MESSAGE (default)
MV_SINGLE_SIGN_ON_URL
Specifies a login page to which a single-signon-protected DTM is directed to authenticate a login session
from a MarkView Capture and Output component, specifically, MarkView Fax, or MarkView Process Mail
Gateway for NT. This preference is ignored if MV_ENABLE_SINGLE_SIGN_ON is set to FALSE.
Values: A string of up to 2000 characters
MVW_SECURITY_REALM
Identifies the realm that web-authenticated users validate against.
Values: A string of up to 2000 characters, MarkView Users (default)
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SYSTEM_LOCK_TIMEOUT_PERIOD
Specifies for how many minutes to retain expired locks before purging them from the MV_OBJECT_LOCK
table. Use this preference to preserve a record of locks without allowing the table to grow too large.
Values: An integer >0 (greater than or equal to zero), 5 (default)
SYSTEM_OBJ_AUTH_RETENTION_PERIOD
Specifies for how many minutes to retain expired keys before purging them from the
MV_OBJECT_AUTHORIZATION table. Use this preference to preserve a record of authorization key
requests without allowing the table to grow too large. The system deletes no more than 100 rows at a time
to help keep the rollback segment from becoming too large.
Values: An integer >0 (greater than or equal to zero), 1440 (default)

MarkView Document Library Preferences
ADMIN_ACCESS_MVRM_OBJECT_CLASS
Displays the Document Types main tab in MarkView Administration for Document Library.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVRM_OBJECT_PRIV
Specifies the type of access an administrator has to document privilege administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVRM_OBJ_CLASS_PROPERTY
Displays the Document Type Properties main tab and the Document Types—Document Type Properties
subtab in MarkView Administration for Document Library.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVRM_OBJ_PROPERTY_VALUE
Specifies the type of access an administrator has to document property value administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVRM_OBJ_PROP_VALUE_AUTH
Displays the Document Type Properties—Document Type Property Value Privilege Authorizations subtab
in MarkView Administration for Document Library.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_MVRM_SEARCH
Enables MarkView Administration for Document Library to define custom search fields.
Values: ALL, SELECT, NONE (default)
MVRM_CREATE_OBJECT_WO_ATTACHMENT_FORM
When TRUE, gives the user permission to create a document without a document image attachment on
the File Record page.
Values: TRUE, FALSE (default)
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MVRM_ENABLE_EMAIL
When TRUE, displays the email button on the Search Results page of the MarkView Document Library
interface. Users can click the email button to email the selected document using the default email
application. This functionality requires that you modify the custom callout.
Values: TRUE, FALSE (default)
MVRM_ENABLE_FAX
When TRUE, displays the Fax button on the Search Results page of the MarkView Document Library
interface. Users can click the Fax button to fax the selected document using the default fax application.
This functionality requires that you modify the custom callout.
Values: TRUE, FALSE (default)
MVRM_ENABLE_FULL_TEXT_SEARCH
When TRUE, displays the Full Text Search field on the Search page of the MarkView Document Library
interface.
Values: TRUE (default), FALSE
MVRM_FILERECORD_JUMP_TO_OBJECT
Specifies the location where the user can file a new document after a single new document upload.
Values:
• TRUE: Takes the user to the unfiled documents queue.
• FALSE (default): Keeps the user at the File Record page.
MVRM_FILING
Displays the File Record tab on the MarkView Document Library interface.
Values: TRUE (default), FALSE
MVRM_HTTP_BASE_URL
Specifies the URL from which users start a session with the MarkView Document Library. If this value is
incorrect, users cannot work with the MarkView Document Library.
Values: A string of up to 400 characters, no default
MVRM_IMG_BASE_URL
Specifies the URL of the GUI elements of the MarkView Document Library, such as style sheets and tab
and button graphics. If this value is incorrect, the MarkView Document Library can still function correctly,
but graphic elements are displayed using the broken image symbol of your browser, and text may appear
in a different font.
Value: A string of up 400 characters
MVRM_NON_MV_DOCS_ARE_ATTACHMENTS
When TRUE, the MarkView Document Library auto-saves non-MarkView documents to the user's
computer.
Values: TRUE, FALSE (default)
MVRM_NUM_DOCUMENTS_TO_UPLOAD_AT_ONCE
Specifies the number of file uploaded lines to display on the File Record tab of the MarkView Document
Library interface. If the value is less than 1, no lines are displayed, and the employee cannot upload files.
This preference can only be specified at the User and System levels.
Values: An integer >0 (greater than or equal to zero), 1 (default)
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MVRM_VIEW_BAR_CODE
When TRUE, displays the bar code button on the View Document page of the MarkView Document
Library interface. When available, clicking the bar code button lets the employee view the bar code cover
page for the document. This preference can only be specified at the System level.
Values: TRUE, FALSE (default)
MVRM_WKSTN_SERIAL_NO
Specifies the workstation serial number ID used by the document library.
Values: Workstation ID

MarkView DTM Preferences
CMSYNC_LOGGING_LEVEL
Sets the logging level for messages in MarkView Content Management Systems Synchronization.
Specifies what appears in cmsync.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
MVAS_DTM_ARCHIVELINK_BASE_URL
Specifies the base URL of the ArchiveLink interfaced Content Server that stores the documents.
Values: A string of up to 2000 characters, no default
MVAS_DTM_ARCHIVELINK_REPO_NAME
Specifies the repository name of the ArchiveLink in which to store the documents.
Values: Name of the repository
MVAS_DTM_BASE_URL
Specifies the URL location of the DTM.
Values: A string of up to 2000 characters, no default
MVAS_DTM_COMPATIBILITY_MODE
Specifies the security setting for the Document Transport Module.
Values:
• 4.1: Basic Compatibility supports the session key based DownloadDocument DTM action used by the
MarkView viewer.
• 4.2 (default): Extended Compatibility supports full the MarkView suite security for DownloadDocument,
as well as the Image actions (DownloadImage, ExistsImage, UploadImage, DeleteImage). Kofax
recommends Extended compatibility mode.
MVAS_DTM_COPY_SUCCESS_PAGE
Specifies the default success page that displays if an image file copy is successful.
Values: A string of up to 2000 characters
MVAS_DTM_DELETE_MODE
Controls how a deletion occurs if the Document Transport Module platform uses UNC.
Values:
• SIMPLE (default): Deletes the file.
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• OVERWRITE: Replaces each byte of the file with 'x', prior to deleting the file.
• ZEROSIZE: Overwrites the file, then deletes it and creates a zero size file with the same name. This
setting is the most secure, but also the most resource intensive.
MVAS_DTM_DELETE_PRIV_CODE
Specifies the default privilege code that the Document Transport Module uses if none is specified for
deleting an image file. The Document Transport Module verifies that the workstation serial number,
document type, and user all have the proper privileges according to this preference.
Values:
• A string of up to 2000 characters
• FLDDEL (default)
MVAS_DTM_DOWNLOAD_BLOCK_SIZE
Specifies the size in bytes of the units of data being retrieved from the document server, and then
passed to the end user. The Document Transport Module requests this data size, then passes as much
information to the user as it can. A good rule of thumb is to set this number to the block size of your
document server. This approach allows for hard drive optimization when reading the smallest block
possible.
Values:
• An integer >0
• 0 (default)
MVAS_DTM_DOWNLOAD_PRIV_CODE
Sets the default privilege code that the Document Transport Module uses if none is specified for
downloading. The Document Transport Module verifies that the workstation serial number, document
type, and user all have the proper privileges according to this preference. For optimization purposes,
you should always return this value from the custom packages. If you use an implementation specific
application, you may want to create your own privilege code.
Values:
• A string of up to 200 characters
• FLDDNLD (default)
MVAS_DTM_ERROR_PAGE
Specifies the URL to display if an error occurs.
Values: A URL of up to 200 characters
MVAS_DTM_FILENET_DOMAIN_NAME
Specifies the FileNet Content Manager domain in which the object store is contained.
Values: FNP8V45 (default), domain name
MVAS_DTM_FILENET_FOLDERS
Specifies a single folder name or a list of folders separated by a comma. The folders are potential
locations of documents within the Object Store. Use a forward slash (/) as a subfolder delimiter. The first
mentioned folder name indicates the location to upload new documents.
Values: docserver (default), a character string.
If the docserver folder does not exist on the server, this folder will be created when a user uploads a
document to FileNet for the first time.
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MVAS_DTM_FILENET_HOSTNAME
Specifies the name of the host server on which the FileNet Content Manager integration engine specified
in the MVAS_DTM_INTEGRATE_MODE preference and the MarkView DTM reside.
Values: hostname
MVAS_DTM_FILENET_JAAS_STANZA_NAME
Specifies the JAAS against which to authenticate the FileNet username and password when connecting to
the FileNet Content Engine when storing and retrieving documents.
Values: FileNetP8WSI (default for FileNet web services), web service name
MVAS_DTM_FILENET_OBJECT_STORE
Specifies the FileNet Content Manager object store database in which to store MarkView documents.
Values: alphanumeric character string
MVAS_DTM_FILENET_PASSWORD
Specifies the password associated with the username specified in the preference
MVAS_DTM_FILENET_USERNAME.
Values: A character string
MVAS_DTM_FILENET_PORT
Specifies the http or https port that MarkView DTM uses to connect to the FileNet Content Manager
integration engine specified in the MVAS_DTM_INTEGRATE_MODE preference.
Values: A valid port number
MVAS_DTM_FILENET_PROTOCOL
Specifies the protocol for MarkView to use when connecting to the FileNet Content Manager integration
engine specified in the MVAS_DTM_INTEGRATE_MODE preference.
Values: http (default), https
MVAS_DTM_FILENET_URL_TRANSPORT
Specifies the transport protocol name in the connection URL to FileNet Content Engine Web Services.
Values:
• For IBM FileNet CM 5.0 or earlier: Set the preference to FNCEWS40DIME.
• For IBM FileNet CM 5.1 or later: Set the preference to FNCEWS40MTOM.
The default system value is FNCEWS40DIME.
MVAS_DTM_FILENET_USERNAME
Specifies the username to use when storing documents in and retrieving them from FileNet Content
Manager.
Values: A string of up to 30 alphanumeric characters (without spaces or special characters)
MVAS_DTM_FILENET_WASP_LOCATION
Specifies the location where the FileNet Content Engine Client web service is defined. The directory
specified must contain the clientconf.xml file. (The default value is the default FileNet installation location.)
Values: ${FILENET_HOME}\CEClient\wsi (default), web services location
For integrations with IBM FileNet 4.5.1 or later, leave the field empty as the preference value.
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MVAS_DTM_ICM_CONNECTION_TIMEOUT
Specifies the number of milliseconds before the IBM Content Manager connections timeout during
connection initialization.
Values: 0 (default), an integer >0
MVAS_DTM_ICM_INIT_CONNECTIONS
Specifies the initial number of IBM Content Manager connections.
Values: 10 (default), an integer >0
MVAS_DTM_ICM_MAX_CONNECTIONS
Specifies the maximum number of IBM Content Manager connections at a time.
Values: 20 (default), an integer >0
MVAS_DTM_ICM_MIN_CONNECTIONS
Specifies the minimum number of IBM Content Manager connections at a time.
Values: 7 (default), an integer >0
MVAS_DTM_ICM_HOSTNAME
Specifies the name of the host server on which the IBM Content Manager integration engine specified in
the MVAS_DTM_INTEGRATE_MODE preference and the MarkView DTM reside.
Values: hostname
MVAS_DTM_ICM_PASSWORD
Specifies the password associated with username specified in the preference
MVAS_DTM_ICM_USERNAME.
Values: A character string
MVAS_DTM_ICM_PROTOCOL
Specifies the protocol for MarkView to use when connecting to the IBM Content Manager integration
engine specified in the MVAS_DTM_INTEGRATE_MODE preference.
Values: http (default), https
MVAS_DTM_ICM_USERNAME
Specifies the username to use when storing documents in and retrieving them from IBM Content
Manager.
Values: A string of up to 30 alphanumeric characters (without spaces or special characters)
MVAS_DTM_INTEGRATE_MODE
Specifies the third-party (if any) integration that MarkView DTM uses.
Values: OFF (default), ArchiveLink, IBM Content Manager, Documentum Content Server, FileNet Content
Manager, Oracle WebCenter Content
MVAS_DTM_LOGGING_LEVEL
Sets the logging level for messages in the MarkView Document Transport Module. Specifies what
appears in the mvdtm.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
MVAS_DTM_WCC_DOCUMENT_TYPE
Specifies the Oracle WebCenter Content (OWCC) document type to assign to new MarkView documents.
Configure other valid values in OWCC. See the Oracle documentation for more information.
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Values: DOCUMENT (default)
MVAS_DTM_WCC_HOSTNAME
Specifies the name of the host server on which the Oracle WebCenter Content integration engine
specified in the MVAS_DTM_INTEGRATE_MODE preference and the MarkView DTM reside.
Values: hostname
MVAS_DTM_WCC_OBJECT_STORE
Specifies the Oracle WebCenter Content object store database in which to store MarkView documents.
Values: alphanumeric character string
MVAS_DTM_WCC_PASSWORD
Specifies the password associated with username specified in the preference
MVAS_DTM_WCC_USERNAME.
Values: A character string
MVAS_DTM_WCC_PORT
Specifies the http or https port that MarkView DTM uses to connect to the Oracle WebCenter Content
integration engine specified in the MVAS_DTM_INTEGRATE_MODE preference.
Values: A valid port number
MVAS_DTM_WCC_PROTOCOL
Specifies the protocol for MarkView to use when connecting to the Oracle WebCenter Content integration
engine specified in the MVAS_DTM_INTEGRATE_MODE preference.
Values: http (default), https
MVAS_DTM_WCC_SECURITY_GROUP
Specifies the Oracle WebCenter Content security group for new MarkView documents. Configure values
in OWCC. See the Oracle documentation for more information.
Values: SECURE (default)
MVAS_DTM_WCC_USERNAME
Specifies the username to use when storing documents in and retrieving them from Oracle WebCenter
Content.
Values: A string of up to 30 alphanumeric characters (without spaces or special characters)
MVAS_DTM_UPLOAD_PRIV_CODE
Specifies the default privilege code that the Document Transport Module uses if none is specified for
uploading. The Document Transport Module verifies that the workstation serial number, document type,
and user all have the proper privileges according to this preference. For optimization, always return this
value from custom packages. If you use an implementation-specific application, create your own privilege
code.
Values:
• A string of up to 200 characters
• FLDUPLD (default)
MVAS_DTM_UPLOAD_SUCCESS_PAGE
Specifies the URL to display when an upload is successful.
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Values:
• A string of up to 200 characters
• URL (default)
MVAS_DTM_VIEWER_DNLD_AUTH_TIMEOUT
Specifies the time-out period, in seconds, within which the viewer must request a document image. The
time out starts from the time the URL is requested. The MarkView viewer requests a document, then
proceeds to retrieve it through the Document Transport Module. In this scenario, there is a time out
associated with the requesting URL and the time within which it is valid. Security restrictions require that
this limit be in place.
If the viewer is inside a fast network, the MarkView viewer might need a fraction of a second to process
the request. If the viewer is outside a firewall on an external network, you might have to make additional
allowances for network traffic.
Values: An integer >0, 0 (default)
MVAS_DTM_WORKSTATION_SERIAL_NO
Specifies the workstation serial number ID associated with the MarkView Document Transport Module.
For a list of workstation serial numbers, select the Workstations tab in MarkView Administration. The
Serial Number column in the Workstations > List page identifies the serial number IDs currently defined in
your system.
The workstation serial number works in concert with associated platform, volume, and volume path values
to locate and access MarkView documents on the Document Server.
Values: Workstation serial number, MVAS_DTM_1 (default)
See Also: WEBCLNT_WKSTN_SERIAL_NO

MarkView e-Invoice Preferences
CONNECTOR_ADMIN_EMAIL
Specifies the email address of the person or account designated as the administrative contact for einvoice processing issues. This email address is unrelated to the daily reminders that are sent to AP users
who have e-invoice items in their Connector Review > Working Folder.
Values: An email address for your site (for example, einvoiceadmin@dexco.com)
CONNECTOR_DEBUG_MODE
Enables or disables the logging of debugging messages during e-invoice processing.
Values:
• TRUE (default): Enable
• FALSE: Disable
CONNECTOR_REVIEW_IMG_BASE_URL
Specifies the full URL of the Connector/Graphics directory. Set the URL in the following format, including a
trailing slash:
http://GraphicsServerHost:GraphicsServerPort/graphics/connector/
Values: URL of the Connector/Graphics directory
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MarkView Expense Management Preferences
EXPENSE_REPORT_STATUS_BACKUP_ATTRIBUTE
Stores the value of the configurable field in the Oracle iExpense table ap_expense_report_headers_all.
Values: ATTRIBUTE1 through ATTRIBUTE15 (default)
MVEXP_ENABLED
If set to Yes, enables MarkView Expense Management. If No, disables Expense Management.
You can set this preference at the system or organization level.
Values: Y (default), N
MVT_BARCODE_CAPTION
If TRUE, displays the bar code value in plain text below the bar code.
Values: TRUE (default), FALSE
MVT_BARCODE_CHECKSUM
If TRUE, includes a checksum digit at the end of the bar code. The checksum validates the value of the
bar code.
Values: TRUE (default), FALSE
MVT_BARCODE_FORMAT
Specifies the format of the generated bar code.
Values: 3 of 9, code 128 (default)
MVT_BARCODE_WIDTH
Specifies the width of the narrowest bar in a generated bar code.
Values: An integer, 2 (default)
MVEXP_CONCURRENT_APPROVAL
Controls the approval order for an expense report. This preferences applies to systems running Oracle
Internet Expenses Mini-Pack J or earlier versions.
Regardless of concurrent approval settings, AP users can always access an expense report by querying
the expense report number on the Expense Report form.
Values:
• N (default): Indicates that concurrent approvals are not allowed. An AP user cannot approve the report
until manager approval is complete.
• Y: Allows concurrent approvals. This means that an AP approver can approve an expense report before
manager approval is complete.
MVEXP_EXPENSES_FAX_NUMBER
On the cover page instructions, specifies the fax number for employees to use when faxing in expense
report packets. You must provide the value when the seed data is created. You can insert the tag
MVEXP_EXPENSES_FAX_NUMBER in any message. MarkView Expense Management resolves this
value at runtime, replacing it with the fax number.
Values: A fax number (provided when seed data is created)
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MVEXP_RECEIPTS_REMINDER_XX
Controls the reminders that are sent to users. When a user submits an expense report that requires
receipts, but fails to submit receipts, Oracle Notifications can send reminders to the user. Configure the
number and frequency of reminders using the MarkView suite preferences. These preferences take
the form MVEXP_RECEIPTS_REMINDER_nn xx, where nn is a number from 01, 02, or 03, and xx is a
number from 01 to 99 indicating the reminder notification countdown in hours.
For example, you might have three reminders:
MVEXP_RECEIPTS_REMINDER_01 4
MVEXP_RECEIPTS_REMINDER_02 24
MVEXP_RECEIPTS_REMINDER_03 48
If no receipts are received for the expense report, the preparer receives a reminder after 4 hours. If no
receipts are received after 24 hours, a second reminder is sent. If no receipts are received after 48 hours,
MarkView Internet Expense sends a third and final reminder.
Create additional reminder preferences by calling MV_Admin.AddMVPreferenceDefinition.
Values: The number of hours before Oracle Notifications sends the reminder
MVEXP_RECEIPTS_REQUIRED_FOR_AP_ONLY
Controls whether managers can approve expense reports before the submitter attaches receipts to the
report.
Values:
• Y: Allows the AP approver to approve expense reports without the receipts attached.
• N (default): Does not allow the AP approver to see the expense report until related receipts are
attached.
MVEXP_SKIP_LINES_WITH_MISSING_RECEIPTS
Specifies whether the system pauses expense processing until after receiving all receipts or skips lines
that are missing receipts and continues processing.
Values:
• Y: Gets a count of all expense lines where the receipt_required_flag equals Y and the
receipt_missing_flag is N.
If the count is greater than 0, the ReceiptsRequireManager is Y. If the count is 0, the
ReceiptsRequireManager is N.
• N: Gets a count of all expense lines where the receipt_required_flag equals Y and ignores the
receipt_missing_flag.
If the count is greater than 0, the ReceiptsRequireManager is Y. If the count is 0, the
ReceiptsRequireManager is N.
MVEXP_UNMATCHED_PACKET_RETRY_COUNT
Specifies how many times MarkView Expense Management tries to match a receipts
packet. This preference works in conjunction with the retry interval specified in
MVEXP_UNMATCHED_PACKET_RETRY_PERIOD.
A bar code packet (receipts with a bar coded cover page) might not match any corresponding expense
report work item. This should not happen during normal processing. However, if it does, MarkView
Expense Management waits and tries again later to match the packet.
Values: An integer >0, 4 (default)
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MVEXP_UNMATCHED_PACKET_RETRY_PERIOD
Specifies for how many hours MarkView Internet Expense waits before trying again to match an
unmatched packet. This preference works in conjunction with the number of retries specified in
MVEXP_UNMATCHED_PACKET_RETRY_COUNT.
Values: An integer >0, 6 (default)

MarkView Export Server Preferences
EMAILDOC_MAX_NUM_PAGES_ALLOWED
Specifies the maximum number of pages allowed in a PDF when using the Email Document feature from
the MarkView viewer.
The number of pages that an employee can send depends on the available system memory and
the processor speed. For the best results, test this feature in a non-production environment before
implementing the change in a production environment.
If you reset this value, you must restart the application server for the value to take effect.
Values: 50 (default), a number of 1 or higher
MVAS_EXPORT_BASE_URL
Specifies the base URL of the export server. Use this value as the servlet address when creating an
export queue assignment for the export server.
Values:
• A string of up to 200 characters
• Seeded URL (default)
MVT_HISTORY_SHOW_EMAILDOC_HISTORY
Specifies whether or not the email history of a document appears in the Document History section of the
viewer.
Values: SHOW (default), HIDE

MarkView Folder Desktop Edition Preferences
FOLDER_DEFAULT_FOLDER_ID
Specifies a folder in which to place uploaded documents, if no folder is open for that purpose at the time of
upload.
Values: A string of up to 200 characters, no default
FOLDER_REQUIRE_OPEN_FOLDER_FOR_NEW_DOCS
Specifies whether there must be an open folder for a document upload to occur.
Values: TRUE (default), FALSE

238

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

MarkView Folder Preferences
SECURITY_REQUIRE_ACCESS_FOR_FOLDER_LIST
Specifies whether users must have security access to a folder to view the documents in the folder.
Values:
• TRUE (default): Users must have security access to the folder.
• FALSE: Users are not required to have security access to the folder.

MarkView for Oracle Applications Preferences
ERP_ORACLE_LOGGING_LEVEL
Specifies the level of logging to use for tracking communication between MarkView and the ERP, for
example, the extraction of user data or information about invoices from the ERP. Specifies what appears
in the erp-oracle.log.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
MVOA_DISABLE_SFXPNDQS_GETNEXT
When TRUE, disables the Get Next button on the Pending Queues form. Clicking this button retrieves the
next work item into the Working Folder only. For some, this is an unexpected result. Disabling the button
is a way to eliminate the confusion.
Values: TRUE (default), FALSE
MVOA_FNDATTCH_AUTO_LAUNCH
Determines the behavior when the Find Attachments (FNDATTCH) form retrieves a MarkView document
type, with respect to automatically displaying the document image. You can set this preference at the
system, group, and user level.
Values:
• ALWAYS: Always automatically start the viewer and display the document.
• ONE: Only automatically start the viewer and display the document if there is a single attachment,
which is a MarkView document. The setting is ignored for any other attachment types.
• NEVER (default): Never automatically start the viewer and display the document.
MVOA_FNDATTCH_AUTO_MINIMIZE
Determines the behavior when the Find Attachments (FNDATTCH) form retrieves a MarkView document
type, with respect to automatically minimizing the FNDATTCH form. You can set this preference at the
system, group, and user level.
Values:
• ALWAYS: Always automatically minimize the FNDATTCH form when retrieving a MarkView document
type.
• ONE: Only automatically minimize the FNDATTCH form if there is a single attachment, which is a
MarkView document. The setting is ignored for any other attachment types.
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• NEVER (default): Never automatically minimize the FNDATTCH form when retrieving a MarkView
document type.
MVOA_USE_AUTHORIZED_DOCUMENT_ACCESS
When TRUE, prevents users from viewing the document who are unauthorized by the application. This is
a way to prevent users from randomly browsing through document IDs to view documents.
Values: TRUE, FALSE (default)
MVOA_WF_ENABLE_GETNEXT
When TRUE, enables the GetNext button in the Working Folder.
Values: TRUE (default), FALSE
MVOA_WF_SHOW_ON_GETNEXT
When set to TRUE, clicking GetNext automatically opens the MarkView viewer with the next work item
document displayed.
Values: TRUE (default), FALSE

MarkView Invoice Audit Preferences
INVOICE_AUDIT_MAX_RESULTS
Controls the maximum number of lines in a .csv file that the Invoice Audit tool accepts when querying the
ERP. If you upload a file with more than this number of lines, the Invoice Audit tool generates an error
message. You can set this preference at the system level.
Values: a number from 1 to 20000, 5000 (default)
INVOICE_AUDIT_PRINT_QUEUE
Defines the print queue to use for batch printing. If this preference has no value set or if the queue
does not exist, MarkView generates an error when you attempt to save the preference. You can set this
preference at the system, group or user level.
Value: A string of up to 200 alphanumeric characters, DEFAULT_BATCH_QUEUE (default).
MVERP_SERVICE_LOGGING_LEVEL
Sets the logging level for ERP service messages. Specifies what appears in the erp-services.log.
Values: WARN (default), OFF, FATAL, ERROR, INFO, DEBUG, TRACE, ALL

MarkView Mobile Preferences
MOBILE_HTTP_APPLICATION_URL
Defines the URL path for access to the MarkView mobile version.
Value: A string of up to 400 characters, /mobile (default)
MOBILE_LOGGING_LEVEL
Controls the logging levels for the mobile application. Sends information to the mobile.log file.
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Sets the logging level for MarkView mobile messages.
Values: OFF, FATAL, ERROR, WARN (default), INFO, DEBUG, TRACE, ALL

MarkView Process Administration Preferences
ADMIN_ACCESS_SF_ACTION
Specifies the type of access a user has to action administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_APPLICATION_FUNCTION
Specifies the type of access a user has to application function administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_DATABASE_OBJECT
Specifies the type of access a user has to database objects information.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_EVENT_PROPERTY
Specifies the type of access a user has to event property administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_EVENT_TYPES
Specifies the type of access a user has to event type administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_MANAGER
Specifies the type of access a user has to manager administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_MANAGER_EVENT_ASSIGNMENT
Specifies the type of access a user has to event assignment administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_PREFERENCE
Specifies the type of access a user has to preference administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_QUEUE
Specifies the type of access a user has to queue administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_ROLE
Specifies the type of access a user has to role administration.
Values: LL, SELECT, NONE (default)
ADMIN_ACCESS_SF_ROLE_ACTION_AUTH
Specifies the type of access a user has to role action authorization administration.
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Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_ROLE_PREFERENCE
Specifies the type of access a user has to role preference administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_ROLE_QUEUE_PRIVILEGE
Specifies the type of access a user has to role queue privilege administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_ROLE_ROUTABLE_QUEUE
Specifies the type of access a user has to role routable queue administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_SYSTEM_PREFERENCE
Specifies the type of access a user has to system preference administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_USER_PREFERENCE
Specifies the type of access a user has to user preference administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_USER_PROFILE
Specifies the type of access a user has to user profile administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SF_USER_ROLE_GRANT
Specifies the type of access a user has to user role grant administration.
Values: ALL, SELECT, NONE (default)
ADMIN_ACCESS_SFS_REPOSITORY
Specifies the type of access a user has to SaveSet repository administration.
Values: ALL, SELECT, NONE (default)
ADMIN_DOC_BASE_URL
Specifies the URL where the documentation elements of the MarkView Process Administration, such
as HTML pages and help graphics, are stored. If this value is not set correctly, The MarkView Process
Administration can still function, but the online help not appear when you click the Help button.
Values: A string of up to 400 characters, no default
ADMIN_IMG_BASE_URL
Specifies the URL where the GUI elements of the MarkView Process Administration, such as style sheets
and button graphics, are stored. If this value is not set correctly, the MarkView Process Administration can
still function correctly. However, each graphical element on the page will be displayed using the broken
image symbol of your browser, and the text may appear in a different font than usual.
Values: A string of up to 400 characters, no default
ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
Controls optional Alt Text that can be displayed when an MarkView Process Administration user places
the mouse over the customer logo. This preference is ignored when no customer logo URL has been set.
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Values: A string of up to 400 characters, no default
See also
• ADMIN_WEB_CUSTOMER_LOGO_LINK
• ADMIN_WEB_CUSTOMER_LOGO_URL
ADMIN_WEB_CUSTOMER_LOGO_LINK
Specifies the URL for the page to which the MarkView Administrator or MarkView Process Administrator is
sent after clicking the customer logo. MarkView ignores this preference if no customer logo URL is set.
Values: A string of up to 400 characters, no default
See also
• ADMIN_WEB_CUSTOMER_LOGO_LINK
• ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
ADMIN_WEB_CUSTOMER_LOGO_URL
Specifies the URL for a customer logo graphic. You can configure MarkView Process Administration to
display the logo in the upper right-hand corner of the administration pages. Any logo used for this purpose
should be exactly 30 pixels in height. To display the logo, set this preference to the complete URL for the
location of the image. For example, your URL might look like this:
http://your.server.com:81/images/logo.gif
Values: A string of up to 400 characters, no default
See also
• ADMIN_WEB_CUSTOMER_LOGO_ALT_TEXT
• ADMIN_WEB_CUSTOMER_LOGO_LINK

MarkView Process Monitor Preferences
To access these preferences, select Administration > Process Admin to access the Process
Administration application.
MONITOR_HISTORY_DATE_FORMAT
Specifies the default date format for work item history display.
Values:
• MM/DD/YYYY HH:MI AM (default)
• DD/MM/YYYY HH:MI AM
• DD-MON-YYYY HH:MI AM
• MM/DD/YYYY HH24:MI
•
•
•
•
•
•

DD/MM/YYYY HH24:MI
DD-MON-YYYY HH24:MI
MM/DD/YYYY
DD/MM/YYYY
DD-MON-YYYY
HH24:MI:SS
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• HH24:MI
•
•
•
•

MM/DD/YYYY HH:MI:SS AM
DD/MM/YYYY HH:MI:SS AM
DD-MON-YYYY HH:MI:SS AM
HH:MI:SS AM

MONITOR_HISTORY_DISPLAY_DETAIL
When set to Y, displays additional details columns in the Work Item History view.
Values: Y, N (default)
MONITOR_MINIMUM_REFRESH_RATE
Specifies the minimum polling period in seconds for the Process MarkView Process Monitor.
Values:
• An integer >0
• 10 (default)
MONITOR_READABLE_ONLY
Specifies whether users can edit existing configurations.
Values:
• TRUE: Configurations are read-only.
• FALSE (default): Existing configurations can be edited.
MONITOR_REFRESH_RATE
Specifies the default polling period in seconds for the Process MarkView Process Monitor.
Values:
• An integer >0
• 30 (default)
MONITOR_WEB_CACHE_TIMEOUT
Specifies for how many seconds the Process Monitor retains bar-graph data before re-querying the
database.
Values:
• An integer >0
• 60 (default)
MONITOR_WEB_CUSTOMER_LOGO_ALT_TEXT
Controls optional Alt Text that can be displayed when a Process MarkView Process Monitor user places
the mouse over the customer logo. This preference is ignored when no customer logo URL is set.
Values: A string of up to 400 characters, no default
MONITOR_WEB_CUSTOMER_LOGO_LINK
Specifies the URL for the page to which the Process MarkView Process Monitor user is sent when he or
she clicks on the customer logo. This preference is ignored when no customer logo URL is set.
Values: A string of up to 400 characters, no default
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MONITOR_WEB_CUSTOMER_LOGO_URL
Specifies whether a logo is displayed in the upper right corner of the Process MarkView Process Monitor
window. Make any logo used for this purpose exactly 30 pixels in height. To display the logo, set this
preference to the complete URL for the location of the image. For example, a logo URL might look like
this:
http://your.server.com:81/images/logo.gif
Values: A URL string of up to 400 characters, no default
MONITOR_WEB_I8N_STYLESHEET
Specifies the font used to display characters. You must have Arial Unicode MS installed on the end user
computer running Process MarkView Process Monitor to use this font.
Values:
• TRUE: Uses Arial Unicode MS.
• FALSE (default): Uses the default font Arial.
MONITOR_WEB_QUERY_TIMEOUT
Specifies for how many seconds the spreadsheet views (items in queue, work item history) remain active
before timing out.
Values:
• An integer >0
• 300 (default)
MONITOR_WEB_SESSION_TIMEOUT
Specifies how many seconds elapse before the session times out.
Values :
• An integer >0
• 3600 (default)
MONITOR_WORKITEMS_DATE_FORMAT
Specifies the date format used in Process MarkView Process Monitor.
Values:
• MM/DD/YYYY HH:MI AM (default)
• DD/MM/YYYY HH:MI AM
• DD-MON-YYYY HH:MI AM
• MM/DD/YYYY HH24:MI
• DD/MM/YYYY HH24:MI
• DD-MON-YYYY HH24:MI
• MM/DD/YYYY
•
•
•
•
•
•
•

DD/MM/YYYY
DD-MON-YYYY
HH24:MI:SS
HH24:MI
MM/DD/YYYY HH:MI:SS AM
DD/MM/YYYY HH:MI:SS AM
DD-MON-YYYY HH:MI:SS AM
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• HH:MI:SS AM
PROCESS_MONITOR_LOGGING_LEVEL
Controls the logging output of Process MarkView Process Monitor.
Values: WARN (default), OFF, FATAL, ERROR, INFO, DEBUG, TRACE, ALL

MarkView Receipt Invoice Verification Preferences
MVAP_RECEIPTS_HOLD_QUEUE_TIMEOUT
Specifies the number of days that an invoice remains in the Receipts Hold Queue. At the end of the
timeout period, the invoice is processed to the next queue and populated to the ERP.
Values:
• An integer greater than 0
• 10 (default)
MVCN_DELETE_UNMATCHED_GRIV_LINES
Specifies whether MarkView changes the line structure type to "deleted" for unmatched invoice lines after
an invoice leaves the Receipts Hold Queue.
Values: TRUE, or FALSE (default)
MVCN_AUTOCREATE_PO_LINE
Specifies whether MarkView creates a dummy line on a PO if the total invoice amount in the invoice
header does not match the total of the invoice lines.
Values:
• TRUE (default): MarkView creates dummy lines. After processing, the invoice moves to the Interface
Processing Error queue.
• FALSE: MarkView does not create dummy lines. After processing, the invoice moves to the Verify AP
Process Complete queue.
MVERP_RECEIPTS_EXTRACTION_PERIOD
Specifies the length of the receipts export period in days, based on the posting date of the document.
Values: 183 (default), any integer greater than 0

MarkView Self-Service Invoice Preferences
SSI_ALERT_AFTER_SUPPLIER_MAINT
When True, MarkView sends an email message to the requestor when Supplier Maintenance is complete.
Values: True (default), False
SSI_ALERT_ON_IMPORT_FAILS
When True, MarkView sends an email message to the requestor when invoice import fails.
Values: True (default), False
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SSI_ALLOW_SUPPLIER_CREATE
When Yes, an SSI user can add a new supplier. When the user submits the new invoice, the SSI workflow
submits the work item for Supplier Maintenance, where a member of the AP department adds or changes
the supplier entry in Oracle Applications, if necessary. The work item is then routed back to the requester.
Values: Yes, No (default)
SSI_ALLOW_SUPPLIER_MODIFY
If Yes, the user can edit an existing supplier when they submit an invoice. See
SSI_ALLOW_SUPPLIER_CREATE.
Values: Yes, No (default)
SSI_AUTO_CALC_TAX_DEFAULT
Specifies whether the Auto Calculate Tax check box is selected by default, or if MarkView uses the
Supplier Site setting.
Values: Supplier Site (default),Yes, No
SSI_AUTO_EXPIRE_HOURS
Specifies the number of hours before the invoice request expires in a non-PO workflow.
Values: 96 (default), any integer
SSI_CREATE_TEMPLATE
Specifies if a user can assign an invoice or group of invoices to a template.
Values:
• Yes (default): Lets the user assign an invoice or group of invoices to a Template. This template can be
opened to facilitate faster entry of recurring invoices.
• No: Prevents the user from creating templates, but lets the user open templates created by others.
SSI_EMAIL_ADDRESS
Defines the email address used when sending follow-up documents.
Values: A valid email address, no default
SSI_ENABLE_CUSTOM
When True, MarkView calls any custom procedures defined for SSI during processing.
Values: True, False (default)
SSI_ENABLE_FOLLOWUP_CONFIRMATION
When True, sends an email message to the requestor when a follow-up document is attached to the
invoice.
Values: True (default), False
SSI_FAX_NUMBER
Defines the fax number that appears on the Fax Cover Page.
Values: A text string; no default
SSI_FOLLOWUP_EXPIRATION_ACTION
Defines the action to take when an invoice expires.
Values: ROUTE_TO_AP (default), CUSTOM, none
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SSI_FOLLOWUP_REMINDER_01, SSI_FOLLOWUP_REMINDER_02,
SSI_FOLLOWUP_REMINDER_03
How many hours between email reminders. MarkView sends reminders until it has sent all three
reminders or it encounters a reminder with a value of 0.
Values: A numeric value; defaults:
• SSI_FOLLOWUP_REMINDER_01: 4
• SSI_FOLLOWUP_REMINDER_02: 24
• SSI_FOLLOWUP_REMINDER_03: 72
SSI_INVOICE_SOURCE
The name of the invoice source used to load invoices created by SSI.
Note Changing this preference requires manual modification of the mvoa_ssi_import_processed_tr and
mvoa_ssi_import_rejected_tr triggers. Kofax recommends against changing this preference value.
Values: MARKVIEW SSI (default), free text
SSI_LOGGING_LEVEL
Specifies the granularity of the logging messages written by the MVAS SSI Module. Specifies what
appears in the mvssi.log.
Values:
• OFF: No messages logged.
• FATAL:Fatal error messages only. Recommended for production environments.
• ERROR
• WARN (default)
• INFO: Alerts when new sessions are established and terminated, when database connections are
established and terminated, and when application threads are started and stopped. Recommended for
test environments.
• DEBUG: For debugging purposes only. Should not be used without the direction of Technical Support
and even then should only be set at the User Preference level for the user doing the debugging.
• TRACE: Shows the preference values used by each session as it is established and when a session
changes to a new web page.
• ALL
SSI_LOV_RECORDS_PER_PAGE
Defines the number of records shown by default in long-list LOVs in SSI. When an Administrator uses the
SSI interface to change this value, MarkView automatically creates a User-Level preference.
Values: 10 (default)
SSI_REDEFAULT_ON_SUPPLIER_CHANGE
Specifies whether to redefault the dependent fields such as Payment Currency if the user changes the
supplier prior to submitting the invoice.
Values: Yes (default), No
SSI_REQUIRE_FOLLOWUP_FOR_APPROVAL
Specifies whether to require that a follow-up document be sent before the invoice goes to approval.
Values: True (default), False
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SSI_TAX_ENTRY_MODE
Specifies the type of tax-related fields to display during invoice entry.
Values for R12:
• REGIME_TO_RATE: Show Regime to Rate Flow Tax Fields (default)
• STCC: Show Tax Classification Code for Direct Tax Rate Determination
• NONE: Do not show any tax fields
SSI_TEMPLATE_SECURITY
Defines the level of availability for user-defined templates.
Values:
• PER_USER (default): Allows only the user who created a template to open or modify the template.
• PER_GROUP: Allows any user who is a member of the group that has the template assigned to them
to open or modify the template.
• NONE: Allows any application user to open or modify templates.

MarkView User Display Preferences
MVT_HISTORY_SHOW_CURRENT_QUEUE
Controls the display of the current queue in the document details in the MarkView viewer (Line Type
CURRENT_QUEUE).
Values: SHOW (default), HIDE
MVT_HISTORY_SHOW_DOCUMENT_CREATION
Controls the display of information about document creation in the document details in the MarkView
viewer (Line Type DOCUMENT_CREATION).
Values: SHOW (default), HIDE
MVT_HISTORY_SHOW_MARKUP_DETAIL
Controls the display of action details in the document details in the MarkView viewer (Line Type
MARKUP_DETAIL). Action details include who took the action and when, and in which views.
Values: SHOW (default), HIDE
MVT_HISTORY_SHOW_MARKUP_HISTORY
Controls the display of action history in the document details in the MarkView viewer (Line Type
MARKUP_HISTORY). Action history is the message (if any) that results when the action is saved. For
example, Donald Gray (DGray) took the Request Comment action and routed the work item to Casey
Brown (CBrown) for approval with the following comments: "This looks okay to me. "
This preference is meaningful only if the MVT_RETAIN_MARKUP_HISTORY_MESSAGES preference is
set to ALL; otherwise, there is no data to display.
Values: SHOW (default), HIDE
MVT_HISTORY_SHOW_WORKFLOW_HISTORY
Controls the display of workflow history in the document details in the MarkView
viewer (Line Type WORKFLOW_HISTORY). This preference is meaningful only if the
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MVT_RETAIN_WORKFLOW_HISTORY_MESSAGES preference is set to ALL; otherwise, there is no
data to display.
Values: SHOW (default), HIDE
MVT_HISTORY_SHOW_WORKFLOW_TRANSITION
Controls the display of workflow transitions in the document details in the MarkView viewer (Line Type
WORKFLOW_TRANSITION).
Values: SHOW (default), HIDE

MarkView Viewer Preferences
MAX_LIST_ROWS_ALLOWED
Specifies the maximum number of rows returned from the server to the client viewer.
Values: 500 (default), a number of 1 or higher
MVOA_DFM_LOV_FILTER_ALL_FIELDS
Controls whether list filtering includes searching the description field in the Accounting segment and
project lists. You can set this preference at the system level.
• TRUE: Includes the description field in the search.
• FALSE: Excludes the description field from the search. This value may improve viewer performance,
depending on the lists in use.
Values: TRUE (default), FALSE
MVT_WEB_DOCUMENT_CHECK_SECURITY_CUSTOM
Specifies whether MarkView uses the MV_SECURITY_CUSTOM package to authorize users before
displaying document links and icons.
Values:
• NONE (default): The viewer does not check MV_SECURITY_CUSTOM before displaying the document
link and icon.
• HIDE_UNAUTHORIZED: The viewer checks MV_SECURITY_CUSTOM and does not display the
document icon if the user is unauthorized to view the document. This setting prevents an unauthorized
user from determining if the document exists.
• SHOW_UNAUTHORIZED_ICON: The viewer checks MV_SECURITY_CUSTOM and shows a special
icon if the user is unauthorized to view the document. Users would be able to see that a document
exists, but would be unable to access the document.
PDF_IMAGE_SCALE_METHOD
Regulates the image page size and specifies the image scaling strategy.
Values:
• noScale (default): Page size has the same size as the original image. The value of the
PRINT_PAGE_SIZE preference is ignored for image pages.
• fitToPage: Images larger than the standard page size are shrunk to fit the page.
• scaleToPage: Small images are scaled up, large images are shrunk to the page size.

250

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

PRINT_PAGE_SIZE
Determines the image page size if the PDF_IMAGE_SCALE_METHOD preference is set to fitToPage or
scaleToPage. The PRINT_PAGE_SIZE preference also determines the text (non-image) page size.
Values: A4, Legal, Letter (default).
SECURITY_AUTHORIZED_DOCUMENT_TIMEOUT
Specifies the duration in seconds that the key specified in
SECURITY_AUTHORIZED_DOCUMENT_KEY_TYPE remains valid. Specifying a low value for this
preference creates the risk that authorization time-out before the viewer can retrieve a document from the
database.
Values: 300 (default), an integer >0
SECURITY_AUTHORIZED_DOCUMENT_KEY_TYPE
Specifies the type of character set obfuscation used to conceal the document ID. Both types provide equal
security, but Type 2 creates a longer string.
Values:
• Type1: Uses 128 character obfuscation
• Type2 (default): Uses 256 character obfuscation
SECURITY_AUTHORIZED_DOCUMENT_SYSTEM_ID
Specifies the MarkView System ID. This preference is specific to the MarkView Viewer Web Edition. This
value should be unique if a client computer needs to connect to multiple MarkView implementations.
Having a unique key prevents one systems' document keys from being used on another.
Values: A string of up to 200 characters, MVPROD (default)
SECURITY_AUTHORIZED_DOCUMENT_TIMEOUT
Specifies the duration in seconds that the key specified in
SECURITY_AUTHORIZED_DOCUMENT_KEY_TYPE remains valid. Specifying a low value for this
preference creates the risk that authorization time-out before the viewer can retrieve a document from the
database.
Values:
• An integer >0
• 300 (default)
SECURITY_AUTHORIZED_LOGON_TIMEOUT
Specifies the time in seconds that an authorization key remains valid. This preference is used when you
specify a WEBCLNT_LOGON_STYLE of TERSE.
Values:
• A positive integer
• NULL (default)
SECURITY_ENFORCE_ACCESS_CONTROL
Determines whether the MarkView viewer uses document keys. Document keys prevent unauthorized
users from cutting and pasting document URLs as a method of accessing documents. When FALSE, all
users have access to any document image.
Values: TRUE (default), FALSE
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SECURITY_ENFORCE_OS_USERNAME_MATCH
When TRUE, the MarkView viewer compares the user’s MarkView username to the user’s operating
system username. The two must match before the user can log in.
Values: TRUE, FALSE (default)
SECURITY_MASK_ACCESS_VIOLATIONS
When TRUE, the MarkView viewer displays user friendly error messages in response to password
violations. When FALSE, users see the underlying Java or package errors.
Values: TRUE, FALSE (default)
SECURITY_REQUIRE_ACCESS_TO_FAX
When TRUE, specifies that users must have permission to access a document to fax it.
Values: TRUE (default), FALSE
SECURITY_REQUIRE_ACCESS_TO_PRINT
When TRUE, users must have permission to access the document to print it.
Values: TRUE (default), FALSE
SECURITY_REQUIRE_ACCESS_TO_RASTERIZE
When TRUE, specifies that users must have permission to access a document to rasterize it.
Values: TRUE (default), FALSE
SYSTEM_VIEW_LOCKING_MODE
Specifies that when MarkView locks a document image, other users cannot work with the document.
Values:
• HARD_ONDEMAND (default): The viewer locks the first view alphabetically of the document image
once a user takes an action on the document.
• SOFT_ONDEMAND: The viewer locks the document image once a user takes an action on the
document. The lock, however, is non-exclusive, creating a potential for users to overwrite each other’s
changes.
• MANUAL: Users must manually lock the document image.
• NONE: The viewer does not lock document images. This setting creates a potential for users to
overwrite each other’s changes.
VIEWER_AUTO_PROCEED_MODE
Controls the page flow after a user takes an auto-proceed action. An auto-proceed action is generally
considered to be one that causes the work item to transition in the workflow.
Values:
• CURRENT: Always redisplay the main viewer page for the document on which the action was taken.
• CALLER: Return to the calling application, Web Inbox for example, unless none is defined, in which
case behave as CURRENT.
• NEXT_OR_CURRENT: Go to the next document in the list unless not working on a list or the current
document is the last one in the list, in which case behave as CURRENT.
• NEXT_OR_CALLER (default): Go to the next document in the list unless not working on a list or the
current document is the last one in the list, in which case behave as CALLER.
VIEWER_ENABLE_SAVE_IMAGE_ROTATION
Specifies whether employees have the option to save their image rotation settings.
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Values: TRUE, FALSE (default)
VIEWER_EMAILDOC_INTERNAL_DOMAINS
Specifies the domains to which an employee can send only an email link, not a PDF attachment. For
example, if you set this preference to "mycompany.com,Kofax.com" email sent to abc@mycompany.com
or abc@Kofax.com can contain only a link, not a PDF attachment. The employee using the Email
Document feature does not need to be in the same domain.
If you reset this preference, you must restart the application server to activate the change.
Values: A set of valid email domains separated by a comma, no default
VIEWER_FLASH_QUALITY
Controls the quality of images accessed from the Doc server by specifying the value of the SWFObject
'quality' parameter.
Values: low, medium, high, best (default)
VIEWER_FLASH_VERSION
Specifies the minimum version of Adobe Flash Player used by the viewer. MarkView verifies that you are
running at least the version specified.
Values: 10.0.0 (default)
VIEWER_HTTP_BASE_URL
Specifies the HTTP base URL of the MarkView viewer.
Values: http://(appserver):(port)/viewer (default)
VIEWER_IMAGE_CACHE_SIZE
Specifies the number of full-size page images to cache in the viewer.
Values: 10 (default), a number of 1 or higher
VIEWER_INCLUDE_EMAIL
Specifies whether to include an email request option on the toolbar menu.
Values: TRUE (default), FALSE
VIEWER_INCLUDE_FAX_REQUEST
Specifies whether to include a fax request option on the toolbar menu.
Values: TRUE (default), FALSE
VIEWER_INCLUDE_PDF_EXPORT
Specifies whether to include the option for a user to email a PDF attachment from the viewer.
Values: TRUE (default), FALSE
VIEWER_INCLUDE_PRINT
Specifies whether to include a print option on the toolbar menu. Clicking this button prints the document
and history directly to a local printer.
Values: TRUE (default), FALSE
VIEWER_INCLUDE_PRINT_REQUEST
Specifies whether to include a print request option on the toolbar menu. Clicking this button queues the
print request for servicing by the MarkView Print Server.
Values: TRUE (default), FALSE
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VIEWER_LOGGING_LEVEL
Specifies the log level for viewer components. Specifies what appears in the viewer.log.
Values: ERROR, WARN (default), INFO, DEBUG, TRACE, ALL
VIEWER_THUMBNAIL_CACHE_SIZE
Specifies the number of thumbnail images to cache.
Values: 25 (default), a number of 1 or higher
WEBCLNT_IMG_BASE_URL
Specifies the URL of the GUI elements of the viewer, such as style sheets and tab and button graphics. If
this value is not set correctly, the viewer can still function, but each of the graphical elements on the page
uses the broken image symbol of your browser, and text may appear in a different font than usual.
Values:
• A string of up to 400 characters
• NULL (default)
WEBCLNT_HTTP_BASE_URL
Specifies the base URL for the database access descriptor. It is used as the prefix for references in the
control window, making the MarkView viewer available from other MarkView suite applications.
Values:
• A string of up to 200 characters
• NULL (default)

MarkView Web Folder Preferences
WEBFLD_ALLOW_FILE_UPLOAD
If TRUE, enables users to upload native files from Web Folder.
Values: TRUE, FALSE (default)
WEBFLD_ALLOW_FILTERS
If TRUE, enables users to filter on documents in Web Folder.
Values: TRUE (default), FALSE
WEBFLD_ALLOW_ORDER_FOLDER
If TRUE, enables users to specify the order of documents in Web Folder.
Values: TRUE, FALSE (default)
WEBFLD_ALLOW_SORTING
If TRUE, enables users to sort documents in Web Folder by Description, Type, or Date.
Values: TRUE (default), FALSE
WEBFLD_ALLOW_UNFOLDER
If TRUE, enables users to remove documents from Web Folder.
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Values: TRUE, FALSE (default)
WEBFLD_DOCS_PER_PAGE
Sets the default number of documents to appear in a page view. If the user changes the value in the folder
list view, the changed value becomes the default. To display a continuous scrolling list, specify a numeric
value or ALL.
Values: A string of up to 200 characters, 20 (default)
WEBFLD_DOCS_PER_PAGE_MODE
Establishes how documents per page is enforced.
Values:
• MANDATORY: Enforces the system-level value of the WEBFLD_DOCS_PER_PAGE preference and
disables the per-page control in the folder list view.
• DEFAULT (default): Accepts the user-level value of the WEBFLD_DOCS_PER_PAGE preference,
which can be changed by the user using the per-page control in the folder list view.
WEBFLD_FILES_PER_UPLOAD
Sets the number of files that can be uploaded at one time.
Values: An integer >0, 3 (default)
WEBFLD_IMG_BASE_URL
Specifies the location of MarkView graphics for Web Folder.
Values: A string of up to 200 characters, no default
WEBFLD_SHOW_NON_MV_DOCS
If TRUE, Web Folder displays both MarkView and native documents; otherwise, only MarkView
documents appear.
Values: TRUE (default), FALSE
WEBFLD_USE_DOCUMENT_KEY
If TRUE, Web Folder uses encrypted keys when starting documents; otherwise, document IDs are
unencrypted.
Values: TRUE, FALSE (default)

MarkView Web Inbox Preferences
MVT_WIB_ALLOW_APPROVE
Determines if approval from the Web Inbox is available.
To enable the multiple approval feature, set this preference to TRUE for the group that will have access to
this feature.
Values: TRUE, FALSE (default)

255

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

MVT_WIB_API_GET_NEXT
Determines the Get Next Functionality to show.
Values: NONE (default)
MVT_WIB_API_MAX_RECORDS
Determines the maximum number of records a web inquiry query is allowed to return. Queries over the
limit will be rejected.
Values: 400 (default)
MVT_WIB_API_QUERY_DEBUG
Determines if the primary query used to generate the Payables Web Inbox result sets are displayed.
Values: HIDE (default)
MVT_WIB_API_SORT_TYPE
Specifies if inquiry sorting is done on the client or the server.
Values: CLIENT, SERVER (default)
MVT_WIB_APPROVE_FORM_NAME
Specifies the name of the Form Markup rendered on the document when approval through the Web Inbox
is selected.
Values:
• A string of up to 2000 characters
• NULL (default)
MVT_WIB_APPROVE_VIEW_NAME
Specifies the name of the View Type used on the document when approval through the Web Inbox is
selected.
Values:
• A string of up to 2000 characters
• NULL (default)
MVT_WIB_COLOR
Specifies the color used on MarkView Web Inbox pages.
Values: 03B68 (default)
MVT_WIB_GET_NEXT
Determines the Get Next Functionality to show.
Values: NONE (default)
MVT_WIB_SELECT_QUEUE
Specifies if the user can select a specific queue when pending or get next is allowed.
Values: TRUE, FALSE (default)
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MarkView Web Inquiry Preferences
MVT_WIQ_API_ADV_QUERY_FIELDS
If set to Y (yes), the advanced query fields appear on the Web Inquiry search page by default. Otherwise,
only the basic fields appear on the page. You can set this preference at the system, group, and user
levels.
Values: Y, N (default)
MVT_WIQ_API_BATCH_EMAIL
This preference is inactive.
MVT_WIQ_API_BATCH_FAX
This preference is inactive.
MVT_WIQ_API_BATCH_PRINT
Determines which batch print options are available to the user. Use this preference to set printing
capabilities on the Web Inquiry page of MarkView for Accounts Payable.
Values:
• ALL: Web Inquiry displays the Batch Print All button. Users can print all of the documents returned by a
search.
• SELECTED: MarkViewWeb Inquiry displays the Batch column and the Batch Print Selected button on
the Web Inquiry page. Users can select and print documents returned by a search.
• ALL OR SELECTED: MarkViewWeb Inquiry displays both the Batch Print All and the Batch Print
Selected buttons. Users can print all or selected documents.
• NO (default): No printing is permitted from the Web Inquiry page.
MVT_WIQ_API_MAX_RECORDS
Specifies the maximum number of records that a web inquiry query can return.
Values: 400 (default)
MVT_WIQ_API_QUERY_DEBUG
Determines what debugging information is available to the user. Use this preference to view queries and
step through the processes that run the MarkView Web Inquiry component of MarkView for Accounts
Payable.
Values:
• SHOW: Web Inquiry displays and automatically runs queries.
• HIDE (default): Web Inquiry automatically runs queries and does not display debugging information. In
most cases, you should choose this setting.
• SHOW_ONLY: Web Inquiry displays queries and waits for user approval before running the query.
MVT_WIQ_API_SECURITY
Specifies whether MarkView Web Inquiry calls a non-standard security procedure.
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Values:
• NONE: MarkView Web Inquiry uses default MarkView security.
• WHERELEVEL: MarkView(default) Web Inquiry calls a non-standard security procedure.
MVT_WIQ_API_SORT_TYPE
Determines whether inquiry sorting takes place on the server computer or the client computer.
Values: SERVER (default), CLIENT
MVT_WIQ_COLOR
Specifies the color used on MarkView Web Inquiry pages.
Values: 0071B9 (default)
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Chapter 21

Troubleshooting Guidelines
This chapter describes common issues, potential causes, and actions to take to resolve the issues.

Solving Issues with User Functions
If MarkView User Groups and Roles are set up incorrectly, your users might encounter problems
accessing or viewing MarkView documents and interface elements. For example:
• A menu item is not available in MarkView home
In Module Admin, check the Menu Item Group Auth table and confirm the user group assigned to the
menu. In Markview Admin, verify that the user is a member of that group.
• An AP processor receives a "no items pending" message even when MarkView has items pending.
In Process Administration, verify that the user’s role has the retrieval privilege for the queue and that
work items are pending for the user.
• A Markup is not available in the viewer
In MarkView Administration, check the Tool Privilege Auths for the missing tool. Ensure that the user is
assigned to a group that has access to the tool.
• A user cannot see work items in the Process Monitor
Use Process Administration to ensure that the user has roles enabled that have the examine privilege
authorized for the Process Monitor.

Identifying Common AP Entry Mistakes
• Clicking Get Next too frequently
Causes unattached documents to end up in the AP Working Folder
• Placing transitional actions too early
Causes an error message because the work item is not attached to a header; for preapproved, the item
is not fully distributed or matched to a PO.
• If no transitional action is taken
Causes the invoice to remain in the Working Folder.
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Resolving Email, Fax, and Print Issues
MarkView email, fax, and printing rely on the export server installation and setup. Verify the configuration
of the Fax Export server, the MarkView Fax server, and the MarkView Application Server Export server.
For information about setting up and configuring servers, see the MarkView Installation Guide.

Email
Problems trying to email PDF documents can be related to permissions. For example, the configured
servlet user name does not have the proper authorizations.
To test, ensure that the export user can open and view the document being exported. If this user cannot
authenticate or does not have permission to view the document, the export operation fails. The export
user must be able to log in to MarkView.

Investigating Workflow Issues
• If you are unsure as to why invoices are routed to a particular queue, for example, workflow admin,
check the preference settings and selections made during Organization Setup. To determine what
caused a work item to be routed to the Workflow Admin queue, use the Process Monitor to view the
Work Item History. The last transition includes the error that caused the work item to be routed to the
Workflow Admin queue.
• A user name changed in an Oracle HR record
• Work items assigned under the original user name cannot be accessed.
To solve this issue, assign the new user name in MarkView as the alternate to the original user
name. (MarkView retains both user names.)
• Work items that are in-process and need approval at the next level in the hierarchy are routed to
the Workflow Administration queue. This occurs because the system cannot determine the next
Approver in the hierarchy.
To solve this issue, for the new MarkView user name, change the
MVERP_USE_ALTERNATE_AUTHORITY preference setting at the user level to ALL and route the
affected work items back to the previous queue. Once all work items that were put into process under
the original user name finish processing, you can change the preference setting.

Addressing Performance Issues
• If your site experiences performance slow-downs and sporadic Java Virtual Machine (JVM) crashes
preceded by a slow-down, try restarting the MarkView Application Server on a weekly basis. Doing so
refreshes the runtime environment.
• If your site processes large batches and experiences excessive memory usage that result in
performance slow-downs, verify that the MarkView preference SPLIT_DOCUMENTS is set to TRUE
(default).
When set to FALSE, this preference instructs the connector to combine all pages from all images into a
single multi-page image, which leads to excessive memory use.
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Verifying the State of MarkView and the Viewer
1. From MarkView home, select Verify MarkView.
2. Click one of the show-document icons.
The MarkView viewer opens and displays the MarkView icon or a blank document. Both MarkView
and the viewer are running if the document image opens in the MarkView viewer.

Viewer Displays an Error About the Number of Pages
If the viewer displays an error that the number of pages should never be less than 1, check the viewer
workstation settings as follows.
1. From MarkView home, select Administration > MarkView Admin.
2. Select the Workstations tab.
3. Locate MarkView Express and click Details.
4. In the Details window, verify that the Serial Number is EXPRESS. Any other entry in this field
prevents the viewer from functioning.
5. Change the field entry to EXPRESS and click Save.

Finding a Lost Invoice
Use the Process Monitor to locate lost invoices. For information about using the Process Monitor, see
Monitoring Queues with the Process Monitor on page 113.

Viewing Expense Reports After an AP Import
If you import an AP Invoice and then purge Expense Reports, the Expense Report summary information
still appears in Expense Home, with a link to View Receipts. When you click the link, however, you not see
the receipt document because the Expense Report was purged from Oracle.

Logging Resources
This section provides pointers to logging resources available across MarkView.

Capture and Output Components
As Windows services, these components use the event log table:
• MarkView Bar Code Server
• MarkView Fax Server
• MarkView Process Mail Gateway
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Fax Server
MarkView Fax Server functions as a Windows service, so Fax Server logging activity is recorded in
the event log. You can control the level of logging. The default is to log errors, warnings, and some
informational messages such as successful send and receive fax activity.
To troubleshoot a problem, turn on debug mode by setting the value of the following Registry key to True:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\MVFaxServer7\Parameters\DebugMode
This writes messages to the standard Windows Events log.

Applications Log
The application server log files are located in the <path>/log directory, where <path> is the location where
you installed MarkView.
For information about setting up the log files location, see the Kofax MarkView Installation Guide.
MarkView Self-Service Invoice (SSI), another Application Server application, is a separate product. The
Self-Service Invoice log files are located at <path>/<ssi_instance_name>/log.

MarkView Installation
The MarkView installer records up to four log files during installation. For information about these log files,
see the MarkView Installation Guide.

Clearing Log Files
Log files can grow exponentially, which can degrade performance, and can be difficult to analyze when
investigating issues. For the best results, perform regular maintenance on the log files.
Archived log files provide an historical record that allows you to establish a baseline, detect patterns, and
so forth, but eventually they outlive their usefulness. Determine a suitable retention period after which you
purge archived files.
1. Establish a volume threshold at which to roll over the log file (20 MB, for example).
2. When the log file reaches the threshold, stop the process or application that is generating the log.
3. Move the log file to an archive directory. Use a timestamp naming convention to identify the period of
logging activity covered.
4. Later, go back and condense archived files (zip or tar) for more efficient storage and portability.

Synchronizing Password Changes
Many corporate IT policies require periodic password changes for the database schemas and
administrator accounts. Implementing such a policy with the MarkView schema and MarkView
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Administrator account passwords impact many MarkView suite components. Propagate the password
changes across the following components:
• All MarkView Capture and Output components.
• All application servers where a MarkView data source is defined.

Updating the MarkView Schema Password on the WebLogic Application
Server
Update your Connection Pool from the WebLogic Console.
1. Navigate to Domain Structure > Services > Datasources.
2. Select the MarkViewDS data source and click the Connection Pool tab.
3. Update the Password and Confirm Password fields.

Updating the MarkView Schema Password on the WildFly Application Server
Update your Connection Pool from the WildFly Console.
1. Navigate to Configuration > Datasources.
2. Select the MarkViewDS data source and click the Security tab.
3. Click Edit and update the Password and Confirm Password fields.

Updating Capture and Output Component Passwords
After Changing the MarkView Schema Password
If you changed the MarkView Schema password, complete the procedures in this section.

Updating the MarkView Import Server Password
1.
2.
3.
4.
5.
6.

Stop the MarkView Import Server service.
Launch the MarkView Import Server - Configuration tool.
Select the import server you are using and click Preferences.
In the Database Password field, enter the new password.
Click Test DB to verify your entry.
Click OK.

Updating the MarkView Data Export Server Password
1.
2.
3.
4.
5.
6.

Stop the MarkView Data Export Server service.
Launch the MarkView Data Export Server - Configuration tool.
Select the export server you are using and click Preferences.
In the Database Password field, enter the new password.
Click Test DB to verify your entry.
Click OK.

Updating the MarkView Fax Export Server Password
1. Stop the MarkView Fax Export Server service.
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2. Launch the MarkView Fax Export Server - Configuration tool.
3.
4.
5.
6.

Select the name of the fax export server you are using and click Preferences.
In the Database Password field, enter the new password.
Click Test DB to verify your entry.
Click OK.

Updating the MarkView Barcode Server Password
1.
2.
3.
4.
5.
6.

Stop the Barcode Server service.
Open the MarkView Barcode Server - Configuration tool.
Select the instance that you are running and click Preferences.
In the DbPassword field, enter the new password.
Click Test to verify your entry.
Click OK.

Updating the Process Mail Gateway Password
1. Stop the Mail Gateway service.
2. Open the MarkView Mail Gateway - Configuration tool.
3. Select the instance that you are running and click Preferences.
4. In the Database Password field, enter the new password.
5. Click Test DB to verify your entry.
6. Click OK.

Updating the Kofax MarkView Export Connector Password
1. On the server where Kofax Capture is installed, navigate to the \bin folder, for example, C:\Program
Files (x86)\Kofax\CaptureSS\ServLib\Bin.
2. Run the MVImportAPIConfig.exe file.
3. Select the MarkView Import API Configuration and click Preferences.
4. In the Database Password field, enter the new password.
5. Click Test DB to verify your entry.
6. Click OK.

Updating the Kofax Transformation Module Password
1. On the Capture and Output server, from the Start menu, select Programs > Kofax
Transformation > Project Builder.
2. Open the project that is synchronized with your batch.
3. From the menu bar, select Project > Script Variables.
4. Update the DatabasePWD script variable.
5. Click OK.
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Updating Relational Database Passwords
If your project settings in Kofax Capture include any relational databases, update those passwords as
follows:
1. In Kofax Capture, right-click the project name and select Project Settings.
2. Click the Databases tab.
3. Select a relational database line, for example, LimLockDB, and click Properties.
See the Database Type column to identify relational databases.
4. Next to the Connection String field, click Configure.
5. In the dialog box that opens, update Password.
6. Click Test Connection.
7. Click OK.
Note After updating passwords in Kofax Capture and Kofax Transformation Module, synchronize
and publish the project in Kofax Capture.

Updating the Database Validation Properties in Kofax Capture Batch Classes
1. In Kofax Capture Administration, expand each Batch Class.
2.
3.
4.
5.

Right-click the Document Type and select Database Validation.
Click Properties.
In the Password field, enter the new password.
Click OK.
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Component Performance Tuning
A MarkView implementation involves many components working together. This section provides
information about some of the more common problems and their solutions.

Performance Issues and Measurements
If you encounter performance issues, use the following metrics and performance statistics to localize the
source of your issue. The Technical Support team may also ask for this information if you enter a support
call.
• Server and viewer products—the most common performance problems are network related. Network
traces that show the amount of time it takes for a request to be sent and processed are helpful. For
upload and download issues, combine the amount of time it takes to download and upload a document
image with a network trace.
• MarkView Web Inbox and Invoice Inquiry type applications—you can provide data about execution
times for the SQL statements that the packages call within the database.
• MarkView Process Manager performance—issues directly relate to the number of events being created
coupled with processing time. Processing time can be high if the SQL queries executed in the rule code
are not properly tuned.

Using Performance Monitoring Tools
When you track performance in your MarkView implementation, use the Trace Route (tracert) command
to determine the network route from one host to another. For example, use this command to determine if a
router is down.
Although tracert can be effective, it only provides the theoretical route between the client and the host.
The actual route can vary based on network utilization. To be accurate, ping from a UNIX machine back to
the PC using the -R option to record the route taken, but only if your network devices support this option.
Use this utility for basic performance checks. For more information about your network, contact your
network operations organization.
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Starting Points
To improve and tune performance, look at the following applications and systems, which are the most
likely cause of bottlenecks:
• MarkView viewer
• Application server
• Get Next button in the Oracle Applications
• MarkView Process Monitor (for queues with large number of items)
• MarkView Process Manager (when catching up after spinning)
• Wide Area Networks
• Firewalls

Database Tuning
If you tie your performance issues to your database, consider the transactions that take place, and the
timeline along which events occur.

Database Transactions
•
•
•
•
•
•
•
•
•
•

Authentication
MarkView Accounting Details tool usage
Other general actions
HTTP user authentication
Application server-DB user session initialization
User groups
User Action tools
Session logging
Application server-DB user session transactions
Taking actions

User Session Transactional Timeline
The following time shows the database transactions that take place during a typical viewer session. Use
this information to observe, test, and identify events as they occur within your database.
•
•
•
•
•

Client sends HTTP request
Application Server issues an authentication challenge
Client sends authentication credentials
Response sent to client
MarkView viewer
• Application server DB execution
• Application server fetches TIFF from Document Server, renders as PNG
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• Application server response with document metadata and rendered document
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Appendix A

Synchronous and Asynchronous Events
MarkView classifies events as asynchronous or synchronous. This appendix describes the difference
between event types and how MarkView processes them.

Asynchronous Events
The MarkView system processes asynchronous events in the following separate database sessions:
1. An event is alerted in the first database session (for example, in a viewer session when a user
takes an action). Within that session, the system records the event and the event property values in
database tables. Then, the system commits the transaction.
2. MarkView Process Manager runs within its own database session. The MarkView Process Manager
periodically polls database tables, searching for new events. Upon finding a new event record, the
MarkView Process Manager examines the recorded events and property values, and runs any
triggered workflow rules. When processing is completed, the MarkView Process Manager commits
the transaction.
The MarkView Process Manager reports errors to the Process Manager log. If an error occurs and the
event is associated with a work item, the work item transitions to the Error queue.

Synchronous Events
The MarkView system processes synchronous events in the current database session. All of the rule logic
associated with the event is executed in the same database session as the process that alerted the event.
If the rule logic contains time-consuming SQL queries or if there are many rules to execute, this database
session can be busy for a long time.
If an error occurs and the event is associated with a work item, the item transitions to the Error queue. If
the event is not associated with a work item, the standard exception NO_DATA_FOUND is raised back to
the process that alerted the event.

Changes in MarkView Process Manager
The current version of the MarkView Manager runs as a database job (Oracle DBMS_JOB) and therefore
has no operating system dependencies. The MarkViewProcess Manager runs from within the context of a
database session under the MARKVIEW database schema.
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This version polls for events to process, executes the rule code associated with those events, and records
these actions in the database.
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Appendix B

Removing MarkView from the Oracle
E#Business Suite
Removing MarkView from Oracle Internet Expenses
To help resolve support issues, Technical Support may ask you to remove MarkView software from your
Oracle installation. This section describes how to remove the MarkView software from an installation of
Oracle Internet Expenses.

Replacing Modified Oracle Forms
MarkView uses modified versions of default Oracle forms. To restore a standard Oracle Internet Expense
installation, you must restore the original forms. From the MarkView for Oracle Applications database
objects, run the following scripts:
SFXINWKB_Undo.sql
SFXXXEER_Undo.sql
These scripts repoint all form functions from the modified versions of the forms back to the shipped
version of the forms.

Removing Integration Points from the APEXP Workflow
The APEXP workflow integrates with the MarkView suite at a number of points. Each procedure in this
section removes an integration point.

Opening the APEXP Workflow
1. Open the Oracle Workflow Builder.
2. Select File > Open.
3. Select Database and enter the APPS database Username, Password, and Connect String
information (the Effective text box can be left blank) and click OK.
4. From the Hidden list, select Expenses and click the Back button (<<). Expenses appear in the
Visible list.
In some versions of Oracle Applications, this workflow is called "AP Expense Report."
5. Click OK.
The expenses appear in a tree structure.
6. Expand the tree to display all of the options under the Expenses menu tree.

271

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

Removing MarkView System Activities
1. Open the process: AP Standard Expense Report Process.
2. Click SQL*Flow Initialize and click Delete.
3. Reconnect the two activities connected by SQL*Flow Initialize by right-clicking the first activity and
dragging and dropping onto the second. If the transition requires a result code, select the appropriate
transition from the list.

Removing MarkView System Functions
1. Expand the Functions section in Navigator.
2. Select the SQL*Flow Initialize function and click Delete.
A confirmation window opens.
3. Click OK to confirm the deletion.

Deleting MarkView Systems Messages
Note If the Systems Receipts Reminder Message was ever sent, you cannot delete it. The system
generate an error. Ignore the error and save the workflow. The second time it save without incident.
1. Expand the Messages section of Navigator.
2. Select the message Remind Employee Send Receipts Message and click Delete.
3. Click OK to confirm the deletion.

Deleting the Document Link Attribute
1.
2.
3.
4.

Expand the Messages section in Navigator.
Expand the properties for the Request Expense Report Approval Message.
Select and delete the Document Link attribute.
Repeat the preceding steps for other messages that contain the Document Link.
The following table lists the old and new names of seeded messages changed by Oracle.
Document Link Seeded Messages
Old Name

New Name

Inform Employee Expense Report Submitted by
Preparer Message

Inform Individual that Expense Report Submitted by
Preparer

Inform Preparer Missing Receipts Shortpay Message

Inform Preparer of Policy Non-Compliance for Missing
Receipts

Inform Preparer Policy Violation Shortpay Req More
Info Message

Inform Preparer of Policy Non-Compliance for Missing
Receipts

Request Employee Approval Message

Individual's Approval Message Request

Verify With Manager Approval Amount Message

Verify With Manager Amount Approved With
Company Violations
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The following messages remain unchanged across different Oracle versions:
•
•
•
•

Request Expense Report Approval Message
Expense Report Rejection Message
Request AP Review Policy Message
Inform AP Mgr Has Approved Shortpay With No Receipts Message

Deleting the Bar Code Link Attribute from Seeded Messages
1.
2.
3.
4.

Expand the Messages section in Navigator.
Expand the properties for Inform Preparer Missing Receipts Shortpay Message.
Select and delete the Bar code attribute.
Repeat the preceding steps for other messages that contain the "Bar code attribute."
The following table lists old and new message names of seeded messages changed by Oracle.
Bar Code Link Seeded Messages
Old Name

New Name

Inform Preparer Missing Receipts Shortpay Message

Inform Preparer of Policy Non-Compliance for Missing
Receipts

Inform Preparer Policy Violation Shortpay Req More
Info Message

Inform Preparer of Policy Non-Compliance for Missing
Receipts

Deleting MarkView Systems Attributes
1. Expand the Attributes section in Navigator.
2. Select the Document Link attribute and click Delete.
3. Select the Bar Code attribute, and click Delete.
A confirmation window opens.
4. Click OK to confirm the deletion.
5. Click Save.
Note Warnings, such as issues with out-of-the-box Oracle workflows, may appear during the save
process. Although this is normal, review the warnings to ensure that they are not a result of the
changes you just made. If the Systems Receipts Reminder Message was ever sent, then it could
not be deleted, but generated an error. Ignore the error and resave the workflow. The second time
save without incident.

Removing Integration Points from the OIE Regions
1.
2.
3.
4.
5.

Log in to Apps as SYSADMIN.
Switch to the Functional Administrator responsibility.
Click the Personalization tab.
Select Import/Export.
Expand oracle > apps > ap > oie > audit > webui > customizations > site > 0 and select:
• OIE_AUD_AUDIT_PAGE

273

Kofax MarkView Administrator's Guide for Oracle E-Business Suite, Volume 1

• OIE_AUD_SEARCH_PAGE
6. Expand oracle > apps > ap > oie > history > webui > customizations > site > 0 and select
ExpenseReportsPG.
7. Expand oracle > apps > ap > oie > webui > customizations > site > 0 and select the following:
• HomePG
• OIEMAINPAGE
• TrackReportsTblRN
8. Click Delete.
9. Click the Yes to confirm the deletion.

Removing MarkView Customizations from the
APPS.AP_WEB_OA_CUSTOM_PKG package
Customizations in the AP_WEB_OA_CUSTOM_PKG package add the bar code on the Expense
Submission page. To remove these customizations, revert to the standard Oracle supplied version of the
AP_WEB_OA_CUSTOM_PKG package.
If you do not have the standard Oracle supplied version of the AP_WEB_OA_CUSTOM_PKG package,
you can manually make the following changes to your current version of the package.
1. Open the AP_WEB_OA_CUSTOM_PKG package for editing.
2. Find the following lines:
l_msgtxt := ' ' ||
MVOAIN_Expense_Report.OIECustomHeader(P_ReportHeaderId,P_CurrentPage);
--l_msgtxt := NULL;

3. Comment out the first line and uncomment the second one:
--l_msgtxt := ' ' ||
MVOAIN_Expense_Report.OIECustomHeader(P_ReportHeaderId,P_CurrentPage);
l_msgtxt := NULL;

4. Find the following line:
Return '<B>Warning: </B>Call to MVOAIN_Expense_Report not successful<BR>' ||
' page = ' || P_CurrentPage ||
'<B>Error: </B>' || SUBSTR(SQLERRM, 1, 200);

5. Replace the line with the following:
Return '<B>Warning: </B>Call to AP_WEB_OA_CUSTOM_PKG.GetCustomizedExpRepSummary
not successful<BR>' || ' page = ' ||
P_CurrentPage ||
'<B>Error: </B>' || SUBSTR(SQLERRM, 1, 200);

6. Compile the new version of the package.
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Appendix C

Third-Party License Agreement
BEA Public License Version 2.1
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.
• "License" shall mean the terms and conditions of this agreement.
• "Licensor" shall mean BEA Systems, Inc.
• "Legal Entity" shall mean the union of the acting entity and all other entities that control, are
controlled by, or are under common control with that entity. For the purposes of this definition,
"control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or
(ii) ownership of fifty percent (50%) or more of the outstanding shares, or
(iii) beneficial ownership of such entity.
• "You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License, including but not limited to each Contributor other than Licensor in such Contributor’s role
as a licensee for the Software.
• "Source Format" shall mean the preferred form for making modifications, including but not limited
to software source code, documentation source, and configuration files.
• "Object Format" shall mean any form resulting from mechanical transformation or translation of a
Source Format, including but not limited to compiled object code, generated documentation, and
conversions to other media types.
• "Software" shall mean the original version of the software accompanying this agreement as
released by BEA, including in Source or Object Format, and also any documentation provided
therewith.
• "Derivative Works" shall mean any work, whether in Source or Object Format, that is based on
(or derived from) the Software and for which the editorial revisions, annotations, elaborations, or
other modifications represent, as a whole, an original work of authorship. For the purposes of this
License, Derivative Works shall not include works that remain separable from, or merely link (or
bind by name) to the interfaces of, the Software and derivative works thereof.
• "Contribution" shall mean any work of authorship, including the original version of the Software
and any modifications or additions to that Software or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Software by the copyright owner or by an individual
or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to
the Licensor or its representatives, including but not limited to communication on electronic
mailing lists, source code control systems, and issue tracking systems that are managed by, or
on behalf of, the Licensor for the purpose of discussing and improving the Software, but excluding
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communication that is conspicuously marked or otherwise designated in writing by the copyright
owner as "Not a Contribution."
• "Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a
Contribution has been received by Licensor and subsequently incorporated within the Software.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Software and such Derivative Works in Source or Object Format. Each
Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if any,
to grant the foregoing copyright license.
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Software, where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Software to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Software or a Contribution incorporated within the Software constitutes direct or contributory
patent infringement, then any patent licenses granted to You under this License for that Software
shall terminate as of the date such litigation is filed.
4. Redistribution. You may reproduce and distribute copies of the Software or Derivative Works thereof
in any medium, with or without modifications, and in Source or Object Format, provided that You
meet the following conditions:
• You must give any other recipients of the Software or Derivative Works a copy of this License; and
• You must cause any modified files to carry prominent notices stating that You changed the files;
and
• You must retain, in the Source Format of any Derivative Works that You distribute, BEA’s
copyright notice, "© [Date] BEA Systems, Inc. All rights Reserved.", and all other copyright, patent,
trademark, and attribution notices from the Source Format of the Software, excluding those
notices that do not pertain to any part of the Derivative Works; and
• You must affix to the Software or any Derivative Works in a prominent manner BEA’s copyright
notice, "(© [Date] BEA Systems, Inc. All rights Reserved." whenever You distribute the Software or
such Derivative Works in Object Format.
You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or
for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the
Software otherwise complies with the conditions stated in this License.
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Software by You to the Licensor shall be under the terms and
conditions of this License, without any additional terms or conditions. Notwithstanding the above,
nothing herein shall supersede or modify the terms of any separate license agreement you may have
executed with Licensor regarding such Contributions.
6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Software and reproducing the content of the NOTICE file.
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7. Disclaimer of Warranty. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT,
THE SOFTWARE IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR
REPRESENTATIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT
LIMITATION, ANY WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using and distributing the Software and assume all risks associated with Your
exercise of rights under this Agreement, including but not limited to the risks and costs of program
errors, compliance with applicable laws, damage to or loss of data, programs or equipment, and
unavailability or interruption of operations. Further, You understand that although each Contributor
grants the licenses to its Contributions set forth herein, no assurances are provided by any
Contributor that its Contribution does not infringe the patent or other intellectual property rights of
any other entity. Each Contributor disclaims any liability to You for claims brought by any other entity
based on infringement of intellectual property rights or otherwise. As a condition to exercising the
rights and licenses granted hereunder, You hereby assume sole responsibility to secure any other
intellectual property rights needed, if any.
8. Limitation of Liability. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NO
CONTRIBUTOR SHALL HAVE ANY LIABILITY TO YOU FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT
LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE SOFTWARE
OR THE EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
9. Accepting Warranty or Additional Liability. Commercial distributors of software may accept certain
responsibilities with respect to end users, business partners and the like. While this license is
intended to facilitate the commercial use of the Software, if You include the Software in a commercial
product offering, You may do so only in a manner which does not create potential liability for any
Contributor. Therefore, if You include the Software in a commercial product offering, You shall and
hereby do agree to defend and indemnify each and every Contributor against any losses, damages
and costs (collectively "Losses") arising from claims, lawsuits and other legal actions brought by a
third party against such Contributor(s) to the extent caused by Your acts or omissions in connection
with Your distribution of the Software in a commercial product offering. The obligations in this
section do not apply to any claims or Losses relating to any actual or alleged intellectual property
infringement. In order to qualify to receive indemnification from You, a Contributor must:
a. promptly notify You in writing of such claim, and
b. allow the You to control, and cooperate with the You in, the defense and any related settlement
negotiations.
The Contributor indemnified by You may participate in any such claim at its own expense.
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